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An ACT! database is a collection of files that store all the information about your contacts. In general, you'll need to
create only one database for all your contacts; you do not need to create multiple databases. See Categorizing 
your contacts for information about categorizing your contacts within a database. When you run the Database 
Setup wizard, you have the option of creating a database. If you decided not to create a database when you ran 
the Database Setup wizard, you will need to create a database now.



 Overview

To create a database

1. From the File menu, choose New. 
The New dialog box appears.

2. Select ACT! 3.0 Database from the File type list and click OK.
The New Database dialog box appears.

3. Enter a name for your database, specify a location for it, and click Save. 
If this is the first time you've created a database, a dialog box appears requesting the "My Record" information. 
The My Record is the contact record for the creator of the database. 
Note
In a multiuser database, each user has a My Record contact record.

4. Fill in the My Record information and click OK.
ACT! creates a new database. You're now ready to import or add your contact data. 

 Related Topics



If you have your contacts in a previous version of ACT!, you can simply open your ACT! contact database. You use 
the Open command to bring your ACT! contact data into the new database. If you have your contacts in another 
software application, you'll need to import them.

Note
Before bringing your old contact data into the new version, you may want to reindex your old ACT! database in 
your old ACT! version. 



The Create Backup option keeps your old ACT! database intact and makes a copy of it in ACT! 3.0 format. 
All of the files that are part of the old database are moved to the Backup folder in the same folder as your other old 
databases. In general, you should select this option-it's always wise to keep a backup of data in case of accidental 
corruption.

The Do Not Create Backup option converts your old ACT! database into an ACT! 3.0 database. If you select 
this option, you will no longer be able to open your database in a previous ACT! version.



 Overview

To bring your old ACT! contact data into your new database

1. From the File menu, choose Open.
The Open dialog box appears.

2. Find your old ACT! database and click Open.
Note
If you are importing files from ACT! 2.1 for DOS, select *.CCD from the File Type drop-down list.
The Convert Database dialog box appears.
You can decide whether or not to create a backup copy of your old database when you convert it to the new 
version.

3. Select Create Backup or Do Not Create Backup.    
4. Click OK.

Your old ACT! database is converted to ACT! 3.0 format, and is automatically opened. 
Note
Data that was in the Home Phone Extension field in ACT! 2.0 appears in the Alt Phone Extension field in ACT! 
3.0. Data that was in the Car Phone field in ACT! 2.0 appears in the Mobile Phone field in ACT! 3.0.
If the old ACT! database is a multiuser database, you must have Administrator security level to convert the 
database.

 Related Topics



You can add new contacts to your ACT! database at any time. A contact record contains more than 70 fields in 
which you can enter information about a contact. You can use as many or as few of these fields as you need. You 
can also add more fields if you want to record additional information about your contacts.
When you add a new contact, you can add a blank record and simply fill in all the information, or you can duplicate
address information from another contact record. For example, you may want to add several contacts who all work
at the same company and who all have the same address. You can use the Duplicate Contact command to copy 
the basic address information; then you simply enter the additional information.



 Overview

To add a new contact
From the Contact menu, choose New Contact, or click the New Contact tool in the toolbar.

A blank contact record appears. 
You are ready to enter the new contact's information.

 Related Topics



 Overview

To add multiple contacts with the same address 

1. From the Contact menu, choose Duplicate Contact.
The Duplicate Contact dialog box appears.
You can copy all of the fields in the current contact record except the E-mail Address field, or you can copy only 
the primary fields. The default primary fields are Company, Address 1, Address 2, Address 3, City, State 
(County, Land, or Province), Zip (Postcode), Country, Phone, and Fax. You can set other fields as primary fields. 
For information about modifying fields, see Setting field attributes.

2. Select the Duplicate Data From Primary Fields option or the Duplicate Data From All Fields option and click OK.
Note
If you select the Duplicate Data From All Fields option, the data in the E-mail Address field will not be 
duplicated.
A new contact record appears, filled in with the copied information from the original contact record.

3. Repeat these steps for each additional contact with the same address.
 Related Topics



When you add new contacts to your database, ACT! automatically saves them as soon as you move to another 
record or perform another action. You do not need to use the Save command to save contact information; 
however, if you simply enter a contact and you don't move to another record or perform another action, you may 
want to choose Save from the File menu.



 Overview

To manually save contact information
From the File menu, choose Save, click the Save File tool in the toolbar, or press Ctrl+S.

The Save command and the Save File tool are dimmed when all of the information has already been saved.
 Related Topics



The top area of the Contact window includes fields for the most basic contact information, such as name, company
name, address, phone number, and so on. The tabs at the bottom of the window bring up additional views, with 
more fields for entering contact information. 
Note that you can click any of the tabs at the bottom of the window, but the current contact in the top part of the 
window doesn't change. All of the information in the tabs is associated with the currently displayed contact.



 Overview

To enter basic contact information

1. Enter the company name in the Company field, then press the Tab key to move to the Contact field.
If you are entering a personal contact and do not want to enter a company name, you can leave the Company 
field blank. You are not required to enter data in any of the fields.

2. Enter the contact's name in the Contact field, then press the Tab key to move to the Title field.
When you enter a contact's name, you can enter the full first and last name, as well as any titles before or after
names such as Mr., Mrs., Ms., Jr., Sr., Esq., and so on. In most cases, ACT! can determine which part of a contact
name is the first name, and which is the last. For some unusual names that don't have a clear first and last 
name, you may need to specify which part of the name is the first name, and which is the last. To do this, click 
in the Contact field and press F2. The Contact Name dialog box appears.
Select the first and last names and click OK.

3. Enter the contact's title in the Title field or choose a title from the drop-down list, then press the Tab key to 
move to the Department field.

4. Enter the name of the contact's department or choose a department from the drop-down list, then press the 
Tab key to move to the Phone field.

5. Enter the contact's main phone number in the Phone field.
Note
ACT! includes additional phone fields in which you can enter alternate telephone numbers for your contacts.
The Phone field is set up to automatically format U.S. and Canadian phone numbers in the ###-###-#### 
style (for example, 800555-1212). You simply enter the numbers, and ACT! automatically puts in the dashes in 
the appropriate places. By default, international phone numbers are not formatted automatically. 

6. Continue entering contact information in each of the fields in the top part of the Contact window. Use the Tab 
key to move between fields.
When you reach the E-mail Address field, you'll notice that if you start typing, the E-mail Addresses dialog box 
appears.
Some of the fields, such as Title, Department, and ID/Status include drop-down lists from which you can choose 
an item instead of typing it into the field. When you click in any of these fields, a button appears, indicating 
that the field contains a drop-down list. You can type the first one or two letters of an option from the list in the 
field, and the appropriate selection will automatically fill the field. 
Note
The ID/Status field contains a drop-down list of categories for your contacts. You may find it useful to assign 
your contacts to categories such as Prospect, Vendor, Competitor, and so on, so that you'll be able to find all 
the contacts in each of those categories with a single command. For more information about doing this, see 
Categorizing your contacts.

 Related Topics



By default, you use the Tab key on your keyboard to move from one field to the next. You can also use the Enter 
key to move between fields; however, the Enter key and the Tab key move between the fields differently. Pressing 
the Tab key moves through each of the fields in order; pressing the Enter key moves between the most commonly 
used fields, known as "group stop" fields.
If you prefer to reverse the functions of the Tab and the Enter key, you can do this by setting an option in the 
General tab of the Preferences dialog box.



 Overview

To specify which key to use to move from field to field

1. From the Edit menu, choose Preferences.
2. Click the General tab if it is not already selected.
3. In the Move Between Fields Using group box, select either the Tab Key or the Enter Key option and click OK.

 Related Topics



You can enter international addresses and phone numbers using the fields in the Contact window. You can use the 
Address 1, Address 2, and Address 3 fields to enter any kind of address information, use the Zip field to enter 
international postal codes, and in the Country field, enter the country name or choose it from a drop-down list. In 
the Phone field and in all the additional phone fields, you select the country code and then enter the phone 
number. You can decide whether or not international phone numbers are automatically formatted according to the 
specified phone format for the selected country.



For example, you cannot enter different formats for U.K. and Irish phone numbers.



 Overview

To enter an international phone number

1. Click in the Phone field.
2 Click the browse button on the right side of the Phone field or press F2.

The Country Codes dialog box appears.
3. Select a country from the Country list.

The country code is displayed to the right of the country’s name in the list.
4. Select an option in the Phone Format group box.

Select the Free Form option if you want to enter phone numbers for the selected country without automatic
formatting.

Select the Apply This Format For Country Code option if you want all phone numbers for the selected 
country to be automatically formatted as you enter them. Note that this setting has no effect on phone numbers 
that you have already entered. 
5. (Optional) If necessary, modify the phone format for the selected country.

The format is used only if you select the Apply This Format For Country Code option. 
Note
All countries that use the same country code use the same format.    

6. Click OK.
7. Enter the phone number in the Phone field.

If you selected the Free Form option, you can enter numbers in any format. If you selected the Apply This 
Format For Country Code option, the phone number is automatically formatted as you enter it.

 Related Topics



By default, all of the ACT! phone fields display the country code before a phone number only if it differs from the 
country code of the My Record phone number. If you always want to see the country codes in the Phone field, you 
can turn on the Always Display Country Code In Phone Fields option. You may want to turn on this option if you 
have many contacts in different countries.



 Overview

To turn on the country code display

1. From the Edit menu, choose Preferences.
2. Click the General tab if it is not already selected.
3. Select the Always Display Country Code In Phone Fields option and click OK.

 Related Topics



By default, ACT! automatically fills in the Salutation field with the contact's first name. The salutation is used when 
you write letters to your contacts. You may want to address all of your contacts by their first names or you may 
prefer to address them all as Mr. or Ms. Last Name. You can specify that the last name be filled in automatically, or 
you can turn off the automatic filling of the Salutation field and enter the salutations manually.
When you enter names in the Contact field, ACT! recognizes certain first-name prefixes, such as Mr., Ms., and Dr.; 
last-name prefixes, such as de, da, von, and van; and last-name suffixes, such as Esq., Jr., and PhD. If you use 
name prefixes and suffixes that are recognized by ACT!, the Salutation field will be filled in properly, and therefore 
letters and memos will be correctly addressed. You can add to the lists of name prefixes and suffixes so that ACT! 
will recognize other prefixes and suffixes. Also, the program can tell which part of the name is the first name, and 
which part of the name is the last name so that you can quickly find contacts by looking up their first or last name.



Select the Use Contact's First Name option to have ACT! automatically fill in the Salutation field with the 
contact's first name.

Select the Use Contact's Last Name option to have ACT! automatically fill in the Salutation field with the 
contact's last name along with any titles you have entered before or after the name. For example, if you enter "Ms. 
Gloria Lenares" in the Contact field and select the Use Contact's Last Name option, the Salutation field will be filled 
in with "Ms. Lenares."

Select the Do Not Fill Salutation option if you do not want ACT! to fill in the salutation field automatically. If 
you select this option, you need to enter the appropriate salutation for each contact in the Salutation field.



 Overview

To change the way the Salutation field is filled in

1. From the Edit menu, choose Preferences.
2. Click the Names tab.
3. In the Salutation group box, select the appropriate options and click OK.    

 Related Topics



 Overview

To modify the lists of name prefixes and suffixes

1. From the Edit menu, choose Preferences, and click the Names tab.
In the Name Prefixes And Suffixes group box, you can view the default prefixes and suffixes by selecting the 
First Name Prefixes, Last Name Prefixes, or Last Name Suffixes options.

2. To add a new name prefix or suffix, select the appropriate option and click Add.
The Name Prefix/Suffix dialog box appears.

3. Enter the new name prefix or suffix and click OK.
4. To delete a name prefix or suffix, select the item from the appropriate list and click Remove.
5. Click OK when you have finished editing the name prefixes and suffixes.

 Related Topics



By default, some ACT! fields contain a drop-down list from which you can choose an item rather than typing the 
text in the field. For example, the City field is set up with a list of cities. Instead of typing "Montreal," you can 
simply choose Montreal from the list. An even more efficient way to choose an item from a drop-down list is to type
the first one or two letters of its name; this automatically fills the field with the item that starts with those letters. 
For example, you could type the letters "mo" to select Montreal as the city that will appear in the City field.
The following fields have drop-down lists by default: City, Country, Department, ID/Status, Last Results, State, Title,
Home City, Home Country, Home State, Asst. Title, 2nd Title, 3rd Title, Referred By, Record Manager, and 
Public/Private. You can edit the entries or add new entries to the existing lists in all of these fields except for the 
Public/Private and Record Manager fields. You can also create drop-down lists for other fields in the database.



 Overview

To select items from field drop-down lists

1. Click in one of the fields that has a drop-down list.
A drop-down arrow appears in the field, indicating that a list is available.

2. Click the drop-down arrow in the field.
The drop-down list appears with the items that you've entered.

3. Choose an entry from the list.
The text you selected appears in the field.

 Related Topics 



 Overview

To modify a field's drop-down list

1. Click in a field that has a drop-down list.
2. Click the drop-down arrow in the field.
3. Choose Edit List, which is always the last command in the field drop-down lists, or press F2.

The Edit List dialog box appears.
4. Do one of the following:

Click the Add button if you want to add items to the list. The Add dialog box appears. In the Item field, 
enter the text you want to appear in the list. Continue to add items to the list and click OK when you have finished.

Select an item from the list, and click Delete if you want to remove it from the list.
Select an item from the list, and click Modify if you want to edit an existing entry in the list. The Modify 

dialog box appears. Change the Item name or Description and click OK.
5. Click OK when you have finished editing your list.

 Related Topics



The User Fields tab includes nine user-definable fields. You can use these fields to enter any kind of information 
about your contacts. You can also change the names of the fields. For example, you may want to use the User 1 
field to enter your contacts' birthdays. 
For information about changing the names of fields, see Setting field attributes.



 Overview

To enter contact information in the user fields

1. Click the User Fields tab at the bottom of the Contact window.
When you first start using ACT!, the User Fields tab is selected.

2. Enter information in any or all of the User 1 through User 9 fields.
You can press the Tab key on your keyboard to move between fields.

 Related Topics



The Phone/Home tab includes fields for home phone, mobile phone, pager, alternate phone number, and for home 
address information. 



 Overview

To enter additional phone numbers and a home address

1. Click the Phone/Home tab at the bottom of the Contact window.
2. Enter information in any or all of the fields.

 Related Topics



The Alt Contacts tab contains fields in which you can enter the names and phone numbers of additional contacts 
who are in some way associated with the current contact. For example, you may want to include the name and 
phone number of the contact's assistant, manager, or partner. 
This tab also contains a Web Site field in which you can enter a contact's web site address, or URL (Uniform 
Resource Locator). After you enter a contact's URL, the Web Site field becomes an active link to the specified URL. 
When you click the address in the Web Site field, ACT! automatically launches your default web browser and goes 
to the specified web site.

Note
You must already have a web browser such as Netscape or Microsoft Explorer set up on your computer.



 Overview

To enter additional contacts in the current contact record

1. Click the Alt Contacts tab at the bottom of the Contact window.
2. Enter information in any or all of the fields.

After you enter a URL in the Web Site field, you can launch your web browser and open that URL with a single 
click in the Web Site field. 

 Related Topics



 Overview

To edit the address in the Web Site field
Do one of the following:
Use the Tab key on the keyboard to move to the Web Site field. You can now edit the address in the field.
Without clicking, move the pointer over the address in the Web Site field and leave it there for a few 

seconds. The pointer changes to an I-beam pointer, and you can now edit the address in the field.
 Related Topics



The Status tab includes fields of information about when you made changes to the contact record and when you 
last contacted the contact. These fields are automatically filled in. The Status tab also includes six additional user 
fields that you can customize to suit your needs as well as a field in which you can assign public or private status 
to the contact.
By default, all contacts are public contacts. This means that in a multiuser environment, other users who log on to 
your database will be able to see the contacts marked as public. You may, however, want to add some of your 
personal contacts to your ACT! database, and you may not want other users to see these records. By marking 
them as private contacts, no other users of your database can see those records. Not even a user with 
Administrator security level can see private contacts. 



 Overview

To enter and view a contact's status information

1. Click the Status tab at the bottom of the Contact window.
You cannot edit the data in the Last Reach, Last Meeting, Last Attempt, Letter Date, Create Date, Edit Date, 
Merge Date, or Record Creator fields. You can change data in the Record Manager, Public/Private, and User 10 
through User 15 fields.

2. (Optional) Change the Record Manager and Public/Private field data, and enter information in the User 10 
through User 15 fields.

 Related Topics



Some users find it convenient to enter contact information using the Contact List, which displays your contacts in a
list form with a column for each of the data fields. All of the same fields are available whether you are using the 
Contact window or the Contact List window.
If the Contact List doesn't display the contact information in the way you want, you can rearrange the order of the 
fields and remove fields that you don't use.



 Overview

To enter contact information in the Contact List

1. From the View menu, choose Contact List, or click the Contact List button at the bottom of the window.
2. Add a new contact or select an existing contact for whom you want to enter information.
3. Fill in the contact information in each of the fields, using the Tab key to move between fields.

 Related Topics.



You can enter any kind of information as a note about a contact. For example, after having a meeting with a 
contact, you may want to write a note to record what happened in the meeting. The note stays attached to the 
contact record unless you delete it. 
You enter notes in the Notes/History tab in the Contact window. In addition to displaying notes, this tab shows any 
history for the current contact, and also displays pointers to any files that are attached to the contact 
record. 

Note
You must enter notes in the Contact window. You cannot enter notes in the Contact List window.



 Overview

To enter a note in a contact record

1. Make sure that you are in the Contact window.
If you are not in the Contact window, choose Contacts from the View menu, or click the Contact Window button 
at the bottom of the window.

2. Click the Notes/History tab at the bottom of the Contact window.
The Notes/History tab appears.

3. Click the Insert Note button in the Notes/History tab, or you can click the Insert Note tool in the toolbar or 
choose Insert Note from the Contact menu.
A blank note with a border around it appears in the Regarding column.

4. Type the note in the note area. 
You can type as much as you want in the note. The text automatically wraps to the next line if it exceeds the 
width of the note area. 

5. (Optional) To adjust the width of the note, place the pointer over the right edge of the note border and drag to 
change its width.
The note text is saved as soon as you click anywhere outside of the Notes/ History tab.

 Related Topics



 Overview

To delete a note from a contact record

1. Click the Notes/History tab at the bottom of the Contact window.
2. Select the note that you want to delete by clicking its icon.

You can select multiple notes by pressing the Shift key as you make additional selections.
3. Press the right mouse button and choose Delete from the shortcut menu, or press the Delete key on your 

keyboard.
A message appears asking if you're sure you want to delete the selected note.

4. Click Yes to delete the note.
 Related Topics



You can choose to display or hide the column headings in the Notes/History tab.



 Overview

To display or hide the column headings

1. Click the Notes/History tab if it is not already selected.
2. Do one of the following:

If you want the column names to appear at the top of the columns, press the right mouse button and 
choose Show Column Headings from the shortcut menu.

If the column names are already displayed, press the right mouse button and choose Hide Column 
Headings from the shortcut menu.

If the Notes/History tab doesn't display the information in the way you want, you can rearrange the order of the
fields and remove fields that you don't use.

 Related Topics



You can attach any kind of file to a contact record. For example, you may have created a spreadsheet to track 
orders from a specific contact. If you attach the spreadsheet file to the contact's record, that file will always be 
part of the contact's record. You can later double-click the attachment to open the file in the application that was 
used to create it. 
If you have a scanner, you may find it useful to scan documents such as receipts, invoices, and faxes and then 
attach the scanned versions to contact records. In this way, you can easily keep track of all documents associated 
with your contacts.



 Overview

To attach a file to a contact record

1. Make sure that the correct contact is displayed in the Contact window.
2. Click the Notes/History tab if it is not already selected.
3. From the Contact menu, choose Attach File.

The Attach File dialog box appears.
4. Find the file that you want to attach and click Open.

The Notes/History tab now shows the name of the attachment and the date that you attached the file to the 
contact record.

 Related Topics 



 Overview

To delete an attachment from a contact record

1. Click the Notes/History tab at the bottom of the Contact window.
2. Select the attachment that you want to delete by clicking its icon.

You can select multiple attachments by pressing the Shift key as you make additional selections.
3. Press the right mouse button and choose Delete from the shortcut menu, or press the Delete key on your 

keyboard.
A message appears asking if you're sure you want to delete the selected attachment.

4. Click Yes to delete the attachment.
Note
This action deletes the shortcut to the attachment, not the attachment itself.

 Related Topics



You can print contacts' addresses and phone numbers in a number of commonly used paper formats such as 
Avery, Day Runner, and Day-Timer. This is a convenient way to take contact information with you when you are 
away from your computer.



Select this option: To print this contact data:
Primary address Contact's main address
Secondary address Contact's home address
Phone numbers All of the contact's phone numbers
Alternate contacts Second and third contacts' names and phone 

numbers
E-mail address The contact’s e-mail addresses (prints a 

maximum of three e-mail addresses)

Select this option: To do the following:
Double sided printing Print the address book on both sides of the 

page.
Break page on new 
letter

Start a new page for each letter of the 
alphabet.

Letter at top of page Print the current alphabetic letter at the top of 
each page.

Lines between 
contacts

Print a line between contact entries.

 European postal 
format

Print the postal code before the city.

 Overview

To print contact address books

1. From the File menu, choose Print.
The Print dialog box appears.

2. From the Printout Type drop-down list, choose Address Book if it is not already selected.
3. From the list of printout types on the left side of the dialog box, select the format in which you want to print the 

address book.
A preview of the selected address book printout appears on the right side of the dialog box.

4. Click Options to specify which information you want to print in your address books.    
The Address Book Options dialog box appears.

5. In the Print group box, select the items that you want to print in the address book. 
Using the Additional Fields drop-down lists in the upper-right side of the dialog box, you can also specify up to 
three additional fields of information to print in the address book.

6. In the Print settings group box, specify how you want to print the address book.    
7. In the Sort Order group box, specify whether to sort the address book by company name or by last name.
8. In the Create Printout For group box, specify whether to include the current contact, the current lookup, or 
all contacts in the printout.
9. (Optional) Click Font to specify the typeface that you want to use to print the address book.
10. Click OK in the Address Book Options dialog box.

The Print dialog box reappears.
11.Click OK.

The standard Windows Print dialog box appears.



12.Click OK to print the address book.
In some cases, you will be prompted to insert paper in your printer.

 Related Topics



At any time, you can simply correct information or add new information to a contact record. For example, you may 
need to update a telephone number or address, or you may want to add a home address to a contact record.



For example, if you want to enter a new fax number for the contact, move the pointer to the Fax field. You can 
move between fields using the mouse, the Tab key, or the Enter key.



 Overview

To change a single contact record

1. In either the Contact window or the Contact List window, go to the contact record that you want to change.
You can use one of the commands in the Lookup menu to quickly find a contact.    

2. Move to the field that you want to update.    
3. Select the data that you want to replace and type in the new data.
4. (Optional) When you have finished making changes to a contact record, choose Save from the File menu or
click the Save File tool in the toolbar.

If you do not use the Save command, your data will be saved automatically when you move to a different 
contact record or when you move to another window such as a calendar or the E-mail window.

 Related Topics



Sometimes you may want to update more than one contact record at a time. For example, you may have several 
contacts who work at the same company. If that company moves to a new location, you can update all of the 
contacts' addresses at the same time, rather than having to enter the new address into each contact record 
individually.



For example, if you want to change the address for all your contacts at Company XYZ, you can choose Company 
from the Lookup menu and enter Company XYZ as the company to be found.



If you are updating an address, city, and zip code (postcode), enter the new information in the Address, City, and 
Zip (Postcode) fields. You can change information in any of the fields, including fields on different tabs. For 
example, you may want to update information in the User Fields tab and in the Alt Contacts tab.



 Overview

To change multiple records at one time

1. Choose Contacts from the View menu, or click the Contact Window button to display the Contact window.
2. Use one of the commands in the Lookup menu to find the contacts whose records you want to update.    
3. From the Edit menu, choose Replace.

The Replace window appears with all of the fields empty.
You can use any of the tabs at the bottom of the Contact window to view additional fields in which you want to 
change information. Note that you cannot modify information in the Notes/History, Activities, or Groups tab 
from the Replace window.
Note
If you need to edit fields that do not appear in the currently selected layout, you must switch to the layout that 
contains those fields. You can choose a different layout from the layout drop-down menu at the bottom of the 
window.

4. Enter the new or changed information in one or more fields.    
If you want a field to be blank, put the pointer in the field and type <<BLANK>> or press Ctrl+F5.

5. When you have finished entering the information that you want to change, choose Apply from the Replace 
menu or click the Apply tool in the toolbar.
Note
Keep in mind that all of the contacts in the current lookup will be affected by this procedure. If the process is 
taking too long and you need to cancel it, press the Esc key. All changes that have already been made will 
remain in affect.
The Contact window reappears with the new information in the appropriate fields. 

 Related Topics



Occasionally, you may find that you've entered contact information in one field and then decide that you would 
rather have it in another field. For example, if you enter contacts' hobbies in the User 1 field and birthdays in the 
User 7 field, you may run out of space in the User 1 field and decide that you would prefer to use the longer User 7
field for hobbies. You can swap the information between the two fields without doing any manual copying or 
pasting.



 Overview

To swap contact information between fields

1. Choose Contacts from the View menu or click the Contact Window button to display the Contact window.
2. Use one of the commands in the Lookup menu to find the contacts whose records you want to update.    
3. From the Edit menu, choose Replace.

The Replace window appears.
4. From the Replace menu, choose Swap Fields or click the Swap Fields tool in the toolbar.

The Swap Field Contents dialog box appears.
5. From the Swap Contents Of drop-down list, select the field whose information you want to replace and 

exchange with that of another field.
6. From the With Contents Of drop-down list, select the field whose information will be exchanged with the other 

field, and click OK.
The Contact window reappears with all of the information in the fields that you specified.

7. If you want to swap information between other fields, repeat steps 3 through 6.
Note
Keep in mind that all of the contacts in the current lookup will be affected by this procedure. If the process is 
taking too long and you need to cancel it, press the Esc key. All changes that have already been made will 
remain in affect.

 Related Topics 



Sometimes you may find it useful to copy information from one field to another, and copying data manually from 
one field and pasting it into another field can be time-consuming, especially if you want to copy the data and paste
it into multiple contact records. You can use the Copy A Field command in the Replace window to quickly copy 
information between fields in one or more contact records.



 Overview

To copy contact information between fields

1. Choose Contacts from the View menu or click the Contact Window button to display the Contact window.
2. Use one of the commands in the Lookup menu to find the contacts whose records you want to update.    
3. From the Edit menu, choose Replace.

The Replace window appears.
4. From the Replace menu, choose Copy A Field or click the Copy A Field tool in the toolbar.

The Copy Field Contents dialog box appears.
5. From the Copy Contents Of drop-down list, select the field from which you want to copy data.
6. From the To drop-down list, select the field into which you want to copy the data and click OK.

The Contact window reappears with all of the information in the fields that you specified.
7. If you want to copy information between other fields, repeat steps 3 through 6. 

Note
Keep in mind that all of the contacts in the current lookup will be affected by this procedure. If the process is 
taking too long and you need to cancel it, press the Esc key. All changes that have already been made will 
remain in affect.

 Related Topics 



When you have all of your contacts in an ACT! database, you may find it useful to categorize them so that you can 
quickly bring up a collection of records based on certain criteria. For example, you may want to categorize some of
your contacts as personal and some as professional so that you can quickly print an address book for one of the 
two sets of contacts at a time. Or you may want to set up distinct categories for your contacts based on their field 
of business so that you can send bulk mailings to certain categories of contacts.



 Overview

To categorize your contacts
Do one of the following:
Use the ID/Status field in the Contact window to assign your contacts to categories such as customers, 

prospects, vendors, consultants, and so on. If you use this field to categorize your contacts, you can later use the 
ID/Status command in the Lookup menu to find all of your contacts in each category. 

Create groups of contacts, which represent accounts, company records, or any other collection of contacts 
who have something in common. Although setting up groups is slightly more complicated than setting an ID/Status 
for each contact, group records let you keep track of notes, history, and activities for the whole group instead of for 
each contact. In addition, a contact can be a member of several different groups. 

 Related Topics



On certain occasions, you may decide to delete one or more contact records from your database. You can delete 
the current contact or the current lookup. Be aware, however, that if you delete a contact or a lookup of contacts, 
you will lose all history, notes, and other information associated with those contacts. 



 Overview

To delete a contact

1. Go to the contact record that you want to delete.
2. From the Contact menu, choose Delete Contact, or press Ctrl+Delete.

A dialog box appears with a warning that the deletion of records cannot be undone.
3. Click Record to delete the current contact, or click Lookup to delete the current lookup.

The contact or lookup is removed from your database.
 Related Topics



Displaying one contact record at a time is not always the most convenient way to view your contacts. On many 
occasions, you may find it useful to work with a list of all your contacts. ACT! lets you view your contacts in a list, 
and from the list you can select one or more contacts. You can also omit contacts from the Contact List or select 
the contacts you want to appear in the Contact List.



 Overview

To view a list of your contacts
From the View menu, choose Contact List or click the contact list button at the bottom of the screen.

All of your contacts appear in a list.
The Contact List may not show the information about your contacts that you find most useful. For example, you
may want to view only the contact names and telephone numbers, rather than viewing all of their address 
information. You may also want to change the order in which contacts appear in the Contact List. By default, 
contacts appear in alphabetical order by company name. 

 Related Topics



 Overview

To specify which contacts appear in the Contact List

1. Use the selection buttons in the Contact List window to select the contacts that you want to appear in the 
Contact List.
Shift+click to select multiple contacts who are adjacent in the list. Ctrl+click to select multiple contacts who are
dispersed in the list.

2. Click the right mouse button, and choose Lookup Selected from the shortcut menu.
Only the selected contacts appear in the Contact List. They are now the current lookup.

 Related Topics



 Overview

To open the Contact window for a contact in the Contact List
Double-click the selection button for a contact in the Contact List.

The Contact window appears with the selected contact’s record.
 Related Topics



 Overview

To omit a contact from the Contact List

1. Use the selection buttons in the Contact List window to select one or more contacts that you do not want to 
appear in the list.
Shift+click to select multiple contacts who are adjacent in the list. Ctrl+click to select multiple contacts who are
dispersed in the list.

2. Click the right mouse button, and choose Omit Selected from the shortcut menu.
The selected contacts no longer appear in the Contact List, and the record counter displays the number of 
contacts currently displayed in the Contact list. The omitted contacts are still in the database, however, and 
you can quickly find them using one of the Lookup commands. 

 Related Topics



When you are in the Contact window, you can see any notes, histories, and attachments associated with a contact.



 Overview

To view the notes and history for the current contact

1. Make sure that you are in the Contact window by choosing Contacts from the View menu or by clicking the 
Contact Window button.

2. Click the Notes/History tab at the bottom of the window.
By default, all of the notes, histories, and attachments associated with the current contact appear in this tab. If 
you want, you can turn off the display of any of these items. You can also specify the dates for which you want 
to see notes, histories, and attachments. This is known as filtering.

 Related Topics



 Overview

To turn off the display of notes, histories, or attachments
Click any of the three check boxes to keep notes, histories, or attachments from appearing.

You can turn them back on by clicking the check boxes again.
 Related Topics



 Overview

To filter notes, histories, and attachments by date

1. Click anywhere in the Notes/History tab.
2. From the Edit menu, choose Filter.

You can also click the right mouse button and choose Filter from the shortcut menu. The Filter Notes/History 
dialog box appears.

3. In the Users group box, select the users whose Notes/Histories you want to see, or select All Users.
If you are the only user of the database, only your name appears in the Users list.

4. In the Show group box, select the items that you want to appear in the Notes/ History tab.
5. In the Select Dates group box, select one of the date options.

If you select the Date Range option, a Date Range field appears with a drop-down button. 
6. Click the button to display a drop-down date selector from which you can select a date range.
7. Select a date range on the date selector.

You do this by dragging through the dates you want, releasing the mouse when you have specified the end 
date. To select more than one month, drag through the first month that you want to include, then drag off the 
right side of the date selector. The date selector will scroll through the next months until you move the pointer 
back over the date selector.

8. Click outside of the date selector when you have selected the dates for which you want to see notes, histories, 
and/or attachments.
The specified date range appears in the Date Range field.

9. Click OK.
The Notes/History tab displays only what you have specified. 
Note
To display the notes and histories for all users and all dates, select the All Users and All Dates options in the 
Filter Notes/History dialog box.

 Related Topics



By default, ACT! sorts your contacts by company name in ascending (A to Z) alphabetical order. When you use one
of the Lookup commands to find a set of contacts, the found set of contacts is sorted alphabetically by the lookup 
criteria. For example, if you use the Lookup > State (County, Land, or Province) command, the found set of 
contacts is sorted alphabetically by state (county, land, or province). 
You may prefer to see your contacts in an order based on different criteria, such as alphabetically by last name. 
Using the Sort command, you can specify up to three different sorting criteria, each of which can be in ascending 
or descending order.



Ascending means from A to Z or from the smallest number to the largest number; Descending means from Z to A 
or from the largest number to the smallest number.



 Overview

To sort your contacts using one or more criteria

1. From the Edit menu, choose Sort.
The Sort Contacts dialog box appears.

2. Select an option from the Sort Contacts By list.
This is the first-level sort criterion; this means that your contacts will appear in the order you specify here. 

3. Select Ascending or Descending for the sorting order.    
4. (Optional) Select an option from the And Then By and And Finally By lists, and specify Ascending or 
Descending order for each of these.
5. Click OK.

 Related Topics



One of the most critical tasks in managing your contacts is finding specific contact records when you need them. 
Finding contacts can be as simple as looking up someone by first name, or as sophisticated as finding all of your 
contacts in the western region of the United States who have purchased more than one hundred units of your 
product in the last six months. 
When ACT! finds one or more of your contacts, it creates what is called a lookup. A lookup is a selection of contact 
records based on criteria that you specify. When you perform a lookup operation, only the contacts in that lookup 
appear in your Contact and Contact List windows. For example, if you use the City lookup command to find all of 
your contacts in Paris, only the contacts whose addresses are in Paris appear in the Contact and Contact List 
windows.
You use the Lookup menu to find contacts. Some people think of this as "running a filter on" or "searching" a 
database. When you perform a lookup, you create a set of contacts who match the criteria of your lookup. 



Commands in the Lookup menu
Command Result
My Record Finds your own contact record.
All Contacts Finds every contact record in the open 

database.
Company Finds all contact records in the open database 

that match the Company criterion that you 
specify.

First Name Finds all contact records in the open database 
that match the First Name criterion that you 
specify.

Last Name Finds all contact records in the open database 
that match the Last Name criterion that you 
specify.

Phone Finds all contact records in the open database 
that match the Phone criterion that you 
specify.

City Finds all contact records in the open database 
that match the City criterion that you specify.

State 
(County, 
Land, or 
Province)

Finds all contact records in the open database 
that match the State (County, Land, or 
Province) criterion that you specify.

Zip Code 
(Postcode)

Finds all contact records in the open database 
that match the Zip Code (Postcode) criterion 
that you specify.

ID/Status Finds all contact records in the open database 
that match the ID/Status criterion that you 
specify.

Other Fields Finds all contact records that match the 
criterion that you specify for an indexed field. 
By default, indexed fields are those that 
appear in the Lookup menu. You can modify 
your database so that more fields are 
indexed and available to you for quick 
lookups.

Previous Replaces the currently found set of contact 
records with the previously found set of 
records.

Keyword Finds all contacts whose records contain a 
keyword that you specify. Note that Keyword 
lookups can be time-consuming because they
search non-indexed fields.

By Example Finds all contact records that match the 
criteria specified in a query. Note that By 
Example lookups can be time-consuming 
because they search non-indexed fields. 



Synchronized
Records

Finds most recently synchronized records and 
records marked for deletion.

Modify Menu Lets you add your saved queries to the Lookup
menu.

 Related Topics 



For example, to find all of your contacts in Amsterdam, enter Amsterdam in the Enter The City To Be Found field. 
You can also enter just the first few characters of a search criterion. For example, if you enter the letters "ja" when 
looking up contacts by first name, ACT! will find all contacts whose first name starts with "ja" such as James, Janet, 
Jacob, and so on. 



For example, if you first use the State command to find all of your contacts in Texas and then use the City 
command to find all of your contacts in London, your Texas contacts will no longer be in the current lookup; only 
your London contacts will be part of the current set of contacts. This is the option that you will probably use most 
frequently.



 Overview

To find contacts using a single search criterion

1. Choose one of the commands from the Lookup menu.    
The Lookup dialog box appears, unless you chose My Record, All Contacts, Other Fields, Previous, Keyword, or
By Example.
If you choose the Other Fields command from the Lookup menu, the Lookup Other dialog box appears.

2. (Other Fields command only) Select the field on which you want to search from the Available Fields drop-down 
list.
If a field does not appear in the Available Fields drop-down list, it is not an indexed field.

3. Enter the search criterion in the Enter The Value To Be Found field in the Lookup dialog box.    
If a field has a drop-down list set up for it, the drop-down list is also available in the Lookup dialog box, so you 
can simply choose the item for which you want to search from the drop-down list.

4. Select the Replace Lookup option and click OK.
Replace Lookup is the default option, and it causes the new set of contacts to replace the previously found set 
of contacts.    

 Related Topics 



One of the most critical tasks in managing your contacts is finding specific contact records when you need them. 
Finding contacts can be as simple as looking up someone by first name, or as sophisticated as finding all of your 
contacts in the western region of the United States who have purchased more than one hundred units of your 
product in the last six months. 
When ACT! finds one or more of your contacts, it creates what is called a lookup. A lookup is a selection of contact 
records based on criteria that you specify. When you perform a lookup operation, only the contacts in that lookup 
appear in your Contact and Contact List windows. For example, if you use the City lookup command to find all of 
your contacts in Paris, only the contacts whose address is in Paris appear in the Contact and Contact List windows.
You can also find contacts by searching for keywords contained in their records. A keyword is any word that 
appears somewhere in a contact's record. For example, you may want to find a contact whose name you have 
forgotten; however, you remember making a note in his record that he sold tennis equipment. You can search for 
the keyword "tennis," and find that contact. 
ACT! can search for keywords in the following places in a contact record:

In the fields of a contact record
In the fields of a group record
In the activities scheduled for a contact
In the notes and history of a contact
In a contact's e-mail address



 Overview

To find contacts or groups using keywords

1. From the Lookup menu, choose Keyword.
The Lookup Keyword dialog box appears.

2. Enter a word or phrase that you want to find.
You can enter a whole word or just the first few characters of the word you want to find.

3. Select Contacts, Groups, Activities, Notes/History, or E-mail Address to specify where you want ACT! to search 
for the keyword, and click OK.
The Groups option is not available if you choose Lookup > Keyword from a contact record. The E-mail Address 
option is not available if you choose Lookup > Keyword from a group record.
Note
Although you can select all of these options at the same time, it may be very time-consuming to have ACT! 
search through all of these areas for keywords. Try limiting your selections if you find that the lookup operation 
takes too long.

 Related Topics 



After you use one of the Lookup commands to find a set of contacts, you can add to this lookup by selecting 
additional lookup criteria and adding the contacts to the current set of contacts. Conversely, you can refine or 
narrow your set of contacts by specifying different lookup criteria and eliminating contacts who do not match these
criteria.
For example, you may be planning a trip to Chicago, and you want to see a list of all your contacts in Chicago so 
that you can set up appointments with them while you're in the area. Using the City command in the Lookup 
menu, you can easily find all of your contacts in Chicago. 
You may then realize that some of your contacts are in the Chicago area, but are not in the city limits, so you can 
broaden your lookup by adding additional cities (or additional zip codes). Finally, you may decide that you now 
have contacts in too broad an area, so you can narrow the lookup to eliminate the contacts who are too far from 
Chicago.



For example, if you previously looked up all your contacts in New York and then decided that you also wanted to 
include your New Jersey contacts, you would choose the State command from the Lookup menu, enter New Jersey, 
and select the Add To Lookup option. The resulting set of contacts would include all contacts in New York and New 
Jersey.



For example, if you first look up all of your contacts at Company X and then decide that you want only the contacts
at Company X who work in the London office, you would choose the City command from the Lookup menu, enter 
London, and select Narrow Lookup. The resulting set of contacts would include all of your Company X contacts in 
the London office and eliminate all of your contacts at other Company X locations.



 Overview

To broaden or narrow a lookup

1. Use one of the Lookup commands to find a set of contacts.    
2. From the Lookup menu, choose another command that will let you add to or narrow your current set of 
contacts.
3. In the Lookup dialog box, enter the value to be found, then select the Add To Lookup or the Narrow 
Lookup option and click OK.

Note
These options are not available if you choose My Record, All Contacts, Previous, Keyword, or By Example from 
the Lookup menu.

Add To Lookup causes the newly found set of contacts to be added to the previously found set of contacts.  
 

Narrow Lookup causes the current set of contacts to be reduced to a specified subset of contacts. When 
you select this option, ACT! looks only in the current set of contacts to find the new set of contacts.    

 
 Related Topics 



In some cases, you will not be able to find the precise set of contacts that you want using the Add To Lookup and 
Narrow Lookup options in the Lookup dialog box. When this is true, you will need to use the By Example command 
in the Lookup menu, which allows you to create a query. A query is a sophisticated search operation that compares
all the contacts in the open database with the multiple criteria that you specify, resulting in a lookup of contacts 
that match those criteria.
For example, suppose that you want to find all of your contacts in France, Germany, and Italy who have ordered 
products from you in the last year. Assuming that you have set up a field in your database in which you enter the 
date of a contact's last order, you can find all of these contacts using a query.



 Overview

The advantages of using queries
Queries allow you to find contacts that you cannot find using the other commands in the Lookup menu. The 
following list explains some of the advantages of using queries:

You can find contacts based on information in any field in the database. The other Lookup commands 
search a limited number of fields.

In a single step, you can find contacts based on criteria in multiple fields, or based on multiple criteria in 
one field. With the other Lookup commands, you have to perform multiple lookups to add to or subtract from a set 
of contacts.

You can save and reuse query specifications. You cannot do this with other lookups.
 Related Topics



You need to create a new query in order to find a group of contacts that cannot be found using the other Lookup 
commands. When you create a query, you can save it and reuse it. This is useful if you frequently want to find the 
same set of contacts.
Before you can create a query, you will need to understand the operators to use when setting up the query. 
Operators are symbols or words that define the relationship between the different fields that you want to search. 
One operator that you will find invaluable is the || (OR) operator, which lets you search for multiple values in one 
field and find records that match different criteria. This is something you cannot do with the Lookup commands, 
which let you search for only one value at a time. 
For example, if you want to search for all your contacts in the New England states, you could enter ME || NH || VT ||
MA || RI || CT in the State field and run the query. Your lookup would include all contacts in the six New England 
states.



Query operators
Operator Result of Query
&& Finds all contacts whose records match all of 

the specified criteria. 
|| Finds all contacts whose records match one of 

the specified criteria. 
= Finds all contacts whose records contain data 

that is equal to the specified value.
<> Finds all contacts whose records contain data 

that is not equal to the specified value.
< Finds all contacts whose records contain data 

that is less than the specified value.
> Finds all contacts whose records contain data 

that is greater than the specified value.
<= Finds all contacts whose records contain data 

that is less than or equal to the specified 
value.

>= Finds all contacts whose records contain data 
that is greater than or equal to the specified 
value.

* Finds all contacts whose records contain data 
that begins or ends with the specified 
characters.

.. Finds all contacts whose records contain data 
that falls within the specified range.

When you enter a value in a field, the default operator is "=" (is equal to) unless you specify another 
operator. For example, if you enter 2/14/97 in the Last Results field, ACT! will find contacts who have that exact 
date in their Last Results field. To find all contacts who have last results since 2/14/97, you would enter >2/14/97 in 
the Last Results field.

To find multiword items, you must enclose the two or more words in quotation marks. For example, to find 
New York, enter the following: "New York".

If you enter search criteria in more than one field, the && (and) operator is automatically used between 
these fields. For example, if you enter London in the City field and Prospect in the ID/Status field, the query will find 
all prospects in London. If you want the relationship between fields to be OR (||), you must create an Advanced 
query.

Queries are not case-sensitive, so you do not have to enter text with the correct capitalization. For 
example, you could enter "XYZ COMPANY", "XYZ Company", or "xyz company" to find all of your contacts at XYZ 
Company.

If you make mistakes and want to start over, choose Clear Query from the Query menu. All of the criteria 
you have entered will be deleted, and you can start over.

If you want to close the Query window without running a query, click the Close button.



 Overview

To create a query

1. Make sure that you are in the Contact window or the Group window.
You can only create a query from one of these windows.

2. From the Lookup menu, choose By Example.
A blank Contact or Group window appears. A Query menu appears in the menu bar, and a new toolbar appears.

3. (Optional) From the Query menu, choose Show Query Helper.
The Query Helper appears.
This shows all the query operators that you can use. To add an operator, select it in the Operators list and click 
Insert, or double-click the operator.    

4. Enter the values or criteria for which you want to search, adding the operators as needed.
You can enter values in any of the fields on any of the Contact window tabs except for the Notes/History, 
Activities, and Groups tabs. You can enter values in any of the fields on any of the Group window tabs except 
for the Notes/ History, Activities, and Contacts tabs.
Note
To search for contacts who have no data in a specific field, put the pointer in the field and press Ctrl+F5. For 
example, before attempting to send a fax to several contacts, you might want to find all contacts whose Fax 
field is blank.

5. (Optional) To specify the order in which your contacts will appear when you run your query, choose Specify 
Query Sort from the Query menu.
The Sort Contacts dialog box appears. 

6. Choose Run Query from the Query menu, or click the Run Query tool in the toolbar.
ACT! searches the currently open database and finds all of the contacts that match your search specifications. 
If no contacts match the criteria that you've specified, a message appears saying that no contacts were found.

 Some tips for creating queries
 Related Topics



In some cases, you will not be able to create the exact query you want using the By Example command. For 
example, you might want to find all of your contacts in the U.K. whose sales volume is more than 10,000 units and 
all of your contacts in Germany whose sales volume is more than 20,000 units. You can't do this using the By 
Example command. You need to create what's called an Advanced query. An Advanced query is a text-only 
representation of your query statement, with Boolean logic equations expressing the search criteria. You create an 
Advanced query by converting a By Example query to an Advanced query.



For example, because the By Example query automatically connects the fields with the && (and) operator, you 
may want to change one or more of the && operators to the OR operator, or you can add the NOT operator so that 
the relationship between fields is AND NOT. 



Advanced Query operators
Operator Result of Query
&&
AND

Finds all contacts whose records match all of 
the specified criteria. 

||
OR

Finds all contacts whose records match one of 
the specified criteria. 

= Finds all contacts whose records contain data 
that is equal to the specified value.

<> Finds all contacts whose records contain data 
that is not equal to the specified value.

< Finds all contacts whose records contain data 
that is less than the specified value.

> Finds all contacts whose records contain data 
that is greater than the specified value.

<= Finds all contacts whose records contain data 
that is less than or equal to the specified 
value.

>= Finds all contacts whose records contain data 
that is greater than or equal to the specified 
value.

* Finds all contacts whose records contain data 
that begins or ends with the specified 
characters.

CONTAINS Finds all contacts whose records contain the 
specified data.

<<>>
BLANK

(Advanced queries only) Finds all contacts 
whose records have no data in the specified 
field.

!
NOT

(Advanced queries only) Finds all contacts 
whose records do not contain the specified 
criteria.

.. (Advanced queries only) Finds all contacts 
whose records contain data that falls within 
the specified range.

 Overview

To convert a By Example query to an Advanced query

1. After you enter search criteria in the By Example window, choose Convert to Advanced Query from the Query 
menu.
The query appears as a text screen, with the Query Helper available. The Query Helper for Advanced queries 
includes additional operators to those available in the By Example Query Helper.

2. Edit the existing query, as needed.    
3. Use the Query Helper to add additional fields and operators on which to search.

To insert a new field or operator using the Query Helper, select the field or operator and click Insert, or double-
click the field or operator.    

If you prefer to type your query directly, you can close the Query Helper and enter your query statements manually.



To avoid creating syntax errors, however, it is advisable to select the fields and operators from the Query Helper.
4. (Optional) From the Query menu, choose Check Query Syntax.

This will check your entire query to make sure that you have used the proper syntax everywhere in the query 
and inform you of any errors in the query syntax.

5. (Optional) To specify the order in which your contacts will appear when you have run the query, choose Specify 
Query Sort from the Query menu.
The Sort Contacts dialog box appears. 

6. Choose Run Query from the Query menu, or click the Run Query tool in the toolbar.
ACT! searches the currently open database, and finds all of the contacts that match your query specifications. If
no contacts match the criteria that you've specified, a message appears saying that no contacts were found.

 Related Topics



You may want to save some of your queries so that you can quickly find the same set of contacts at another time. 
Even if you have to modify the query later, you may still save time by editing an existing query rather than by 
creating a new query. If you have specified a sort order for the query, the sort order is saved when you save the 
query.



 Overview

To save a query

1. Create a By Example or an Advanced query and make sure that it runs correctly.
2. From the File menu, choose Save.

The Save dialog box appears.
3. Enter a name for the file.
4. Make sure that the file type is Query File (*.QRY) and click Save.

 Related Topics



 Overview

To reuse a query

1. From the Lookup menu, choose By Example to open the Query window.
2. From the File menu, choose Open.

The Open dialog box appears.
3. Locate the saved query that you want to use and click Open.

The query reappears in the Query window.
4. Choose Run Query from the Query menu, or click the Run Query tool in the toolbar.

 Related Topics



ACT! offers several easy ways to schedule activities with your contacts. You can schedule an activity directly from 
the Contact window by choosing a menu command, by clicking a button, or by dragging a contact from the 
Contact window onto the Calendar window. You can also open a Daily, Weekly, or Monthly calendar and enter 
activities directly on the calendars. You can view a list of your scheduled activities, keep track of past activities 
that you have had with your contacts, and print your calendars.



 Overview

To specify different kinds of activities
ACT! activities fall into the following three categories:

Calls are telephone calls that you put on your schedule so that you remember to call a contact. You may 
want to set a specific time and duration for a call.

Meetings are appointments that you put on your schedule. You generally set a specific time and duration 
for a meeting.

To-do items are activities or tasks that you need to complete but that you may not need to schedule at a 
specific time during a day. For example, you may want to create a to-do item for "pick up dry-cleaning" or "send 
birthday card."

 Related Topics



 Overview

To schedule personal appointments
When you schedule an activity, ACT! requires that a contact be assigned to the activity. Sometimes, however, 
there is no obvious contact associated with an activity. For example, you know that you have to pick up dinner on 
your way home tomorrow night. You do not want to create a contact record for the restaurant where you will get 
the dinner; instead, you schedule an activity with yourself as the contact. Whenever you want to schedule an 
activity without assigning it to someone else, you can schedule the activity with yourself.

 Related Topics



In ACT!, there are three basic ways to schedule activities:
Choosing a menu command or clicking a tool
Dragging a contact from the Contact window onto one of the calendars
Entering activities directly on the Daily, Weekly, or Monthly calendars

Each of these methods creates a scheduled activity and leads you to the Schedule Activity dialog box where you 
specify the details of the activity.



 Overview

To schedule activities from a contact record
Because you must always schedule an activity with a contact in your database, you may find it easiest to go to the
appropriate contact record and schedule an activity from there. You can quickly schedule activities with the current
contact using any of the following methods:

Choosing a command from the Contact menu. You can choose Schedule Call, Schedule Meeting, or 
Schedule To-Do from the Contact menu. When you choose any of these commands, the Schedule Activity dialog 
box appears. 

Clicking one of the three scheduling tools in the toolbar. When you click any of these tools, the Schedule 
Activity dialog box appears. 

Clicking the right mouse button with the pointer in the current contact's Activities tab, and choosing 
Schedule Call, Schedule Meeting, or Schedule To-Do from the shortcut menu.

Dragging the current contact record onto a calendar.
Note that you need to have both the Contact window and either the Calendar window or the Mini-Calendar 
open so that you can drag the contact to a calendar. You may need to tile or resize your windows to see them
both. For information about resizing and tiling windows, see your Microsoft Windows online help.
To drag the current contact, position the pointer over any blank area in the contact record, such as the area 
to the right of the Fax field. Press the mouse button to "pick up" the current contact and drag the contact 
onto any of the calendars. When you release the mouse button, the Schedule Activity dialog box appears. 

 Related Topics



You can schedule activities by specifying a time for an activity directly on the calendars. When you set a time for 
an activity on a calendar, ACT! automatically picks the current contact in the Contact window as the person with 
whom the activity is scheduled. You can, however, select a different contact from the Schedule Activity dialog box.
ACT! includes the following calendars:

A Daily calendar
A Weekly calendar
A Monthly calendar
A Mini-Calendar. 

You can have the Mini-Calendar open along with the other calendars, and you can use it to move quickly to another
day, week, or month. The other calendars update automatically when you change days, weeks, or months on the 
Mini-Calendar. You can also use the Mini-Calendar to open one of the other calendars or to switch to a different 
calendar. For example, if you double-click a date in the Mini-Calendar, the Daily Calendar appears for that date. For
information about changing the display of the Mini-Calendar, see Setting calendar preferences.



 Overview

To display the calendars
From the View menu, choose Calendars, or click one of the three calendar buttons at the bottom of the 

window.
A Daily, Weekly, or Monthly calendar appears. To display the Mini-Calendar, choose Mini-Calendar from the View
menu.

 Related Topics 



For example, if you want to schedule a two-hour meeting starting at 1:00 p.m., position the cursor anywhere in the
1:00 p.m. time slot, press the mouse button, and drag to select the area from 1:00 to 3:00 p.m.



 Overview

To schedule an activity from the Daily or Weekly calendar

Position the pointer anywhere in the time slot where you want the activity to begin. Drag to select the entire 
time period that the activity will occupy.    

You can also click the gray time button to select the activity's start time.
When you release the mouse button or click the gray time button, the Schedule Activity dialog box appears.

 Related Topics    



You can set Call, Meeting, or To-do as the type of activity you are scheduling.



 Overview

To set the activity type

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. From the Activity Type drop-down list, choose Call, Meeting, or To-Do. 

This is already set if you chose Schedule Call, Schedule Meeting, or Schedule To-Do from the Activities menu, or
if you clicked one of the scheduling tools in the toolbar.

 Related Topics



If you scheduled the activity on one of the calendars, the correct date is already entered in the Date field. If the 
date in the Date field is not set correctly, you can easily change it.



 Overview

To set a date for your activity

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Click the arrow to the right of the date in the Date field.

A drop-down date selector appears.
3. Select a date from the date selector by clicking the date. 

Scroll forward or backward one month at a time by clicking the forward or backward arrows.
When you click a date, the date selector disappears, and the selected date appears in the Date field.

 Related Topics



For every activity, you must either define a starting time or specify that the activity is timeless.



 Overview

To set the starting time for an activity

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Click the arrow to the right of the time in the Time field.

A small version of the Daily calendar appears.
3. Click anywhere in a time slot to set the starting time for the activity, or drag through multiple time slots to 

specify both the starting time and the duration of the activity.
When you release the mouse button, the starting time appears in the Time field. If you dragged to define a 
duration, the duration appears in the Duration field.

 Related Topics



A timeless activity is one that you want to do on a specific day, at an unspecified time. For example, you may want
to put a to-do activity "Clean off all paperwork from desk" on Friday, but you don't want to assign a specific time to
it. You could define this to-do activity as timeless. Timeless activities appear in the daily recap area of the Daily, 
Weekly, and Monthly calendars.



 Overview

To set a timeless activity

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Click the arrow to the right of the time in the Time field.

A small version of the Daily calendar appears.
3. Click the Timeless button at the bottom of the calendar.

The word "None" appears in the Time field.
 Related Topics



If an activity's duration is set incorrectly, you can enter a new duration in the Duration field. You can also set 
default durations for your calls, meetings, and to-do activities using the Scheduling tab of the Preferences dialog 
box. For example, you may want all of your calls set to last 15 minutes and your meetings set to one hour.



For example, to set a duration of one hour and 45 minutes, you can enter 1 hr 45 min. in the duration field.



 Overview

To set an activity’s duration 

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Click the arrow to the right of the Duration field.

A duration drop-down list appears.
3. Click to select a duration from the drop-down list.
4. (Optional) If you prefer, type a duration in the duration field..    

 Related Topics



By default, the With field is filled in with the name of the current contact. You can change this from within the 
Schedule Activity dialog box.



 Overview

To specify with whom an activity is scheduled

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Click the Browse button next to the name in the With field.

The Select Contacts dialog box appears.
The list on the right side of the dialog box shows the contact or contacts with whom the activity is currently 
scheduled. The list of contacts on the left side of the dialog box shows all of the contacts in the database, the 
current lookup, or an existing group. By default, the All Contacts option is selected.
You cannot schedule an activity with someone who is not already in your database. If you don't want to add a 
contact to the database because this is a one-time-only activity, select your name from the list on the left side 
of the dialog box. 

3. Click to select a contact from the list on the left side of the dialog box.
To schedule a single activity with all of the contacts in the list, click Select All.
To schedule a single activity with multiple contacts in the list, Shift+click to select contacts whose names 

appear next to each other in the list. Ctrl+click to select additional contacts who are dispersed in the list.
4. Move the selected contacts to the Scheduled With list on the right side of the dialog box by doing one of the 

following:
Use the Add button to add the selected contacts from the list on the left side of the dialog box to the 

Scheduled With list.
Use the Replace button to replace the entire contents of the Scheduled With list with the selected contacts 

from the list on the left. Using the Replace button removes any existing contacts from the Scheduled With list.
5. (Optional) If you want to remove a contact from the Scheduled With list, select the contact in the list and click 

the Remove button.
When you do this, the activity is no longer scheduled with the person you have removed from the Scheduled 
With list.

6. Click OK when you have finished selecting the contacts with whom you are scheduling the activity.
The Schedule Activity dialog box reappears. The With field displays the name of the contact with whom you 
have scheduled the activity.

 Related Topics 



You can add a description for the activity in the Regarding field. The description you enter here appears on the 
calendars so that you know the purpose of the activity. 



 Overview

To add a description for an activity

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Enter the description in the Regarding field, or choose a description from the Regarding drop-down list.

 Related Topics



You can set an alarm for any activity so that you will be reminded of your activity. If you set an alarm for an 
activity, ACT! displays a message and beeps at a specified time before the activity. You will receive an alarm for an
activity, even if ACT! is minimized. If ACT! is minimized, a flashing icon appears in the Windows taskbar, indicating 
that an alarm is going off for a scheduled activity. ACT! must be running for an alarm to appear.
You can also specify default alarm settings for calls, meetings, and to-do activities using the Scheduling tab of the 
Preferences dialog box. You may always want an alarm to go off five minutes before a scheduled telephone call, 
but you may want an alarm set to remind you 15 minutes before a meeting.



For example, if you want an alarm to go off ten minutes before a scheduled meeting, choose 10 Minutes from the 
Alarm Lead Time drop-down list, or type 10 min in the Alarm Lead Time field.



 Overview

To set an alarm to remind you of an activity

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Select the Set Alarm option.
3. Enter a lead time for the alarm in the Alarm Lead Time field, or choose a time from the Lead Time drop-down 

list.    
Note that the Alarm Lead Time field is dimmed and unavailable if you do not select the Set Alarm option.

 Related Topics



When you schedule an activity with one or more contacts, you can automatically send an e-mail message to the 
contacts to notify them of the scheduled activity. Also, if you have to reschedule the activity, you can automatically
send an e-mail message notifying the contacts of the schedule change. If you turn on the Send E-mail Reminder 
option, you will be prompted to send e-mail messages when you schedule or reschedule an activity.



 Overview

To have an e-mail message sent when you schedule an activity

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Select the Send E-mail Reminder option.

 Related Topics



You may find it useful to set priorities for your activities. When you set activities' priorities, you can view or sort 
activities by priority.
You can specify default priority settings for all of your calls, meetings, and to-do activities using the Scheduling tab
of the Preferences dialog box. For example, you may want all of your meetings to be high-priority items, while your
to-do activities are medium-priority items.



 Overview

To set an activity’s priority

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Choose High, Medium, or Low from the Priority drop-down list.

 Related Topics



You can assign colors to activities so that different kinds of activities appear in different colors on your calendar. 
For example, you may want to assign different colors to your business activities and your personal activities. 



 Overview

To set an activity’s display color

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Click the color swatch in the Activity Color field.

A color palette appears.
3. Click the color that you want to assign to the activity.

The selected color appears in the Activity Color field.
 Related Topics



You can schedule activities that occur more than once without having to enter them multiple times by using the 
Recurring Settings tab in the Schedule Activity dialog box. To specify how often an activity recurs, you can set 
activities to appear at the following intervals:

Daily
Weekly
Monthly
Custom

You use the Daily option in the Recurring Settings tab of the Schedule Activity dialog box to schedule activities that
occur every day, every other day, or at any interval of days. Use the Weekly option to schedule activities that 
occur every week, every other week, or at any interval of weeks. Use the Monthly option to schedule activities that
occur every month, every other month, or at any interval of months.



For example, you may want to schedule an activity to occur every other day for two months. In this case, you 
would select a date on which the activity will stop recurring two months from today's date.



For example, to schedule a staff meeting every Friday, select the Fri option.



For example, to schedule a regular meeting on the third Wednesday of every month, select the Third option and 
the Wed option.



 Overview

To schedule daily, weekly, or monthly recurring activities

1. Make sure that the Recurring Settings tab is active in the Schedule Activity dialog box.
2. Select the Daily, Weekly, or Monthly option.

The Activity Occurs group box appears.
3. Enter a number of days, weeks, or months in the Every _ Days, Every _ Weeks, or Every _ Months field.

You can specify intervals of 1 to 31 days, 1 to 52 weeks, or 1 to 60 months. 
4. Select a date from the Until drop-down date selector, or type a date in the field.

This is the date on which the activity will stop recurring.     
5. (Weekly and monthly activities only) Select a day of the week on which you want to schedule the activity.    
6. (Monthly activities only) Specify on which of the selected days you want to schedule the recurring activity.   

7. Click OK.
 Related Topics



You can use the Custom option in the Recurring Settings tab of the Schedule Activity dialog box to schedule 
activities that occur every month, every other month, or at any interval of months on random days of the month. 
For example, you may have to drive the children to school on the 4th, 6th, 21st, and 28th days of every month.



The Every-Month field lets you specify how often the activity recurs. For example, enter 2 if you want to set an 
activity to occur every other month. You can enter a number between 1 and 60 in this field.



 Overview

To schedule randomly recurring activities

1. Make sure that the Recurring Settings tab is active in the Schedule Activity dialog box.
2. Select the Custom option.

The Activity Occurs group box appears.
3. Enter a number in the Every _ Months field.    
4. Choose a date from the Until drop-down date selector, or type a date in the field.

This is the date on which the activity will stop recurring.
5. Select the days of the month on which you want to schedule the activity.

Note
If you want to schedule an activity for the last day of every month, select 31 on the calendar. This will schedule 
a recurring activity for the last day of every month, regardless of whether the month has 28, 30, or 31 days.
If you accidentally select the wrong day, click the day again to deselect it.

6. Click OK.
 Related Topics



You can schedule activities that occur more than once without having to enter them multiple times by using the 
Recurring Settings tab in the Schedule Activity dialog box.



 Overview

To stop a recurring activity
If you have entered a recurring activity on your calendar, and you decide that you want to delete it from future 
calendars and Task Lists, you can simply select the next instance of the activity on your calendar and do one of the
following things:

Select the Once option in the Recurring Settings tab.
Set the Until date to today's date.

This cancels future occurrences of the activity, and they no longer appear on any calendars or Task Lists.
 Related Topics    



If you share your contact data with other users, either in a network database or through data synchronization, you 
may want to specify that some activities are your private activities. These could be personal appointments or any 
activities that you don't want other users to see. If you schedule private activities, no one else will see these 
activities when they log on to your database or when you send them synchronization updates.



 Overview

To schedule private activities

1. Make sure that the Activity Information tab is active in the Schedule Activity dialog box.
2. Select the Private Activity option.

 Related Topics



If you use a shared ACT! database, you can schedule activities for other users of the database. For example, an 
assistant may want to schedule a meeting for a manager. When you schedule an activity for another user, the 
activity appears on the other user's calendar. 



 Overview

To schedule activities for another user of your database

1. Use the Activity Information tab of the Schedule Activity dialog box to set the time, duration, and other 
activity details.

2. Click the Browse button to the right of the With field.
The Select Contacts dialog box appears.

3. Click the More button in the lower right corner of the dialog box.
The Scheduling For Another User group box appears, with your name in the Scheduled By field.

4. Select the user for whom you want to schedule the activity by choosing a name from the Scheduled For drop-
down list and click OK.

 Related Topics



You may find it helpful to see the calendars of other users of your database. For example, if you're trying to find a 
time when several people are free for a meeting or a conference call, you can view their schedules to check for an 
available time.



 Overview

To view other users' calendars

1. Open a Daily, Weekly, or Monthly calendar.
2. From the Edit menu, choose Filter, or click the Filter tool in the toolbar.

The Filter Calendar dialog box appears.
3. Select one of the options in the Users group box.

The Selected Users option lets you select the users whose activities you want to see on the calendar.
The All Users option displays the activities for all the users of the database.

4. If you want to see only certain activity types or priorities, turn off the activity types and priorities that you don't
want to appear and click OK.

 Related Topics



You can set default durations, priorities, and alarms for your calls, meetings, and to-do activities. You can also 
specify which activities to roll over, how you want to clear activities from your calendars, whether to check for 
schedule conflicts, and whether new activities should be public or private activities.



 Overview

To set your scheduling preferences

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears.

2. Click the Scheduling tab.
3. In the Activity Defaults group box, select default settings for Calls, Meetings, and To-Dos.

For each of the three activity types (call, meeting, and to-do), you can set a default priority, alarm lead time, 
and duration for alarms. You can also specify whether you always want an alarm set for each of the activity 
types. Finally, you can specify whether any of the activity types should be scheduled as timeless activities.

4. Select any or all of the options in the Automatically Roll Over group box.
These options determine which activities are automatically rolled over to the current day if they were not 
completed and cleared on the scheduled day. When an activity is "rolled over," it becomes a timeless activity 
on the current day.

5. Select Remove, Gray, or Strikeout in the When Clearing Activities group box.
These settings determine whether activities are removed from calendars, grayed, or struck out when you clear 
them.

6. (Optional) Select the Enable Activity Conflict Checking option.
You can turn this option on or off, depending on whether or not you want to receive an alert message if you 
schedule an activity that conflicts with or overlaps another activity.

7. (Optional) Select the Default Activities To Public option.
Turning on this option makes all new activities public activities.

8. Click OK.
 Related Topics



Although you can schedule more than one activity at the same time, ACT! can let you know when you are 
scheduling activities that overlap. You can choose to accept the schedule conflict or reschedule the new activity. 



 Overview

To receive notification of schedule conflicts
Select the Enable Activity Conflict Checking option in the Scheduling tab of the Preferences dialog box. 

When you schedule an activity that conflicts with an already scheduled activity, the Conflict Alert dialog box 
appears.
If you want to leave the overlapping activities, click Accept. If you would prefer to reschedule the new activity, 
click Reschedule, and set a new time or date for the activity. If you want to turn off conflict checking for all 
activities, select the Disable Activity Conflict Checking option. 

 Related Topics



Schedules often change, and you may need to move scheduled activities around on your calendars. ACT! lets you 
do exactly this. You can pick up an activity from a calendar and move it to a new spot on the calendar. You can also
reschedule an activity directly from the Task List or from the Activities tab in the Contact window. You decide which
is the most convenient way for you to reschedule activities.



 Overview

To reschedule from the Task List or the Activities tab

1. Click in the date or time field of the activity that you want to reschedule.
A drop-down arrow appears in the field.

2. Click the arrow.
A drop-down date or time selector appears.

3. Change the date or time for the activity.
4. Click outside of the date or time selector to apply the change.

 Related Topics 



Many people like to work with their schedules in the form of a list. ACT! lets you view your activities as a list, called
the Task List. You can use the Task List to view all of your activities at once, or you can specify which activities 
appear in the Task List. You can also change the order in which they appear. For example, you may want to see a 
list of all the telephone calls you have scheduled for the next two weeks, and you may want them to appear in 
order by date.
The Task List lets you do more than view your scheduled activities. From the Task List, you can schedule new 
activities, reschedule activities, and clear activities by simply clicking the right mouse button and choosing the 
appropriate command from the shortcut menu.
By default, all activities are displayed in the Task List, including uncompleted activities that have rolled over from 
previous days. For information about limiting the activities that appear in the Task List, see Specifying which 
activities appear on lists and calendars



 Overview

To view your scheduled activities in a list
From the View menu, choose Task List, or click the Task List button at the bottom of the Contact window.

The Task List appears.
 Related Topics



For example, to sort by date, click the Date label. This causes your contacts to be displayed in ascending order by 
date (earliest dates first, latest dates last). 



 Overview

To change the order in which activities appear in the Task List
Click the label of the column by which you want to sort the list.    

To sort a list in descending order, hold down the Shift key when you click the column label.
If you want to print your Task List, you can run the Task List report and then print it. You can also add, remove, 
or change the order of columns in the Task List. 

 Related Topics



The Activities tab in the Contact window displays the activities you have scheduled with the current contact. Just 
as you can with the Task List, you can specify which activities appear in the Activities tab. You can also change the 
order in which they appear.



 Overview

To view the activities for a specific contact

1. Use a command in the Lookup menu to locate the contact whose activities you want to see.    
2. Click the Activities tab.

The activities for the current contact appear in the Activities tab.
 Related Topics



For example, to sort by date, click the Date label. This causes your contacts to be displayed in ascending order by 
date (earliest dates first, latest dates last). 



 Overview

To change the order in which activities appear in the Activities tab
Click the label of the column by which you want to sort the list.    

To sort a list in descending order, hold down the Shift key when you click the column label.
 Related Topics



As you view your schedule in the Calendar or Task List window, you might find it helpful to quickly find the contacts
with whom you have scheduled activities. From the Daily, Weekly, or Monthly calendar, you can create a lookup of 
all the contacts who appear on your current schedule. If you select a specific activity on a calendar, ACT! displays 
the contact with whom that activity is scheduled. From the Task List, you can create a lookup of all the contacts 
associated with activities on the Task List, or you can select one or more activities and create a lookup of the 
contacts associated with those activities.



 Overview

To find contacts with whom you have scheduled activities

1. Make sure that either the Calendar or Task List window is active.
2. (Optional) Select an activity on the Daily, Weekly, or Monthly calendar, or select one or more activities on the 

Task List. 
If you do not select any activities, ACT! will create a lookup of all contacts whose activities appear in the current
Calendar or Task List window.

3. Press the right mouse button and choose Create Lookup from the shortcut menu.
The contacts with whom you have scheduled activities appear in the Contact window. If you selected an activity
on the calendar or task list, the contact associated with that activity is displayed as the current contact.

 Related Topics



You can specify which activities appear in the Task List, on the calendars, and on the Activities tab of the Contact 
window. For example, you may want to use the Task List to view all the telephone calls you have scheduled for the 
next two weeks and use the calendars to view your appointments.
If you share ACT! data with other users, either on a shared network database or through data synchronization, you 
can also specify which users' activities are displayed.



 Overview

To specify which activities appear on lists and calendars

1. From the Edit menu, choose Filter or click the Filter tool in the toolbar.
The Filter Activities dialog box appears if you choose Filter in the Task List or the Activities tab of the 
Contact window.
The Filter Calendar dialog box appears if you choose Filter in the Calendar window.
Note that if you choose the Filter command from the Calendar window, the Filter Calendar dialog box does not 
include the Activity Dates options because you cannot limit the dates displayed on the calendars.

2. In either dialog box, select the activities that you want and click OK.
 Related Topics



You can specify whether you want your Monthly calendars to start on a Sunday or a Monday. You can also specify 
the time increments and the first hour displayed on the Daily and Weekly calendars.



 Overview

To set calendar preferences

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears.

2. Click the Calendars tab.
3. Select Sunday or Monday from the Calendar Week Starts On group box.

This option determines which day is displayed as the first day of the week on the Monthly calendars.
4. Choose a time increment from the Daily Calendar drop-down list.
5. Choose a time increment from the Weekly Calendar drop-down list.
6. (Optional) To display only one month in the Mini-Calendar instead of three, select the When Displaying Mini-

Calendar, Show Only Current Month option.
7. Specify the hour that you want to appear as the starting time for the Daily and Weekly calendars, and click OK.

 Related Topics 



When you clear an ACT! activity from your schedule, a history of the activity is automatically recorded in the 
contact record of the person with whom you scheduled the activity. You can view histories and create reports 
based on past activities with your contacts. Therefore, clearing an ACT! activity does not mean that you are 
deleting all information about the activity-you are simply marking it as completed.
When clearing an activity from your schedule, you can record information about the results of the activity, and 
schedule a follow-up activity with the contact.

Note
You have the option to display cleared activities in gray or with a line through them on your schedules, or to 
remove them from your schedules. Whether they appear or not, you can still see a history or report of your 
completed activities.



 Overview

To clear an activity from your schedule

1. Select the activity that you want to clear.
You can select the activity from the Activities tab in the Contact window, from the Task List, or from one of the 
calendars.

2. Perform one of the following actions:
From the Contact menu, choose Clear Activity.
In the Calendar window, click the check box next to the activity in the Daily Checklist.
In the Task List or the Activities tab of the Contact window, click the "completed" (check mark) column.

The Clear Activity dialog box appears.
3. Select an option from the Result drop-down list.
4. (Optional) Click Follow Up and schedule a follow-up activity with this contact.

When you finish scheduling your follow-up activity, the Clear Activity dialog box reappears.
5. Click OK when you have completed setting options in the Clear Activity dialog box.

 Related Topics 



 Overview

To specify whether cleared activities appear on your schedule

1. From the Edit menu, choose Preferences.
2. Click the Scheduling tab.
3. In the When Clearing Activities group box, select Remove, Gray, or Strikeout.

The Remove option removes all cleared activities from all calendars. The Gray option leaves the cleared 
activities on your calendars but displays them in gray. The Strikeout option leaves the cleared activities on your
calendars but puts a line through them.

 Related Topics    



Frequently when clearing an activity, you want to schedule a follow-up meeting or call with the same contact. For 
example, you may call a possible sales prospect who tells you that her budget is frozen for this quarter, but that 
she would like to talk to you about your product in the following quarter. You can make a note that you reached the
person and schedule a follow-up call for the following quarter. 



 Overview

To schedule a follow-up activity

1. Select the activity that you want to clear.
You can select the activity from the Activities tab in the Contact window, from the Task List, or from one of the 
calendars.

2. From the Contact menu, choose Clear Activity.
The Clear Activity dialog box appears.

3. Select an option from the Result drop-down list.
4. Click Follow Up and schedule a follow-up activity with this contact.

When you finish scheduling your follow-up activity, the Clear Activity dialog box reappears.
5. Click OK.

The original activity is cleared, a history is recorded, and the follow-up activity is scheduled.
 Related Topics



When you clear activities, an activity history is automatically generated unless you explicitly delete the activity. In 
some cases, however, you may want to create an ad hoc history record for a contact without formally scheduling 
and clearing an activity for that person. For example, you may make a telephone call to a client when you are 
away from the office, without using the ACT! dialer. When you get back to the office, you want to create a history 
record for the contact, indicating what happened during the telephone call.



 Overview

To record an activity history

1. Make sure that the contact for whom you want to record a history is the current contact.
2. From the Contact menu, choose Record History.

The Record History dialog box appears.
3. Select an option from the Activity Result drop-down list.
4. Enter information about the activity in the Regarding field or select an option from the drop-down list, and click 

OK.
A history record is created for the current contact.

 Related Topics



If you accidentally schedule an activity that you don't want on your schedule, you may simply want to delete it. 
Keep in mind, however, that deleting an activity means that there is no record of the activity in the database. In 
general, you should only delete activities if you scheduled them by mistake.



 Overview

To delete activities

1. Select the activity that you want to delete.
You can select the activity from the Activities tab in the Contact window, from the Task List, or from one of the 
calendars.

2. Press the Delete key on the keyboard.
The Clear Activity dialog box appears.

3. From the Result drop-down list, choose the Call Erased, Meeting Erased, or To-do Erased option, depending on 
the type of activity you're deleting.
The activity is erased from the database and the calendars, and no history record is created.

 Related Topics



You may want to print your schedules to take with you when you go to a meeting or when you're traveling. You can
print your calendars in several formats such as Avery, Day Runner, and Day Timer.



To print the priority of each activity, select the Priorities option. 
To print other users' public activities, select the Public Activities option.



In the Date Range field, specify a date range for the calendar printout. You can type a date range in the 
field, or select a date range from the drop-down date selector by dragging through the dates you want. To select 
more than one month, drag through the first month that you want to include, then drag off the right side of the date
selector. The date selector scrolls through the next months until you move the pointer back over the date selector. 
Click outside of the date selector to apply the date range.

Choose an hour from the Start Hour drop-down list. This determines the hour at which the printed calendar
begins.

Select the Company Name option to print the company name on the calendar in addition to the contact 
name.

Select the 5 Week View option to print a full five-week monthly calendar starting with the Sunday before 
the selected start date, and ending with the Saturday after the selected end date.

Select the Saturday and Sunday option if you want to include Saturday and Sunday in the printouts.



 Overview

To print a calendar

1. From the File menu, choose Print.
The Print dialog box appears.

2. Choose the type of calendar you want to print from the Printout Type drop-down list.
You can choose to print a daily, weekly, or monthly calendar. When you select a printout type, a list of available
paper forms of that type appears.

3. Select the format in which you want to print your calendar from the displayed list.
A print preview appears on the right side of the Print dialog box.

4. (Optional) Click the Options button.
The Calendar Options dialog box appears.

5. In the Print group box, select which activities to print on the calendars.    
6. In the Print Settings group box, set the options that you want.    

 Related Topics



Before you can begin to link contacts, activities, and notes together, you need to create one or more groups. You 
create a new group of contacts in the Groups window. You can give the group any name you want, and you can add
as many contacts as you want to the group. Keep in mind that a single contact can belong to several groups.
When you add a new group, you can add a blank group record and simply fill in all the information, or you can 
duplicate information from another group record that you have already created. You can use the Duplicate Group 
command to copy the basic group information; then you simply enter the information that's different.



 Overview

To create a new group

1. From the View menu, choose Groups, or click the Groups button at the bottom of the Contact window.
The Groups window appears. If you have not created any groups, an Untitled group appears. You can change its
name and use it as your first group.

2. From the Group menu, choose New Group, or click the New Group tool in the toolbar.
3. Enter a name for the new group in the Group Name field.

When you move to another field, the name is automatically updated in the group name list on the left side of 
the window.

4. Enter a description for the group in the Description field.
The tabs at the bottom of the Groups window include more fields in which you can enter data about the 
selected group.

 Related Topics



 Overview

To create a new group using information from another group

1. In the Groups window, select the group whose information you want to copy.
You select a group by clicking its name in the list on the left side of the Groups window.
Note
Do not double-click the group name; double-clicking the group name returns you to the Contact window with 
the selected group as the current lookup.

2. From the Group menu, choose Duplicate Group.
The Duplicate dialog box appears.
You can copy all of the fields in the current group record, or you can copy just the primary fields. The default 
primary group fields are Address 1, Address 2, Address 3, City, Description, Division, State (County, Land, 
Province), Zip (Postcode), and Country. You can set other fields as primary fields. For information about 
modifying fields, see Setting field attributes.

3. Select the Duplicate Data From Primary Fields option or the Duplicate Data From All Fields option, and click OK.
A group contact record appears, filled in with the copied information from the original group record.

 Related Topics



When you first create a group, there are no contacts in the group. The next step is to specify which contacts you 
want to add to the group. 



 Overview

To add contacts to a group

1. In the Groups window, select the group to which you want to add contacts.
You select a group by clicking its name in the list on the left side of the Groups window.
Note
Do not double-click the group name; double-clicking the group name returns you to the Contact window with 
the selected group as the current lookup.

2. From the Group menu, choose Group Membership, or click the Group Membership tool in the toolbar.
The Group Membership dialog box appears.

3. Select an option in the Select Contact From group box.
You can select contacts from a list of all contacts in the database, from the current lookup of contacts, or from 
an existing group of contacts. By default, the All Contacts option is selected.

4. Click to select one or more contacts from the list on the left side of the dialog box.
Shift+click to select multiple contacts whose names appear next to each other in the list. Ctrl+click to 

select additional contacts who are dispersed in the list.
To select all of the contacts in the list, click Select All.

5. Click Add to add the selected contacts from the list on the left side of the dialog box to the list on the right.
The list on the right side of the dialog box displays the contacts who are members of the selected group.

6. When you have added all the contacts that you want in the group, click Close.
All of the contacts that you selected are now members of the group. If you click the Contacts tab in the Groups 
window, you'll see a list of the contacts in the group.

 Related Topics



Occasionally, you may want to remove a contact from a group. For example, if one of your groups is a company 
group, and one of the members of the group leaves the company, you'll want to remove the person from the 
group.



 Overview

To remove a contact from a group

1. From the group list on the left side of the window, select the group from which you want to remove a contact.
2. From the Group menu, choose Group Membership, or click the Group Membership tool in the toolbar.
3. In the list on the right side of the dialog box, click to select one or more contacts whom you want to remove 

from the group.
Shift+click to select multiple contacts whose names appear next to each other in the list. Ctrl+click to select 
additional contacts who are dispersed in the list.

4. Click Remove.
5. When you have removed the contacts you no longer want in the group, click Close.

The contacts you removed from the group no longer appear in the Contacts tab of the Groups window. 
However, they are still your database.

 Related Topics



When you have created one or more groups, you may want to see a list of the group's members. You can see the 
members of a group using the Contacts tab at the bottom of the Groups window. If you are in the Contact window, 
you can create a lookup of a group by choosing that group from the group drop-down menu at the bottom of the 
Contact window. 
From either the Contacts tab in the Groups window or the Groups tab in the Contact window, you can add or 
remove members from groups by clicking the right mouse button and choosing Group Membership from the 
shortcut menu, then adding or removing members in the Group Membership dialog box.



 Overview

To view the members of a group in the Groups window

1. Select a group on the left side of the Groups window.
2. Click the Contacts tab at the bottom of the Groups window.

The Contacts tab appears, displaying a list of all the members of the selected group.
 Related Topics



 Overview

To view a lookup of a group in the Contact window
Choose the group's name from the group drop-down menu at the bottom of the Contact window.

 Related Topics



From the Notes/History tab in the Contact window, you can select contacts' notes, histories, and attachments and 
assign them to a group record. For example, if you write a note in a contact record and decide that you'd also like 
the note to appear in a particular group record, you can select the note and assign it to the group of your choice. If
you do this, the note is attached to both a contact record and a group record.

Note
If you are working in the Contact window and you view a group lookup by choosing it from the group drop-down
menu at the bottom of the contact window, all new notes, histories, and attachments are automatically 
assigned to the selected group. Also, any new contacts that you add are automatically added to the group's 
membership. 

In some cases, you may only want to add a note or attachment to a group record without adding it to a contact 
record. For example, if you have a group record representing a company, you might want to keep the directions for
how to get to the company's headquarters. Rather than entering the directions in a note for each contact at the 
company, you can record the directions in a note linked to the group record for the company.
Using the Notes/History tab in the Groups window, you can add notes and attach files to a group record just as you
add them to contact records. At any time, you can view a group's notes, history, and attachments by clicking the 
Notes/History tab at the bottom of the Groups window.



 Overview

To assign a contact's note, history, or attachment to a group record

1. From the View menu, choose Contacts, or click the Contact button at the bottom of the screen.
2. In the Contact window, find the contact whose note, history, or attachment you want to assign to a group.

If necessary, use one of the Lookup commands to find the contact.
3. Click the Notes/History tab if it is not already selected.
4. Select a note, history, or attachment by clicking its icon.
5. Click the Details button in the upper-right corner of the Notes/History tab area.

The Details dialog box appears.
6. Choose a group from the Group Assignment drop-down list and click OK.

The note, history, or attachment is now assigned to the selected group. When you view the group record in the 
Groups window, you will see any notes, histories, or attachments assigned to the group.

 Related Topics



 Overview

To enter a note in a group record

1. In the Groups window, select the group about which you want to add a note.
If you have a long list of group names, you can find a group quickly by choosing Other Fields from the Lookup 
menu and entering the group name that you want to find.

2. Click the Notes/History tab at the bottom of the Groups window.
3. Click the Insert Note button in the Notes/History tab, click the Insert Note tool in the toolbar, or choose Insert 

Group Note from the Group menu.
A blank note appears with a border around it.

4. Type the note in the note area. 
You can type as much as you want in the note. The text will automatically wrap to the next line if it exceeds the
width of the note area. 

5. (Optional) To adjust the width of the note, place the pointer over the right edge of the note border and drag to 
change its width.

 Related Topics



 Overview

To attach a file to a group record

1. Make sure that the correct group record is displayed in the Groups window.
2. Click the Notes/History tab if it is not already selected.
3. From the Group menu, choose Attach File.

The Attach File dialog box appears.
4. Find the file that you want to attach and click Open.

The Notes/History tab now shows the name of the attachment and the date that you attached the file to the 
group record.

 Related Topics



When you schedule activities, you must schedule them with one or more contacts; you cannot schedule an activity
directly with a group. However, you can assign a scheduled activity to a specific group. You do this using the 
Associate With Group option in the Schedule Activity dialog box. When you associate an activity with a group, that 
activity appears in the Activities tab of the Groups window.



 Overview

To view group activities

1. In the Groups window, select the group whose activities you want to see.
If you have a long list of group names, you can find a group quickly by choosing Other Fields from the Lookup 
menu and entering the group name that you want to find.

2. Click the Activities tab at the bottom of the Groups window.
All activities that you have associated with the selected group appear in the Activities tab.

 Related Topics



The User Fields, Address, and Status tabs at the bottom of the Groups window provide additional fields in which 
you can enter information about your groups.



 Overview

To define your own group information
The User Fields tab contains six user-definable fields that you can use to record any kind of group information. You 
can change the names of any of these fields and specify the kinds of data that they can contain.

 Related Topics



 Overview

To enter group address information
The Address tab contains fields in which you can enter address information for the selected group. This is 
especially useful if you are using the group record as a company record-you can enter the company address 
information here. 

Note
You cannot use this group address information to produce bulk mailings. You can only use address information 
from contact records to create mail merge letters.

 Related Topics



The Status tab includes fields of information about the group record that show when the record was created, when 
changes were made to it, who created it, and when data was last merged into the record. ACT! automatically fills 
in these fields. The Status tab also includes fields in which you can assign a priority and manager to the group, and
designate the group as a public or a private group.
By default, all groups are public groups. This means that if you use ACT! in a multiuser environment, other users 
who log on to your database will be able to see the groups marked as public. You may, however, want to add some
of your personal groups to your ACT! database, and you may not want other users to see these records. By 
marking them as private groups, no other users of your database can see those groups-not even a user with 
Administrator security level. 

Note
Groups that you convert from ACT! 2.0 are automatically marked as private in ACT! 3.0.

 Related Topics



 Overview

To enter and view group status information

1. Click the Status tab at the bottom of the Groups window.
All of the fields are automatically filled in. You cannot edit the data in the Create Date, Edit Date, Merge Date, 
or Record Creator fields. You can change data in the Public/Private, Record Manager, and Priority fields.

2. (Optional) Change the data in the Public/Private, Record Manager, and Priority fields.
 Related Topics



If you have only a few groups, finding them is as simple as locating the name in the list on the left side of the 
Groups window. However, if you have a long list of groups, it can be more efficient to use a Lookup command to 
find the group or groups that you want to display. You can find a group using the group's name, city, priority, or 
state.



 Overview

To find a group

1. In the Groups window, choose Other Fields from the Lookup menu.
The Lookup Other dialog box appears.
Choose City, Group Name, Priority, or State from this drop-down list.

2. From the Available Fields drop-down list, choose City, Group Name, Priority, or State, depending on how you 
want to search for a group.

3. Enter the city, group name, priority, or state for which you want to search and click OK.
All groups that match the specified criteria are displayed in the Groups window list. 
Note
To display all of your groups, choose All Groups from the Lookup menu in the Groups window.

 Related Topics



If you find that you have no need to keep a group, you can easily delete it. Do not be concerned about losing 
contact records when you delete groups; contact records are never deleted when you delete a group.



 Overview

To delete a group

1. In the Groups window, select the group that you want to delete.
2. From the Group menu, choose Delete Group.

A dialog box appears with a warning that the deletion of records cannot be undone.
3. Click Record to delete the current group, or click Lookup to delete the current group lookup.

The group or lookup, including all of its notes, history, and pointers to attachments, is deleted.
 Related Topics



ACT! includes a full-featured word processor that you can use to write all of your letters, memos, and fax 
messages. If you prefer to use Microsoft Word 6.0 or 7.0, or the latest version of WordPerfect, you can use those 
word-processing applications rather than using the ACT! word processor. ACT! includes a set of templates for 
letters, memos, and fax cover pages, which you can use or modify to suit your needs. You can also create your 
own templates using the ACT! word processor, Microsoft Word, or WordPerfect.
ACT! makes it simple to fax or e-mail your letters or memos to any or all of the contacts in your ACT! database. You
can send faxes and e-mail messages directly from the ACT! word processor, Microsoft Word, or WordPerfect. 



 Overview

To select your preferred word-processing application

1. From the Edit menu, choose Preferences.
2. Click the General tab if it is not already selected.
3. Choose a word-processing application from the Word Processor drop-down list and click OK.

 Related Topics



You can write letters and memos to contacts in your ACT! database without ever having to type a name or an 
address. ACT! comes with letter and memo templates, which are set up to extract the appropriate contact 
information from the database.
You can use the templates as designed, modify them to suit your needs, or create new templates.
You can also create word-processing documents that do not use templates to take information from an ACT! 
database. For example, you may want to create a data sheet that doesn't need to be filled in with information from
your ACT! database.
You can easily compose a letter or memo to the current contact using the commands in the Write menu. Keep in 
mind that when you choose Letter, Memorandum, Fax Cover Page, or Other Document from the Write menu, ACT! 
addresses the document to the current contact. Therefore, make sure that the current contact is the person to 
whom you want to send a document.
When you choose Letter, Memorandum, Fax Cover Page, or Other Document from the Write menu, ACT! opens the 
word-processing application that you have set as your preferred word processor. You can have the word-processing
application open while other windows such as the Contact window or the Calendar window are open.



The Write menu commands
The Letter command creates a letter addressed to the current contact using the default letter template.
The Memorandum command creates a memo addressed to the current contact using the default memo 

template.
The Fax Cover Page command creates a fax cover page addressed to the current contact using the default 

fax cover page template.
The Other Document command creates a document addressed to the current contact using a template 

that you specify.
When you choose one of these commands, the word-processing application opens and displays the appropriate 
template. The template is automatically filled in with the current contact's information.



 Overview

To write letters or memos to a single contact

1. In the Contact window, choose one of the commands from the Lookup menu to find the contact to whom you 
want to send a letter.    

2. From the Write menu, choose one of the available commands.    
3. Type the body of the letter, memo, or fax.
4. Save your document.
5. Print, fax, or e-mail your document.

After you print, fax, or e-mail your document, the Create History dialog box appears.
6. If you want to create a history record for the document, skip to the next step. If you do not want to create a 

history for the document, click Cancel.
7. (Optional) If you do not want to attach the document to the history record, turn off the Attach Document To 

History option. 
When this option is turned on, a shortcut to the document is automatically added to the history record.

8. Enter a description of the document in the Regarding field and click Create.
A history record is created for the document.
If you select the Attach Document To History option and have not yet saved the document, the Save As dialog 
box appears where you can enter a name for the document and the location in which you want to save it.

 Related Topics 



You can write letters and memos to contacts in your ACT! database without ever having to type a name or an 
address. ACT! comes with several letter and memo templates, which are set up to extract the appropriate contact 
information from the database.
You can use the templates as designed, modify them to suit your needs, or create new templates.
You can also create word-processing documents that do not use templates to take information from an ACT! 
database. For example, you may want to create a data sheet that doesn't need to be filled in with information from
your ACT! database.
You can quickly create a bulk mailing of form letters to any number of contacts in your database. This is known as 
a mail merge operation. For example, if you are sending a form letter to each of your contacts, you can use the 
mail merge feature to personalize each letter with the contact's name and address.
With ACT! you use templates for your mail merges. The templates contain fields, such as contact name, address, 
company, and so on. When you perform a mail merge, the fields are filled in with the selected contacts' 
information. ACT! comes with templates that you can use for your mail merges. You can modify these templates to 
suit your needs, or create new templates.



The Send Output To group box options
The Printer option sends all of the merged letters directly to the currently selected printer. If you select the 

Create History When Sent option, a history of your sending the document is entered in each contact's record.
The E-mail option sends all of the merged letters as e-mail messages. If you choose to create a history, a 

history of your sending the e-mail message is recorded in each contact's record. The text of the letter appears in 
the message body area of the e-mail message.

The Fax option sends all of the merged letters as fax transmissions to the addressees and then records a 
history of your sending the fax in each contact's record.

The File option merges the letters into a single file containing a letter or memo for each contact. For 
example, if you selected the letter template, and specified that you wanted to create letters for all the contacts in 
the current lookup, a single file would be created containing a letter for each contact in the lookup. This option is 
helpful if you want to preview letters or memos before you print or send them. If you use Microsoft Word or 
WordPerfect as your selected word processor, you can then fax or e-mail the individual letters or memos to each 
contact. However, it is important to note that if you're using the ACT! word processor, you cannot fax or e-mail the 
letters or memos to each individual contact. In addition, if you're using the ACT! word processor and you select this 
option, no history is recorded of your creating the file.



 Overview

To write form letters or memos to multiple contacts

1. Enter the text of the letter into the template if you have not already done so.
2. Use a command in the Lookup menu to find the contacts to whom you want to send a form letter or memo.    
3. From the Write menu, choose Mail Merge.

The Open dialog box appears.
4. Select a template and click Open.

The Mail Merge dialog box appears.
5. Select an option from the Merge With group box.

You can send a letter to the active contact, to the active lookup, or to all the contacts in your database.
6. Select an option from the Send Output To group box.    
7. If you want to record a history of the letter or memo, select the Create History When Sent option.

When you select this option, a history of your sending the document, e-mail message, or fax is recorded in each
contact's record, depending on which output option you select. Note that if you're using the ACT! word 
processor and select the File output option, you cannot record a history of the document.

8. Enter a description of the letter or memo in the Regarding field and click OK.
 Related Topics



You can create your own templates for letters and memos, or you can modify existing templates. In most cases, 
you'll find it easier to edit an existing template. You set up templates by selecting the fields in the database from 
which you want to extract information. You can use any of the fields in the currently open ACT! database.
When you have inserted the fields into the template, you can format and edit the template just as you do with 
other word-processing documents.

Note
If you created word-processing templates in ACT! 2.0, you can open and use those templates in ACT! 3.0.



 Overview

To edit existing templates

1. Make sure that you are in the Contact window.
2. From the Write menu, choose Edit Document Template.

The Open dialog box appears.
3. Find the template that you want to open and click Open. You can open an ACT! 2.0 or an ACT! 3.0 template.

The template is opened in the word-processing application that you have selected as your default, and the Mail
Merge Fields dialog box automatically appears.

4. In the Field Type group box, specify whether you want to insert a field from a contact record, a field from the My
Record, or a field label.

5. From the Field list, select the fields that you want to add to the template, clicking Insert after making each 
selection. You can also double-click a field name to quickly add the field to the template.

6. Click Close when you have finished adding fields.
Note
If you're using the ACT! word processor and decide you want to make changes in the Mail Merge Fields dialog 
box after you've closed the dialog box, you can choose Mail Merge Fields from the Insert menu to open the 
dialog box again. If you're using Microsoft Word or WordPerfect, you can reopen the Mail Merge Fields dialog box
by choosing Mail Merge Fields from the View menu.

7. Make any other changes to the template.
You can delete any fields that you don't want in the template by simply selecting them as text objects and 
deleting them. You can also make formatting changes as you would to an ordinary document.

8. From the File menu, choose Save As, and save the template with a new name.
You can add templates that you use frequently to the Write menu using the Modify Menu command.

 Related Topics



You can create your own templates for letters and memos, or you can modify existing templates. In most cases, 
you'll find it easier to edit an existing template. You set up templates by selecting the fields in the database from 
which you want to extract information. You can use any of the fields in the currently open ACT! database.
Sometimes you may want to create a new template, without starting from an existing template. If you want to 
create a template that isn't at all similar to an existing template, it may be easier to start with a new template.



 Overview

To create new templates

1. From the File menu, choose New.
The New dialog box appears.

2. Select ACT! Word Processor Template and click OK.
If you've selected Word or WordPerfect as your default word processor, select Microsoft Word 6.x-7.0 Template 
or WordPerfect 6.x Template.

3. Click OK.
A blank template appears, along with the Mail Merge Fields dialog box dialog box.

4. In the Field Type group box, specify whether you want to insert a field from a contact record, a field from the My
Record, or a field label.

5. From the Field list, select the fields that you want to add to the template, clicking Insert after making each 
selection. You can also double-click a field name to quickly add the field to the template.

6. Click Close when you have finished adding fields.
Note
If you're using the ACT! word processor and decide you want to make changes in the Mail Merge Fields dialog 
box after you've closed the dialog box, you can choose Mail Merge Fields from the Insert menu to open the 
dialog box again. If you're using Microsoft Word or WordPerfect, you can reopen the Mail Merge Fields dialog box
by choosing Mail Merge Fields from the View menu.

7. Make any other changes to the template.
You can delete any fields that you don't want in the template by simply selecting them as text objects and 
deleting them. You can also make formatting changes as you would to an ordinary document.

8. From the File menu, choose Save As, and save the template with a new name.
You can add templates that you use frequently to the Write menu using the Modify Menu command.

 Related Topics



ACT! Help topics explain how to use the ACT! word processor. If you use Microsoft Word or WordPerfect as your 
default word-processing application, you will need to refer to the respective documentation.



 Overview

To create a new document

1. From the word-processing File menu, choose New.
The New dialog box appears.

2. Select ACT! Word Processor Document and click OK.
A blank word-processing document appears.

 Related Topics



You can easily move a word, a sentence, a paragraph, or any block of text from one place in a document to 
another.



 Overview

To move text to another location

1. Select the text that you want to move by dragging to select a block of text or by double-clicking to select a 
single word.

2. From the Edit menu, choose Cut.
3. Click to place the cursor where you want to insert the text.
4. From the Edit menu, choose Paste.

The text is inserted at the new position in the document.
 Related Topics



You may want the same text to appear in more than one location in a document. You don't have to retype the text; 
you can simply make a copy of it and insert it in another location.



 Overview

To copy text to another location

1. Select the text that you want to copy.
2. From the Edit menu, choose Copy.
3. Click to place the cursor where you want to insert the text.
4. From the Edit menu, choose Paste.

A copy of the text is inserted at the new position in the document.
 Related Topics



The ACT! word processor lets you put the current date and time in your document and updates them automatically.



 Overview

To insert the current date in a document

1. From the Insert menu, choose Date.
The Insert Date dialog box appears.

2. In the Date Format group box, select either Short Format or Long Format.
An example of Short Format is "10/23/96" (month/day/year).
An example of Long Format is "Wednesday, October 23, 1996."

Note
The Short Date and Long Date formats in the Insert Date dialog box are the same formats that you set in the 
Date tab of the Windows Regional Settings Properties dialog box. For example, if you wanted your Short Date 
setting to display the day before the month (23/10/96), you would set this in the Regional Settings Properties 
dialog box in Windows. See your Windows online help for additional information.

3. Select an update option and click OK.
Always Update In Document means that the date will be updated automatically when you open or print the

file.
Never Update In Document means that the original date becomes normal text in the document, and it is 

never updated automatically.
 Related Topics



 Overview

To insert the current time in a document

1. From the Insert menu, choose Time.
The Insert Time dialog box appears.

2. Select an update option and click OK.
Always Update In Document means that the time will be updated automatically when you print or open the

file.
Never Update In Document means that the original time becomes normal text in the document, and it is 

never updated automatically.
Note
You can change the way the times appear by setting the Time style in the Time tab of the Windows Regional 
Settings Properties dialog box. See your Windows online help for additional information.

 Related Topics



You can have the ACT! word processor search through a document for a word or phrase and automatically replace 
it with another. For example, you may want to search for a product name and replace all instances of it with 
another product name. You can verify each text replacement, or the word processor can replace all instances of 
the word at the same time.



For example, if you enter "open" in the Find field, the word processor will find the words "open," "opened," 
"opening," and so on, unless you select the Match Whole Words option. With this option selected, the word 
processor will find only the complete word "open."



 Overview

To search for and replace words or phrases

1. From the Edit menu, choose Find And Replace.
The Find and Replace dialog box appears.

2. Enter the word or phrase for which you want to search in the Find field.
3. Enter the word or phrase with which you want to replace the found text in the Replace With field.
4. (Optional) Select the Match Whole Words option.

If you select this option, the word processor must find the text entered in the Find field as a complete word, 
rather than part of another word.    

5. (Optional) Select the Case Sensitive option.
This option determines whether the word processor tries to match upper- and lowercase letters when it 
searches for text. Select this option if you want your text searches to consider capitalization. If you do not 
select this option, the word processor will find all instances of the specified word, regardless of capitalization 
styles.

6. Click Find Next to start finding the word you entered in the Find field.
The word processor highlights the specified word when it finds it.

7. Click Replace if you want to replace the word with the word you entered in the Replace With field.
You can also type something else in the Replace With field.

8. (Optional) Click Replace All to replace all instances of the specified word.
If you click this button, the word processor automatically replaces the word everywhere that it appears in the 
document. 
Caution
You cannot undo a Replace All operation.

 Related Topics



By default, the ACT! word processor displays a ruler at the top of your word-processing documents to help you 
judge where the text is appearing on the page. You can also use the ruler to change margins, indentation, and 
tabs. You can turn the ruler display on or off.



 Overview

To display a ruler
From the View menu, choose Ruler.

A check appears next to the Ruler command when it is on, and a ruler appears at the top of your word-
processing document. To turn off the ruler display, choose the Ruler command again. The check next to the 
Ruler command disappears, and the ruler no longer appears at the top of your word-processing document.

 Related Topics



Page guides are light gray lines that mark the boundary of the editable page, as well as the header and footer 
areas. You may find it useful to display page guides as you are laying out a word-processing document. 



 Overview

To display page guides
From the View menu, choose Page Guides.

A check appears next to the Page Guides command when it is on, and page guides appear in your word-
processing document. To turn off the page guides display, choose the Page Guides command again. The check 
next to the Page Guides command disappears, and the page guides no longer appear in your word-processing 
document.

 Related Topics



You can decide which units of measurement to use in your word-processing documents. The units of measurement 
apply to the rulers, as well as to all the text formatting values. You can select one of the following units:

Inches
Centimeters
Points
Picas



 Overview

To change the units of measurement

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears with the General tab active.

2. Choose a unit of measurement from the Measurement Units drop-down list and click OK.
 Related Topics



The toolbar at the top of the Word-processing window includes various tools.
When you position the pointer over one of the tools, a tool tip appears. Tool tips are text messages that indicate 
what the tool does. 



 Overview

To turn the tooltips on or off in the word processor

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears with the General tab active.

2. Turn the Display Tool Tips option on or off.
 Related Topics



You can adjust the amount of space in the top, bottom, left, and right margins of the page. You can also specify the
sizes of headers and footers. 
A header contains text or graphics that appear at the top of every page. A footer contains text or graphics that 
appear at the bottom of every page. For example, you may want to set up a document that has your company's 
logo at the top of every page and the page number at the bottom of every page. You can specify the size of 
headers and footers on a page. You can also determine whether or not header and footer text appears on the first 
page of a document.



 Overview

To adjust the page margins

1. From the Format menu, choose Page Margins.
The Page Margins dialog box appears.

2. Enter values for the Top, Bottom, Left, and Right page margins, and click OK.
 Related Topics



For example, if you want your header to be one inch high, enter 1.0 in the Header height field.



For example, you may not want a page number to appear on the first page of a document, but you may want it to 
appear on all subsequent pages.



 Overview

To create a header and footer for a document

1. From the Format menu, choose Header and Footer.
The Header and Footer dialog box appears.

2. In the Show group box, select either or both the Header and Footer options.
3. Set values for the Header height and Footer height.

These values determine the height of the header or footer.    
4. (Optional) Select the Exclude Header And Footer From First Page option.

Select this option if you do not want header and footer text to appear on the first page of your document.    
5. Click OK when you've finished creating your header and footer.

Before inserting text or graphics into your header or footer, you may find it helpful to clearly see the borders of 
your header and footer on the page. To view the borders of a header or footer, choose Page Guides from the 
View menu.

6. Insert the text or graphics file that you want to appear in the header and footer. You can insert any graphics file
that has a .BMP extension.

To insert your own text, simply type it in.
To insert the current date, time, or page number, choose Date, Time, or Page Number from the Insert 

menu.
To insert a bitmap file, choose File from the Insert menu, locate your bitmap (*.BMP) file and click Open.

 Related Topics



When you create multiple-page documents, the ACT! word processor automatically starts a new page when the 
previous page is full. In some cases, you may want to make your own decisions about where to start a new page. 
For example, you may want to make sure that a paragraph doesn't break in the middle, leaving half of it on one 
page and half of it on the next page.



 Overview

To insert a page break in a multiple-page document

1. Put the cursor exactly where you want to start a new page.
2. From the Insert menu, choose Page Break.

A new page is inserted in the document. If you later need to remove the page break, you can delete it by 
putting the insertion point at the beginning of the new page and pressing the Backspace key.

 Related Topics



You can change the font, the font style, the font size, and the color of the text in your document. You can use the 
toolbar to select fonts, font sizes, or apply bold type, italics, or underlining to your text. If you want to apply other 
styles or change the color of your text, you must use the commands in the Format menu.
Using the Font command in the Format menu, you can change your font, font size, or select from a list of built-in 
styles for each font. The Style command in the Format menu allows you to apply styles that may not be built into a
font, such as underlining or strikeout. For example, if you are writing a letter using the Arial font, and want to apply
bold type and underlining to a particular word, you would choose the bold option from the available styles in the 
Font dialog box, and apply underlining using the Style command in the Format menu.



 Overview

To change the font in a document

1. Select the text that you want to appear in a different font.
If you want to change the font for the entire document, choose Select All from the Edit menu.

2. Use the font controls in the toolbar to change the font.
 Related Topics



 Overview

To change the font style

1. Select the text that you want to appear in a different style.
2. From the Format menu, choose Font.

The Font dialog box appears.
3. Select a style in the Font Style list and click OK.

The text appears in the selected style.
4. (Optional) If you want to apply a style that is not built into a font, such as strikeout or underlining, select the 

text to which you want to apply the style, choose Style from the Format menu, and select a style from the 
submenu.

 Related Topics



 Overview

To change the text color

1. Select the text that you want to appear in a different color.
If you want to change the text color for the entire document, choose Select All from the Edit menu.

2. From the Format menu, choose Color and select a color from the submenu.
The text appears in the selected color.

 Related Topics



You can set indentation, line-spacing, and alignment options for an individual paragraph or for multiple 
paragraphs. If you simply want to change the alignment of a paragraph, select the paragraph and click one of the 
alignment buttons in the ruler.

The Left option aligns your paragraph flush with the left margin, leaving a ragged right edge.
The Center option centers your paragraph on the page, leaving ragged left and right edges.
The Right option aligns your paragraph flush with the right margin, leaving a ragged left edge.
The Justified option expands, or justifies, the spacing between words to align your paragraph flush with 

both the right and left margins.
If you want to set indentation or line-spacing options, you need to use the Paragraph command in the Format 
menu.



The First Line option indents only the first line of a paragraph.
The Left option indents the entire left side of a paragraph.
The Right option indents the entire right side of a paragraph.



For example, turn on this option if you want to make sure that a heading stays with the paragraph that follows it.



 Overview

To format a paragraph

1. Select the paragraph or paragraphs that you want to format.
2. From the Format menu, choose Paragraph.

The Paragraph dialog box appears.
3. In the Indentation group box, set the indentation options that you want applied to the paragraph.    
4. In the Spacing group box, set the line spacing option that you want applied to the paragraph.

You can apply single-, one-and-a-half-, or double-spacing, or you can enter a custom spacing value by selecting 
the Every option and selecting a value.

5. In the Alignment group box, select a text alignment option.
6. (Optional) Select the Keep With Next option.

Selecting this option ensures that a page break will not be inserted between the current paragraph and the 
next paragraph.    

7. Click OK when you have set the paragraph attributes.
If you simply want to adjust the indentation of one or more paragraphs, you can do this on the ruler.

 Related Topics



 Overview

To change paragraph margins from the ruler

1. Make sure that Ruler is checked in the View menu.
2. Select the paragraph to which you want to apply the new margins.
3. Position the pointer on the right or left margin marker, and drag the marker to a new position.

 Related Topics



You can set tabs in your word-processing documents using the tab controls on the ruler or by setting tab locations 
and attributes in a dialog box.
In the Tabs dialog box, you can change the character on which a decimal tab is aligned, and set leader characters 
for tabs. Leader characters are solid, dashed, or dotted lines that fill the space taken up by a tab. Leader 
characters are often used in tables of contents to connect the heading to the page number.



The tab alignment buttons
To set this tab alignment Click this button
Left-aligned: text is aligned flush left 
with the tab position.
Center-aligned: text is centered around
the tab position.
Right-aligned: text is aligned flush 
right with the tab position.
Decimal-aligned: text is aligned around
a decimal point or other character.

 Overview

To set tabs from the ruler

1. From the View menu, choose Ruler to display the ruler if it is not already displayed.
2. Place the cursor in the paragraph in which you want to set a tab.
3. Click one of the tab alignment buttons in the toolbar to select the kind of tab you want to set.    

If you decide to change the alignment of a tab, simply click it in the ruler to select it, then click a different tab 
alignment button on the toolbar.

4. Click the location in the ruler where you want to place a tab.
If you need to move a tab, you can drag it to a new location on the ruler.

 Related Topics



For example, if you are working with European decimals, enter a comma for the decimal character.



  Overview

To set tabs and leader characters from the Tabs dialog box

1. From the Format menu, choose Tabs.
The Tabs dialog box appears.

2. In the Tab Stop Position field, enter the location where you want the tab to appear.
3. In the Alignment group box, specify the kind of tab you want to set.    
4. (Optional) If you are setting a decimal-aligned tab and want to change the decimal character, type a 
different character in the Align On field.    
5. (Optional) In the Leader group box, select an option for tab leader characters.

You can specify a Solid Line, Dashed Line, or select Other and enter a different character such as a period or an 
asterisk.

6. Click Add when you have set the tab location and attributes you want.
When you click Add, the tab location is added to the list on the left side of the Tabs dialog box, and the 
corresponding tab alignment symbol is added to the appropriate location on the ruler.

7. (Optional) Follow steps 2 through 6 to add additional tabs.
8. Click OK when you've finished adding tabs.

 Related Topics



 Overview

To modify existing tabs

1. From the Format menu, choose Tabs.
The Tabs dialog box appears.

2. In the list of existing tabs on the left side of the dialog box, select the tab that you want to modify.
3. Change the tab attributes as necessary, and click Modify.

The attributes of the tab are changed.
4. (Optional) Follow steps 2 and 3 to modify additional tabs.
5. Click OK when you've finished modifying tabs.

 Related Topics



 Overview

To remove tabs

1. From the Format menu, choose Tabs.
The Tabs dialog box appears.

2. In the list of existing tabs on the left side of the dialog box, select the tab that you want to remove.
3. Click Clear.

The tab is removed from your document.
4. (Optional) Follow steps 2 and 3 to remove additional tabs.
5. Click OK when you've finished removing tabs.

 Related Topics



If you have set tabs, indentation, or margins for one paragraph, you can copy those formats and apply them to 
other paragraphs in your document. The formats that you can copy from one paragraph and apply to another 
paragraph are those that you can set on the ruler:

Tabs
Indents
Left and right margins
Justification



 Overview

To copy ruler formats from a paragraph

1. Put the cursor in the paragraph whose formats you want to copy.
2. From the Edit menu, choose Copy Ruler.

You can now apply the paragraph formats to one or several other paragraphs.
 Related Topics



 Overview

To apply copied formats to another paragraph

1. Put the cursor in the paragraph in which you want to apply the copied formats.
2. From the Edit menu, choose Apply Ruler.

The formats are applied to the selected paragraph.
 Related Topics



The ACT! word processor includes a spell checker so that you can automatically check the spelling in your 
documents. You can check the spelling in an entire document, or you can select a word or a paragraph and check 
the spelling of the selected text. 
You can decide which dictionary you want to use to check the spelling. In addition to selecting a main dictionary, 
you can select one of your own user dictionaries. You can create your own user dictionaries to which you can add 
words that you use often, but that are not found in the main dictionary. For example, you may want to add your 
client names to a user dictionary that you use for checking correspondence. You may want to create another user 
dictionary for technical terms and product codes, and use this dictionary for checking data sheets or specifications.



 Overview

To select dictionaries for spell checking

1. From the Spelling menu, choose Select Dictionaries.
The Preferences dialog box appears with the Spelling tab active.

2. Use the Browse button to the right of the Main Dictionary field to locate the name of the dictionary that you 
want to use. 

3. Choose a dialect from the Dialect drop-down list.
You can choose American, Australian, or British English.

4. Use the browse button to the right of the User Dictionary field to locate the name of the user dictionary that 
you want to use, and click OK.

 Related Topics 



 Overview

To edit your user dictionary

1. Select the dictionary you want to edit.
2. From the Spelling menu, choose Modify User Dictionary.

The User Dictionary dialog box appears.
3. In the User Dictionary Entries group box, click one of the following buttons:

Use the Add button to add new words to your user dictionary.
Use the Remove button to remove a word from your user dictionary. 
Use the Modify button to edit a word in your user dictionary. This may be useful if you have accidentally 

misspelled a word in your user dictionary.
4. Click OK when you have finished editing your user dictionary.

Make sure that you have correctly spelled the words in your user dictionary. The spell checker will not catch 
misspelled words if they are in your user dictionary.

 Related Topics



The ACT! word processor includes a spell checker so that you can automatically check the spelling in your 
documents. You can check the spelling in an entire document, or you can select a word or a paragraph and check 
the spelling of the selected text. 
The spell checker searches your document and finds all words that do not appear in either the main or the 
currently specified user dictionary. You can also specify whether or not you want the spell checker to suggest 
corrections for misspelled words.



 Overview

To have the spell checker suggest corrections

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears with the General tab active.

2. Click the Spelling tab.
3. Select the Auto Suggest Spelling Changes option and click OK.

 Related Topics



 Overview

To check the spelling in a word-processing document

1. From the Spelling menu, choose Check Document.
If you want to check just a selected block of text, select the text and choose Check Selection from the Spelling 
menu.
The ACT! Spell Check dialog box appears with the first misspelled, or unrecognized, word in the Word field.
If the Auto Suggest option is selected, suggested replacement words appear in the Suggestions list on the right 
side of the dialog box. The first word in the Suggestions list also appears in the Replace With field.

2. Do one of the following:
Select a word from the Suggestions list and click Replace. If the correct word is already selected, click 

Replace.
Type a word in the Replace With field.
Click Skip if you want to leave the word unchanged, but you do not want to add it to your user dictionary.
Click Suggest to see a list of possible replacement words. The Suggest button is dimmed if the Auto 

Suggest option is selected.
Click Add to add the word to your user dictionary. If you do this, the spell checker will no longer stop when 

it finds that word.
Click Cancel to end the spell check.

When the spell checker finishes checking the document, a message appears telling you how many words were 
checked and how many questionable words were found.

 Related Topics



You may want to place text that was created in another application in one of your word-processing documents. For 
example, you may have some text in another file that you want to reuse. You can insert RTF, Plain Text, or another 
ACT! word-processing document into an ACT! word-processing document.



For example, if you are inserting an RTF file, choose Rich Text Format (*.rtf).



 Overview

To insert files in ACT! word-processing documents

1. Position the cursor where you want to insert the file in your document.
2. From the Insert menu, choose File.

The Insert dialog box appears.
3. Locate the file that you want in your document.

If you don't see the file that you want to insert, make sure that you have chosen the correct file format in the 
Files Of Type drop-down list.    

4. When you have selected the file you want, click Open.
The file is inserted in your document.

 Related Topics



You can use one of three commands to save your documents:
The Save command saves a document with its existing name. If you are saving a new, untitled document, 

ACT! asks you for a file name.
The Save As command saves a copy of the document with a new file name, file type, or location. The 

original version of the document remains unchanged.
The Save Selection As command saves the selected portion of your document as a separate file. If you 

have not selected a block of text in your document, the Save Selection As command is dimmed.



 Overview

To save a document
From the File menu in the ACT! word processor, choose Save.

The document is saved with its original name. If you have not already named the document, you are prompted 
for a file name.

 Related Topics



 Overview

To save a copy of a document

1. From the File menu in the ACT! word processor, choose Save As.
The Save As dialog box appears.

2. Type the name of the file in the File Name field.
3. Click Save.

 Related Topics



 Overview

To save a selection of text as a new file

1. Select the text that you want to save as a new file.
2. From the File menu, choose Save Selection As.

The Save As dialog box appears.
3. Type the name of the file and click Save.

The block of text is saved as a new file.
 Related Topics



You can open existing ACT! 2.0 or ACT! 3.0 word-processing documents from the ACT! word processor or from any 
ACT! window.



 Overview

To open a word-processing document from an ACT! window

1. From the File menu, choose Open.
The Open dialog box appears.

2. Choose the appropriate option from the Files Of Type drop-down list.
3. Find the document that you want to open and click Open.

 Related Topics



 Overview

To open a document from the ACT! word processor

1. From the File menu, choose Open.
The Open dialog box appears.

2. Find the document that you want to open and click Open.
 Related Topics



When you have created letters and memos, you can send them to the recipients in several ways:
You can print them and send them as paper documents. You can also print envelopes and mailing labels. 
You can send them as fax messages directly from the ACT! word processor, Microsoft Word, or WordPerfect.
You can send them as e-mail messages directly from the ACT! word processor, Microsoft Word, or 

WordPerfect.
You can print your letters and memos just as you print any documents you create with a word-processing 
application. Keep in mind, however, that printing a template will print the field names used in the template. You 
must first use the Mail Merge command in the ACT! word processor to get real contact data into a template before 
you print it.



 Overview

To print a letter or memo 

1. Open the document that you want to print.
2. From the File menu, choose Print.

The Print dialog box appears.
3. Select the print options that you want and click OK.

The document is sent to the printer you specified.
 Related Topics



You can send the letters and memos that you write by e-mail if your contacts have e-mail addresses. 



 Overview

To prepare and send a word-processing document as an e-mail message

1. Open the letter or memo that you want to send as an e-mail message.
2. If you are using the ACT! word processor, choose Send > E-mail from the File menu. If you are using Microsoft 

Word or WordPerfect as your selected word processor, choose Send E-mail Using ACT! from the File menu in 
either application.
The Send E-mail dialog box appears.

3. Select one of the following options and click OK.
Select the Entire Document As File Attachment option if you want to save the document as a file that is 

attached to an e-mail message.
Select the Entire Document In Message Body option if you want the document to appear in the body of an 

e-mail message.
Select the Selected Text In Message Body option if you want selected text in your document to appear in 

the body of an e-mail message. This option appears dimmed until you drag to select a portion of text in your 
document, or double-click a word to select it.

When you return to your ACT! database, the E-mail window appears if you are already logged in to an e-mail 
system.
If you are not already logged in to an e-mail system, a login dialog box appears for your selected e-mail system.

4. (Optional) Log in to your selected e-mail system.
The E-mail window appears with the document or selected text inserted in the message body or the document 
attached as a file, depending on which option you selected.

5. Address and send the message.
 Related Topics



After you write form letters or memos, you may want to create mailing labels or envelopes. You can easily produce 
and print mailing labels or envelopes for the current contact, the current lookup, or all contacts in your database. 
ACT! comes with numerous U.S. and international label templates, and several U.S. and international envelope 
templates. The label templates are based on the standard Avery labels.
You can also modify existing label and envelope templates, or create entirely new templates.

Note
You do not use the ACT! word processor to produce mailing labels and envelopes.



For example, if you've already used some of the labels on a sheet of labels, you may want to start printing on the 
fifth label in the second row of labels. In this case, enter 2 in the Row field and 5 in the Column field.



 Overview

To create mailing labels or envelopes

1. If necessary, perform a lookup to find the contacts for whom you want to create mailing labels or envelopes.
2. From the File menu, choose Print.

The Print dialog box appears.
3. From the Printout Type drop-down list, choose either Labels or Envelopes, depending on what you want to 

create.
A list of available label or envelope templates appears on the left side of the dialog box. The label names match
the names of the corresponding Avery labels.

4. Select a label or envelope template from the list on the left side of the dialog box and click OK.
The Run Label or Run Envelope dialog box appears.

5. In the Create Report For group box in the General tab, specify whether to create labels or envelopes for the 
current contact, the current lookup, or all contacts.

6. (Optional) If you want to create a label or envelope based on the information in your My Record, turn off the 
Exclude My Record option.

7. In the Send Output To group box, select an output option for the labels or envelopes.
The Printer option sends the labels or envelopes directly to the default printer.
The Preview option displays an on-screen preview of the labels or envelopes. After previewing them, you 

can choose to print the labels or envelopes.
8. (Optional for labels only) Click the Position tab, and specify on which label to start printing using the Row and 

Column controls.    
9. Click OK to create the labels or envelopes.

 Related Topics



You can dial contacts' telephone numbers and manage your telephone calls from within ACT! using the ACT! dialer.
You can think of the dialer as an extension of your telephone or modem that works with ACT! to make calling your 
contacts simpler and easier. While you are using the dialer, you have full access to all of the features and functions
of ACT! so you can schedule activities, write letters, or perform other contact management tasks while you are 
talking to your contacts.
The dialer utilizes the TAPI (Telephony Application Programming Interface) technology that comes with your 
Windows 95 or Windows NT 4.0 operating systems. TAPI functions as a link between your computer and your 
modem or telephone, allowing you to place and manage calls using your computer.
To use the ACT! dialer, you must have Microsoft Windows 95 or Microsoft Windows NT version 4.0 installed on your 
computer. The ACT! dialer is not available if you are using Microsoft Windows NT version 3.51.
You can use the dialer with one or both of the following:

A modem that shares the same line as your telephone
A telephone equipped with TAPI hardware and the appropriate telephone driver software installed on your 

computer
Note
With most existing modems, you will be able to use the dialer only to dial telephone numbers. You will not have 
access to the automatic timing, Hold, Call Forward, Call Transfer, and Conference features available in the 
dialer. If you have questions about which features your modem supports, refer to the documentation that came 
with your modem, or contact your modem vendor.

If you have questions about using your telephone with the ACT! dialer, contact your company's telephone 
administrator, or your telephone system vendor.
Before you use the dialer, you must turn it on and set preferences for how it will work with your telephone or 
modem.



For example, if you use the dialer from sales offices in San Francisco and London, you can set dialing preferences 
for both locations. The locations that you create in the Dialing Properties dialog box are used by all Windows 95 
applications that allow dialing. For more information about the options available in the Dialing Properties dialog 
box, see the Windows online help.



For example, the telephone line in your office might have two extensions. Each of those extensions is a separate 
address. 



 Overview

To set up the dialer

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears.

2. Click the Dialer tab.
The Use Dialer option is turned off by default.

3. Select the Use Dialer option to turn on the dialer.
The dialer startup process may take a few seconds depending on the type of telephone you are using.

4. Choose the modem or telephone line you want to use from the Modem Or Line drop-down list, and click Setup 
to configure the modem or telephone line you chose.
When you click Setup, a setup dialog box appears for your modem or telephony service provider.
For more information about the options available in the setup dialog box, refer to the documentation that came 
with your modem or telephony software.
Note
If you do not see your modem or telephone listed in the Modem Or Line drop-down list, check to make sure that
you correctly installed the modem driver or telephone driver software. For information about installing a 
modem driver or telephony driver, see your Windows online help. 

5. Choose a location from the Location drop-down list, and click Properties to set location options.
When you click Properties, the Windows Dialing Properties dialog box appears. In the Dialing Properties dialog 
box, you can specify any special options that apply to your calling location (such as a number you must dial to 
access an outside line), or add new dialing locations.    

6. Choose the telephone extension or modem address that you want to use from the Address drop-down list.
A telephone or modem "address" is a telephone number. Most modems support only one address. However, 
one telephone line may support multiple addresses.    

7. Select the Hide Dialer After Dialing option if you want to hide the dialer after you dial a telephone number. Turn 
off this option if you want the dialer to remain on the screen after you dial a telephone number.

8. (Optional) If Caller ID is available in your area, select the Lookup Contact Using Caller ID option.
When you select this option, ACT! identifies the telephone number of an incoming call and searches your 
database for a matching number. If a matching telephone number is found, ACT! automatically displays the 
contact record that contains that telephone number. 
Note
Caller ID is not available in all areas. If Caller ID is available in your area, you will need to purchase the service 
from your local telephone service provider in order to use it. In addition, your telephone may require additional 
equipment to support Caller ID. For more information about Caller ID, contact your local telephone service 
provider.

9. Select the Start Timer Automatically On Outgoing Calls option if you want ACT! to automatically time and 
record histories of your outgoing calls.
Note
You can also manually time and record histories for both your outgoing and incoming calls.

10.(Optional) Select the Modem Has Speaker Phone Capabilities option.
Select this option if your modem has speaker phone capabilities. If you have questions about the capabilities of 
your modem, see the documentation that came with your modem.
Note
If you turn on this option for modems that don't have speaker phone capabilities, the dialer will not return to its 



default state after you make a call. If you notice that the Hang Up button is still active in the dialer, click the 
Hang Up button to return the dialer to the default state, then verify that the Modem Has Speaker Phone 
Capabilities option is turned off. 

 Related Topics 



You can dial contacts' telephone numbers and manage your telephone calls from within ACT! using the ACT! dialer.
You can think of the dialer as an extension of your telephone or modem that works with ACT! to make calling your 
contacts simpler and easier. While you are using the dialer, you have full access to all of the features and functions
of ACT! so you can schedule activities, write letters, or perform other contact management tasks while you are 
talking to your contacts.
The dialer utilizes the TAPI (Telephony Application Programming Interface) technology that comes with your 
Windows 95 or Windows NT 4.0 operating systems. TAPI functions as a link between your computer and your 
modem or telephone, allowing you to place and manage calls using your computer.
To use the ACT! dialer, you must have Microsoft Windows 95 or Microsoft Windows NT version 4.0 installed on your 
computer. The ACT! dialer is not available if you are using Microsoft Windows NT version 3.51.
You can use the dialer with one or both of the following:

A modem that shares the same line as your telephone
A telephone equipped with TAPI hardware and the appropriate telephone driver software installed on your 

computer
Note
With most existing modems, you will be able to use the dialer only to dial telephone numbers. You will not have 
access to the automatic timing, Hold, Call Forward, Call Transfer, and Conference features available in the 
dialer. If you have questions about which features your modem supports, refer to the documentation that came 
with your modem, or contact your modem vendor.

If you have questions about using your telephone with the ACT! dialer, contact your company's telephone 
administrator, or your telephone system vendor.
You can use the dialer with your telephone or modem to dial your contacts' telephone numbers, and you can time 
your telephone calls and record histories of your calls.



 Overview

To make a telephone call

1. Display the record of the contact you want to call.
2. From the Contact menu, choose Phone Contact, or click the Dial Phone tool in the toolbar.

The dialer appears, displaying all of the telephone numbers associated with that contact.
3. (Optional) If you want to dial a different contact from the one currently displayed, click the Browse button to the

right of the Contact field. 
When you click the Browse button, the Select Contact dialog box appears. This dialog box contains a list of 
all the contacts in your database, sorted by last name. Select the new contact from the list and click OK. 

4. From the list of available numbers, select the telephone number you want to dial.
This list displays all of the phone fields and telephone numbers associated with the current contact, including 
fax numbers, extensions, and any numbers that appear in user-defined phone fields. Note that numbers that 
appear in user-defined extension fields do not appear in this list.
Note
You can also type a number in the Number To Dial field. However, if you type a number in the Number To Dial 
field, you must enter all of the characters that are necessary for dialing the number from your location, such as 
a country code or number that you dial to access an outside line from your location. When you choose a 
number that you've already entered in an ACT! phone field, these characters are automatically entered based 
on the settings in the Windows Dialing Properties dialog box.

5. (Optional) If you want to change the location from which you're dialing, choose a location from the Dialing From
drop-down list.
The dialer lists any dialing locations that you set up in the Windows Dialing Properties dialog box. For more 
information about setting up dialing locations, see the Windows online help.

6. Click Dial or press the Enter key.
If you are using a TAPI-enhanced telephone, the dialer disappears while ACT! dials the number. If you 

turned off the Hide Dialer After Dialing option in the Dialer Preferences tab, the dialer remains on the screen while 
ACT! dials the number.

If you are using a modem, the Windows Call Status dialog box appears.
If you selected the Start Timer Automatically On Outgoing Calls option in the Dialer Preferences tab, the Timer 
appears and begins timing your call. 

7. (Optional) If you need to hang up while the call is going through, do one of the following:
If you are using a TAPI-enhanced telephone, open the dialer and click the Hang Up button, or hang up the 

telephone handset.
If you are using a modem, click the Hang Up button in the Call Status dialog box.

8. When the person you are calling answers the call, do one of the following:
If you are using a TAPI-enhanced telephone, pick up the handset and begin your conversation.
If you are using a modem, pick up the handset on your telephone, and click Talk in the Call Status dialog 

box.
Once the connection is made, additional options appear in the dialer if you are using a TAPI-enhanced 
telephone or a modem that supports call-management features. The Hold button appears, as do any available 
call-management options such as Transfer or Conference. 
Note
If you are using a modem with speaker phone capabilities and your call accidentally hangs up when you click 
Talk, check the Dialer Preferences tab to verify that the Modem Has Speaker Phone Capabilities option is turned
on.

9. When you're ready to end the call, do one of the following:
If you are using a telephone, hang up the telephone handset, or click Hang Up in the dialer.
If you are using a modem, hang up the telephone handset.



If you turned on the Set Timer Automatically On Outgoing Calls option, and you are using a TAPI-enhanced 
telephone, or a modem with speaker phone capabilities, the Timer stops automatically and the Record 
History dialog appears. If you are using a modem that does not have speaker phone capabilities, click Stop to 
stop the timer and display the Record History dialog box.

 Related Topics



If you're using the dialer with a TAPI-enhanced telephone, you can use the Set Timer Automatically On Outgoing 
Calls option in the Dialer Preferences tab to automatically time calls that you make. You can also manually time 
your outgoing or incoming calls by choosing Timer from the Tools menu at any time during the call process.

Note
If you are using the dialer with a modem that does not have speaker phone capabilities, you can use the Set 
Timer Automatically On Outgoing Calls option to automatically display the timer and begin timing your call, but 
the timer will not stop automatically when you hang up the call. You must stop the timer manually when you're 
ready to end the call.

When you end any timed call, the Record History dialog box appears. You can record the outcome of the telephone 
call (such as whether you actually reached your contact or left a message) and add notes describing the purpose 
of the call. The elapsed time of your call is added to the information you enter in the Regarding field of the Record 
History dialog box. You can view this information in the Notes/ History tab of the Contact window. 



 Overview

To manually time outgoing and incoming calls

1. Do one of the following:
To manually time and record a history for an outgoing call, place your call following the steps described in 

Making telephone calls.
To manually time and record a history for an incoming call, display the contact record of the person who is 

calling. If you want to record a history for a caller is who is not in your ACT! database, display your own contact 
record (My Record). The call history will be added to your contact record.
2. From the Tools menu, choose Timer.

The timer appears.
3. Click Start when you are ready to begin timing your call.

When the timer starts, the Resume button becomes the Pause button. If you want the timer to pause at any 
time during the call, click Pause. To resume timing the call, click Resume.

4. (Optional) If you want to reset the timer, click Reset.
The timer is reset to zero and resumes timing.

5. (Optional) If you want to stop timing the call and cancel the call history, click the Close button in the top right 
corner of the dialog box. 

6. When you want to stop the timer, click Stop.
The Record History dialog box appears with the name of the current contact in the title bar.

7. From the Activity Result drop-down list, choose an option that describes the result of your call.
8. Enter a description of the call in the Regarding field, or choose a description from the Regarding drop-down list. 
9. Click OK to close the dialog box and save the call history.

 Related Topics



 Overview

To automatically time outgoing calls

1. Make sure that the Start Timer Automatically On Outgoing Calls option is selected in the Dialer tab of the 
Preferences dialog box. 

2. Follow the steps described in Making telephone calls.
When you click Dial, the timer appears automatically and begins timing your call.

3. (Optional) Do any of the following while timing your call:
To pause the timer at any time during the call, click Pause; click Resume to resume timing.
To reset the timer, click Reset.
To stop timing the call and cancel the call history, click the Close button in the top right corner of the dialog

box. 
To stop timing the call before you're ready to hang up, click Stop to stop the timer and display the Record 

History dialog box (shown in step 4 below).
4. When you've completed the call, click Hang Up in the dialer, or hang up the telephone handset.

The Record History dialog box appears with the name of the current contact in the title bar.
5. From the Activity Result drop-down list, choose an option that describes the result of your call.
6. Enter a description of the call in the Regarding field, or choose a description from the Regarding drop-down list.
7. Click OK to close the dialog box and save the call history.

 Related Topics



If you are using a telephone equipped with TAPI hardware and software, or if you are using a modem that supports 
call-management features, you can use ACT! to manage your telephone calls. ACT! supports the following call-
management features:

Hold
Call Forward
Call Transfer
Conference calling (three-way)

It is important to note that depending on the type of telephone system or modem you use, some call-management
features may not be available. Because different telephone systems and modems use some call-management 
features differently, options within these features may also be unavailable. For example, your telephone system 
may support call forwarding, but not all of the forwarding options that ACT! supports may be available with your 
telephone system. Contact your company's telephone administrator, or your telephone system vendor or modem 
vendor, if you have questions about which features are supported by your telephone system or modem.



 Overview

To put a call on hold

1. Click the Hold button in the dialer when you want to place the call on hold.
The call is placed on hold, and the Unhold button appears in the dialer.

2. When you're ready to resume the call, click Unhold.
 Related Topics 



The Forward All Calls option forwards all of your calls to the number you select.
The Forward Only When Busy option forwards calls to the selected number only when your number is busy.
The Forward Only When No Answer option forwards calls to the selected number only when there is no 

answer at your number.
The Forward When Busy Or No Answer option forwards calls to the selected number when your number is 

busy or when there is no answer at your number.
The Cancel Forwarding option cancels call forwarding.

Note
The list above includes all of the options that ACT! provides for call forwarding. Because the type of telephone 
system you use determines which options are available, you may not see all of these forwarding options.



For example, if you forward your calls to extension 3535, you would see a message that reads "Calls Forwarded to 
3535" unless your system can't determine the forwarding number, in which case you would see a message that 
reads "Calls Forwarded." If you have questions about how your telephone system handles forwarded calls, contact 
the telephone administrator at your company, or your telephone system vendor.



 Overview

To forward a call

1. In the dialer, click Forward.
The Forward Calls dialog box appears.

2. From the Choose New Forwarding Mode drop-down list, choose an option for forwarding your calls.    
The current forwarding status is displayed at the top of the dialog box. The type of telephone system you use 
determines the type of forwarding status message that you see. Some telephone systems can determine the 
number to which your calls are being forwarded. Other systems can determine only that your calls are being 
forwarded, but can't detect the number to which the calls are being forwarded.    

3. Specify the telephone number to which you want to forward your calls using one of the following methods:
If you know that the number to which you want to forward the call is in your ACT! database, click the 

Browse button located to the right of the Forward To field to display the Select Contact dialog box. Select the 
contact you want, and choose a telephone number from the Phone Field drop-down list. 

If you already know the number to which you want to forward your calls, or if the number is not in your 
ACT! database, type the number in the Number field.
4. Click OK.

Your calls are forwarded to the number you specified, and an asterisk appears on the Forward button to indicate
that call forwarding is turned on. 

 Related Topics 



 Overview

To turn off call forwarding

1. To turn off call forwarding, click the Forward button in the dialer.
2. Choose Cancel Forwarding from the Choose New Forwarding Mode drop-down list in the Forward Calls dialog 

box. 
Caution:
Some telephone systems may be unable to determine the status of call forwarding after you shut down the 
application you are using to dial your telephone. If this is true of your telephone system, when you turn on call 
forwarding in the dialer, and then close ACT!, call forwarding may appear to be turned off when you open ACT! 
again. In this case, even though call forwarding is still on, you will not see the asterisk in the Forward button, 
and the forwarding status in the Forward Calls dialog will show that call forwarding is turned off. If this occurs 
with your telephone system, contact your telephone system vendor for assistance.

 Related Topics



 Overview

To transfer a call

1. In the dialer, click Transfer.
The Transfer Calls dialog box appears.

2. Specify the telephone number to which you want to transfer the call.
If you know that the number to which you want to transfer the call is in your ACT! database, click the 

Browse button located to the right of the Transfer To field to display the Select Contact dialog box. Select the 
contact you want, and choose a telephone number from the Phone Field drop-down list. 

If you already know the number to which you want to transfer your calls, or if the number is not in your 
ACT! database, type the number in the Number To Dial field. 
3. Click OK to begin transferring the call.

The Transfer Calls dialog box disappears, and the Complete button appears in the dialer.
4. (Optional) If the Conference button is active, click Conference to cancel the call transfer and begin a conference

call with the other two people on the line. 
Note
This feature may not be available on some telephone systems.

5. (Optional) If you want to cancel the transfer, click Hang Up in the dialer.
Depending on your telephone system, one of the following may occur when you click Hang Up:

The number to which you are transferring the call disconnects, and the caller automatically returns to your 
line.

The number to which you are transferring the call disconnects, and the caller is placed on hold. To speak to
the caller again, click the Unhold button in the dialer.
6. To complete the transfer, do one of the following:

When the person to whom you're transferring the call answers the telephone, inform them of the incoming 
call, then click Complete and hang up the telephone handset.

Click Complete while the transfer destination is ringing. For example, you might do this if you know the 
person to whom you're transferring the call is not in, and you want to transfer the caller to a voice mail system.

When you click Complete, the call is transferred to the number you specified. If you selected the Set Timer 
Automatically On Outgoing Calls option in the Dialer Preferences tab, the Record History dialog box appears.

7. Enter the necessary information in the Record History dialog box and click OK.
 Related Topics 



 Overview

To place a conference call

1. Follow the steps in Making telephone calls to place a call to the first person you want to include in the 
conference.

2. In the dialer, click Conference.
The Conference dialog box appears.

3. Specify the telephone number of the person you want to add to the call.
If you know that the number of the person you want to add to the conference call is in your ACT! database,

click the Browse button located to the right of the Conference With field to display the Select Contact dialog box. 
Select the contact you want, and choose a telephone number from the Phone Field drop-down list. 

If you know the number of the person you want to add to the conference call, or if the number is not in 
your ACT! database, type the number in the Number To Dial field. 
4. Click OK in the Conference dialog box.

After you click OK, the Conference dialog box disappears, and the Complete button now appears in the dialer. 
Because the ACT! dialer allows a maximum of three people in a conference call, the Conference button 
disappears when you've added a third person to the call.
At this point, you can speak privately with the person you're adding to the conference, and the first person in 
the conference is placed on hold.

5. (Optional) If the Transfer button is active, click Transfer to cancel the conference call and transfer the person 
you're adding to the person you called first.
Note
This feature may not be available on some telephone systems.

6. (Optional) If you want to cancel the conference call, click Hang Up in the dialer.
Depending on your telephone system, one of the following may occur when you click Hang Up:

The person you're currently adding to the conference call disconnects, and the first person in the 
conference automatically returns to your line.

The person you're currently adding to the conference call disconnects, and the first person in the 
conference is placed on hold. To speak to that person again, click the Unhold button in the dialer.
7. Click Complete when you're ready to begin the conference call.

 Related Topics 



The Caller ID feature allows you to determine who is calling before you answer a telephone call. At the present 
time, Caller ID is not available in all areas. If Caller ID is available in your area, you can set the Lookup Contact 
Using Caller ID option in the Dialer Preferences tab to display the contact record of an incoming caller.
To use Caller ID to display your incoming calls, your local telephone company must provide Caller ID, and Caller ID 
must be enabled on your telephone line. Your telephone equipment must also support Caller ID. If you have 
questions about Caller ID, contact your local telephone company.



 Overview

To automatically display a contact record on an incoming call

1. Make sure that the Lookup Contact Using Caller ID option is selected in the Dialer tab of the Preferences dialog
box.
When the telephone rings, ACT! looks at the number of the incoming caller and searches the telephone 
numbers in all indexed phone fields in the active database for a matching number. If you set the Phone Ext. 
field to be an indexed field, ACT! also searches the Phone Ext. field for a matching extension. If a matching 
number or extension is found, ACT! displays the first contact record of a lookup based on that telephone 
number or extension. If ACT! finds multiple contact records containing that telephone number or extension, all 
of the contact records containing that number or extension are included in the lookup.

2. If you want to answer the call, pick up the telephone handset and begin your conversation.
 Related Topics 



You can record histories for any timed telephone calls you make or receive. When you complete a timed call, ACT! 
automatically displays the Record History dialog box. You can record the outcome of the telephone call (such as 
whether you reached your contact or left a message) and add notes describing the purpose of the call.



 Overview

To record a telephone call history

1. Make sure that the Start Timer Automatically On Outgoing Calls option is selected in the Dialer tab of the 
Preferences dialog box.
If you are using the Caller ID feature to automatically display contact records on incoming calls, set the Start 
Timer Automatically On Incoming Calls option to time and record histories for your incoming telephone calls.

2. Follow the steps for placing or answering calls described earlier in Making a telephone call and 
Automatically displaying a contact record on an incoming call

3. When you've completed a call, click Hang Up in the dialer.
The Record History dialog box appears.

4. In the Activity Result drop-down list, choose an option that describes the result of your call.
5. Enter a description of the call in the Regarding field, or choose a description from the Regarding drop-down list. 
6. Click OK to close the dialog box and save the call history.

 Related Topics



ACT! provides several ways to create and send faxes. You can fax single documents, mail merges, or reports, and 
you can use the ACT! fax cover page template to create your own cover pages. You can also fax pages from your 
calendar or address book directly from ACT! without ever needing to print the pages.
To send faxes using ACT!, you need the following:

Fax modem installed and configured
Microsoft Fax or WinFax PRO software version 4.0 or 7.0 installed on your computer

Before you can send faxes, you need to specify which type of fax software you want to use. ACT! supports both 
Microsoft Fax and WinFax PRO.



 Overview

To select your fax software

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears.

2. Click the General tab if it is not already selected.
3. Choose your fax software from the Fax Software drop-down list and click OK.

 Related Topics



A simple fax can be any document you create in the ACT! word processor, in Microsoft Word, or in WordPerfect that
is not sent as a mail merge. An example of a simple fax might be a letter that you want to fax to a single contact. 
You can send a simple fax using the Send > Fax command in the ACT! word processor File menu, or by using the 
Send Fax Using ACT! command in the Microsoft Word or WordPerfect File menus.
The procedures for sending a fax differ slightly depending on whether you're faxing a single document that you 
created using a command in the Write menu, or whether you're faxing a previously saved document or new 
document that you created using the File > New command.



 Overview

To fax a document created using a command in the Write menu

1. Follow the steps in Writing letters or memos to a single contact to prepare your word-processing 
document.

2. If you are using the ACT! word processor, choose Send > Fax from the File menu. If you are using Microsoft 
Word or WordPerfect as your default word processor, choose Send Fax Using ACT! from the File menu in either 
application.
The fax is sent using your selected fax software, and the Create History dialog box appears.

3. If you want to create a history record for the document, skip to the next step. If you don't want to create a 
history for the document, click Cancel.

4. (Optional) If you do not want to attach the document to the history record, turn off the Attach Document To 
History option.
If this option is turned on, a shortcut to the document is automatically added to the history record.

5. Enter a description of the document in the Regarding field and click Create.
A history record is created for the document.
If you select the Attach Document To History option and have not yet saved the document, the Save As dialog 
box appears where you can enter a name for the document and the location in which you want to save it.

 Related Topics



 Overview

To fax a new or previously saved document

1. Do one of the following:
To fax a new word-processing document, choose New from the ACT! File menu, and select the appropriate 

file type for your default word processor.
To fax a previously saved word-processing document, open the saved document.

2. If you are using the ACT! word processor, choose Send > Fax from the File menu. If you are using Microsoft 
Word or WordPerfect as your default word processor, choose Send Fax Using ACT! from the File menu in either 
application.
The Send Fax dialog box appears.

3. Select an option in the Select Contacts From group box.
You can select contacts from a list of all your contacts, from the contacts in the current lookup, or from a group.
If you choose the Selected Group option, a list of groups appears in the drop-down list. You can select a group 
from this list.
A list of contacts based on your selection appears in the list below the Select Contacts From group box.

4. From the list, choose the contacts to whom you want to send the fax.
To send the fax to specific contacts in the list, select the name of each contact to whom you want to send 

the fax, and click To.
To send the fax to all the contacts in the list, click Select All, then click To.

The selected contacts appear in the Recipients list on the right side of the dialog box.
5. (Optional) If you decide that you want to remove a contact from the Recipients list, select the contact and click 

Remove.
6. In the Regarding field, type the subject of the fax.
7. (Optional) Select Create History When Sent if you want to create a history record for the document.
8. (Optional) Select Attach Document To History if you are creating a history record and want to attach a shortcut 

to the document in the history record.
9. Click Send.

The fax is sent to the contacts you specified. If you selected the Create History When Sent option, a history is 
recorded of your faxing the document.
If you selected the Attach Document To History option and have not yet saved the document, the Save As 
dialog box appears where you can enter a name for the document and the location in which you want to save 
it.

 Related Topics



Using the ACT! fax cover page template, you can create cover pages for items you send through an external fax 
machine. For example, if you receive a letter from a vendor and want to fax the letter to a contact in your ACT! 
database, you can create the cover page in ACT!, print it out, and fax the cover page and letter to your contact 
through your office fax machine. 
You can also use the ACT! cover page template when you want to send a quick, one-page fax in ACT! using your 
fax software. If you send the ACT! fax cover page as a one-page fax through your fax software, be sure to turn off 
the cover page option in your fax software to prevent sending an extra cover page. For information about creating 
and using cover pages in WinFax PRO or Microsoft Fax, see the documentation that came with your fax software.



 Overview

To create a fax cover page to send through a fax machine

1. Display the record of the contact to whom you want to send a fax.
2. From the Write menu, choose Fax Cover Page.

A fax cover page appears in your specified word-processing application, addressed to the current contact.
Note
Depending on which word-processing application you use, it may take a few seconds for your fax cover page to 
appear.

3. Make any necessary modifications to the information on the cover page, and type the subject of the fax.
4. From the File menu, choose Print.

The Print dialog box appears.
5. Select the appropriate options for your printer and click OK.

The cover page is sent to your printer, and the Create History dialog box appears.
6. If you want to create a history record for the document, skip to the next step. If you do not want to create a 

history for the document, click Cancel.
7. (Optional) If you do not want to attach the document to the history record, turn off the Attach Document To 

History option.
If this option is turned on, a shortcut to the document is automatically added to the history record.

8. Enter a description of the document in the Regarding field and click Create.
A history record is created for the document.
If you select the Attach Document To History option and have not yet saved the document, the Save As dialog 
box appears where you can enter a name for the document and the location in which you want to save it.

 Related Topics



 Overview

To create and send an ACT! cover page as a one-page fax

1. Display the record of the contact to whom you want to send a fax.
2. From the Write menu, choose Fax Cover Page.

A fax cover page appears in your specified word-processing application, addressed to the current contact.
Note
Depending on which word-processing application you use, it may take a few seconds for your fax cover page to 
appear.

3. Make any necessary modifications to the information on the cover page, and type the subject of the fax.
Note
Remember to turn off the cover page option in your fax software to prevent sending an additional cover page.

4. If you are using the ACT! word processor, choose Send > Fax from the File menu. If you are using Microsoft 
Word or WordPerfect as your default word processor, choose Send Fax Using ACT! from the File menu in either 
application.
The fax is sent using your selected fax software, and the Create History dialog box appears.

5. If you want to create a history record for the document, skip to the next step. If you do not want to create a 
history for the document, click Cancel.

6. (Optional) If you do not want to attach the document to the history record, turn off the Attach Document To 
History option.
If this option is turned on, a shortcut to the document is automatically added to the history record.

7. Enter a description of the document in the Regarding field and click Create.
A history record is created for the document. If you select the Attach Document To History option and have not 
yet saved the document, the Save As dialog box appears where you can enter a name for the document and 
the location in which you want to save it.

 Related Topics



When you want to send a personalized fax to your contacts, such as a form letter that includes each contact's 
name and address, you use the Mail Merge feature.
When you perform a mail merge, you select a template, and ACT! automatically fills in the fields in the template 
with contact information you specify. ACT! comes with different types of templates that you can edit to meet your 
needs, or you can create your own templates.
You can send information to the active contact, the active lookup, or all the contacts in your database.



 Overview

To send a personalized fax to multiple contacts

1. Begin the mail merge process by doing one of the following:
If you already have a template open in the ACT! word processor, choose Mail Merge from the word-

processing File menu and skip to step 3. 
If you are in another area of ACT! such as the Contact window, or if you are using Microsoft Word or 

WordPerfect as your selected word processor, choose Mail Merge from the Write menu.
The Open dialog box appears.

2. Select the template you want and click Open.
The Mail Merge dialog box appears. 

3. Select an option from the Merge With group box.
You can fax your template to the active contact, to all the contacts in the active lookup, or to all the contacts in 
your database.

4. Select the Fax option from the Send Output To group box.
5. If you want to record a history of your sending the fax, select the Create History When Sent option.
6. Type the subject of the fax in the Regarding field and click OK.

The merged letters are sent as faxes to the specified contacts. If you selected the Create History When Sent 
option, ACT! records a history of the fax in the contact record of each recipient. The history includes the date 
you sent the fax and the subject of the fax.

 Related Topics    



In addition to documents and templates, you may want to send other items as faxes. For example, if you are on 
the road, you might need to fax a page from your weekly calendar to your assistant back at the office. 
You can fax any item that you can print in ACT! by simply selecting your fax driver as your printer in the Print 
dialog box.



 Overview

To fax a calendar or address book

1. From the File menu, choose Print.
The Print dialog box appears.

2. Choose Address Book or Calendar from the Printout Type drop-down list.
3. From the displayed list, select the format in which you want your printout to appear.

A preview appears on the right side of the dialog box.
4. Click the Options button to specify what information you want to include in your fax.

Not all available print options will be applicable when you are faxing a calendar or address book.
5. Click Print Setup.

The Print Setup dialog box appears.
6. From the Name drop-down list, choose the name of your fax software and click OK.

The Print dialog box appears again.
7. Click OK in the Print dialog box.

A second Print dialog box appears.
8. Click OK in the second Print dialog box.

A dialog box appears for the fax software you selected.
9. Select the contact to whom you want to send the fax, and follow the remaining steps required by your software 

for sending faxes.
If you have questions about your fax software's process for sending faxes, refer to the documentation that 
came with your fax software.

 Related Topics



When you run a report, you can specify that you want to send it as a fax. This section provides information about 
how to send a report as a fax.



 Overview

To fax a report

1. To begin running the report, follow steps 1 through 6 in Running a report.
When you select the Fax option in the Run Report dialog box and click OK, the Send Fax dialog box appears.

2. Select an option in the Select Contacts From group box.
You can select recipients from a list of all your contacts, from the contacts in the current lookup, or from a 
group. If you choose the Selected Group option, a list of groups appears in the drop-down list. You can select a 
group from this list.
When you select an option, a list of contacts based on your selection appears in the list below the Select 
Contacts From group box.

3. From the list, choose the contacts to whom you want to send the fax.
If you want to send the fax to specific contacts in the list, select the name of each contact to whom you 

want to send the fax, and click To.
If you want to send the fax to all the contacts in the list, click Select All, then click To.

The selected contacts appear in the Recipients list on the right side of the dialog box. 
4. (Optional) If you decide that you want to remove a contact from the Recipients list, select the contact and click 

Remove.
5. In the Regarding field, type the subject of the fax.
6. (Optional) Select Create History When Sent if you want to create a history record of your faxing the report.
7. Click Send.

The fax is sent to the contacts you specified. If you selected the Create History When Sent option, a history is 
recorded of your faxing the report.

 Related Topics



 Overview

To fax files created in other applications
If you use WinFax PRO, you can use it to fax files created in other applications to the contacts in your ACT! 
database. When you use WinFax PRO with ACT!, WinFax PRO automatically creates a phonebook that contains 
contact information from your ACT! database. When you send a fax from another application, WinFax PRO simply 
reads the information in the phonebook containing your ACT! contacts and sends the faxes to the contacts you 
specify. For more information about using phonebooks in WinFax PRO, see the WinFax PRO documentation.

 Related Topics



From within ACT!, you can send and receive e-mail messages. You can send an e-mail message to a single contact 
or to multiple contacts. Also, you can attach contact records, group records, or files from external applications to 
your e-mail messages.
Before you can send e-mail messages to your contacts, you must enter their e-mail addresses. You can enter more 
than one e-mail address for a contact. Also, you need to enter your own e-mail address.



cc:Mail
CompuServe
Lotus Notes
Microsoft Exchange
Other. You can use this option to enter an e-mail system or address that is not supported by ACT! but that 

you want to record for informational purposes.



 Overview

To enter a contact’s e-mail address

1. Go to the contact record for the contact whose e-mail address you want to enter.
If you want to enter your own e-mail address, choose My Record from the Lookup menu.

2. From the Contact menu, choose E-mail Addresses.
The E-mail Addresses dialog box appears.

3. In the Address Detail group box, choose an e-mail system from the E-mail System drop-down list.    
4. (Optional) If you chose Other from the E-mail System drop-down list, enter the name of the e-mail system 
in the Reference System field. 
5. Enter the contact's exact e-mail address in the E-mail Address field.

If you do not know the contact's exact e-mail address, click the Browse button located to the right of the E-mail 
Address field. This will prompt you to log on to the selected e-mail system. When you have logged on to the e-
mail system, you can browse through the address list and locate your contact's address.

6. (Optional) Click New to enter additional e-mail addresses for the contact, then repeat steps 3 through 5.
The addresses appear in the list of current e-mail addresses.
The first e-mail address that you enter is marked with a red dot, meaning that it is the primary e-mail address. 
ACT! uses the primary e-mail address when you send an e-mail message to a contact. If you want another 
address to be the primary e-mail address, select it and click Make Primary.

7. (Optional) If you want to delete an e-mail address in the Current E-mail Addresses list, select the address and 
click Delete, or press the Delete key on the keyboard.

8. When you have finished entering the contact's e-mail addresses, click OK.
 Related Topics



You can create new e-mail messages without logging on to your e-mail system. However, you must log on to send 
messages and to receive new messages. You log on to an e-mail system from the E-mail window. When the E-mail 
window is active, the E-mail menu appears. This menu contains all the commands that you need to send and 
receive e-mail messages.



 Overview

To log on to an e-mail system

1. From the View menu in the Contact window, choose E-mail, or click the E-mail button at the bottom of the 
Contact window.
The E-mail window appears.
You will see the folders for the e-mail systems that are installed on your system. 

2. Click a folder in the Folders column to select the e-mail service to which you want to connect, and choose 
Connect from the E-mail menu. You can also double-click the folder to connect to that e-mail service.
With some e-mail systems, a dialog box appears prompting you to log on to the e-mail system.

3. If a logon dialog box appears, enter your name and password and click OK.
You are logged on to the selected e-mail service, and the inbox for that e-mail system appears.

 Related Topics



You can use ACT! with cc:Mail Mobile, CompuServe, and Microsoft Exchange to send and receive e-mail messages 
when you're on the road. Just as with network e-mail systems, you log on, send, and receive mail from the E-mail 
window.



 Overview

To connect to cc:Mail Mobile

1. From the View menu in the Contact window, choose E-mail.
The E-mail window appears.

2. Click the cc:Mail Inbox folder in the Folders column, and choose Connect from the E-mail menu. You can also 
double-click the cc:Mail Inbox folder to connect to cc:Mail.
A cc:Mail Login dialog box appears.

3. Enter your name and password. You may also need to enter your post office path if it is not filled in correctly.
You are connected to cc:Mail Mobile, and your messages appear in the inbox.

 Related Topics



 Overview

To connect to CompuServe

1. From the View menu in the Contact window, choose E-mail.
The E-mail window appears.

2. (Optional) If you want to change the settings for this session, move the pointer over the CompuServe Inbox 
folder, click the right mouse button, and choose Modify Session Settings from the shortcut menu.
A dialog box appears in which you can change your session settings. When you've finished changing your 
settings, click OK.

3. Click the CompuServe Inbox folder in the Folders column, and choose Connect from the E-mail menu. You can 
also double-click the CompuServe folder to connect to CompuServe.
A dialog box appears informing you of the status of the connection. Once the connection is made, your 
CompuServe messages appear in the inbox.

 Related Topics



 Overview

To connect to Microsoft Exchange

1. From the View menu in the Contact window, choose E-mail.
The E-mail window appears.

2. Click the MS Exchange Inbox folder in the Folders column, and choose Connect from the E-mail menu. You can 
also double-click the MS Exchange Inbox folder to connect to Microsoft Exchange.
A dialog box appears in which you can choose the Microsoft Exchange profile you want to use for this session. 
For information about setting up profiles in Microsoft Exchange, see your Microsoft Exchange online help.

3. Choose the profile you set up for remote mail and click OK.
The Connect To Server dialog box appears in which you can specify options for sending and receiving remote 
mail.

4. Specify the options you want and click OK.
Your modem begins connecting to the remote server. When the connection is complete, a dialog box appears in
which you can log on to Microsoft Exchange.

5. Type your Microsoft Exchange password in the logon dialog box and click OK.
Your Microsoft Exchange Inbox appears.

 Related Topics



You can specify how often you're notified of new incoming messages. If you receive e-mail messages often, you 
may want to be notified of new mail every 10 minutes. If you receive e-mail messages infrequently, you may want 
to be notified of new messages only every hour.
When the E-mail window is open or minimized, you'll receive the new message notification no matter where you 
are in your ACT! database. If you close the E-mail window, you will no longer receive notification of new messages.

Note
If you are using a remote e-mail system or CompuServe, you will not receive notification of new mail because 
you need to dial into those systems to get new messages.



 Overview

To specify how often to check for new messages

1. From the Edit menu, choose Preferences.
2. Click the E-mail tab if it is not already active.
3. Select the Notify Me Of New Mail Every _ Minutes option.
4. Set the number of minutes and click OK.

You can enter a value in the minutes field, or you can click the arrows to increase or decrease the number of 
minutes.

 Related Topics



You can write an e-mail message in the word processor and send it by e-mail, or you can write your message 
directly in the E-mail window. This section explains how to write an e-mail message in the E-mail window. For 
information about how to write an e-mail message in the word processor, see Preparing and sending a word-
processing document as an e-mail message.



ACT! Contacts. You can select any contact in your ACT! database.
CompuServe. You can select anyone in your CompuServe address book.
cc:Mail. You can select anyone in your cc:Mail directory, from both your public and private groups.
MS Exchange. You can select anyone in your Microsoft Exchange directory.
Lotus Notes. You can select anyone in your Lotus Notes directory.



 Overview

To write an e-mail message

1. Do one of the following:
If the E-mail window isn't open, choose E-mail Message from the Write menu.
If the E-mail window is already open, choose Create Message from the E-mail menu, or click the Create 

Message tool in the toolbar.
A blank e-mail message appears. If you choose E-mail Message from the Write menu, the message is addressed
to the last contact or group you were viewing. If you were viewing your own contact record (My Record), the 
message appears without an address.

2. Click the Address button.
The Address dialog box appears.

3. Choose a system from the Address Book drop-down list.    
If you are not logged on to the e-mail system that you select, you will be prompted to log on.

4. Choose an option from the Select From drop-down list.
The options available in the Select From drop-down list differ depending on which e-mail system you selected in
the Address Book drop-down list. If you selected ACT! Contacts, you can choose one of the following:

Directory. You can select anyone in your database.
Current Lookup. You can select anyone in the current lookup.
Groups. You can select one or more groups.

5. Select the contact(s) or group(s) to whom you want to send the message and click Add.
Shift+click to select multiple contacts who are adjacent in the list, or Ctrl+click to select multiple contacts who 
are dispersed in the list. You can also double-click a contact name to add it.
If you select ACT! Contacts as your Address Book and then select a contact name, you can click the Edit button 
to modify a contact's e-mail address.

6. Click OK when you have selected all the recipients of the e-mail message.
7. (Optional) If you want to send the message with Low or High priority, select a priority for the message from the 

Priority group box in the blank e-mail message.
By default, messages are sent with Normal priority.

8. Type a subject for the message in the Subject field.
9. (Optional) Select the Receipt option.

This option lets you automatically receive an e-mail message when each addressee opens the e-mail message 
you sent.

10.Type the message text in the message body area.
 Related Topics



You can attach ACT! contact records, lookups, or groups to an e-mail message. For example, if you create a contact
record for a sales prospect, you may want to send the contact record to one of your sales representatives.



 Overview

To attach an ACT! contact to an e-mail message

1. Prepare the e-mail message that you want to send.
2. From the E-mail menu, choose Attach > Contact, or click the Attach Contact tool in the toolbar.

The Attach Contact(s) dialog box appears.
3. Select the contact or contacts that you want to attach to the e-mail message.

To attach the current lookup of contacts, click the Attach Current Lookup button.
4. Select the Include options that you want for this contact and click OK.

You can include the contact's Notes/History and Activities.
The contact or contacts appear in the Attachments area of the e-mail message.
Note
You can also drag a contact from the Contact window and drop it onto the Attachments area of the e-mail 
message.

 Related Topics



 Overview

Attaching a group to an e-mail message

1. Prepare the e-mail message that you want to send.
2. From the E-mail menu, choose Attach > Group, or click the Attach Group tool in the toolbar.

The Attach Group(s) dialog appears.
3. Select the group or groups that you want to attach to the e-mail message.

To attach the current lookup of groups, you must perform a lookup in the Groups window, then click the Attach 
Current Lookup button.

4. Select the Include options that you want for the group(s) and click OK.
You can include the Notes/History and Activities for all the contacts in a group.
The group or groups appear in the Attachments area of the e-mail message.

 Related Topics



You can attach a file from another application to an e-mail message. For example, you may want to send a 
prospective client a copy of your price list, which you've created in a spreadsheet program.



 Overview

To attach a file to an e-mail message

1. Prepare the e-mail message that you want to send.
2. From the E-mail menu, choose Attach > File, or click the Attach File tool in the toolbar.

The Choose File to Attach dialog box appears.
3. Locate the file that you want to attach and click Open.

The file is attached to your e-mail message. The Attachments area of the e-mail message shows the filename of
the attachment.
Note
You can also drag a file from Windows Explorer and drop it onto the Attachments area of an e-mail message.

 Related Topics



When you finish writing an e-mail message, you can send it right away or move it to the Outbox so that you can 
send it at a later time. This can be useful if you are not able to log on to your e-mail system. You can use the 
Outbox to store your messages until you are ready to log on and send them.



 Overview

To send an e-mail message immediately

1. Prepare your e-mail message.
2. When you have finished preparing your message, choose Send Mail Now from the E-mail menu, or click the 

Send Now tool in the toolbar.
 Related Topics



 Overview

To store a message for later delivery

1. Prepare your e-mail message.
2. From the E-mail menu, choose Send Mail Later, or click the Send Later tool in the toolbar.

The message is now stored in the Outbox.
 Related Topics



 Overview

To send a message from the Outbox

1. Double-click the Outbox icon in the E-mail window's Folders list.
The messages in the Outbox appear on the right side of the window.

2. Select the message that you want to send.
3. From the E-mail menu, choose Send Mail Now, or click the Send Now tool in the toolbar.

Your message is sent. 
If the contact to whom you’re sending the message doesn’t have a primary e-mail address, a message appears 
asking if you would like to add a primary e-mail address for the contact. If you click Yes, the E-mail Addresses 
dialog box appears, and you can set up the contact’s primary e-mail address.

 Related Topics



You may want to create some generic text that appears at the beginning of all of your e-mail messages. You can do
this using the Initial Text option in the E-mail Preferences dialog box.



 Overview

To create standard text for your e-mail messages

1. From the Edit menu, choose Preferences.
2. Click the E-mail tab if it is not already active.
3. In the Initial Text field, enter the text that you want to appear at the beginning of all your e-mail messages.
4. When you have entered the text exactly as you want it to appear, click OK.

This text will automatically appear at the beginning of all of your new e-mail messages until you delete it or 
change it.

 Related Topics



When you send e-mail messages to your contacts, you may want to make a note of the e-mail in the contacts' 
history records. You can create a history whenever you send an e-mail message using the Create History When 
Sent option in the E-mail Preferences dialog box.



 Overview

To keep a history of all e-mail messages you send

1. From the Edit menu, choose Preferences.
2. Click the E-mail tab if it is not already active.
3. Select the Create History When Sent option if it is not already selected.

Note
This option is turned on by default.

 Related Topics



When you receive e-mail messages, they appear in your inbox. The E-mail window includes inbox icons for 
CompuServe, cc:Mail, Lotus Notes, and Microsoft Exchange. Unless you use more than one of these e-mail 
systems, your incoming e-mail messages will always appear in the same inbox. 
If you have multiple supported e-mail systems listed in your My Record, a Combined inbox is available in the E-mail
window. The Combined inbox contains messages from all of the supported e-mail systems.
You can also move messages from your inbox to the Briefcase, which lets you read your messages when you are 
not logged on to your e-mail system.



 Overview

To read e-mail messages in your inbox

1. If the E-mail window isn't open, choose E-mail from the View menu.
2. Double-click the inbox folder for your e-mail system.

A list of messages appears. By default, ACT! displays your messages in order from the newest to the oldest. If 
you would rather see your oldest messages at the top of the list, you can change the order in which the 
messages are displayed by clicking the arrow in the upper-left corner above the list of messages.

3. Select the message that you want to read.
4. From the E-mail menu, choose Read Message, or click the Read Message tool in the toolbar.
5. (Optional) To move to the previous or next message in your inbox, choose Previous Message or Next Message 

from the E-mail menu, or click the Previous Message or Next Message tools in the toolbar.
 Related Topics



When your inbox is open, new mail does not automatically appear in your list of messages. If you set the Notify Me
Of New Mail Every _ Minutes option in the E-mail Preferences tab, ACT! notifies you of new messages at the time 
interval you specified. If you receive this notification while your inbox is open, click OK to acknowledge the 
notification, then choose Refresh List from the shortcut menu to display your new messages. Your new messages 
appear at the top of the list of messages in your inbox.
However, there may be times when you're expecting a message and do not want to wait for ACT! to notify you of 
new mail. You can check for new mail at any time while you're in the inbox by using the Refresh List command in 
the shortcut menu.



 Overview

To check for new mail while in your inbox

1. Click the right mouse button anywhere in the list of messages.
2. From the shortcut menu, choose Refresh List.

Any new mail you've received appears at the top of the list. 
 Related Topics



When you receive an e-mail message with a contact or group record attached, you can merge the record directly 
into your currently open database. Also, when you receive an e-mail reminder for a scheduled activity, the activity 
is attached to the e-mail message. You can merge the activity into your database, and it will appear on your 
calendar.



 Overview

To merge a record or an activity into your database

1. Open the message containing the attached record that you want to merge into your database.
2. Click to select the attached contact, group, or activity that you want to merge into your database.
3. Click the Merge Record(s) tool in the toolbar.

The Merge Options dialog box appears.
4. (Optional) In the If Source Records Match Destination Records group box, specify how you want ACT! to handle 

duplicate records.
When you are merging information from one ACT! database into another, one or more records may be 
duplicated in both databases. In this case, ACT! needs to know how to treat the duplicate records. You can 
decide which records to use if duplicates are found. Note that the "source records" are the records in the 
attachment; the "destination records" are the records in the database into which you are merging the 
attachment.

5. (Optional) In the If Source Records Do Not Match Destination Records group box, specify whether you want to 
add different record types.
You can decide whether or not to add contact records, notes/history records, activity records, and group 
records.

6. (Optional) Select the Confirm Each Match option if you want to review each record prior to merging it into the 
current database.
If you select this option, the Merge Confirmation dialog box appears for each contact or group that matches a 
contact or group in the open database. You can decide to merge the matching record into the existing record, 
add a new record, or skip the record completely.

7. Click OK.
Note
If you decide to reset all of the merge options to their default settings, click the Default button in the Merge 
Options dialog box, then click OK.

 Related Topics



Often you may want to reply to an e-mail message or forward the message to someone else. You can do this by 
selecting the message and choosing the appropriate command from the E-mail menu.



If you select the Include Message Body option, the original message is included in your reply message.
If you select the Include Attachments option, the original attachments are included in your reply message.
If you select the Reply To All option, your reply message is sent to all of the people on the original 

distribution list.



 Overview

To reply to e-mail messages

1. Open or select the message to which you want to reply.
2. From the E-mail menu, choose Reply To Message, or click the Reply tool in the toolbar.

The Reply/Forward Options dialog box appears.
3. Select one or more of the Reply/Forward options and click OK.    
4. Type your reply in the message body area.

Send your message.
 Related Topics



If you select the Include Message Body option, the original message is included in your forwarded 
message.

If you select the Include Attachments option, the original attachments are included in your forwarded 
message.



 Overview

To forward e-mail messages

1. Open the message that you want to forward.
2. From the E-mail menu, choose Forward Message, or click the Forward tool in the toolbar.

The Reply/Forward Options dialog box appears.
3. Select one or more of the Reply/Forward options and click OK.    
4. Select the contact or contacts to whom you want to send the message.
5. Type any text that you want to precede the forwarded message.

Send your message.
 Related Topics



 Overview

To quickly forward an e-mail message to someone else

1. Select the message that you want to forward.
The Address dialog box appears.

2. Add the contact or contacts to whom you want to forward the message and click OK.
A confirmation message appears asking if you want to forward the e-mail message.

3. Click Yes to forward the message to the selected contacts.
 Related Topics



You may not want to keep some of the e-mail messages that you receive. You can easily delete one or more e-mail 
messages from any e-mail folder.



 Overview

To delete e-mail messages

1. Double-click the folder containing the message that you want to delete.
2. Select the message or messages that you want to delete.

Shift+click to select multiple messages that are adjacent in the list, or Ctrl+click to select multiple messages 
that are dispersed in the list. 

3. From the E-mail menu, choose Delete Message, or click the Delete Message tool in the toolbar. You can also 
press the Delete key.
A confirmation message appears, asking if you want to delete the message.

4. Click Yes.
The message is deleted.

 Related Topics



By default, ACT! displays a confirmation before you delete a selected e-mail message. However, you may prefer 
not to receive a confirmation when deleting messages. You can specify whether or not you want to see these 
confirmation messages before you delete messages.



 Overview

To confirm message deletions

1. From the Edit menu, choose Preferences.
2. Click the E-mail tab if it is not already active.
3. Select the Confirm When Deleting Message(s) option and click OK.

 Related Topics 



You can disconnect from an e-mail system at any time by choosing Disconnect from the E-mail menu. You can also 
disconnect from an e-mail system simply by closing the E-Mail window.



 Overview

To disconnect from an e-mail system
Choose Disconnect from the E-mail menu.

 Related Topics



Reports extract information from fields in your ACT! database and display the information in an organized and 
visually appealing format. After you run a report, you can preview it, print it, fax it, send it to someone via e-mail, 
or save it as a file for future reference. Mailing labels and envelopes are also forms of reports. They pull 
information from your database, lay out the information according to a predefined design, and put it into a form 
that you can print. 
You may want to print contact information such as the information that appears in the Contact window or Contact 
List window. For example, if you're planning a business trip to London, you may want to print a list of all of your 
London contacts. Although you cannot print a contact list directly from the Contact List window, you can easily run 
a contact report and print it. Whenever you want to print contact or group data, you must first run a report, then 
print it.
A report begins with a design, which includes the fields that you want to appear in the report. This design is a 
report template. ACT! comes with predefined report, label, and envelope templates that you can use, or you can 
modify them to suit your specific needs. Each of these templates contains the names of the fields from which ACT! 
will pull information. The fields are positioned in the template in a predefined order. When you run the report, ACT! 
fills in the information required by the report template.



 Overview

To understand the ACT! reports
The following report templates let you view and print information about your contacts. All of these reports appear 
in the top level of the Reports menu except for Group List and Group Report. To choose Group List or Group Report,
choose Other Report from the Reports menu, and then select the report that you want to use.
Report 
description

Report 
filename

Information included in 
report

Contact Report CONTACT All contact information 
including notes, history, 
and activities for each 
contact.

Contact Directory DIRECTRY Primary address and home
address for each contact.

Phone List PHONELST Company name, company 
phone number, and mobile
phone number for each 
contact.

Task List TASKLIST Calls, meetings, and to-do 
activities scheduled with 
each contact during a 
specified date range.

Notes/History NOTEHIST Notes and history items for
each contact during a 
specified date range.

History Summary HISTORY Total number of attempted
calls, completed calls, 
meetings held, letters 
sent, and fields changed 
for each contact during a 
specified date range.

Activities/Time 
Spent

ACTIVITY Activities scheduled and 
time spent with each 
contact during a specified 
date range.

Contact Status STATUS ID/Status, last results, and 
to-do activities for each 
contact during a specified 
date range.

Source of Referral REFERRAL Referred By information for
each contact.

Group 
Membership

GRPMEMBR List of all groups and all 
contacts in each group.

Group List GRPLIST List of all groups with 
group name and 
description.

Group Report GROUP All information including 
notes, history, and 



activities for each group.
 Related Topics



Running a report is as simple as selecting the report template that you want to use, specifying which contact or 
group data you want to include in the report, and selecting an output option for the completed report. 
Before running a report, however, you need to decide which contact or group data you want to include in the 
report. For example, you may want to run a History Summary report for a single contact, or a Contact Report for all
contacts in a single state or region. When you run a report, you can decide whether to include data from the 
current contact or group record, the current contact or group lookup, or all contacts or groups. If you want to 
include the current contact or group or the current lookup, you need to perform the lookup before running the 
report. 



 Overview

To run a report

1. (Optional) Perform a lookup to find the record or records that you want to include in the report.
2. From the Reports menu, choose the report that you want to run.

Note
Not all of the available reports appear in the Reports menu. To run a report that doesn't appear in the menu, 
choose Other Report from the Reports menu and select the report that you want.
The Run Report dialog box appears.

3. Click the General tab if it is not already selected.
4. In the Create Report For group box, specify the contacts or groups that you want to include in the report. If you 

want to include information from your My Record in the report, turn off the Exclude My Record option.
If you have selected a contact report, you can include the current contact, the current contact lookup, or all 
contacts. If you have selected a group report, you can include the current group, the current group lookup, or 
all groups.

5. In the Send Output To group box, select an output option for the report.
The Printer option sends the report directly to the default printer.
The Preview option displays an on-screen preview of the report. After previewing the report, you can 

choose to print it.
The Fax option sends the report using your selected fax software. 
The E-mail option sends the report as an attachment to an e-mail message.
The File option saves the report as a file with a .RPT extension that you can later open, view, and print.

6. (Optional) Click the Filter tab of the Run Report dialog box and specify which Notes/History, Activities, and 
users' data you want to include in the report. 
If the report does not include sections for Notes/History and Activities, those filter options are not available. If 
they are available, you can select a date range of Notes/History and Activities from the Date Range drop-down 
list, or by clicking Custom and specifying a custom date range.
If you are working in a multiuser database, the other users' names appear in the Selected Users list. You can 
run the report for all users in the database, or you can select the users whose data you want to appear in the 
report.

7. Click OK to run the report.
 Related Topics



You may want to modify one or more of the existing report, label, or envelope templates. For example, you can add
or remove a field from a report template, or change the layout or appearance of the report template. You can make
subtle or major changes to the existing report templates using the ACT! report designer. 
Report templates can display contact or group information, and they can also calculate information such as totals 
and averages of numeric data. For example, if you use a field to track sales figures, you can create report 
templates that calculate total sales, average sales, and minimum or maximum sales.
The most important concept to understand when working with report templates is that ACT! report templates 
contain different sections of information. The various report sections are labeled on-screen. For example, a very 
simple report template may have just three sections: Header, Contact, and Footer. 

Note
Label and envelope templates do not have sections. When you modify a label or envelope template, you can 
only change the fields contained in the template and the appearance of the objects in the template. 



For example, the Title Header can contain the name of the report, such as "Activities Completed."



For example, you may want to put information from your My Record in the Title Footer to indicate who created the 
report.



For example, the Contact Status report contains a Summary that displays the total number of contact profiles in 
the report.



In a sales report, for example, you may want to include the total sales figures and the largest sale in the Summary.



For example, the Group section of the Group List report contains the group name and description.



The Notes/History report, for example, includes a Notes/History section below the Contact section.



The Task List report, for example, includes an Activities section below the Contact section.



For example, as part of a contact report, you may want to include the groups in which each contact is a member. 
This information would appear in the Group subsection.



For example, as part of a group report, you may want to display the contacts who are members of each group. This
information would appear in the Contact subsection.



For example, if you put a Summary Sorted By City section in a Contact section, the contacts in the report will be 
sorted by city.



The Contact section of the Phone List report, for example, contains the company name, contact name, phone, and 
phone extension.



 Overview

To understand the sections in a report template
Every report template must have at least one section. Following is a list and brief explanation of each of the 
sections that you can include in a report template.

Header
The Header appears at the top of every page, unless you add a separate Title Header to be used above the 
Header on the first page of the report. Use the Header for any information or graphic object that you want to 
appear on every page, such as the current date, column headings, or a company logo. 

Title header
The Title Header appears only on the first page of a report, above the Header.    

Footer
The Footer appears at the bottom of every page. Use the Footer for any information that you want to appear 
on every page, such as the page number, date, or time.

Title footer
The Title Footer appears only on the first page of a report, just above the Footer.    

Summary
The Summary section can appear above or below the body of the report and contains summaries of the 
summary fields included in the body section that precedes or follows it. Summaries can be totals, averages, 
counts, and minimum or maximum values.    

A Summary can contain one or more summary fields.    
Contact

The Contact section contains information from fields in contact records. The information in the Contact 
section appears for each contact that you include when you run the report.    

Note
A report can contain only one Contact section, and it cannot contain both a Contact and a Group section. It can, 
however, contain a Contact section and a Group subsection.

Group
The Group section contains information from fields in group records. The information in the Group section 
appears for each group that you include when you run the report.     

Note
A report can contain only one Group section, and it cannot contain both a Group and a Contact section. It can, 
however, contain a Group section and a Contact subsection.

Notes/History
The Notes/History section contains information from fields in the Notes/History tab of a contact or group 
record. Therefore, you can include a Notes/History section below either a Contact section or a Group section. 
You must first have a Contact or a Group section in a report template before you can include a Notes/History 
section.    

Activities
The Activities section contains information from fields in the Activities tab of a contact or group record. 
Therefore, you can include an Activities section below either a Contact section or a Group section. You must 
first have a Contact or a Group section in a report template before you can include an Activities section.    

Group subsection 
The Group subsection contains information from fields in the Groups tab of a contact record. Therefore, you 
can only include a Group subsection if you have a Contact section in the report template.    

Contact subsection
The Contact subsection contains information from fields in the Contacts tab of a group record. Therefore, you 
can only include a Contact subsection if you have a Group section in the report template.    

Summary sorted by
The Summary Sorted By section contains a summary of the values sorted by a specific field. For example, the
History Summary report includes a Summary Sorted By section that displays total counts of the notes and 



history sorted by type. You can also use a Summary Sorted By section just to sort a section without putting 
any summary fields in the section.    

 Related Topics                        



When you understand the various sections that you can use in a report template, adding them to the template is a
straightforward procedure.



For example, if you selected the Contact section, the Group section is dimmed because you cannot add a Group 
section to a Contact section. You can, however, add a Group Subsection to a Contact section.



 Overview

To add sections to a report template

1. From the ACT! File menu, choose Open.
The Open dialog box appears.

2. From the Files Of Type drop-down list, choose Report Template (*.rep).
3. Select the report template to which you want to add sections and click Open.

The template appears in the report designer window.
4. From the Edit menu, choose Define Sections.

The Define Sections dialog box appears, displaying the sections that are currently included in the report 
template. By default, every report template has a Header, Contact, and Footer section.

5. (Optional) If you want to add subsections to an existing section, select the section to which you want to add a 
subsection.

6. Click Add.
The Add/Change Section dialog box appears.
The available sections appear in the Sections group box. If a section name is dimmed, you cannot add it to the 
currently selected section.     

7. Select the section that you want to add.
If you select the Summary Sorted By section, the field list on the right side of the dialog box and the Sort Order 
drop-down list become available. Select the field by which you want to sort the data, and select Ascending or 
Descending order from the Sort Order drop-down list.

8. (Optional) Select any of the following options to specify how information in the selected section is displayed 
and printed:

The Page Break Before Each Section option starts a new page at the beginning of the selected section.
The Allow Section to Break Across Multiple Pages option displays and prints all of the information in a 

section, even if it doesn't fit on a single page. If you turn off this option, a page break is inserted before the section 
if the section can't fit in the remaining space on the current page.

The Collapse Blank Lines option eliminates lines in the selected section that contain only fields with no 
data or that are duplicated. Any graphic objects whose upper-left corners fall within the line are also eliminated.

The Collapse Blank Section option eliminates sections in the report that contain no data. Any graphic 
objects whose upper-left corners fall within the section are also eliminated.
9. Click OK.

The Define Sections dialog box reappears with the new section added to the list. 
10.(Optional) To add more sections, click Add and repeat steps 5 through 9. 
11.When you have finished adding sections, click OK in the Define Sections dialog box. 

The new sections appear in the report template. If you want to add fields to the new sections, see Adding 
fields to a report template.

 Related Topics      



You can modify existing sections in a report template. For example, you may want to change the options you have 
set for a section, such as allowing a section to be collapsed if it contains no data, or specifying a field by which a 
Summary section is sorted. You can also remove entire sections from a report template. You cannot, however, 
change the order of sections in a report template. Report sections follow a predefined order.



 Overview

To modify an existing section of a report

1. From the Edit menu in the report designer, choose Define Sections.
The Define Sections dialog box appears.

2. In the Sections list, select the section that you want to modify and click Change.
The Change Section dialog box appears. All of the sections except for the selected section are dimmed in 
the Sections list.

3. Change any of the available options for the section and click OK.
The Define Sections dialog box reappears.

4. Click OK in the Define Sections dialog box.
 Related Topics



 Overview

To remove a section from a report

1. From the Edit menu in the report designer, choose Define Sections.
The Define Sections dialog box appears.

2. In the Sections list, select the section that you want to remove from the report and click Delete.
If the section contains any fields, graphic objects, text objects, or subsections, a message appears asking if 
you're sure that you want to delete the section, the objects it contains, and the related subsections.

3. If the confirmation message appears, click Yes.
The Define Sections dialog box reappears.

4. Click OK.
The section and all its contents are deleted from the report template.

 Related Topics



You can easily add fields to an existing report, label, or envelope template. For example, you may decide that you 
want to add the Home Phone field to the Phone List report. You can also add summary fields to templates. 
Summary fields calculate values for a set of records using the information in a specified field. For example, if you 
have created a field in your database to keep track of sales, you can use this field as a summary field in a report. 
This will let you display total sales figures for some or all of the contacts in your database.



For example, put Activities fields in the Activities section, put Group fields in the Group section, and so on.



 Overview

To add a field to a report template

1. Click the Field tool in the tool palette.
When you move the pointer over the template, it turns into a crosshair pointer, which looks like a plus (+) sign.

2. Position the pointer where you want to insert a field in the template and drag to define the field's width.
Note
When you create a field in a report template, the bottom edge of the field is automatically aligned to the 
nearest grid line.
When you release the mouse button, the Field List dialog box appears. The Field List dialog box contains five 
tabs: Contact, Group, Notes/History, Activities, and System. In each tab, you can select different fields to 
add to the report template.
Note
Be sure to put the appropriate kinds of fields in the appropriate sections of the report.    

3. Click one of the tabs, select the field that you want to add to the template, and click Add.
You can add multiple fields by double-clicking each of them, one at a time. They will appear in the order that 
you select them, with each field on a new line. 
You can also Shift+click to select multiple fields that are adjacent in the list or Ctrl+click to select multiple fields
that are dispersed in the list, then click Add. They will appear in the same order in which they appear in the 
Field List dialog box.

4. (Optional) If you don't want to include a field label for a field in the template, turn off the Add Field Label option.
5. (Optional) In the Contact tab, select the Use My Record option if you want data from your My Record included in

the report.
6. Repeat step 3 to add fields from any of the other tabs.
7. (Optional) Click the System tab, and select one or all of the available fields to include in your template. You can 

also enter a field label for any of the system fields.
The System fields include the Page Number, Date, Time, Activity Date Range, and Notes/History Date Range 
fields. You may want one or all of these to appear in the Header, Title Header, Footer, or Title Footer sections of 
your report template.

8. Click Close when you have finished adding fields.
The fields appear in the template. The letter before each field name indicates the kind of field; this can help 
you verify that the fields are in the correct section. C: appears for Contact fields, G: appears for Group fields, N: 
appears for Notes/History fields, A: appears for Activities fields, and S: appears for System fields.

 Related Topics



The Summary Type Options
Select this 
option

To display this information

Count Total number of records that contain data in 
the selected field.

Total Total of all values in the selected field.
Average Average of all values in the selected field.
Minimum Lowest value or earliest date or time in the 

selected field.
Maximum Highest value or latest date or time in the 

selected field.

For example, if you are using a summary field to show the total sales, you may want to label it "Total Sales."



 Overview

To add a summary field to a report template

1. Click the Field tool in the tool palette.
When you move the pointer over the report template, it turns into a crosshair pointer, which looks like a plus 
(+) sign.

2. Position the pointer where you want to insert a field in the report template and drag to define the field's 
position and size.
Note
You need to put summary fields in either Summary or Summary Sorted By sections; they will not work if you put
them in any of the other sections.

3. When you release the mouse button, the Field List dialog box appears. 
4. Select the Summary Field option in the Field Type group box.

The Summary Type options are enabled. 
By default, the Count option is selected. If you select Total, Average, Minimum, or Maximum as the Summary 
Type, only numeric, currency, date, or time fields appear in the Available Fields list. If you select Count, all of 
the fields appear in the Available Fields list. For information about field types, see Specifying the type of 
data allowed in a field.

5. Select one of the Summary Type options.    
6. (Optional) If you want the summary field to be labeled in the report, enter the label text in the Summary 
Field Label field.    
7. From the Available Fields list, double-click the field that you want to function as a summary field, or select 
the field and click Add.
8. Click Close.

The summary field is added to the report template.
 Related Topics



If you include a field in a report template and later decide that you want the field to have a field label, you can add
the label to the field using the Add Label command.



 Overview

To add a field label to a field in a report template

1. Select the field or fields to which you want to add a label.
2. From the Objects menu, choose Add Label.

The field label appears in front of the field.
 Related Topics



If you decide that you no longer want to include one or more fields in a template, you can easily remove them.



 Overview

To remove fields from a report template

1. Click the Selection tool in the tool palette.
2. Select the field and field label that you want to remove from the template.

Click the field label to select it, then press the Shift key and click the field itself. This will select both the field 
and the field label. You can also Shift+click to select multiple fields, or you can drag to select one or more fields
with their field labels.

3. Press the Delete key.
The field and field label are removed from the template. 
Note
If you inadvertently delete a field, you can choose Undo Clear from the Edit menu to restore the field to its 
original position.

 Related Topics



You can move any object in a report template, including a field, a field label, a text object, or a graphic. You can 
simply drag an object from one position to another, or you can use precise controls to align objects. You can also 
move objects to different layers in the template, so that objects can overlap one another. For example, if you 
create a circle and then add a square on top of the circle, you can use a command to move the square behind the 
circle.
When you are moving objects in a template, you may find it useful to choose the Snap to Grid command from the 
View menu. This command causes all objects that you move to automatically "snap," or move, to the grid lines. 
This will help you keep objects lined up according to the grid. If you do not want objects to snap to the grid 
automatically, you can later align them to the grid.



 Overview

To move an object manually in a template

1. Click the Selection tool in the tool palette.
2. Select the object or objects that you want to move.

You can click an object to select it, press the Shift key and click to select additional objects, or drag to select 
one or more objects. If you select a single object, open selection handles appear around it.
If you select more than one object, the first object that you select has open selection handles while all the other
selected objects have closed selection handles.

3. Drag the objects or use the arrow keys to move the objects to a new position.
 Related Topics



 Overview

To change the layering of objects in the template

1. Select the object or objects that you want to move to a different layer.
2. Choose one of the following commands from the Objects menu:
Command Result
Move to Front Moves the selected object(s) to the top 

layer of the template.
Move Forward Moves the selected object(s) forward one 

layer in the template.
Move to Back Moves the selected object(s) to the 

bottom layer in the template.
Move Backwards Moves the selected object(s) back one 

layer in the template.
 Related Topics



You can manually change the size of an object in a template, or you can automatically make multiple objects the 
same height or the same width. For example, if you add several fields to a template, you can use commands in the
Objects menu to make them the same size. 
If you make multiple objects the same width or height, they are all resized to the width or height of the primary 
object in the selection. By default, the first object that you select is the primary object. The primary object has 
open selection handles while the secondary objects have closed selection handles. If you want a different object to
be the primary object, press the Ctrl key and click the object that you want to be primary.



 Overview

To manually resize an object in a template

1. Select the object that you want to resize.
2. Position the pointer over one of the selection handles.

The pointer changes to a double-headed arrow, indicating the directions you can drag the handle to make the 
object larger or smaller.
Note
In report templates, you can adjust only the width of fields, field, labels, and text objects. In contact and group 
layouts, however, you can change the width and height of fields, field labels, and text objects.

3. Drag the handle outward or inward to make the object larger or smaller.
 Related Topics



 Overview

To make multiple objects the same size

1. Select the objects that you want to make the same size.
2. From the Objects menu, choose one of the following commands:

The Make Same Height command makes the selected objects identical in height to the primary object.
The Make Same Width command makes the selected objects identical in width to the primary object.

 Related Topics



You can align objects in a report template so that they line up with the grid lines or with one another. For example, 
you might want to put two new fields in a template and make sure that their left edges align. When you align 
multiple objects with one another, they are aligned in relation to the primary object in the selection. By default, the
first object that you select is the primary object. If you want a different object to be the primary object, press the 
Ctrl key and click the object that you want to be primary.



 Overview

To align one or more objects to the grid

1. Select the object or objects that you want to align to the grid.
2. From the Objects menu, choose Align to Grid.

The objects are moved so that they align with the grid.
 Related Topics



For example, if you first select a rectangle, then select an ellipse, and select the Align Left Edges option, the ellipse
will be moved so that its left edge aligns vertically with the rectangle's left edge.



 Overview

To align multiple objects with one another

1. Select the objects that you want to align.
You must select at least two objects.

2. Do one of the following:
Click one of the alignment tools in the toolbar.
From the Objects menu, choose Align. 

Note
Some of the alignment options are not available in the report designer but are available in the layout designer.

3. The Align dialog box appears. Select an option in the Left To Right group box in the Align dialog box.
These options determine how the selected objects align horizontally in relation to the primary object.    

Note that if you select the Align Centers option, the objects' vertical centers will be aligned. If you select the None 
option, the objects' horizontal alignment will be unchanged. 
4. Select an option in the Top To Bottom group box in the Align dialog box.

Note
This group box is not available if you are editing a report template. It is available only if you are editing a 
layout.
These options determine how the selected objects align vertically in relation to the primary object, as explained
in the previous step. Note that if you select the Align Centers option, the objects' horizontal centers will be 
aligned. If you select the None option, the objects' vertical alignment will be unchanged.

5. Click OK in the Align dialog box.
The selected objects align in relation to the primary object.

 Related Topics



You can add text to a report template using the Text tool. For example, you may want to put the report title in the 
Header section. When you add text to a report template, you create a text object. You can select text objects and 
change their color, font, style, and alignment. You can also select fields and field labels and change these 
attributes.



 Overview

To add text to a report template

1. Click the Text tool in the tool palette.
2. Move the pointer to the area where you want to add text.
3. Drag to define a text box and begin typing the text.

If the text is too long to fit in the text box you have defined, the text automatically wraps to the next line as you
are typing. When you have finished typing the text, you can change the text color or the font.

 Related Topics



 Overview

To change the alignment of text

1. Use the Selection tool to select the text object.
You can select one or more text objects, fields, or field labels.

2. Do one of the following:
Click the Left, Center, or Right alignment tools in the toolbar.
Click the right mouse button and choose Align Text Left, Align Text Center, or Align Text Right from the 

shortcut menu.
The text is aligned in the text box.

 Related Topics



You may want to change the appearance of a report by adding graphic elements such as lines, circles, squares, 
ellipses, or rectangles. You can use the Rectangle, Ellipse, and Line tools in the tool palette to create these 
elements.



 Overview

To add a rectangle or square to a report template

1. Click the Rectangle tool in the tool palette.
2. Move the pointer to the area where you want to draw a rectangle.
3. Drag to define the rectangle. To create a square, press the Shift key as you drag.

The rectangle or square appears in the template.
 Related Topics



 Overview

To add an ellipse or circle to a report template

1. Click the Ellipse tool in the tool palette.
2. Move the pointer to the area where you want to draw an ellipse.
3. Drag to define the ellipse. To create a circle, press the Shift key as you drag.

The ellipse or circle appears in the template.
 Related Topics



 Overview

To add a line to a report template

1. Click the Line tool in the tool palette.
2. Move pointer to the area where you want to draw a line.
3. Drag to draw a line. To constrain the line to a 90- or 45-degree angle, press the Shift key as you drag.

 Related Topics



You can add a graphic such as a company logo to a report template. The graphic must be a .BMP file.



 Overview

To add a graphic to a report template

1. Open or create a graphic (.BMP) file in a graphics application.
2. Select the graphic and copy it to the Clipboard using the Copy command.
3. In the ACT! report designer, choose Paste from the Edit menu.

The graphic appears in the template.
 Related Topics



You can alter the appearance of the objects in a report template, including fields, field labels, text objects, 
rectangles, ellipses, and lines by changing any of the following attributes: text color, font, fill color, fill pattern, line 
or border color, border style, and line or border width.

Note
When you change object attributes, the attributes you select stay in effect until you change them again. For 
example, if you select a yellow fill color, all new objects that you create (except for text, label or field objects) 
will be filled with yellow unless you select a different fill color for them. 



 Overview

To change the text color

1. Use the Selection tool to select one or more objects that contain text.
This can be a text object that you created with the Text tool, a field label, or a field.

2. Click the Text Color drop-down arrow in the tool palette.
A color palette appears.

3. Select a text color from the palette by clicking the color that you want.
 Related Topics



 Overview

To apply the currently selected text color to an existing text object

1. Use the Selection tool to select one or more objects that contain text.
This can be a text object that you created with the Text tool, a field label, or a field.

2. Click the left side of the Text Color tool in the tool palette.
The currently selected text color is applied to the selected objects' text.

 Related Topics



 Overview

To change the font in a report template

1. Use the Selection tool to select one or more objects that contain text.
This can be a text object that you created with the Text tool, a field label, or a field.

2. Do one of the following:
Choose a new font, font size, or font style from the toolbar.
Click the right mouse button and choose Properties from the shortcut menu, then set the font, font size, 

style, and effects.
 Related Topics



 Overview

To change an object's fill color or pattern

1. Use the Selection tool to select one or more objects that you want to fill with a color or pattern.
2. Click the Fill Color/Pattern drop-down arrow in the tool palette.

A Fill Color/Pattern palette appears
3. Select the color or pattern with which you want to fill the selected objects.

If you want to apply a colored pattern to the objects, select the color, then reopen the palette and select the 
pattern.

 Related Topics



 Overview

To apply the current fill color or pattern to an object

1. Use the Selection tool to select one or more objects.
2. Click the left side of the Fill Color/Pattern tool in the tool palette.

The currently selected fill color or pattern is applied to the selected objects.
 Related Topics



 Overview

To change the color of a line or an object border

1. Use the Selection tool to select one or more lines or objects .
2. Click the Line/Border Color drop-down arrow in the tool palette.

A color palette appears.
3. Select the line or border color that you want to apply.

 Related Topics



 Overview

To apply the current color to a line or an object's border

1. Use the Selection tool to select one or more objects.
2. Click the left side of the Line/Border Color tool in the tool palette.

The currently selected line/border color is applied to the selected objects.
 Related Topics



 Overview

To change an object's border style

1. Use the selection tool to select one or more objects.
2. Click the Border Style drop-down arrow in the tool palette.

A border style selector appears.
3. Select the border style that you want to apply to the selected objects.

 Related Topics



 Overview

To apply the current border style to an object

1. Use the Selection tool to select one or more objects.
2. Click the left side of the Border Style tool in the tool palette.

The currently selected border style is applied to the selected objects.
 Related Topics



 Overview

To change an object's line weight or border weight

1. Use the Selection tool to select the line or object for which you want to change the line or border weight.
2. Click the Line/Border Weight drop-down arrow in the tool palette.

You can select line weights ranging from one point to six points.
3. Select the line weight that you want to apply to the selected lines or to the borders of the selected objects.

 Related Topics



 Overview

To apply the current line weight to an object

1. Use the Selection tool to select one or more objects.
2. Click the left side of the Line/Border Weight tool in the tool palette.

The currently selected line weight is applied to the selected objects.
 Related Topics



For example, if you click inside a field, the tool palette is updated with the field's text color, fill color, border color, 
border style, and border width. 



 Overview

To select attributes from an existing object in a template

1. Click the Attribute tool in the tool palette.
2. Click the object whose color you want to select.

The object's attributes appear in the tool palette.    
You can now apply any or all of the attributes to other objects by selecting the objects and clicking the left side of 
any of the tools in the tool palette. Note that you'll need to apply the attributes one at a time.

 Related Topics



 Overview

To change all of an object's attributes at once

1. Double-click the object whose attributes you want to change.
The Object Properties dialog box appears.
Depending on the kind of object you select, the Object Properties dialog box will have different tabs and options
available.

2. In the Format tab, select any of the following options:
The Don't Print If Duplicated option eliminates any duplicate fields, field labels, or text.
The Close Up Blank Space option shortens the length of the field, field label, or text object so that it 

accommodates the data or text contained in it without leaving extra blank space. It also moves adjacent fields or 
text objects to the left to eliminate the extra blank space.

The Wrap Text option automatically moves text or data to the next line if it is too long to fit in the text 
object or field.

(For numeric and date fields only) The Appearance option specifies how to display numbers or dates in the 
field.

(For numeric fields only) The Negative Numbers option specifies what symbol to use to display negative 
numbers in the field. The Decimal Places option determines how many decimal places are displayed in the report.
3. (For Contact fields only) In the Type tab, select the Use My Record option if you want data from your My Record

to appear in this field in the report.
4. Set any or all of the attributes in the Style and Font tabs and click OK.

 Related Topics



By default, report templates display rulers and grids to help you align objects. If you prefer not to see either or 
both of these, you can turn them off. You can also change the units displayed on the ruler and the number of 
divisions, or tick marks, between units on the ruler.



 Overview

To turn off the display of the rulers
From the View menu, choose Hide Rulers.

If you want to turn the ruler display on again, choose Show Rulers from the View menu.
 Related Topics



 Overview

To turn off the display of the grid
From the View menu, choose Hide Grid.

If you want to turn the grid display on again, choose Show Grid from the View menu.
 Related Topics



For example, if you have selected inches as the ruler unit, and you want the ruler to display eighths of an inch, 
enter 8 in the Divisions field.



 Overview

To change the ruler settings

1. From the View menu, choose Ruler Settings.
The Ruler Settings dialog box appears.

2. Select the units that you want to appear on the rulers.
You can choose inches, centimeters, or points. (Points are units of approximately 1/72 inch, generally used to 
measure type sizes.)

3. Select the number of divisions (tick marks) that you want to appear between each unit on the ruler and click 
OK.    
Note
The divisions also determine the grid size, which affects the behavior of the Snap to Grid and Align to Grid 
commands.

 Related Topics



 Overview

To undo changes to a report template
If you make a mistake or change your mind as you make changes to a report template, you can undo your most 
recent change before you do anything else. Simply choose Undo from the Edit menu before you perform another 
operation. The name of the Undo command changes depending on your most recent action. For example, if you 
create a rectangle, the command is called Undo Create. If you resize an object, the command is called Undo 
Resize.

Note
If you add a field or a field label, or if you apply changes using the Object Properties dialog box, you cannot 
undo the additions or changes.

 Related Topics



When you run a report that contains a Notes/History section or an Activities section, you can specify which 
Notes/History or Activities you want to include in the report. Also, if you are running a report in a multiuser 
database, you can specify which users' data you want to include in the report. These specifications are called 
filters.
Although you may want to set filters each time that you run a report, you can also save filter settings with a report 
template. For example, if you want to create a report template that gives you information about notes/history and 
activities in the last quarter, you can set filtering options to display this information for the last quarter only. Each 
time you run that report, the filtering options will already be set. This can save time if you frequently run the same 
report with the same filter specifications.



 Overview

To specify which data appears in a report template

1. From the Edit menu in the report designer, choose Define Filters.
The Define Filters dialog box appears.

2. Click the Filter tab if it is not already selected.
3. In the Notes/History group box of the Filter tab, specify whether you want to include notes, history, and 

attachments in the report. 
4. In the Date Range field of the Notes/History group box, select a date range for the notes, history, and 

attachments included in the report.
To specify a custom date range, click the Custom button and drag to select a date range in the drop-down date 
selector.

5. In the Activities group box of the Filter tab, specify whether you want to include calls, meetings, and to-do's in 
the report.

6. In the Date Range field of the Activities group box, select a date range for the activities included in the report.
To specify a custom date range, click the Custom button and drag to select a date range in the drop-down date 
selector.

7. In the Include Data From group box, select the users whose data you want to appear in the report and click OK.
8. From the File menu, choose Save to save the filter settings with the report template.

 Related Topics



If you created custom report templates using ACT! 2.0, you can convert and use them in ACT! 3.0. After converting
a report template, you will generally need to make some modifications to it.



 Overview

To convert an ACT! 2.0 report template to ACT! 3.0 format

1. From the ACT! 3.0 File menu, choose Open.
2. From the Files Of Type drop-down list in the Open dialog box, choose Report Template (*.rep).
3. Locate the ACT! 2.0 report template that you want to convert and click Open.

Note
By default, ACT! 2.0 report templates were stored in the ACTWIN2\REPORTS directory.
A message appears asking if you want to update the old report template.

4. Click Yes.
The ACT! 2.0 report template is converted to ACT! 3.0 format and appears in the ACT! 3.0 report designer. The 
converted template is unnamed, and the original ACT! 2.0 report template is left unchanged in its original 
location.

5. Make any necessary modifications to the report template.
6. From the report designer File menu, choose Save.
7. Specify the name and location of the converted report template and click Save.

Note
By default, ACT! 3.0 report templates are stored in the ACT\REPORT folder.

 Related Topics



It is usually easier to modify an existing template than it is to build a new one, but occasionally you may want to 
create a new report, label, or envelope template. For example, if you want to create a very simple report template,
you may find it easier to start with a new template rather than taking the time to edit an existing template.



 Overview

To create a new report template

1. From the File menu, choose New.
The New dialog box appears.

2. Choose Report Template from the File Type list and click OK.
A blank report template appears, with Header, Contact, and Footer sections.

 Related Topics



 Overview

To create a new label template

1. From the File menu, choose New.
The New dialog box appears.

2. Choose Label Template from the File Type list and click OK.
The New Label dialog box appears. If you want to display a different unit of measurement in this dialog box, you
can set the units in the Ruler Settings dialog box. 

3. From the Choose A Label Layout drop-down list, choose a predefined label layout or choose Custom.
4. If necessary, set or change the values for each of the following:

Label margins. Specifies the size of the margin at the top of each label and at the left side of each label.
Label size. Specifies the width and height of each label.
Space between labels. Specifies how much vertical and horizontal space appears between each label.
Number of labels. Specifies how many labels appear across the page horizontally and down the page 

vertically.
If you change any of the values, the name in the Choose A Label Layout field changes to "Custom #." You can 
change this name if you want.

5. Click OK.
A blank label template appears with the dimensions and specifications you have set. You can add fields as 
described in Adding fields to a report template. If you need to make further adjustments to the format, 
choose Format from the Edit menu.

6. (Optional) From the File menu, choose Page Setup, and make changes as needed to the page margins.
For information about running labels, see Producing mailing labels and envelopes.

 Related Topics



 Overview

To create a new envelope template

1. From the File menu, choose New.
The New dialog box appears. If you want to display a different unit of measurement in this dialog box, you 
can set the units in the Ruler Settings dialog box. 

2. Choose Envelope Template from the File Type list and click OK.
The New Envelope dialog box appears.

3. From the Choose An Envelope Size drop-down list, select a predefined envelope size or choose Custom.
4. If necessary, set or change values for the envelope width and height.

If you change any of the values, the name in the Choose An Envelope Size field changes to "Custom #." You 
can change the name if you want.

5. Click OK.
A blank envelope template appears with the dimensions you have set. You can add fields as described in 
Adding fields to a report template. If you need to make further adjustments to the format, choose Format 
from the Edit menu.

6. (Optional) From the File menu, choose Page Setup, and make changes as needed to the page margins.
For information about running labels, see Producing mailing labels and envelopes.

 Related Topics 



When you modify existing report, label, or envelope templates and when you create new templates, you will 
generally want to save the templates so that you can reuse them later. You can also add new report templates to 
the ACT! Reports menu so that all you have to do to run that report is choose its name from the Reports menu. For 
information about adding your own report templates to the Reports menu, see Adding a command to the 
Lookup, Write, or Reports menus.



 Overview

To save a report, label, or envelope template
Do one of the following:
If you want to overwrite an existing template, or if you want to save a new template for the first time, 

choose Save from the File menu.
If you want to save a modified template under a different name, leaving the original template unchanged, 

choose Save As from the File menu and give the template a different name.
 Related Topics



About ACT! dialog box
This dialog box provides information about the version of ACT! you are using. The version number, copyright 
information, licensing information, and database user information are displayed.

Dialog Box Options and Controls:
Serial number. This field displays the serial number for your copy of ACT!.
Product code. This field displays the product code for your copy of ACT!.
This product is licensed to. This field displays who is licensed for running this copy of ACT!.
User name. This field displays the name of the current user of a shared database.
Security level. This field displays the security level of the current user of a shared database.
System info. Click this button to view information about the system on which ACT! is currently running.



Schedule Activity dialog box, Activity Information tab
Use this dialog box to set basic activity details for your call, meeting, and to-do's.

Dialog Box Options and Controls:
Activity type. Select Call, Meeting, or to-do from the drop-down list.
Date. This field displays the date on which the activity will occur. You can change or correct the date that 

appears or select a new date using the drop-down date selector. Click the arrow to the right to display the drop-
down date selector and click the date, or you can enter a date directly in the field.

Time. This field displays the time the activity will start. Click the arrow to the right of the time to display 
the drop-down date selector and click to set the starting time. You can drag to select the starting time and the 
duration, or you can enter a time directly in the field.

Duration. This field displays the duration of the activity. Click the arrow to the right of the field to display 
a duration drop-down list and click to select a duration. You can also type a duration in the field, for example to set 
a duration of one hour and 45 minutes, type 1 hr 45 min.

Priority. Select High, Medium, or Low from the drop-down list.
With. Click the Browse ("...") button in this field. The Select Contacts dialog box appears, and you can 

select one or more contacts. Select your name to schedule personal appointments or for one-time-only activities.
Regarding. Enter a description of the activity or select a description from the drop-down list.
Associate with group. If you want the activity to appear on a group record in addition to a contact 

record, select a group with which to associate the activity.
Activity color. Click the color swatch arrow to the right of the field to display a color palette. Click the 

color that you want to assign to the activity.
Set alarm. Select this option to set an alarm to remind you of a scheduled activity.
Alarm lead time. Enter a lead time or choose a time from the drop-down list. For example, type 10 min 

or choose 10 Minutes from the drop-down list.
Private activity. Select this option to prevent others from seeing your activities when they log on to your 

database or when you send synchronization updates.
Send e-mail reminder. Select this option to receive a prompt to send an e-mail message to a contact 

when you schedule or reschedule an activity. Note that the contacts must have an e-mail address in their contact 
records if you want to send them an e-mail reminder.



Add Columns dialog box
Use this dialog box to add one or more additional columns to a list view.
Dialog Box Options and Controls:

Field List. Double-click the field for which you want to create a column. The new column will appear as 
the last column to the right. You can also select a field and drag it to the position you want in the list view.

Add. Click this button after you have selected one or more fields from the field list.



Add Custom Menu Item dialog box
Use this dialog box to add menu commands to the Lookup, Write, and Report menus. You can add queries and 
word-processor and report templates to these menus.

Dialog Box Options and Controls:
File name and location. Type the path and file name of the query or template. If you do not know the 

path and file name, use the Browse ("...") button to find the query file, word-processing template, report template, 
label template, or envelope template you want to add to the appropriate menu and click Open.

Command name to display in menu. Enter the text you want to appear in the menu.



Add dialog box
Use this dialog box to add a new item to a drop-down list. 

Dialog Box Options and Controls:
Item. Enter the text you want to appear in the drop-down list you are customizing. You can add one or 

more items.
Description. Enter a description for the item you want to appear in the drop-down list.



Add/Change Section dialog box
Use this dialog box to add a new section or subsection or to make changes to a section in a report template. You 
can specify how information in a section or subsection is displayed and printed.

Dialog Box Options and Controls:
Sections. Select a section you want to add from the Sections group box. You can only select one section

at a time. For example, Header, Contact, and Footer are default sections and, unless you have deleted one of them 
in the Define Sections dialog box, they will not be available. You can add any available section. You can also add a 
subsection using this group box.

Page break before each section. Select this option to display or print a new page at the beginning of 
each section of the report.

Allow section to break across multiple pages. Select this option to display or print all of the 
information in a section, even if it doesn't fit on a single page.

Collapse blank lines. Select this option to eliminate lines in the report that contain no data.
Collapse blank section. Select this option to eliminate sections in the report that contain no data.
Field list. Select a field by which to sort the data. This field list is displayed only when you choose the 

summary Sorted By Section.
Sort order. Select Ascending or Descending order from the Sort Order drop-down list.



Add Tab Layout dialog box
Use this dialog box to add a new tab layout.

Dialog Box Options and Controls:
Layout name. Enter the name for the tab you want to create.



Address Book Options dialog box
Use this dialog box to specify what information you want to print in your address book.

Dialog Box Options and Controls:
Primary address. Select this option to print the contact's main address.
Secondary address. Select this option to print the contact's home address.
Phone numbers. Select this option to print all of the contact's phone numbers.
Alternate contacts. Select this option to print the second and third contacts' names and phone numbers.
E-mail addresses. Select this option to print the contact's e-mail addresses.
Additional fields. Select up to three additional database fields of information you would like to print out 

in your address book.
Double sided printing. Select this option to print the address book on both sides of a page.
Break page on new letter. Select this option if you want to start printing a new page for each letter of 

the alphabet.
Letter at top of page. Select this option to display the alphabetic letter at the top of each page of your 

address book.
Lines between contacts. Select this option to print a line between each contact entry in your address 

book.
European postal format. Select this option to reverse the order of City, State, ZIP to ZIP, City, State.
Company name. Select this option to sort contacts by company name.
Last name. Select this option to sort contacts by last name.
Current contact. Select this option to print the address book entry for the current contact only.
Current lookup. Select this option to print the address book entries for the current lookup.
All contacts. Select this option to print the address book entries for all contacts.
Font. Click this button to specify the typeface for your address book printout.



Address dialog box
Use this dialog box to select recipients of an e-mail message.

Dialog Box Options and Controls:
To. Select To, cc, or bcc from the drop-down list. "To" adds the contact to the recipient list, "cc" adds the 

contact to the copy list, and "bcc" adds the contact to the blind copy list.
Address entry. Enter the e-mail address for the contact to whom you want to send e-mail.
Recipient list. This list shows the contacts you want to receive the e-mail message.
Address book. Select the type of e-mail address book in which the recipient's address is stored. ACT! lets 

you select any contact in your database.
Select from. Select an address book entry. You can choose a directory which lets you select anyone in 

your database, current lookup, or groups.
Address book entries. This list shows the entries in the current address book.
Add. Click this button to add the selected contact(s) or group(s) to the Address List. 
Delete. Click this button to remove the selected recipient from the Address List.
Edit. Click this button to make changes to the e-mail address for the current contact.



Alarms dialog box
Use the Alarms dialog box to clear the alarm, clear the activity, set the snooze alarm, or reschedule the activity. 
The Alarms dialog box is automatically displayed at the time of a scheduled activity. The Alarm Lead Time is set in 
the Activity Information tab of the Schedule Activity dialog box. 

Dialog Box Options and Controls:
Ringing alarms. This field displays the scheduled activity about which the alarm is reminding you.
Select All. Click this button to choose all of the current alarms.
Snooze. Click this button to postpone the alarm by an amount of time you specify.
Clear Alarm. Click this button to shut off the alarm for the activity.
Clear Activity. Click this button to clear the activity with the Clear Activity dialog box.
Reschedule. Click this button to reschedule the activity with the Schedule Activity dialog box.
Go To. Click this button to go to the contact record for the contact with whom the activity was scheduled.



Attach Contact(s)/Group(s) dialog box
Use either the Attach Contact(s) or Attach Group(s) dialog box to choose contacts, records, lookups, or groups to 
be attached to an e-mail message.

Dialog Box Options and Controls:
Contact/Group list. Select the contact(s) or group(s) to attach to the e-mail message.
Notes/history. Select this option if you want to include the contact's or group's notes and history in the 

attachment.
Activities. Select this option if you want to include the contact's or group's activities in the attachment.
Attach current lookup. Click this button to attach a current lookup of contacts or groups to an e-mail 

message.



Calendar Options dialog box
Use this dialog box to select which activities to print on the calendars. You can also select printing options such as 
a date range, the hour at which the calendar begins, printing the company name, and a full five-week calendar, 
and including Saturday or Sunday.

Dialog Box Options and Controls:
Calls. Select this option if you want calls to be printed on your calendars.
Meetings. Select this option if you want meetings to be printed on your calendars.
To-do's. Select this option if you want to-do's to be printed on your calendars.
Priorities. Select this option if you want activity priorities to be printed on your calendars.
Public activities. Select this option if you want public activities to be printed on your calendars.
Date range. In the Date Range field, specify a date range for the calendar printout. Select a date range 

from the drop-down date selector by dragging through the dates you want.
Start hour. Choose at which hour you want the printed calendar to begin. Click the arrow to display the 

Start Hour drop-down list and select the hour.
Company name. Select this option if you want the company name printed on the calendar in addition to 

the contact name.
5 week view. Select this option if you want to print a full five-week monthly calendar.
Saturday and Sunday. Select this option if you want to include Saturday and Sunday in the printouts.



Clear Activity dialog box
Use this dialog box to mark an activity as completed or to clear an activity. When you clear an activity, a history is 
automatically recorded in the contact record of the person with whom you scheduled the activity.

Dialog Box Options and Controls:
Company. This field shows the contact's company.
Contact. This field shows the contact with whom the activity was scheduled.
Type. This field shows the type of activity.
Date. This field shows the date of the activity.
Time. This field shows the time of the activity.
Regarding. This field shows the description of the activity that was scheduled.
Result. Select an option from the Result drop-down list.
Follow Up. Click this button to schedule a follow-up activity with the contact.



Conflict Alert dialog box
The Conflict Alert dialog box is displayed when an activity conflicts with an already scheduled activity. 

Dialog Box Options and Controls:
Conflicts with. This list displays one or more activities that are scheduled at the same time and date as 

the current activity.
Disable activity conflict checking. Select this option if you no longer want ACT! to check for conflicting 

activities.
Accept. Click this button to accept the scheduling conflict.
Reschedule. Click this button to display the Schedule Activity dialog box in which you can specify a new 

date and time for the activity.



Contact Name dialog box
Use this dialog box to view a contact's first and last name. You can use this dialog box to specify which part of a 
name is the first name, and which part is the last name.

Dialog Box Options and Controls:
First name. This field displays the contact's name with what ACT! determines to be the first name 

highlighted.
Last name. This field displays the contact's name with what ACT! determines to be the last name 

highlighted.



Convert Database dialog box
The Convert Database dialog box appears when you try to open a database from a previous version of ACT!. You 
can decide whether or not to create a backup copy of your old database when you convert it to the new version.

Dialog Box Options and Controls:
Create backup. Select this option to create a backup of your old database when you convert it to the new

version.
Do not create backup. Select this option to convert your old ACT! database to the current version, 

making the database incompatible with previous versions of ACT!.



Copy Field Contents dialog box
Use this dialog box to replace the contents of one field with the contents of another field.

Dialog Box Options and Controls:
Copy contents of. Select the field that contains the information you want to copy to another field from 

the drop-down list.
To. Select the field in which to copy the information from the drop-down list.



Country Codes dialog box
Use this dialog box to select the country code for international phone numbers. You can decide whether or not 
international phone numbers are automatically formatted according to the specified phone format for the selected 
country.

Dialog Box Options and Controls:
Country. Select a country from the Country list. The country code is displayed to the right of the country's 

name in the list.
Free form. Select this option if you want to enter phone numbers for the selected country without 

automatic formatting.
Apply this format for country code. Select this option if you want all phone numbers for the selected 

country to be automatically formatted as you enter them. Note that this setting has no effect on phone numbers 
that you have already entered. 



Create History dialog box

The Create History dialog box appears when you print, fax, or e-mail a document. You can use It to create a 
history record for the document. You can also create a shortcut to the document from the history record.

Dialog Box Options and Controls:
Attach document to history. Select this option to create a shortcut to the document.
Document printed/faxed/e-mailed. This field displays the name of the document that was printed, 

faxed, or e-mailed.
Subject. Enter a description of the subject of the document.



Modify Menu dialog box
Use this dialog box to add, delete, or modify commands in the Lookup, Write, or Reports menus.

Dialog Box Options and Controls:
Add Item. Select this option to open the Add Custom Menu Item dialog box in which you can add a new 

menu option. 
Delete Item. Click this button to delete a selected option. You can delete options you have added, but you

cannot delete the default menu options.
Separator. Click this button to add a dotted line separator in between two items on the menu. You can use

this command to separate the menu into logical sections.
Move Up. Click this button to move an item up on the list.
Move Down. Click this button to move an item down on the list.



Database Maintenance dialog box
Use this dialog box to compress and reindex the database and to purge notes, histories, attachments, transaction 
logs, and cleared activities from your database.

Dialog Box Options and Controls:
Do not reindex. Select this option if you do not want to delete and rebuild all the index files, but you still 

want to purge notes, histories, and so on.
Reindex database. Select this option to delete and rebuild all index files. You should use this option as 

often as once a week to keep your ACT! database running efficiently.
Compress and reindex database. Select this option to have ACT! delete and rebuild all the index files, 

and to compress the database to recover space from deleted records. You should use this option if you have deleted
a number of records as this optimizes the performance of your database.

Notes. Select this option if you want to delete all of the notes created prior to the date you specify.
Histories. Select this option if you want to delete all of the histories created prior to the date you specify.
Attachments. Select this option if you want to delete all of the attachments created prior to the date you 

specify.
Transaction log. Select this option if you want to delete synchronization transaction log entries created 

prior to the date you specify.
Cleared activities. Select this option if you want to delete activities that you cleared prior to the date you

specify.
Before date. Select a date that specifies which notes, histories, attachments, cleared activities, or 

transaction logs you want deleted. All items created prior to the date will be purged.



Define Fields dialog box, Fields tab, Drop-down tab
Use this dialog box to automatically add drop-down lists of data that help speed up data entry for the selected field
in the field list at left.
Note
To edit field attributes in a shared database, you must have the appropriate rights and all other users must be 
logged out of the system.

Dialog Box Options and Controls:
Item. Enter the name of a drop-down item. This option is available after you click the New button.
Description. Enter a description of the drop-down item. This option is available after you click the New 

button.
New. Click this button to create a new drop-down item.
Delete. Click this button to delete the selected drop-down item.
Import. Click this button to import items from a delimited text file.
Export. Click this button to export items to a delimited text file.
Allow Editing. Select this option if you want all users of the database to be able to edit the drop-down 

lists from the Contact and Group windows.
Show Descriptions. Select this option if you want the drop-down descriptions to appear in your new 

drop-down list. 



Define Fields dialog box, Fields tab, Triggers tab
Use this dialog box to add triggers that open a specified application or macro when you enter or exit a field you 
have selected.
Note
To edit field attributes in a shared database, you must have the appropriate rights and all other users must be 
logged out of the system.

Dialog Box Options and Controls:
Launch when entering field. Enter the filename and location of the application or macro you want to 

launch when you enter the field you selected on the left side of the dialog box. You can use the Browse ("...") button
to locate the application file or macro.

Launch when exiting field. Enter the filename and location of the application or macro you want to 
launch when you exit the field you selected on the left side of the dialog box. You can use the Browse ("...") button 
to locate the application file or macro.



Define Fields dialog box, Advanced tab
Use this dialog box to choose indexing and matching options for a specified field.
Note
To edit field attributes in a shared database, you must have the appropriate rights and all other users must be 
logged out of the system.

Dialog Box Options and Controls:
Record type. Select either Group or Contact to set the record type of the field for which to set indexing or

matching options.
Index list. This control box shows a list of available indexes.
Index on. Select the field you want to index from the drop-down list.
Then on. Select the fields to use for secondary sort criteria using the Then On fields' drop-down lists.
New Index. Click this button to create a new index.
Delete index. Click this button to delete the selected index.
Match on. Select the first field you want to use to match duplicates. Use the drop-down list.
Then on. Select the fields to use for secondary match criteria. Use the drop-down list.
Enable transaction logging. Select this option if you want ACT! track all changes in a transaction log.
Enable duplicate checking. Select this option if you want ACT! to check for duplicate fields.
Allow history editing. Select this option if you want to be able to edit history records in the currently 

open database.



Define Fields dialog box, Fields tab
Use this dialog box and tab to modify fields in your contact or group database. You can use the tabs within the 
Fields tab to change many of the field's attributes, add or modify drop-down lists, and set triggers.
Note
To edit field attributes in a shared database, you must have the appropriate rights and all other users must be 
logged out of the system.

Dialog Box Options and Controls:
Record type. Select either Group or Contact as a record type for the field you want to modify.
Field list. Select the field you want to modify. When you modify the name of a field, the new field name 

appears in the Label field, but the field name does not change.
New field. Click this button to add a field to the selected record type.
Delete field. Click this button to remove the selected field.



Define Fields dialog box, Fields tab, Attributes tab
Use this dialog box to modify field names, types, and sizes, and set field attributes. You can add, delete, or modify 
fields in either the contact or the group database as long as the fields are not core fields.
Note
To edit field attributes in a shared database, you must have the appropriate rights and all other users must be 
logged out of the system.

Dialog Box Options and Controls:
Field name. This displays the field you selected in the field list. You can enter a new name for the field or 

change the name that is displayed.
Type. Select a field type from the drop-down list.
Size. Enter a number to specify how many characters the selected field can hold.
Field format. Specify how the data in a Character, Initial Capitals, Lowercase or Uppercase field will be 

automatically formatted. Use these placeholders: "#" as numeric, "@" as alphabetic, and "%" as alphanumeric.
Default value. Enter a default value for the selected field to assign a specific value that is always entered

in a field automatically.
Entry rules. Select an entry rule option from the drop-down list. Choose Protected to protect the field from

being modified. Select Only From Drop-down to specify that information must be selected from a drop-down that 
appears when the user clicks the field. Select Required to specify that data is required and the field cannot be left 
blank. If you do not want any entry rules, select None.

Primary field. Select this option to make the selected field a primary field. You can copy the primary 
fields from the current record to a new record.

Generate history. Select this option to create a history when the field is updated.
Block synchronization. Select this option if you do not want the selected field to be available for data 

synchronization.



Define Sections dialog box
Use this dialog box to add one or more sections to a report template.

Dialog Box Options and Controls:
Sections. Displays the sections currently included in the report template. By default, every report 

template has a Header, Contact, and Footer section.
Add. Click this button to add new sections to the report template.
Change. Click this button to edit the selected section's properties.
Delete. Click this button to remove the selected section.



Define Tab Layouts dialog box
Use this dialog box to change the name of an existing tab, change the order in which tabs appear, add new tabs, 
or delete existing tabs in the default contact or group layouts.

Dialog Box Options and Controls:
Tab Layouts. This control shows the available tabs.
Add. Click this button to specify the name of a new tab layout in the Add Tab Layout dialog box.
Rename. Click this button to specify a new name for the selected tab layout in the Rename Tab Layout 

dialog box.
Delete. Click this button to remove the selected tab layout from the list.
Move up. Click this button to move the selected layout up in the list.
Move down. Click this button to move the selected layout down in the list.



Define Users dialog box
Use this dialog box to add or delete users in a multiuser database.

Dialog Box Options and Controls:
Users list. This control list show which users have access to the shared database. To add or delete a user, 

click the user's name in this list. The name will be highlighted until you click another name, delete the user's 
account, or add a new account. While a name is highlighted, all changes you make apply only to the highlighted 
user.

Add user. Click this button to add a new user to the shared database.
Delete user. Click this button to remove the selected user from the shared database. In the Delete User 

dialog box select either the Delete Records option or the Reassign To Another User option. In response to the 
confirmation message, click Yes to delete the user.



Define Users dialog box, Receive tab
Use this dialog box to specify how to receive synchronization messages from a user.

Dialog Box Options and Controls:
Collection group. Select the group to which you want to add contacts when you receive synchronization 

updates from the selected user.
Receive private data. Select this option if you want to receive private data when you receive 

synchronization updates from the current user.
Accept database field definitions. Select this option if you want to receive database field definitions 

when you receive synchronization updates from the current user.
Last received. Displays the date on which you last received a synchronization update from the current 

user.



Define Users dialog box, Send tab
Use this dialog box to specify settings for sending synchronization updates to the selected user. These settings are 
used only if the Enable Synchronization option is turned on for this user.

Dialog Box Options and Controls:
Connect via. Select a synchronization update method from the drop-down list.
E-mail address or location. Enter the e-mail address, shared folder location, or modem number to be 

used when sending synchronization updates to the current user. You can use the Browse ("...") button to locate and 
select an e-mail address or shared folder location.

All contacts and groups. Select this option to include changes to all contacts and groups when sending 
synchronization updates.

Selected groups. Select this option to include changes only to specific groups when sending 
synchronization updates.

Send database field definitions. Select this option to include database field definitions, including new 
and modified fields and field drop-down list definitions, when sending synchronization updates.

Send private data. Select this option to include private data when sending synchronization updates to 
the current user.

Send all records (next update only). Select this option to include all records when sending the next 
synchronization update. Generally, you will select this option only the first time you    send a synchronization update
to the current user.

Last sent. Displays the date on which you last sent a synchronization update to the selected user.



Define Users dialog box, User Settings tab
Use this dialog box to set user name, password, security level, and other administrative options for a selected user.
You can use the dialog box and tab to quickly set up multiple users for synchronization.

Dialog Box Options and Controls:
User name. Enter the name of the user you want to have access to the shared database or with whom 

you want to exchange synchronization data.
Password. Enter a password for the selected user. The password can be up to 10 characters. The 

password is optional and can be left empty. Passwords are not case-sensitive.
Security level. Select an option from the Security Level drop-down list.
Enable logon. Select this option to enable the selected user to log on to the database. For 

synchronization, you don't need to select this option.
Enable synchronization. Select this option if you want to be able to synchronize data with the selected 

user.



Delete User dialog box
Use this dialog box if you want to remove a user's access privileges to your database. This may occur if an 
employee leaves the company or is transferred to another division and no longer needs access to the database. 
You can do this by deleting the user's name from the list of authorized users. When you delete a user from your 
database, you can either transfer that user's records to another user or delete the user's records entirely.

Dialog Box Options and Controls:
You are about to delete the user from this database. To maintain records belonging to the user,

please reassign them to another user. Shows you which user you are about to delete from the database.
Delete records. Select this option to delete all of the user's records when you delete the user from the 

database. 
Reassign to another user. Select this option to assign the user's records to another user.
Select from existing users. Choose a user to whom to assign the records.



Details dialog box
Use this dialog box to assign a note, history or attachment to a group record.

Dialog Box Options and Controls:
Type. Displays the type of the item such as a note, history, or attachment.
Date. Displays the date of the selected note, history, or attachment.
Time. Displays the time of the selected note, history, or attachment.
Group assignment. Select a group from the drop-down list.
Created by. Displays the user who created the item.
Attachment. Displays any attachments that are with the selected item.



Duplicate Contact dialog box
Use this dialog to duplicate information from the current contact record to a new contact record. For example, you 
can use this dialog to quickly enter multiple contacts with the same address.

Dialog Box Options and Controls:
Duplicate data from primary fields. Select this option to copy the data only from the primary fields 

when duplicating a record. You can view the existing primary fields and specify other primary fields in the Define 
Fields dialog box. This option is useful if, for example, you are adding numerous contacts to the database who all 
work at the same company. 

Duplicate data from all fields. Select this option if you want to copy all of the fields when duplicating a 
record.



E-mail Addresses dialog box
Use this dialog box to add or edit a contacts' e-mail address. You can enter more than one address for a contact. 
Also, you need to enter your own e-mail address.

Dialog Box Options and Controls:
Current e-mail addresses. This group box displays a list of a contact's current e-mail addresses and 

their respective e-mail systems.
E-mail system. Select an e-mail system from the drop-down list.
Reference system. Enter an e-mail system not supported by ACT! here if the contact uses one. 

Addresses for unsupported mail systems can only be used for informational purposes.
E-mail address. Enter the e-mail address for the current contact, or click the Browse ("...") button. You 

can then log on to the selected e-mail system and browse through the address list to locate your contact's address.
New. Click this button to enter additional e-mail addresses for the contact. Then select an e-mail system 

and enter the address.
Delete. Click this button to delete the selected e-mail address.
Make primary. Click this button to make the selected address the primary e-mail address for the contact. 

The primary address is automatically used when you send e-mail to a contact.



Edit List dialog box
Use this dialog box to add items to or remove items from a field's drop-down list. You can also change an item or 
description of an item.

Dialog Box Options and Controls:
Items. Displays the items in the drop-down list.
Add. Click this button to add a new drop-down item to the list.
Delete. Click this button to remove the selected drop-down item from the list.

Caution
ACT! permanently deletes the selected topic when you click the Delete button. If you inadvertently delete a 
topic, you will need to re-enter the topic in the list by using the Add New Drop-down Item dialog box. 

Modify. Click this button to edit the selected drop-down item. You can change the item name or 
description.



Enter My Record Information dialog box
The My Record is the contact record for the creator of a database. Enter your name, address, phone number, and 
other information about yourself.

Dialog Box Options and Controls:
Company. Enter the name of the company for which you work.
Name. Enter your name in this field.
Address. Enter your address in these fields.
City. Enter the city in which you reside in this field.
State. Enter the abbreviation for the state in which you reside in this field.
Zip. Enter your zip code in this field.
Phone. Enter your phone number in this field.
Ext. Enter your phone extension, if applicable, in this field.
Country. Enter the name of the country in which you live in this field.
Select. Click this button to choose an existing contact record to use as the My Record.



New Envelope dialog box, Envelope Size tab
Use this dialog box to specify a size for the new envelope.

Dialog Box Options and Controls:
Choose an envelope size. Select an envelope size from the drop-down list. If you do not see the size you

want, choose Custom to create your own size.
Envelope size. This area displays the height and width of the currently-selected envelope. If you chose 

Custom above, you can change the height and width in this area. You can also change the height and width of the 
pre-defined styles in this area. 



Export dialog box
Use this dialog box to set options when exporting drop-down list items to a delimited text file.

Dialog Box Options and Controls:
Delimited (text) filename to export to. Click the Browse ("...") button and select the file to which you 

want to export the items. You can also simply enter the name of a new file if you know it.
Export item descriptions. Select this option if you want to export descriptions with the drop-down items.



Export Wizard 1
The Export Wizard exports data from the currently open database to another ACT! database. You use the first 
wizard panel to specify the file type to which you want to export data. 

Dialog Box Options and Controls:
File type. Select ACT! 3.0 (*.DBF), if it is not already selected, from the drop-down list. To export data to 

another application, choose Text-Delimited.
Filename and location. Displays the location and name of the ACT! 3.0 file to which you want to export 

data. Click the Browse ("...") button to locate the destination database you want and click Open. If you are exporting
data to another application, locate the file and click Save. To export data to a new database, you can simply enter 
the name of a new ACT! 3.0 database.

<Back. Click this button to return to the previous wizard panel.
Next>. Click this button to proceed to the next wizard panel.
Finish. Click this button to export your data.
Cancel. Click this button to exit the wizard without completing the procedure.



Export Wizard 2
The Export Wizard exports data from the currently open database to another ACT! database. You use this wizard 
panel to specify the kind of records you want to export. 

Dialog Box Options and Controls:
Contact records only. Select this option to export contact records.
Group records only. Select this option to export group records.
Contact and group records. Select this option to export both contact and group records. This option is 

not available when you export to another application, when you will need to go through the export process twice by 
first saving and exporting contact records, then doing the same procedure with group records.

Options. Click this button to open the Merge Options dialog box in which you can choose source and 
destination records for matching fields during a merge of data. If you are exporting to an application other than an 
ACT! 3.0 database, you will see the Export Options dialog box, in which you can select field separators and choose 
to export field names.

<Back. Click this button to return to the previous wizard panel.
Next>. Click this button to proceed to the next wizard panel.
Finish. Click this button to export your data.
Cancel. Click this button to exit the wizard without completing the procedure.



Export Wizard 3
The Export Wizard exports data from the currently open database to another ACT! database or for use in another 
application. You use this wizard panel to specify which contact or group records you want to export, and if you are 
exporting to another application, you can then use this wizard panel to export data from the currently open 
database to a delimited text file. 

Dialog Box Options and Controls:
Current record. Select this option to export the current record.
Current lookup. Select this option to export the current lookup.
All records. Select this option to export all the records in your database.
<Back. Click this button to return to the previous wizard panel.
Next>. Click this button to proceed to the next wizard panel.
Finish. Click this button to finish the wizard and export your data to a delimited text file. If you are 

exporting to an ACT! database, you need to go the next panel.
Cancel. Click this button to exit the wizard without completing the procedure.



Export Wizard 4
The Export Wizard exports data from the currently open database to another ACT! database or for use in another 
application. You use this wizard panel to specify which contact or group records you want to export, and if you are 
exporting to another application, you can then use this wizard panel to export data from the currently open 
database to a delimited text file. 

Dialog Box Options and Controls:
Current record. Select this option to export the current record.
Current lookup. Select this option to export the current lookup.
All records. Select this option to export all the records in your database.
<Back. Click this button to return to the previous wizard panel.
Next>. Click this button to proceed to the next wizard panel.
Finish. Click this button to finish the wizard and export your data to a delimited text file. If you are 

exporting to an ACT! database, you need to go the next panel.
Cancel. Click this button to exit the wizard without completing the procedure.



Export Wizard 5
The Export Wizard exports data from the currently open database to another ACT! database. You use this wizard 
panel to verify or change the mapping of the fields in the database you are exporting to the individual fields in the 
destination database. You can then export data from the currently open database to another ACT! 3.0 database. 

Dialog Box Options and Controls:
Contact Map. This control displays lists of the fields in your database and lists of the fields in the 

destination database. Using these lists, you can change the mapping of the fields. To map fields, select the field you
want to export and double-click the corresponding row in the column at the right. A drop-down list of field names 
appears. Select the field to which you want to export the selected field. For example, you might export "Contact" to 
"person." You need to do this procedure for each field name that doesn't map to the destination field.

<--. Click this button to scroll through the records of the current database so you can see if the fields are 
mapped correctly for export.

-->. Click this button to scroll through the records of the current database so you can see if the fields are 
mapped correctly for export.

Reset. Click this button to restore the default mapping.
Load map. Click this button to reuse a map file you previously created and saved.
Save file. Click this button to save the current field order to a map file for later use.
<Back. Click this button to return to the last page of the wizard.
Next>. Click this button to proceed to the next page of the wizard.
Finish. Click this button to finish the wizard and export your data to the destination database.
Cancel. Click this button to exit the wizard without completing the procedure.



Export Wizard 6
The Export Wizard exports data from the currently open database to another ACT! database. You use this wizard 
panel to verify or change the mapping of the fields in the database you are exporting to the individual fields in the 
destination database. You can then export data from the currently open database to another ACT! 3.0 database. 

Dialog Box Options and Controls:
Group Map. This control displays lists of the fields in your database and lists of the fields in the 

destination database. Using these lists, you can change the mapping of the fields. To map fields, select the field you
want to export and double-click the corresponding row in the column at the right. A drop-down list of field names 
appears. Select the field to which you want to export the selected field. For example, you might export "Contact" to 
"person." You need to do this procedure for each field name that doesn't map to the destination field.

<--. Click this button to scroll through the records of the current database so you can see if the fields are 
mapped correctly for export.

-->. Click this button to scroll through the records of the current database so you can see if the fields are 
mapped correctly for export.

Reset. Click this button to undo any changes you made to the current unsaved map.
Load map. Click this button to load a map file specifying how the fields are ordered.
Save file. Click this button to save the current field order to a map file for later use.
< Back. Click this button to return to the previous page of the wizard.
Next >. Click this button to proceed to the next page of the wizard.
Finish. Click this button to finish the wizard and export your data to the destination database.
Cancel. Click this button to exit the wizard without completing the procedure.



Fields dialog box
Use this dialog box to choose a field and field label to add to your layout.

Dialog Box Options and Controls:
Field list. Select a field from the list to add to the layout.
Add. Click this button to add the selected field to the layout.
Add label. Select this option if you want a text label to appear next to the selected field in the layout.



File Description dialog box
Use this dialog box to enter a file description name for a new layout in the layout drop-down menu or a new 
template in the template drop-down menu.

Dialog Box Options and Controls:
Description. Enter the name that you want to appear in the layout or template drop-down menu.



Filter Activities dialog box
Use this dialog box to specify which activities appear in the Task List or the Activities tab of the Contact Window. 
The Task List's default is to show activities for today and future dates, and the Activities tab's default is to show 
activities for all dates and all users.

Dialog Box Options and Controls:
Selected users. Select this option to display only the selected users' activities on lists.
All users. Select this option to display all users' activities on lists.
All dates. Select this option to display all activities regardless of their scheduled date.
Today. Select this option to display all activities scheduled for today's date.
Date range. Select this option to display all activities scheduled within a certain range of dates.
Past dates. Select this option to display all activities that were scheduled before today's date.
Future dates. Select this option to display all activities that were scheduled after today's date.
Calls. Select this option to display calls.
Meetings. Select this option to display meetings.
To-do's. Select this option to display to-do's.
High. Select this option to display activities with a high priority level.
Medium. Select this option to display activities with a medium priority level.
Low. Select this option to display activities with a low priority level.
Show only timeless. Select this option to display only activities that you want to do on a particular day at

an unspecified time.
Show cleared activities. Select this option if you would like to view activities that have been cleared.



Filter Calendar dialog box
Use this dialog box to specify which activities appear on the calendars. The calendar's default is to show all 
activities for all dates for the current user.

Dialog Box Options and Controls:
Selected users. Select this option to apply the filter options to display the selected userss activities on 

the calendars. 
All Users. Select this option to display all the users' activities on the calendars.
Calls. Select this option to display calls.
Meetings. Select this option to display meetings.
To-do's. Select this option to display To-do's.
High. Select this option to display activities with a high priority level.
Medium. Select this option to display activities with a medium priority level.
Low. Select this option to display activities with a low priority level.
Show cleared activities. Select this option if you would like to view activities that have been cleared.



Filter Notes/History dialog box
Use this dialog box to specify which notes, histories, and attachments appear in the Notes/History tab of a contact 
window. You can also select the users whose notes, histories and attachments you want to see and which are 
associated with this contact.

Dialog Box Options and Controls:
Selected users. Select this option to display the selected users' notes, histories, and attachments on the 

tab.
All users. Select this option to display all users' notes, histories, and attachments on the tab.
All dates. Select this option to display notes, histories, and attachments on the tab.
Today. Select this option to display notes, histories, and attachments with today's date.
Date range. Select this option to display notes, histories, and attachments within a selected date range.
Past dates. Select this option to display notes, histories, and attachments with dates previous to today's 

date.
Future dates. Select this option to display notes, histories, and attachments with dates later than today's 

date.
Notes. Select this option to display notes associated with this contact.
Histories. Select this option to display histories associated with this contact.
Attachments. Select this option to display attachments associated with this contact.



Font dialog box
Use this dialog box to set font properties.

Dialog Box Options and Controls:
Font. Choose one of the available fonts from the list.
Font style. Choose one of the available styles from the list.
Size. Choose one of the available font sizes from the list.
Sample. Displays sample text that shows how your selections will appear with the current settings.
Script. This control lists the available language scripts for the specified font. Choose the one that is 

appropriate for the language your computer is set up to use.



Contact Group Membership dialog box
Use this dialog box to view and edit the groups the current contact belongs to.

Dialog Box Options and Controls:
Groups. Select the group to which you want to add the current contact as a member.
Select All. Click this button to select all of the listed groups.
Add. Click this button to add the current contact to the selected group.
Remove. Click this button to remove the current contact from the selected group.
Group membership for. Displays the name of the current contact.
Group list. Displays a list of groups of which the current contact is a member.



Group Membership dialog box
Use this dialog box to add members to a new group, or to edit the membership of an existing group, or to delete 
members from a group. You can view the members of a group in the Contact tab of the Group window.

Dialog Box Options and Controls:
All contacts. Select this option to display all contacts available for selection. You can then select one or 

multiple contacts to add to the group.
Current lookup. Select this option to display contacts from the current lookup only. You can then select 

one or multiple contacts to add to the group.
Selected group. Select this option to display contacts from a specific group. You can then select one or 

multiple contacts to add to the group.
Select all. Click this button to select all the contacts that appear in the list at the left which consists of the

selected contacts as specified in the Select Contacts From information above. You can then add all of the contacts 
to the new or edited group using the Add button.

Add. Click this button to add the selected contacts from the list at the left to the list at the right. The list at
the right of the dialog box displays the contacts who are members of the selected group.

Remove. Click this button to remove a contact from the group list at the right. Only the contact(s) 
selected in the list at right are removed.

Edit group. Displays the name of the group you selected in the Groups window. This is the group to which 
you will add members. You can also delete members from the group.

Edited group list. Lists the contacts belonging to the group shown in the Edit Group field.



Import dialog box
Use this dialog box to import items from a delimited text file into a field's drop-down list. This dialog box opens 
from the Define Fields dialog box, Fields tab, Drop-down tab.

Dialog Box Options and Controls:
Filename and location of delimited (text) file. Select a delimited text file you want to import. Click 

the Browse ("...") button to find the file and click Open.
Append imported items. Select this option if you want to add imported items to the existing drop-down 

items.
Import item descriptions. Select this option if the delimited text contains descriptions of items.



Import Wizard 0
Use the Import Wizard to import data from another file into the currently open database.

Dialog Box Options and Controls:
What type of file do you want to import? This control displays the import file type. 
File type. Click the down arrow to display a drop-down list of other import file types and select ACT! 3.0. If

you do not see the file type that you want, you may need to convert your existing file to a delimited text file.
File name and location. Choose a filename and path where the file to be imported is located. If you do 

not know the path, click the Browse ("...") button to open the Open dialog box, where you can choose a path.
< Back. Click this button to return to the previous wizard panel.
Next >. Click this button to proceed to the next wizard panel.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Import Wizard 1
Use the Import Wizard to import data from another file into the currently open database. 

Dialog Box Options and Controls:
What kind of records do you want to import? Choose Contact records only, Group records only, or 

Contact and group records. 
Options. Click the Options button to open the Merge Options dialog box, in which you can choose 

additional options and specify how to handle duplicate records.
< Back. Click this button to return to the previous page of the wizard.
Next >. Click this button to proceed to the next page of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Import Wizard 2
The Import Wizard imports data from another file into the currently open database. Use this screen to decide to 
use a predefined map file or not, then select which predefined map file you want.

Dialog Box Options and Controls:
Use predefined map. Select this option if you want to use a predefined map file to help you import data 

from other applications.
Don't use predefined map. Select this option if you do not want to use a predefined map file to help you

import data from other applications.
Map file list. Select the map you would like to use when you import your data.
< Back. Click this button to return to the previous page of the wizard.
Next >. Click this button to proceed to the next page of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Import Wizard 3
This wizard imports data from another file into the currently open database. Use this screen to map the imported 
data to individual fields in the currently opened database for group records.

Dialog Box Options and Controls:
Map this field. This section displays fields in the current document. 
To this field. Use this section to specify each field of the current database into which you want to import 

the corresponding document field.
Record. Click the arrows to move to the next record in the database.
Reset. Click this button to clear the fields in the "To this field" area and use the default map. 
Load map. Click this button to open the Open dialog box, in which you can choose a map file you 

previously saved, which specifies how the fields are ordered.
Save map. Click this button to open the Save dialog box, in which you can save the current field order to a

map file for later use.
< Back. Click this button to return to the previous page of the wizard.
Next >. Click this button to proceed to the next page of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Import Wizard 4
This wizard imports data from another file into the currently open database. Use this screen to map the imported 
data to individual fields in the currently opened database for contact records.

Dialog Box Options and Controls:
Map this field. This section displays fields in the current document. 
To this field. Use this section to specify each field of the current database into which you want to import 

the corresponding document field.
Record. Click the arrows to move to the next record in the database.
Reset. Click this button to clear the fields in the "To this field" area and use the default map. 
Load map. Click this button to open the Open dialog box, in which you can choose a map file you 

previously saved, which specifies how the fields are ordered.
Save map. Click this button to open the Save dialog box, in which you can save the current field order to a

map file for later use.
< Back. Click this button to return to the previous page of the wizard.
Next >. Click this button to proceed to the next page of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Invalid E-mail Address dialog box
This dialog box appears when you try to use an invalid e-mail address. ACT! displays the invalid address and allows
you to correct it.

Dialog Box Options and Controls:
Edit. Click this button to change the invalid e-mail address.



New Label dialog box, Label Size tab
Use this dialog box to create a new label template.

Dialog Box Options and Controls:
Choose a label layout. Choose a predefined label layout or Custom layout from the drop-down list.
Label layout. This control shows how the various controls affect the printed label.
Top. Specify the amount of space between the top edge of the label and the text by clicking the up or 

down arrows or by entering a value directly in the field.
Left. Specify the amount of space left between the outer left edge of the label and the text by clicking the 

up or down arrows or by entering a value directly in the field.
Width. Specify the width of the label by clicking the up or down arrows or by entering a value directly in 

the field.
Height. Specify the height of the label by clicking the up or down arrows or by entering a value directly in 

the field.
Vertical. Specify the amount of vertical space between the individual labels on sheet of labels by clicking 

the up or down arrows or by entering a value directly in the field.
Horizontal. Specify the amount of horizontal space between the individual labels on a sheet of labels by 

clicking the up or down arrows or by entering a value directly in the field.
Across. Specify how many labels appear across the page horizontally by clicking the up or down arrows or

by entering a value directly in the field.
Down. Specify how many labels appear down the page vertically by clicking the up or down arrows or by 

entering a value directly in the field.
Preview. Shows what the sheet of labels looks like.



Link dialog box
Use the Link dialog box to set options for how to send and receive ACT! data to and from a Personal Digital 
Assistant (PDA). 

Dialog Box Options and Controls:
Send. Select this option if you want to send ACT! data to a specified Personal Digital Assistant.
Receive. Select this option if you want to receive ACT! data from a specified Personal Digital Assistant.
Send and receive. Select this option if you want to both send and receive ACT! data to and from a 

specified Personal Digital Assistant.
Connected to. This displays the name of the currently selected personal digital assistant. To change this, 

click Setup.
Contact range. Displays the current specified range of contacts that will be included in the data transfer.
Last sent. Shows the date that data was last sent to a Personal Digital Assistant.
Send date range. Shows the current selected date range that will apply when you send the data to the 

Personal Digital Assistant.
Receive date range. Shows the current selected date range that will apply when you receive data from 

the Personal Digital Assistant.
Setup. Click this button to open the Link Wizard and complete the setup procedure.
Link. Click this button to link to a specified Personal Digital Assistant so you can send or receive ACT! data.

You can use this option after you have completed the link setup procedure.



Link Options dialog box
Use this dialog box to view or change the settings for the Personal Digital Assistant (PDA) you have selected.

Dialog Box Options and Controls:
Port. Choose the communications port you to which the Personal Digital Assistant is connected.
Baud rate. Choose your Personal Digital Assistant's baud rate.



Link Setup Wizard 1
Use the Link Setup Wizard to transfer ACT! data to and from various Personal Digital Assistants (PDA's). You can 
open the Link Setup Wizard from the Link dialog box. Choose Data Exchange > Link from the File menu to open 
this dialog box.

Dialog Box Options and Controls:
What type of PDA would you want to connect to? Select the type of Personal Data Assistant with 

which you want to link.
Options. Click this button to specify the COM port to which the Personal Data Assistant is connected.
< Back. Click this button to return to the last page of the wizard.
Next >. Click this button to proceed to the next Link Setup Wizard panel.
Finish. Click this button to finish the Link Setup Wizard.
Cancel. Click this button to exit the Link Setup Wizard without completing the procedure.



Link Setup Wizard 2
Use the Link Setup Wizard to transfer ACT! data to and from various Personal Digital Assistants (PDA's). You use 
this panel to specify which information to send to the PDA database.

Dialog Box Options and Controls:
Current contact. Select this option if you want to include the current contact's information in the data 

transfer.
Current lookup. Select this option if you want to include the information from the current lookup in the 

data transfer.
All contacts. Select this option if you want to include the information from all contacts in the data 

transfer.
From selected group. Select this option if you want to include only the current group's information in the

data transfer.
Notes and history. Specify which notes and histories you want to include in the data transfer. You can 

include a date range of notes/histories or select None.
Activities. Specify which activities you want to include in the data transfer. You can select a date range of 

activities or select None.
Field labels. Select this option if you want to include field labels in the data transfer.
Field drop-downs. Select this option if you want to include field drop-downs in the data transfer.
< Back. Click this button to return to the previous Link Setup wizard panel.
Next >. Click this button to proceed to the next Link Setup wizard panel.
Finish. Click this button to finish the Link Setup wizard.
Cancel. Click this button to exit the Link Setup wizard without completing the procedure.



Link Setup Wizard 3
Use the Link Setup Wizard to transfer ACT! data to and from various Personal Digital Assistants (PDA's). This panel 
allows you to select a range of contacts for receiving and sending data.

Dialog Box Options and Controls:
All dates. Select this option if you want to include contacts from all dates when you send data to the 

Personal Digital Assistant.
Date range. Select this option if you want to include contacts from a specified date range when you send 

data to the Personal Digital Assistant. Click the down arrow to view a drop-down date selector from which you can 
choose a specified date range. Select the date range by dragging through the dates you want and releasing the 
mouse on the ending date. Drag off the right side of the calendar to select more than one month. Click outside the 
date selector to apply the date range.

Since last link. Select this option if you want to include only contact data from the last link when 
receiving data from the Personal Digital Assistant.

< Back. Click this button to return to the previous Link Setup wizard panel.
Next >. Click this button to proceed to the next Link Setup wizard panel.
Finish. Click this button to finish the Link Setup wizard.
Cancel. Click this button to exit the Link Setup wizard without completing the procedure.



Link Setup Wizard 4
Use this wizard to transfer ACT! data to and from various Personal Digital Assistants (PDA's). 

Dialog Box Options and Controls:
< Back. Click this button to return to the previous Link Setup wizard panel.
Next >. Click this button to proceed to the next Link Setup wizard panel.
Finish. Click this button to finish the Link Setup wizard.
Cancel. Click this button to exit the Link Setup wizard without completing the procedure.



Lock Database dialog box
Use this dialog box to log users off a shared database so you can perform database maintenance.

Note
You must have Administrator security level to perform database maintenance and access this dialog box.

Dialog Box Options and Controls:
Users. This control displays the users currently logged on to the database.
Logout users in__ minutes. Specify the amount of time until users are automatically logged off the 

database using the drop-down list.



Login dialog box
The Login dialog box is displayed when connecting to a multi-user ACT! database. 

Dialog Box Options and Controls:
User name. Enter your user name for the database.
Password. Enter your password for the database.
Remember password. Select this option if you want ACT! to remember your password the next time you 

log on to this database.



E-mail Login dialog box

The E-mail Login dialog box is displayed when connecting to some e-mail systems. The options you see in this 
dialog box differ depending on which e-mail system you are using.



Lookup dialog box
Use this dialog box to find contacts using a single search criterion. For example, you can look up contacts by 
company, by city, or you can look up all the contacts.

Dialog Box Options and Controls:
Enter the __ to be found. Enter the search criterion. This option varies, depending on the command you 

used to open the dialog box. For example, if you chose the City command, you can enter Amsterdam in the Enter 
the City To Be Found field.

Replace lookup. Select this option to replace contacts found during the previous lookup with the contacts
found during the current lookup.

Add to lookup. Select this option to add the contacts found during the current lookup to the group of 
contacts found during the previous lookup.

Narrow lookup. Select this option to search the already existing lookup list for contacts matching the 
current lookup criterion. 



For example:
Type To find all words that Such as
con* begin with con contest, Connally
*con end with con falcon, lexicon, icon
*con* contain con intercontinental, economy 



Lookup Keyword dialog box
Use this dialog box to perform a lookup based on keywords.

Dialog Box Options and Controls:
Look for. Type a word or phrase that you want to find. You can also use wildcards.    

Contacts. Select this option to search for matching keywords in the fields of contact records.
Groups. Select this option to search in groups for the specified keyword.
Activities. Select this option to search for matching keywords in the activities scheduled for contacts.
Notes/history. Select this option to search for matching keywords in the notes and history of contact 

records.
E-mail address. Select this option to search for matching keywords in the e-mail addresses of contacts.



Lookup Other dialog box
Use this dialog box to specify lookup criteria using the Other Fields command. This dialog box allows you to find 
contact records that you specify for an indexed field.

Dialog Box Options and Controls:
Available fields. Select a field on which to perform a lookup from the Available Fields drop-down list. If a 

field is not indexed, it will not appear in this list.
Enter the __ to be found. Enter the search criteria. This option varies, depending on the field specified in

Available fields. For example, if you chose the City field in Available Fields, you can enter Chicago in the Enter the 
City To Be Found field.

Replace lookup. Select this option to replace the contacts found during the previous lookup with the 
contacts found during the current lookup.

Add to lookup. Select this option if you want to add the contacts found using the lookup criteria to the 
current lookup. Search results will create a larger lookup than the current lookup.

Narrow lookup. Select this option to search the already existing lookup list for contacts matching the 
current lookup criterion. 



Matches dialog box
This dialog box appears when you are sending mail and more than one contact with the same name has been 
found. All contacts with the name are listed, and you are asked to choose which of them you want to receive the 
mail.



Merge Confirmation dialog box
This dialog box appears when you merge a record or activity received in an e-mail message or merge data during 
the import or export process and the record being merged matches one or more records in the currently open 
database. You can decide to merge the matching record into the open database, add a new record to this 
database, or skip the record entirely. You must have the Confirm Each Match option selected in the Merge Options 
dialog box in order for this dialog box to appear.

Dialog Box Options and Controls:
Records being merged. Lists the duplicate fields in the record being merged. By default, ACT! considers 

two contact records to be duplicates if they have the same company name, contact name, and phone number.
Matches in open database. Displays the records or record in the open database that match the record 

being merged.
Merge. Click this button to merge this new record into the selected record in the open database.
Add. Click this button to add the matching record to the open database.
Skip. Click this button to skip the record entirely and neither merge nor add it to the open database.



Merge Options dialog box
Use this dialog box to specify merge options when you merge a record or activity received in an e-mail message or
merge data during the import or export process.

Dialog Box Options and Controls:
If source records match destination records. You can use this group box to specify how you want ACT!

to handle duplicate records.
Contact records. Choose to either replace the contact record with the newest contact record, replace the 

record with the source contact record, or make no change.
Notes/History. Choose to either merge notes/history, replace with the source notes/history, or make no 

change.
Activities. Choose to either merge activity records, replace with the source activity records, or make no 

change.
Group Records. Choose to either replace with the newest group records, replace with the source group 

records, or make no change.
If source records do not match destination records. You can use this group box to specify whether or

not to add different record types.
Contact records. Choose either to add the contact records or not to add the contact records.
Notes/History. Choose to either add the notes/history records or not to add the notes/history records.
Activities. Choose either to add the activity records or not to add the activity records. 
If source group records do not match destination group records. Choose either to add the group 

records or not to add the group records.
Confirm each match. Select this option if you want to review each contact or group record that matches 

a contact or group record in the open database.
Include all public activities. Select this option if you want all public activities to be included in the 

merge.



Modify dialog box
Use this dialog box to edit the name and description of an existing entry in a drop-down list. You open this dialog 
box from the Edit List dialog box.

Dialog Box Options and Controls:
Drop-down item. Change the name of the drop-down item.
Description. Change the description of the drop-down item.



Name Prefix/Suffix dialog box
Use this dialog box to specify the name prefixes and suffixes you want to use in your ACT! database. You can also 
specify salutation options. If you want a last name prefix to be ignored when performing lookups, delete the prefix 
from the list.

Dialog Box Options and Controls:
Enter a new name prefix/suffix. The new prefix or suffix will be added to the Name prefixes and suffixes

list in the Preferences dialog box, Names tab. You will then be able to choose this prefix or suffix when adding a new
record.



New dialog box
Use this dialog box to create a new file. You can create a new database, word processor document, or report 
template. You can also use this dialog box to create a new document in a word processing application such as 
Microsoft Word or WordPerfect.

File type. Lists the file types available for creating new databases and word processor documents and 
templates. The file types displayed will be different if you choose New from the File menu while in the ACT! word 
processor.



Notes/History Header
This area appears as part of the Notes/History tab in the Contact view. Select options to determine whether notes, 
histories, or attachments will appear in the list.

Options:
Notes. Select this option to show notes in the list below.
Histories. Select this option to show histories in the list below.
Attachments. Select this option to show attachments in the list below.
Insert note. Click this button to insert a note for the current record.
Details. Click this button to view various details about the selected activity.



Object Properties dialog box, Format tab
Use this dialog box to set the format properties of the selected object.

Dialog Box Options and Controls:
Field name. This displays the name of the selected field. You cannot edit the field name in this dialog box.
Data type. This displays the data type of the selected field. You cannot change the field type in this dialog

box.
Appearance. Displays a preview of how the selected field will look using the current settings.
Decimal places. Choose to what number of decimal places you want numbers to appear in the selected 

field.



E-mail Password dialog box
This dialog box appears when you select a post office when sending an e-mail message.

Dialog Box Options and Controls:
Please enter your password. Specify your password for the post office.



Preferences dialog box, Calendars tab
Use this dialog box allows you to set calendar preferences.

Dialog Box Options and Controls:
Sunday. Select this option if you want Sunday to be displayed as the first day of the week on the Weekly 

and Monthly calendars.
Monday. Select this option if you want Monday to be displayed as the first day of the week on the Weekly 

and Monthly calendars.
Daily calendar. Choose a time increments for the Daily calendar. For example, if you choose 30 Minutes, 

the Daily calendar will be divided into 30-minute time slots.
Weekly calendar. Choose a time increment for the Weekly calendar. For example, if you choose 1 Hour, 

the Weekly calendar will be divided into 1-hour time slots.
When displaying mini-calendar, show only current month. Select this option to have the Mini-

Calendar display only one month instead of three months.
Start Time. Specify the hour that you want to appear as the starting time for the Daily and Weekly 

calendars.



Preferences dialog box, Colors and Fonts tab
Use this dialog box to change background color, font, font style, font size, and color for many of the ACT windows. 
For windows and views that display lists, you can choose to display grid lines between rows and columns.

Dialog Box Options and Controls:
Customize. Select the window whose colors and fonts you want to change. You can create a unique look 

for each window by choosing different settings for each window. Also, you can create a uniform look for all of your 
windows by choosing the same settings for each window. 

Note
The font and color settings apply only to the window highlighted in the Customize list. Customize each area 
individually by selecting it in the Customize list, then changing the font and color settings.

Font. Displays the current font used in the selected window or the font you selected in the Font dialog box.
Style. Displays the current font style used in the selected window or the font style you selected in the Font

dialog box.
Size. Displays the current point size used in the selected window or the point size you selected in the Font 

dialog box.
Font button. Click this button to change the font, style, and size of text.
Text color. Displays the current text color in the selected window. Click the drop-down arrow and select a 

color from the palette to change colors.
Background color. Displays the current background color in the selected window. Click the drop-down 

arrow and select a color from the palette to change the background colors.
Sample text. Displays the text as you make various changes.
Show grid lines. Select this option to have grid lines appear between rows and columns in any of the list 

views.



Preferences dialog box, E-mail tab
Use this dialog box to specify preferences for sending and receiving e-mail. 

Dialog Box Options and Controls:
Confirm when deleting messages. Select this option if you prefer to receive a confirmation message 

when you delete e-mail messages.
Notify me of new mail every "X" minutes. Select this option to have ACT! check for new mail at 

regular increments you determine. When this option is checked and you are logged into your e-mail system, a 
flashing icon in the status area notifies you of new e-mail messages. 

Initial text. Enter text here that will appear at the beginning of all of your e-mail messages.
Create history when sent. Select this option to create a history whenever you send an e-mail message.



Preferences dialog box, General tab
Use this dialog box to select default applications, file locations, phone formats, and other default settings. You can 
also open this dialog box in the word processor to turn the tooltips on and off.

Dialog Box Options and Controls:
Word processor. Select an application that you want to use from the drop-down list. 
Fax software. Select the fax software that you want to use from the drop-down list.
File type. Choose the type of file whose default location you want to specify.
Location. Specify the default folder location for the selected file type. Click the Browse ("...") button to 

display the Browse for Folder dialog box, and specify the folder's location.
Tab key. Select this option to use the tab key to move from field to field.
Enter key. Select this option to use the Enter key to move from field to field.
Always display country code in phone fields. Select this option if you want the country code always to

appear in the phone fields throughout ACT!.
Prompt before exiting. Select this option if you wish to be shown a confirmation message before exiting 

ACT!.
Remember password. Select this option if you want ACT! to remember your password every time you 

open a database.
Move between records using ACT! 2.0 shortcut keys. Select this option if you want to use the 

shortcut keys from ACT! 2.0 to move between records (Ctrl+Home, Ctrl+End, Page Down, Page Up) instead of the 
ACT! 3.0 shortcut keys (Alt+Home, Alt+End, Ctrl+Page Down, Ctrl+Page Up).



Preferences dialog box, Names tab
Use this dialog box to change the way the Salutation field is filled in. You can view, add, or delete first name or last
name prefixes and last name suffixes. You can also specify a salutation in this dialog box. 

Dialog Box Options and Controls:
First name prefixes. Select this option to view, add, or delete items from a list of first name prefixes. 

When you Select this option, a list of first name prefixes appears in the box at right. 
Last name prefixes. Select this option to view, add, or delete items from a list of last name prefixes. 

When you Select this option, a list of last name prefixes appears in the box at right. If you want a last name prefix to
be ignored when performing lookups, delete the prefix from the list.

Last name suffixes. Select this option to view, add, or delete items from a list of last name suffixes. 
When you Select this option, a list of last name suffixes appears in the box at right. 

Add. Click this button to add a name prefix or suffix.
Remove. Click this button to remove the selected name prefix or suffix.

Caution
ACT! permanently deletes the selected item when you click the Remove button. If you inadvertently delete 
an item, you will need to re-enter the item in the list by using the Name Prefix/Suffix dialog box. 

Use contact's first name. Select this option if you want to use the contact's first name as the default 
salutation.

Use contact's last name. Select this option if you want to use the contact's last name as the default 
salutation.

Do not fill salutation. Select this option if you do not want ACT! to automatically fill in a salutation when 
writing letters and memos.



Preferences dialog box, Scheduling tab
Use this dialog box to set default priorities, durations, and alarms for your activities. You an also specify which 
activities to roll over, whether to check for conflicts, and whether new activities should be public or private. 

Dialog Box Options and Controls:
Type. Choose the type of activity for which you want to set preferences. Choose Calls, Meetings, or To-

do's. 
Priority. Select a default priority for the selected activity in the drop-down list. Choose high, medium, or 

low. 
Alarm lead time. Choose the default alarm lead time for the selected activity in the drop-down list. The 

alarm will sound to give you this amount of time before the activity takes place.
Duration. Choose the default duration for the selected activity from the drop-down list.
Default to timeless. Select this option to make activities timeless. A timeless activity is one you want to 

do on a specific day, at an unspecified time.
Set alarm. Select this option to enable the alarm by default when scheduling activities.
Automatically roll over. Select an option in this group box to automatically roll over incomplete activities

to the current day. If incomplete activities are found, they are rolled over to the current day as timeless activities. 
Calls. Select this option to roll over calls.
Meetings. Select this option to roll over meetings.
To-do's. Select this option to roll over to-do's.
When clearing activities. Select an option in this group box that specifies how you want activities to 

appear on lists and calendars when they are cleared. 
Remove. Select this option to delete the activity when it is cleared.
Gray. Select this option to dim the activity when it is cleared.
Strikeout. Select this option to strike out or show the activity with a line through it when it is cleared.
Enable activity conflict checking. Select this option if you want to receive an alert message if you 

schedule an activity that conflicts with or overlaps another activity.
Default activities to public. Select this option to make all new activities public by default. Public 

activities can be viewed by all users of a shared database.



Preferences dialog box, Startup tab
Use this dialog box to specify which layout to open at startup, which default database to open at startup, and 
which macro to run startup. You can also set other startup preferences.

Dialog Box Options and Controls:
Default contact layout. Select a contact layout to use as the default each time you start ACT!.
Make new contacts private. Select this option if you want to make all new contacts private.
Last opened. Select this option if you want to start up with the database that was last opened.
Named database. Select this option if you want to start up with a specific database. If you Select this 

option, select the database using the Browse ("...") button to find the database file location.
Default group layout. Choose a group layout that will open by default.
Make new groups private. Select this option if you want to make all new groups private.
Second group column. Choose which field you want to use as the second column in the Groups window.
Run macro on startup. Choose a macro to run automatically every time ACT! starts. If you Select this 

option, select the macro using the Browse ("...") button to find the macro file location.



Preferences dialog box, Synchronization tab
Use this dialog box to set an automatic synchronization schedule, to have ACT! remind you to perform data 
synchronization, to have ACT! automatically purge the transaction log, and to enter Wait for Calls mode.

Dialog Box Options and Controls: 
Every "X" hours. Choose how often you want automatic synchronization to occur between the starting 

and stopping times. 
From. Choose the time you want automatic synchronization to start.
Until. Choose the time you want automatic synchronization to stop.
Synchronize on these days. Choose the days of the week you want automatic synchronization to occur. 

If you do not select a day of the week, automatic synchronization will not occur.
Wait for calls. Click this button to enter Wait For Calls mode in order to receive synchronization updates 

by modem. 
Display a reminder if you have not synchronized in "X" days. Select this option if you want ACT! to 

display a reminder if you do not perform a synchronization within a certain number of days. 
Purge transaction log after "X" day(s). Choose how often you want ACT! to clear the transaction log 

(the list of field-by-field changes to a database). For efficient synchronization, you should purge the transaction log 
regularly. Be sure not to purge the transaction log too frequently; if you purge the transaction log of changes that 
have not yet been synchronized, they will be lost.

Currently selected modem. Displays the modem currently chosen for sending and receiving e-mail.
Modem properties. Click this button to configure your modem with the Windows Modem Properties 

dialog box.



Mail Merge dialog box
Use this dialog box to choose which contacts will receive the form letter, as well as how to send it to them.

Dialog Box Options and Controls: 
Active contact. Select this option to create merged letters only for the active contact.
Active lookup. Select this option to create merged letters only for the contacts in the current lookup.
All contacts. Select this option to create merged letters for all contacts in your database.
Printer. Select this option to send the all the merged letters to the printer.
E-mail. Select this option to send the merge output as an e-mail message.
Fax. Select this option to send the merged letters as fax transmissions and then record a history in each 

contact's record.
File. Select this option to send the merge output to a specific file.
Create history when sent. Select this option to create a history of your sending the document, e-mail, or

fax.
Regarding. Enter the subject of the form letter.



Print dialog box
Use this dialog box to print address books, labels, envelopes, reports, and daily, weekly, and monthly calendars in 
a variety of formats.

Dialog Box Options and Controls:
Printout type. Choose an address book, a day, week or month calendar, a report printout, a label 

printout, or an envelope.
Printout type list. This control displays the formats available for the printout type you selected. You can 

choose from a variety of sizes and layouts for your printout, including popular formats like DayRunner, Day-Timer, 
Franklin, or Avery. European A4 and A5 paper sizes are supported for these formats.

Show preview. Select this option if you want to see a preview of the selected print setup. The preview 
shows the format you chose.

Edit template. Click this button to make changes to the selected template.
Options. Click this button to set options if you want to set activity and date range options for your 

calendar printouts. You can also choose whether to use the company name, print a five-week view, or add Saturday 
and Sunday activities.

Print setup. Click this button to set printer options using the Windows Print Setup dialog box.



Query Helper dialog box
Use this dialog box to create a query or an Advanced query which is a text-only representation of your query 
statement, with Boolean logic equations expressing the search criteria. This dialog box shows all the query 
operators you can use.

Dialog Box Options and Controls:
Field name. Displays a list of dimmed field names. Choose a field name to insert into the query.
Operators. Choose an operator to insert into the query.
Insert. Click this button to place the selected item into a query. You can also double-click the operator.



Record History dialog box
Use this dialog box to record and activity history for the current contact. You can open this dialog box from the 
Contact menu, or it appears when you stop the timer after you make a call.

Dialog Box Options and Controls:
Activity result. Choose a result for the completed activity from the drop-down list. 
Regarding. Enter a description for the activity, or choose a description from the drop-down list. To add 

more results to the list, choose Edit List to display the Edit List dialog box in which you can add a custom topic. You 
can also modify or delete a topic. 



Record Macro dialog box
Use this dialog box to create macros by recording actions that you perform regularly and that you want to 
automate. 

Dialog Box Options and Controls:
Name of macro to record. Enter a name for the macro you are creating.
Description. Enter a description of what the macro does.
Record events. Choose an option to specify which events you want to record. Choose Everything, Record 

Clicks and Drags (mouse events), or Everything But Mouse Events.



Records in Use dialog box
This dialog box appears when you try and modify records that have been locked by another user of the database. 
ACT! displays a list of the locked records.



Rename Tab Layout dialog box
Use this dialog box to change the name of the tab layout selected in the Define Tab Layouts dialog box.

Dialog Box Options and Controls:
Layout name. Enter the new name for the selected tab.



Reply/Forward Options dialog box
Use this dialog box to specify how you want to reply to an e-mail message or forward the message to someone 
else.

Dialog Box Options and Controls:
Include message body. Select this option if you want to include the original message in your reply 

message.
Include attachments. Select this option if you want to include the original attachments when you 

forward or reply to the message.
Reply to all. Select this option if you want to reply to all of the people on the original distribution list. 



Retry Delete dialog box
This dialog box appears when you try to delete an item that is locked by other users in the database. You can retry 
the deletion when the item has been unlocked by the user.

Dialog Box Options and Controls:
The items listed below could not be deleted because they were locked by the specified users. 

Would you like to retry deleting these items? Choose Yes or No.
Item list. Displays the items that could not be deleted because they are locked by other users. Each item 

will need to be unlocked by the user before you can delete it.
Retry all. Click this button to retry all of the deletions. Each item will need to be unlocked by the user 

before you can delete it.



Roll Over Activities dialog box
This dialog box appears when ACT! finds activities that were scheduled to be done prior to today's date. If old 
tasks are found, you are prompted to roll them over to the current day as timeless activities.

Dialog Box Options and Controls:
Calls. Displays the number of scheduled calls that have not been completed.
Meetings. Displays the number of scheduled meetings that have not been completed.
To-do's. Displays the number of scheduled to-do's that have not been completed.



Run/Delete Macro dialog box
Use this dialog box to either run macros or delete macros, depending on what menu command you choose. To run 
a macro, chose Run Macro from the Tools menu. To delete a macro, choose Delete Macro form the Tools menu. If 
you use a macro frequently you can add an icon for it in the toolbar.

Dialog Box Options and Controls:
Macros. Select a macro that you want to run or delete from the list.
Description. Displays a description of the selected macro.
Run at recorded speed. Select this option to run the macro at the same speed at which it was recorded. 

This option only appears if you choose the Run Macro command.



Save Copy As dialog box
Use this dialog box to save all the records in the database or create an empty copy of the database. 

Dialog Box Options and Controls:
Copy database. Select this option to copy all records in the database to a new file. The Save As dialog 

box appears, and you can enter a new name and location for this backup copy.
Create empty copy. Select this option to copy the database formatting without copying the actual 

records within the database.



Schedule Activity dialog box, Recurring Settings tab
Use this dialog box to schedule daily, weekly, or monthly recurring activities, and to choose how frequently your 
activities will occur.

Dialog Box Options and Controls:
Once. Select this option to cancel a recurring activity.
Daily. Select this option to schedule an activity that occurs every day, every other day, or at any interval 

of days. You can specify the number of days between each occurrence of the activity and the date on which the 
activity will stop.

Weekly. Select this option to schedule an activity that occurs every week, every other week, or at any 
interval of weeks. You can specify the number of weeks between each occurrence of the activity, on which day of 
the week the activity is scheduled, and the date on which the activity will stop.

Monthly. Select this option to schedule an activity that occurs every month, every other month, or at any 
interval of months. You can specify the number of months between each occurrence of the activity, the weeks in the
month when the activity is scheduled, the day of the week the activity is scheduled, and the date on which the 
activity will stop.

Custom. Select this option to schedule activities for specific days of the month.
Activity occurs every. Specify the frequency of a scheduled activity.
Until. Choose a date on which the activity will stop recurring. You can select a date from the drop-down 

date selector, or type a date in the field.
Repeat on these weeks in the month. (monthly only) Choose on which weeks of the month the activity

will be repeated.
Occurrence of. Choose on which days of the week the activity will be repeated.



Select Contacts dialog box
Use this dialog box to select one or more contacts for a scheduled activity.

Dialog Box Options and Controls:
All contacts. Select this option to select from all contacts in the database.
Current lookup. Select this option to select contacts only from the current lookup. 
Selected group. Select this option to select contacts from a specific group.
Contact list. Displays a list of the contacts in the database, the current lookup, or an existing group. By 

default, the All Contacts option is selected.
Select all. Click this button to select all available contacts in the list at the left. You can then add all of the

contacts to the list of contacts for the scheduled activity, which appears in the list at the right, by clicking the Add 
button. 

Add. Click this button to add the selected contacts to the Scheduled With list. To add an individual contact,
click once on the individual contact's name in the list at left, then click the Add button. The contact's name is added
to the list at right. 

Remove. Click this button to remove the chosen contacts from your selection. To remove an individual 
contact, click once on the individual contact's name in the list at right, then click the Remove button. The contact's 
name is removed from the list at left.

Replace. Click this button to replace the contact in the Scheduled With list with the selected contact.
Scheduled with. Displays the contact or contacts with whom the activity is currently scheduled.
More. Click this button to display the third-party scheduling options, Scheduled for and Scheduled by. 

Changes to "Less" when third-party scheduling options are displayed.
Scheduled for. Displays the contact(s) with whom the activity is currently scheduled.
Scheduled by. Displays the user who is scheduling the activity.



Select Contacts dialog box (GENERIC)
Use the Select Contacts dialog box to select one or more contacts for a scheduled activity. Open this dialog box by 
selecting the Browse ("...") button in the With field of the Schedule Activity dialog box, Activity Information tab.

Dialog Box Options and Controls:
All contacts. Select this option to select from all contacts in the database.
Current lookup. Select this option to select contacts only from the current lookup. 
Selected group. Select this option to select contacts from a specific group.
Contact list. Displays a list of the contacts in the database, the current lookup, or an existing group. By 

default, the All Contacts option is selected.
Select all. Click this button to select all available contacts in the list at the left. You can then add all of the

contacts to the list of contacts for the scheduled activity, which appears in the list at the right, by clicking the Add 
button. 

Add. Click this button to add the selected contacts to the Scheduled With list. To add an individual contact,
click once on the individual contact's name in the list at left, then click the Add button. The contact's name is added
to the list at right. 

Remove. Click this button to remove the chosen contacts from your selection. To remove an individual 
contact, click once on the individual contact's name in the list at right, then click the Remove button. The contact's 
name is removed from the list at left.

Replace. Click this button to replace the contact in the Scheduled With list with the selected contact.
Scheduled with. Displays the contact or contacts with whom the activity is currently scheduled.
More. Click this button to display the third-party scheduling options, Scheduled for and Scheduled by. 

Changes to "Less" when third-party scheduling options are displayed.



Select E-mail Address dialog box
Use this dialog box to select an e-mail address from the address book to assign to the current contact.

Dialog Box Options and Controls:

Address book entries. Select an e-mail address to assign to the current contact.



Select "My Record" dialog box
Use this dialog box to choose a contact (usually yourself) to use for the My Record. The My Record is the contact 
record for the creator of the database.

Dialog Box Options and Controls:
Contact list. Choose a contact from the list to use as the My Record.



Send Fax dialog box
Use this dialog box to fax a new or previously saved document and select the contacts who will receive the fax. 

Dialog Box Options and Controls:
All contacts. Select this option if you want to send the fax to all contacts in the database.
Current lookup. Select this option if you want to send the fax only to the contacts in the current lookup.
Selected group. Select this option to send the fax only to the contacts from a specific group. You can 

select a group from the drop-down list.
Contact list. Displays a list of contacts based on your selection. Choose the contacts you want to receive 

the fax from this list.
Select all. Click this button to send the fax to all contacts in the list, then click To.
To. Click this button to send the fax to the selected contact(s) in the fax recipients list.
Remove. Click this button to remove the selected contacts from your list of fax recipients.
Recipients. Displays a list of the contacts you selected to receive the fax.
Regarding. Type the subject of the fax.
Create history when sent. Select this option to create a history record for the document.
Attach document to history. Select this option to add a shortcut to the document in the history record.



Set Password dialog box
Use this dialog box to set a password for your database. You can change your password at any time.

Dialog Box Options and Controls:
Old password. Enter the current password if a password has already been set.
New password. Enter the new password you want to use. 
Retype new password. Enter the new password again for confirmation.



Snooze Alarm dialog box
Use this dialog box to specify the amount of time until the beep sounds and the Alarms dialog will be redisplayed 
for the selected activities.



Sort Contacts dialog box
Use this dialog box to sort your contacts in ascending or descending order, using up to three fields to customize 
the sort. If you want to sort only by one set of criteria, choose (None) in the Field for the second and third sections.
ACT! sorts all of the records in the current lookup by the lookup criteria. For example, if you use the lookup State 
(Country, Land, Province), the found set of contacts is sorted alphabetically by State (Country, Land, Province).

Dialog Box Options and Controls:
Sort by. Specify the first-level criterion by which the contacts will be sorted. To select a different criterion, 

choose an item from the drop-down list.
And then by. Specify the second-level criterion by which the contacts will be sorted. To select a different 

criterion, choose an item from the drop-down list.
And finally by. Specify the third-level criterion by which the contacts will be sorted. To select a different 

criterion, choose an item from the drop-down list.
Ascending. Select this option to sort the contacts in ascending order according to the sort criteria 

specified. For example, a list of names is sorted alphabetically from A to Z. You can select this option for any of the 
three sort levels. 

Descending. Select this option to sort the contacts in descending order according to the sort criteria 
specified. For example, a list of names is sorted alphabetically from Z to A. You can select this option for any of the 
three sort levels. 



Summary Section Placement dialog box
This dialog box appears when you create a summary section in a report template. Use it to place the summary 
above or below its owner section. 



Swap Field Contents dialog box
Use this dialog box to exchange or swap the contents of one field with the contents of another field.

Dialog Box Options and Controls:
Swap contents of. Select the field whose information you want to replace and exchange with that of 

another field.
With contents of. Select the field whose information will be exchanged with the other field.



Synchronization Setup Wizard 1
Use the Synchronization Setup Wizard to set up direct synchronization with another database or other users. The 
first panel allows you to specify the type of synchronization you want to perform.

Dialog Box Options and Controls:
Direction synchronization with another database. Select this option to have ACT! synchronize data 

with another ACT! database. 
Synchronization with other users. Select this option to have ACT! synchronize data with another ACT! 

user via one of the supported e-mail systems, via a modem, or using a shared folder or floppy disk.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 2
Use the Synchronization Setup Wizard to set up direct synchronization with another database. This panel allows 
you to specify the database with which to synchronize data.

Dialog Box Options and Controls:
File name and location. Choose a filename and path for the database with which you want to 

synchronize. If you do not know the filename and path, click the Browse ("...") button to locate the database you 
want. When you select the database and click Open, the name and location are filled in within the wizard panel.

< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this if you have finished setting up synchronization. If you click it before getting to the last 

Synchronization Setup Wizard panel, all default settings will be used.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 2 (Add User)
Use the Synchronization Setup Wizard to set up synchronization with other users. You can add a new user, or 
modify an existing user in this panel.

Dialog Box Options and Controls:
New user name. Enter the name of the user you are setting up for synchronization.
Make existing user a synchronization user. Select this option to give synchronization privileges to 

someone who is already set up as a user on your database.
Select from existing users. Select a user to whom you want to give synchronization privileges.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 2 (Select User)
Use the Synchronization Setup Wizard to set up direct synchronization with another database or other users. You 
can synchronize data with an existing user or create a new user. This panel allows you to set up a user from whom 
you have received a synchronization update for the first time. You can create a new user or link this user to an 
existing user of the database.

Dialog Box Options and Controls:
Synchronization message containing updates from. This field is filled by default with the name of the

user sending you an incoming synchronization update. You can keep this name or change it without affecting the 
data being received. This field is ignored if you decide to make an existing user    a synchronization user.

New user name. Select this option to add the person who is sending the synchronization update as a new
user in the database.

Make existing user a synchronization user. Select this option to link the synchronization update to an 
existing user in the database.

Select from existing users. Select a user from the list with whom to link the synchronization update.
< Back. Click this button to return to the previous panel of the wizard. This option is not available on the 

first page of the wizard.
Next >. Click this button to proceed to the next panel of the wizard. This option is not available on the last

page of the wizard.
Finish. Click this button to finish the wizard. This option is available only on the last page of the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 3
Use the Synchronization Setup Wizard to set upt synchronization with other users. You can select the users to 
whom you want to send and from whom you want to receive data.

Dialog Box Options and Controls:
Select the users with whom you would like to synchronize data. Select each user by clicking his or 

her name in the list. A check mark appears next to the name of each selected user.
Select all. Click this button to choose all users in the list.
Deselect all. Click this button to revert the list so that no users are selected.
Add user. Click this button to add a new user for synchronization.
Modify user. Click this button to modify the selected user's attributes.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 4 (Groups)
Use the Synchronization Setup Wizard to set up direct synchronization with another database. This panel allows 
you to specify which groups you want to include in the data exchange.

Dialog Box Options and Controls:
All groups and contacts. Select this option to synchronize all groups and contacts in your database.
Selected groups. Select this option to synchronize only selected groups from your database.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button if you have finished setting up synchronization. If you click it before getting to the 

last Synchronization Setup Wizard panel, all default settings will be used.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 4 (Win32s)
Use the Synchronization Setup Wizard to set up direct synchronization with another database or other users. 

Dialog Box Options and Controls:
All groups and all contacts. Select this option if you want to synchronize all groups and contacts.
Selected groups. Select this option if you want to synchronize only groups you select.
Group list. Select the groups you want synchronized.



Synchronization Setup Wizard 5
Use the Synchronization Setup Wizard to set up direct synchronization with another database or to set up 
synchronization with other users. This panel allows you to include notes, histories, and activities data.

Dialog Box Options and Controls:
Notes/history. Select this option to include notes and history in the synchronization message.
Activities. Select this option to include activities in the synchronization message.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button if you have finished setting up synchronization. The Finish button is available after

you select another database with which to synchronize data, or after you finish setting up other users for 
synchronization. If you click Finish before getting to the last Synchronization Setup Wizard panel, all default settings
will be used.

Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 5 (Connect Via)
Use the Synchronization Setup Wizard to set up synchronization with other users. This panel allows you to specify 
how you want to connect with the selected user.

Dialog Box Options and Controls:
Connect via. Choose a connection method to use for synchronization.
E-mail address, location, or modem number. Enter the user's e-mail address, location, or modem 

number. If you do not know the information, click the Browse ("...") button to open a dialog box where you can 
choose a file that contains the information, such as your CompuServe address book or MS Exchange settings.

< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 6
Use the Synchronization Setup Wizard to set up direct synchronization with another database. This panel gives you
the option of sending and receiving private data.

Dialog Box Options and Controls:
Send and receive private data. Select this option to include private data in your synchronization 

updates.
Don't send and receive private data. Select this option to omit private data in your synchronization 

updates.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button if you have finished setting up synchronization. If you click it before getting to the 

last Synchronization Setup Wizard panel, all default settings will be used.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 6 (Include)
Use the Synchronization Setup Wizard to set up synchronization with other users. You can include field names, 
drop-down lists, and definitions you have set for fields.

Dialog Box Options and Controls:
Include private data. Select this option if you want private data to be included when sending 

synchronization messages.
Don't include private data. Select this option if you do not want private data to be included when 

sending synchronization messages.
Send database field definitions. Select this option if you want field names, field drop-downs, and any 

other field definitions included when sending synchronization messages.
Don't send database field definitions. Select this option if you do not want field names, field drop-

downs, and any other field definitions included when sending synchronization messages.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 7
Use the Synchronization Setup Wizard to set up direct synchronization with another database. 

Dialog Box Options and Controls:
Send and receive database field definitions. Select this option to include field names, field drop-

downs, and any other field definitions in your synchronization updates.
Don't send and receive database field definitions. Select this option if you do not want to include 

field names, field drop-downs, and any other field definitions in your synchronization updates.
When synchronizing database field definitions, which field definitions do you want to apply if 

there are conflicts? If you chose to send and receive database field definitions, select one of the following three 
options:

Field definitions from my database. Select this option if you want to resolve conflicts by using field 
definitions from the current database. 
Field definitions from destination database. Select this option if you want to resolve conflicts by using 
field definitions from the destination database. 
Newest field definitions from either database. Select this option if you want to resolve conflicts by 
using the most up-to-date field definitions, regardless of which database they are from.

< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button if you have finished setting up synchronization. If you click it before getting to the 

last Synchronization Setup Wizard panel, all default settings will be used.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 7 (Collection group)
Use the Synchronization Setup Wizard to set up synchronization with other users. This panel lets you specify a 
group to which all contacts received from the selected user will be added. Specifying a collection group is optional.

Dialog Box Options and Controls:
Collection group. Specify a group to keep track of all contacts received from the user with whom you are 

synchronizing. Enter an existing group name, or enter a new group name to create a new group.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 7 (Win32s)
Use the Synchronization Setup Wizard to set up direct synchronization with another database or other users. 

Dialog Box Options and Controls:
Collection group. Choose the group to which you want to add individual contacts when receiving them 

from the current user.
Group list. Choose a group from the list.



Synchronization Setup Wizard 8 (Receive data)
Use the Synchronization Setup Wizard to set up synchronization with other users. 

Dialog Box Options and Controls:
Receive private data. Select this option if you would like to receive all private data from the user with 

whom you are synchronizing.
Don't receive private data. Select this option if you do not want to receive private data from the user 

with whom you are synchronizing.
Accept database field definitions. Select this option if you want to receive field names, field drop-

downs, and any other field definitions from the user with whom you are synchronizing.
Don't accept database field definitions. Select this option if you do not want to receive field names, 

field drop-downs, and any other field definitions from the user with whom you are synchronizing.
< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish the wizard.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronization Setup Wizard 9
Use the Synchronization Setup Wizard to set up direct synchronization with another database or to set up 
synchronization with other users. You can choose whether to send or receive all records, which you will usually do 
only the first time you synchronize, or send or receive new changes.

Dialog Box Options and Controls:
Send only changed records. Select this option to send only records that have changed since the last 

update.
Send all records. Select this option to send all records (for this update only). After the next 

synchronization, the Send Only Changed Records option is automatically selected. After the next synchronization, 
the Send Only Changed Records option is automatically selected.

< Back. Click this button to return to the previous panel of the wizard.
Next >. Click this button to proceed to the next panel of the wizard.
Finish. Click this button to finish setting up synchronization.
Cancel. Click this button to exit the wizard without completing the procedure.



Synchronize dialog box
Use this dialog box to set up data for synchronization with another database or other users. You can also use this 
dialog box to send and apply updates.

Dialog Box Options and Controls:
Apply updates. Select this option to have ACT! look for synchronization updates in the specified database

if you are synchronizing directly with another database, or in your e-mail inboxes, your shared folder, your 
synchronization folder, or your briefcase. 

Send updates. Select this option to have ACT! send your updates to the specified database or, if you are 
synchronizing with other users, ACT! sends your updates using the method you have specified during 
synchronization setup. 

Current setup. This area displays your current synchronization setup. To change the setup, click the 
Setup button. 

Clear the synchronized records to be deleted (this time only). Select this option if you do not want 
to create a lookup of the records that were deleted in the other database. If you do not select this option, a lookup 
will be created containing the records that were deleted in the other database. After you've applied a 
synchronization update, you can view these records and if you want, delete them from your database.

Setup. Click this button to set up data synchronization using the Synchronization Setup Wizard. You can 
click Setup to make any changes to the current setup.

Synchronize. Click this button to begin the synchronization process with the parameters you defined in 
the synchronization setup procedure. Any updates that are found are applied to the currently open database, then 
your updates are sent to the specified database or users.

Done. Click this button when you are finished using the dialog box.



System Information dialog box
This dialog box displays information about the system on which ACT! is running.



Timer dialog box
Use this dialog box to time phone calls and other activities.

Dialog Box Options and Controls:
Pause. Click this button to stop the timer temporarily. The Pause button changes to the Resume button 

during a pause. You can click Resume to go on timing the call.
Reset. Click this button to reset the timer to zero and resume timing.
Start. Click this button to start the timer. The Start button changes to the Stop button when timing begins.

Click Stop to stop the timer. The Record History dialog box appears, and you can record a description of the result of
your call.



Import Text File Options dialog box
Use this dialog box to set options when importing delimited text files into ACT!. The settings you choose will 
depend on the format of the file you are importing.

Dialog Box Options and Controls:

Comma. Select this option if commas were used to separate fields in the file.
Tab. Select this option if tabs were used to separate fields in the file.
Character set. Select the operating system in which the file you are importing was created. Choose from 

Windows (ANSI), DOS, or Macintosh.
Import first record. Select this option if you want to include the first record in the file when importing. 

Sometimes the first record contains field names rather than actual data, so you may not want to import it.



Import dBase File Options dialog box
Use this dialog box to specify which character set was used to create your dBase file before importing it into ACT!. 

Dialog Box Options and Controls:

Character set. Select from Windows (ANSI), DOS, or Macintosh. Choose the operating system in which the file 
you are importing was created.



Export Options dialog box
Use this dialog box to set options when exporting ACT! records to a delimited text file. 

Dialog Box Options and Controls:

Comma. Select this option if you want to use commas to separate fields in the file.
Tab. Select this option if you want to use tabs to separate fields in the file.
Export field names. Select this option to include field names from the current database when exporting 

records.



Contact Window Click a specific area for more information.



Move to the first contact record.



Move to the previous contact record.



Displays the number of contacts in the current lookup.



Move to the next contact record.



Move to the last contact record.



Use the tools in the toolbar to quickly open or save a file, insert a new contact, write notes, schedule activities, 
write letters, make telephone calls, and get online help.



Minimize, maximize, restore, or close ACT!



Minimize, maximize, restore, or close the current database.



Enter contact information in any of these fields.



Enter and view additional contact information by clicking one of the tabs below.



Click any of the tabs to enter and view additional contact information.



Status bar displays current status messages.



Switch to a different contact layout using this drop-down menu.



Create a lookup of a different group using this drop-down menu.



Switch to a different ACT! window using any of these eight icons.



Contact List Window Click a specific area for more information.



Double-click a selection button to open the Contact window for the selected contact.



Click a column heading to sort the contacts by the data in that column. Hold down the Shift key as you click a 
column heading to sort the contacts in descending order. You can also change the width of any of the columns by 
dragging the edge of a column to the right or left.



Enter contact information in any of the columns. You can add new contacts in the Contact List window just as you 
do in the Contact window.



Calendar Window Click a specific area for more information.



Use the tools in the toolbar to quickly open or save a file, print a calendar, schedule activities, move between 
records, create a lookup, filter what appears on your calendar, and get online help.



Minimize, maximize, restore, or close ACT!



Minimize, maximize, restore, or close the Calendar window.



The calendar displays your scheduled activities. You can use the Filter command to specify which activities appear 
on the calendar.



Click the arrows in the date selector to move to a different month. The day displayed in red is the current date.



Use the Daily Checklist to see the activities for the currently selected day. Clear activities by clicking the check box
next to the activity.



Task List Window Click a specific area for more information.



Use the tools in the toolbar to quickly open or save a file, schedule activities, create a lookup, filter what appears 
on your task list, and get online help.



Minimize, maximize, restore, or close the Task List window.



Click a column heading to sort the activities by the data in that column. Hold down the Shift key as you click a 
column heading to sort the activities in descending order.



Clear an activity by clicking in this column.



Shows a list of your activities. Change the width of any of the columns by dragging the edge of a column to the 
right or left.



Groups Window Click a specific area for more information.



Move to the first group record.



Move to the previous group record.



Displays the total number of groups.



Move to the next group record.



Move to the last group record.



Use the tools in the toolbar to quickly open or save a file, create a new group, insert a note, change the members 
of a group, and get online help.



Minimize, maximize, restore, or close the Groups window.



View a list of your groups here.



Enter basic group information here.



Enter and view additional group information by clicking one of the tabs below.



Click any of these tabs to enter and view additional group information.



Status bar displays current status messages.



Switch to a different group layout using this drop-down menu.



E-mail Window Click a specific area for more information.



Use the tools in the toolbar to quickly create, send, reply to, forward, read, print, delete, and process e-mail 
messages.



Double-click an e-mail mailbox to log on to the e-mail system and view your messages.



Click the arrow to change the sort order of the messages in the inbox.



Double-click on a message to open it.



Minimize, maximize, restore, or close the E-mail window.



Query Window Click a specific area for more information.



Create a new query.



Open an existing query.



Save the current query.



Clear all fields in the current query.



Convert the current query to an advanced query.



Run the current query.



Close the query window.



View the ACT! online help topics.



Enter search criteria in any of the fields in the layout.



Enter search criteria in any field in any of the tabs.



Switch to a different layout.



Minimize, maximize, restore, or close the Query window.



Report Designer Click a specific area for more information.



Minimize, maximize, restore, or close the Report Designer window.



You can add, remove, or rearrange fields in the report template. Using the tools in the tool palette, you can change
the appearance of objects in the template. Using commands in the Edit menu, you can add or remove sections in 
the report template.



You can add, remove, or rearrange fields in the report template. Using the tools in the tool palette, you can change
the appearance of objects in the template. Using commands in the Edit menu, you can add or remove sections in 
the report template.



Layout Designer Click a specific area for more information.



Use these tools to create, open, or save a file.



Use these tools to change the font, font size, and font style.



Use these tools to change the alignment of text.



Use these tools to change the alignment of objects.



Close the Layout Designer window.



You can add, remove, or rearrange fields in the layout. Using the tools in the tool palette, you can change the 
appearance of objects in the layout.



You can add, remove, or rearrange fields in the layout. Using the tools in the tool palette, you can change the 
appearance of objects in the layout.



You can add, remove, or rearrange fields in the layout. Using the tools in the tool palette, you can change the 
appearance of objects in the layout.



Use this tool to select objects.



Use this tool to select the attributes of an object.



Use this tool to add text.



Use this tool to create a square or rectangle.



Use this tool to create a circle or ellipse.



Use this tool to create a line.



Use this tool to add a field.



Use this palette to change the text color.



Use this palette to change the fill color/pattern.



Use this palette to change the line/border color.



Use this palette to change the border style.



Use this palette to change the line/border weight.



Click any of the tabs to view, add, or modify additional fields.



Replace Fields Window Click a specific area for more information.



Swap the data in one field with the data from another field.



Copy the data from one field to another field.



Apply the changes to the current lookup.



Close the Replace Fields window.



Enter changes in one or more fields.



Enter changes in any of the fields in any of the tabs.



Minimize, maximize, restore, or close the Replace Fields window.



Displays the security level of the current user of a shared database.



Click this button to view information about the system on which ACT! is currently running.



Displays who is licensed to use this copy of ACT!.



Displays the current version number of ACT!.



Displays the name of the current user of a shared database.



Enter the name of a city you want in the code list.



Enter the area code for the city.



Enter the area code for the city.



Double-click the field for which you want to create a column. The new column will appear as the last column to the
right. You can also select a field and drag it to the position you want in the list view.



Click this button to add the selected contact(s) to the group.



Displays the list of contacts in the current database.



Enter the country code for the country.



Enter the name of a country you want in the code list.



Use the # symbol, dashes, space bar, etc., to create a format for the phone number. For example, the United 
States' format is ###-###-####.



Use the # symbol, dashes, space bar, etc., to create a format for the phone number. For example, the United 
States' format is ###-###-####.



Type the path and file name of the query or template. If you do not know the path and file name, use the Browse 
("...") button to find the query file, word-processing template, report template, label template, or envelope 
template you want to add to the appropriate menu and click Open.



Enter the text you want to appear in the menu.



Type the path and file name of the query or template. If you do not know the path and file name, use the Browse 
("...") button to find the query file, word-processing template, report template, label template, or envelope 
template you want to add to the appropriate menu and click Open.



Enter a description for the item you want to appear in the drop-down list.



Enter a description for the item you want to appear in the drop-down list.



Enter the text for the item you want to appear in the drop-down list. You can add one or more items.



Type the appropriate country code in this box.



Type a description (i.e., country name) in this box.



Use the # symbol, dashes, space bar, etc., to create a format for listing phone numbers for this country. For 
example, the United States' format is ###-###-####.



Select this option to add a Activities section to the template. The Activities section contains information from fields 
in the Activities tab of a contact or group record.



Select this option to display or print all of the information in a section, even if it doesn't fit on a single page.



Select this option to eliminate lines in the report that contain no data.



Select this option to eliminate sections in the report that contain no data.



Select this option to add a Contact section to the template. The Contact section contains information from fields in 
contact records.



Select this option to add a Contact subsection to the template. The Contact subsection contains information from 
fields in the Contacts tab of a group record.



Select a field you want to include in the specified section.



Select this option to add a Footer section to the report. The Footer appears at the bottom of every page, unless 
you add a separate Title Footer to be used only on the first page of the report.



Select this option to add a Group section to the template. The Group section contains information from fields in 
group records.



Select this option to add a Group subsection to the template. The Group subsection contains information from 
fields in the Groups tab of a contact record.



Select this option to add a Header section to the report. The Header appears at the top of every page, unless you 
add a separate Title Header to be used on the first page of the report.



Select this option to add a Notes/History section to the template. The Notes/History section contains information 
from fields in the Notes/History tab of a contact or group record.



Select this option to display or print a new page at the beginning of each section of the report.



Select Ascending or Descending order from the Sort Order drop-down list.



Select Ascending or Descending order from the Sort Order drop-down list.



Select this option if you want to add a Summary section to the template. The Summary section contains 
summaries of the summary fields included in the body section that precedes or follows it.



Select this option to add a Summary Sorted By section to the template. The Summary Sorted By section contains a
summary of the values sorted by a specific field.



Select this option if you want to add a Title Footer section to the report. The Title Footer appears only on the first 
page of the report, replacing the Footer that appears on all other pages of the report.



Select this option if you want to add a Title Header section to the report. The Title Header appears only on the first 
page of the report, replacing the Header that appears on all other pages of the report.



Enter the name for the tab you want to create.



Select up to three additional database fields of information you would like to print out in your address book.



Select up to three additional database fields of information you would like to print out in your address book.



Select up to three additional database fields of information you would like to print out in your address book.



Select this option to print the address book entries for all contacts.



Select this option to print the second and third contacts' names and phone numbers.



Select this option if you want to start printing a new page for each letter of the alphabet.



Select this option to sort contacts by company name.



Select this option to print the address book entry for the current contact only.



Select this option to print the address book entries for the current lookup.



Select this option to enable double-sided printing, which will print the address book on both sides of a page.



Select this option to print the contact's e-mail addresses.



Select this option to reverse the order of City, State, ZIP to ZIP, City, State.



Click this button to specify the font properties for your address book printout.



Select this option to sort contacts by last name.



Select this option to display the alphabetic letter at the top of each page of your address book.



Select this option to print a line between each contact entry in your address book.



Select this option to print all of the contact's phone numbers.



Select this option to print the contact's main address.



Select this option to print the contact's home address.



Click this button to add the selected contact(s) or group(s) to the Address List. 



This list shows the entries in the current address book.



This list shows the entries in the current address book.



This list shows the entries in the current address book.



This list shows the entries in the current address book.



Enter the e-mail address for the contact to whom you want to send e-mail.



This list shows the contacts you want to receive the e-mail message.



Click this button to remove the selected recipient from the Address List.



Click this button to make changes to the e-mail address for the current contact.



Select an address book entry. You can choose a directory which lets you select anyone in your database, current 
lookup, or groups.



Select To, cc, or bcc from the drop-down list. "To" adds the contact to the recipient list, "cc" adds the contact to the
copy list, and "bcc" adds the contact to the blind copy list.



This field displays the scheduled activity about which the alarm is reminding you.



Click this button to clear the activity using the Clear Activity dialog box.



Click this button to shut off the alarm for the activity.



Click this button to go to the contact record for the contact with whom the activity was scheduled.



Click this button to reschedule the activity using the Schedule Activity dialog box.



This field displays the scheduled activity about which the alarm is reminding you.



Click this button to choose all of the current alarms.



Click this button to postpone the alarm by an amount of time you specify.



Select this option if you want to include the contact's or group's activities in the attachment.



Click this button to attach a current lookup of contacts or groups to an e-mail message.



Select the contact(s) or group(s) to attach to the e-mail message.



Select this option if you want to include the contact's or group's notes and history in the attachment.



Select this option if you want to print a full five-week monthly calendar.



Select this option if you want calls to be printed on your calendars.



Select this option if you want the company name printed on the calendar in addition to the contact name.



In the Date Range field, specify a date range for the calendar printout. Select a date range from the drop-down 
date selector by dragging through the dates you want.



Select this option if you want meetings to be printed on your calendars.



Select this option if you want activity priorities to be printed on your calendars.



Select this option if you want public activities to be printed on your calendars.



Select this option if you want to include Saturday and Sunday in the printouts.



Choose at which hour you want the printed calendar to begin. Click the arrow to display the Start Hour drop-down 
list and select the hour.



Select this option if you want to-do's to be printed on your calendars.



This field shows the contact's company.



This field shows the contact's company.



This field shows the contact with whom the activity was scheduled.



This field shows the contact with whom the activity was scheduled.



This field shows the date of the activity.



This field shows the date of the activity.



Click this button to schedule a follow-up activity with the contact.



This field shows the description of the activity that was scheduled.



This field shows the description of the activity that was scheduled.



Select an option from the Result drop-down list.



Select an option from the Result drop-down list.



This field shows the time of the activity.



This field shows the time of the activity.



This field shows the type of activity.



This field shows the type of activity.



Click this button to accept the scheduling conflict.



This list displays one or more activities that are scheduled at the same time and date as the current activity.



Select this option if you no longer want ACT! to check for conflicting activities.



Click this button to display the Schedule Activity dialog box in which you can specify a new date and time for the 
activity.



Enter the first line of the contact's address.



Enter the second line of the contact's address.



Enter the name of the contact's assistant.



Enter the contact's city.



Enter the contact's company name.



Enter the contact's name.



Enter the contact's fax number.



Enter the contact's ID or status. This field lets you assign your own system of identification or status to a contact.



Enter the contact's phone number.



Enter the contact's state.



Enter the contact's title.



Enter the contact's zip code.



Click this button to add the current contact to the selected group.



Displays the name of the current contact.



Select the group to which you want to add the current contact as a member.



Click this button to remove the current contact from the selected group.



Click this button to select all of the listed groups.



Displays a list of groups of which the current contact is a member.



This field displays the contact's name with what ACT! determines to be the first name highlighted.



This field displays the contact's name with what ACT! determines to be the last name highlighted.



Select this option to create a backup of your old database when you convert it to the new version.



Select this option to convert your old ACT! database to the current version, making the database incompatible with
previous versions of ACT!.



Select the field that contains the information you want to copy to another field from the drop-down list.



Select the field in which to copy the information from the drop-down list.



Select this option if you want all phone numbers for the selected country to be automatically formatted as you 
enter them. Note that this setting has no effect on phone numbers that you have already entered. 



Select this option if you want all phone numbers for the selected country to be automatically formatted as you 
enter them. Note that this setting has no effect on phone numbers that you have already entered. 



Select a country from the Country list. The country code is displayed to the right of the country's name in the list.



Select this option if you want to enter phone numbers for the selected country without automatic formatting.



Select this option to create a shortcut to the document.



This field displays the name of the document that was printed, faxed, or e-mailed.



This field displays the name of the document that was printed, faxed, or e-mailed.



Enter a description of the subject of the document.



Enter a description of the subject of the document.



Select this option to open the Add Custom Menu Item dialog box in which you can add a new menu option.



Click this button to delete a selected option. You can delete options you have added, but you cannot delete the 
default menu options.



Lists the custom menu items as you create them.



Click this button to move an item down on the list.



Click this button to move an item up on the list.



Click this button to add a dotted line separator in between two items on the menu. You can use this command to 
separate the menu into logical sections.



Choose a date that specifies which cleared activities you want deleted. All activities cleared prior to the date will 
be purged from the database.



Choose a date that specifies which attachments you want deleted.    All attachments created prior to the date will 
be purged from the database.



Select this option if you want to delete all of the attachments created prior to the date you specify.



Choose a date that specifies which notes you want deleted. All notes created prior to the date will be purged from 
the database.



Choose a date that specifies which histories you want deleted. All histories created prior to the date will be purged 
from the database.



Choose a date that specifies which log entries you want deleted. All log entries created prior to the date will be 
purged from the database.



Choose a date that specifies which cleared activities you want deleted. All activities cleared prior to the date will 
be purged from the database.



Choose a date that specifies which attachments you want deleted. All attachments created prior to the date will be
purged from the database.



Select this option if you want to delete activities that you cleared prior to the date you specify.



Select this option to have ACT! delete and rebuild all the index files, and to compress the database to recover 
space from deleted records. You should use this option if you have deleted a number of records as this optimizes 
the performance of your database.



Select this option if you do not want to delete and rebuild all the index files, but you still want to purge notes, 
histories, and so on.



Select this option if you want to delete all of the histories created prior to the date you specify.



Choose a date that specifies which histories you want deleted. All histories created prior to the date will be purged 
from the database.



Choose a date that specifies which transaction log entries you want deleted. All log entries created prior to the 
date will be purged from the database.



Choose a date that specifies which notes you want deleted. All notes created prior to the date will be purged from 
the database.



Select this option if you want to delete all of the notes created prior to the date you specify.



Select this option to delete and rebuild all index files. You should use this option as often as once a week to keep 
your ACT! database running efficiently.



Select this option if you want to delete synchronization transaction log entries created prior to the date you 
specify.



Select this option if you want all users of the database to be able to edit the drop-down lists from the Contact and 
Group windows.



Click this button to delete the selected drop-down item.



Click this button to export items to a delimited text file.



Click this button to import items from a delimited text file.



Enter the name and description of the drop-down item. These options are available after you click the New button.



Click this button to create a new drop-down item.



Select this option if you want the drop-down descriptions to appear in your new drop-down list. 



Enter the filename and location of the application or macro you want to launch when you enter the field you 
selected on the left side of the dialog box. You can use the Browse ("...") button to locate the application file or 
macro.



Enter the filename and location of the application or macro you want to launch when you exit the field you 
selected on the left side of the dialog box. You can use the Browse ("...") button to locate the application file or 
macro.



Select this option if you want to be able to edit history records in the currently open database.



Click this button to delete the selected index.



Select this option if you want ACT! to check for duplicate fields.



Select this option if you want ACT! to track all changes in a transaction log.



This control box shows a list of available indexes.



Select the field you want to index from the drop-down list.



Select the first field you want to use to match duplicates. Use the drop-down list to find the field you want.



Click this button to create a new index.



Select either Group or Contact to set the record type of the field for which to set indexing or matching options.



Select the fields to use for secondary sort criteria using the Then On fields' drop-down lists.



Select the fields to use for secondary sort criteria using the Then On fields' drop-down lists.



Select the fields to use for secondary match criteria. Use the drop-down list to find the fields you want.



Select the fields to use for secondary match criteria. Use the drop-down list to find the fields you want.



Click this button to remove the selected field.



Select the field you want to modify. When you modify the name of a field, the new field name appears in the Label 
field, but the field name does not change.



Click this button to add a field to the selected record type.



Select either Group or Contact as a record type for the field you want to modify.



Select this option if you do not want the selected field to be available for data synchronization.



Enter a default value for the selected field. This value will always be entered in the field automatically.



Enter a default value for the selected field. This value will always be entered in the field automatically.



Select an entry rule option from the drop-down list. Choose Protected to protect the field from being modified. 
Select Only From Drop-down to specify that information must be selected from a drop-down that appears when the
user clicks the field. Select Required to specify that data is required and the field cannot be left blank. If you do not
want any entry rules, select None.



Specify how the data in a Character, Initial Capitals, Lowercase or Uppercase field will be automatically formatted. 
Use these placeholders: "#" as numeric, "@" as alphabetic, and "%" as alphanumeric.



Specify how the data in a Character, Initial Capitals, Lowercase or Uppercase field will be automatically formatted. 
Use these placeholders: "#" as numeric, "@" as alphabetic, and "%" as alphanumeric.



This displays the field you selected in the field list. You can enter a new name for the field or change the name that
is displayed.



Select this option to create a history when the field is updated.



Select this option to make the selected field a primary field. You can copy the primary fields from the current 
record to a new record.



Enter a number to specify how many characters the selected field can hold.



Enter a number to specify how many characters the selected field can hold.



Select a field type from the drop-down list.



Click this button to add new sections to the report template.



Displays the sections currently included in the report template. By default, every report template has a Header, 
Contact, and Footer section.



Click this button to edit the selected section's properties.



Click this button to remove the selected section.



Click this button to change the section order by moving the selected item down. 



Click this button to change the section order by moving the selected item up. 



Click this button to specify the name of a new tab layout in the Add Tab Layout dialog box.



Click this button to remove the selected tab layout from the list.



This control shows the available tabs.



Click this button to move the selected layout down in the list.



Click this button to move the selected layout up in the list.



Click this button to specify a new name for the selected tab layout in the Rename Tab Layout dialog box.



Click this button to add a new user to the shared database.



Click this button to remove the selected user from the shared database. In the Delete User dialog box select either 
the Delete Records option or the Reassign To Another User option. In response to the confirmation message, click 
Yes to delete the user.



This control list show which users have access to the shared database. To add or delete a user, click the user's 
name in this list. The name will be highlighted until you click another name, delete the user's account, or add a 
new account. While a name is highlighted, all changes you make apply only to the highlighted user.



Select this option if you want to receive database field definitions when you receive synchronization updates from 
the current user.



Select the group to which you want to add contacts when you receive synchronization updates from the selected 
user.



Select the group to which you want to add contacts when you receive synchronization updates from the selected 
user.



Displays the date on which you last received a synchronization update from the current user.



Displays the date on which you last received contact information. 



Select this option if you want to receive private data when you receive synchronization updates from the current 
user.



Use the options in this group box to specify settings for the user when receiving contact data.



Enter the e-mail address, shared folder location, or modem number. You can use the Browse ("...") button to locate 
and select an e-mail address or shared folder location.



Select this option to include changes to all contacts and groups when sending synchronization updates.



Select a synchronization update method from the drop-down list.



Select a synchronization update method from the drop-down list.



Enter the e-mail address, shared folder location, or modem number to be used when sending synchronization 
updates to the current user. You can use the Browse ("...") button to locate and select an e-mail address or shared 
folder location.



Select the groups to include when sending synchronization updates.



Displays the date on which you last sent a synchronization update to the selected user.



Select this option to include changes only to specific groups when sending synchronization updates.



Select this option to include all records when sending the next synchronization update. Generally, you will select 
this option only the first time you    send a synchronization update to the current user.



Select this option to include database field definitions, including new and modified fields and field drop-down list 
definitions, when sending synchronization updates.



Select this option to include private data when sending synchronization updates to the current user.



Select this option to enable the selected user to log on to the database. For synchronization, you don't need to 
select this option.



Select this option if you want to be able to synchronize data with the selected user.



Enter a password for the selected user. The password can be up to 10 characters. The password is optional and 
can be left empty. Passwords are not case-sensitive.



Select an option from the Security Level drop-down list.



Enter the name of the user you want to have access to the shared database or with whom you want to exchange 
synchronization data.



Select this option to delete all of the user's records when you delete the user from the database. 



Shows you which user you are about to delete from the database.



Select this option to assign the user's records to another user.



Choose a user for whom to assign the records.



Choose a user for whom to assign the records.



Displays any attachments that are with the selected item.



Displays the date of the selected note, history, or attachment.



Select a group from the drop-down list.



Select a group from the drop-down list.



Displays the time of the selected note, history, or attachment.



Displays the type of the item, such as a note, history, or attachment.



Displays the user who created the item.



Select this option if you want to copy all of the fields when duplicating a record.



Select this option to copy the data only from the primary fields when duplicating a record. You can view the 
existing primary fields and specify other primary fields in the Define Fields dialog box. This option is useful if, for 
example, you are adding numerous contacts to the database who all work at the same company. 



Enter the e-mail address for the current contact, or click the Browse ("...") button. You can then log on to the 
selected e-mail system and browse through the address list to locate your contact's address.



This group box displays a list of a contact's current e-mail addresses and their respective e-mail systems.



Click this button to delete the selected e-mail address.



Enter the e-mail address for the current contact, or click the Browse ("...") button. You can then log on to the 
selected e-mail system and browse through the address list to locate your contact's address.



Select an e-mail system from the drop-down list.



Click this button to make the selected address the primary e-mail address for the contact. The primary address is 
automatically used when you send e-mail to a contact.



Click this button to enter additional e-mail addresses for the contact. Then select an e-mail system and enter the 
address.



Enter an e-mail system not supported by ACT! here if the contact uses one. Addresses for unsupported mail 
systems can only be used for informational purposes.



Enter an e-mail system not supported by ACT! here if the contact uses one. Addresses for unsupported mail 
systems can only be used for informational purposes.



Select this option if the e-mail system is accessed through a local area network.



Select this option if the e-mail system is accessed remotely with a modem.



Enter your password for the e-mail system.



Enter the location of the post office for the e-mail system.



Enter your user name for the e-mail system.



Displays your address book and lets you locate the e-mail address of the recipient of your message.



Enter the address of the person or persons to whom the e-mail message is being sent and press Enter.



Displays the name of the person or persons to whom the e-mail message is being sent.



Lists any attachments associated with the current e-mail message.



Lists any attachments associated with the current e-mail message.



Displays when the e-mail message was sent.



Lists who sent the e-mail message.



Select this option to designate the e-mail message as high priority.



Select this option to designate the e-mail message as low priority.



Type the body of your e-mail message in this area.



Select this option to designate the e-mail message as normal priority.



Specify the priority level of your e-mail message. Options are High, Normal, and Low.



Check this box to receive a receipt indicating when the recipient reads the e-mail message.



Type the subject of your e-mail message in this box.



Type the subject of your e-mail message in this box.



Displays when the e-mail message was sent.



Click this button to select To, CC, or BCC from the drop-down list. 



Specify a recipient for the e-mail message after you select a post office.



Specify your password for the post office.



Specify a recipient for the e-mail message after you select a post office.



Click this button to add a new drop-down item to the list.



Click this button to remove the selected drop-down item from the list. ACT! permanently deletes the selected topic
when you click the Delete button. If you inadvertently delete a topic, you will need to re-enter the topic in the list 
by using the Add New Drop-down Item dialog box.



Displays the items in the drop-down list.



Click this button to edit the selected drop-down item. You can change the item name or description.



Enter your address in these fields.



Enter your address in these fields.



Enter your address in these fields.



Enter the city in which you reside in this field.



Enter the name of the company for which you work.



Enter the name of the country in which you live in this field.



Enter your phone extension, if applicable, in this field.



Enter your name in this field.



Enter your phone number in this field.



Click this button to choose an existing contact record to use as the My Record.



Enter the abbreviation for the state in which you reside in this field.



Enter your zip code in this field.



Select an envelope size from the drop-down list. If you do not see the size you want, choose Custom to create your
own size.



Specify the vertical dimensions of the envelope being used.



Specify the vertical dimensions of the envelope being used.



Specify the horizontal dimensions of the envelope being used.



Specify the horizontal dimensions of the envelope being used.



Click the Browse ("...") button and select the file to which you want to export the items. You can also simply enter 
the name of a new file if you know it.



Click the Browse ("...") button and select the file to which you want to export the items. You can also simply enter 
the name of a new file if you know it.



Select this option if you want to export descriptions with the drop-down items.



Select this option if you want to include drop-down descriptions when you export data.



Choose a delimited text file to which to export drop-down data.



Displays the location and name of the ACT! 3.0 file to which you want to export data. Click the Browse (...) button 
to open the Open dialog box, where you can locate the file to which you want to export data.



Click this button to return to the previous wizard panel.



Select ACT! 3.0 (*.DBF), if it is not already selected, from the drop-down list. To export data to another application, 
choose Text-Delimited.



Displays the location and name of the ACT! 3.0 file to which you want to export data. Click the Browse ("...") button
to locate the destination database you want and click Open. If you are exporting data to another application, 
locate the file and click Save. To export data to a new database, you can simply enter the name of a new ACT! 3.0 
database.



Click this button to export your data.



Click this button to proceed to the next wizard panel.



Click this button to return to the previous wizard panel.



Select this option to export both contact and group records. This option is not available when you export to 
another application other than an ACT! 3.0 database, when you will need to go through the export process twice 
by first saving and exporting contact records, then doing the same procedure with group records.



Select this option to export contact records.



Click this button to export your data.



Select this option to export group records.



Click this button to proceed to the next wizard panel.



Click this button to open the Merge Options dialog box in which you can choose source and destination records for 
matching fields during a merge of data. If you are exporting to an application other than an ACT! 3.0 database, you
will see the Export Options dialog box, in which you can select field separators and choose to export field names.



Select this option to export all the records in your database.



Click this button to return to the previous wizard panel.



Select this option to export the current lookup.



Select this option to export the current record.



Click this button to finish the wizard and export your data to a delimited text file. If you are exporting to an ACT! 
database, you need to go the next panel.



Click this button to proceed to the next wizard panel.



Click this button to return to the previous wizard page.



Click this button when you have completed the entire wizard procedure.



Click this button to load a map file specifying how the fields are ordered.



Click this button to proceed to the next page of the wizard.



Specify the order in which the fields will be exported.



Click this button to save the current field order to a map file for later use.



Click this button to return to the previous wizard page.



Click this button when you have completed the entire wizard procedure.



Click this button to load a map file specifying how the fields are ordered.



Click this button to proceed to the next page of the wizard.



Click this button to save the current field order to a map file for later use.



Click this button to scroll through the records of the current database so you can see if the fields are mapped 
correctly for export.



Click this button to scroll through the records of the current database so you can see if the fields are mapped 
correctly for export.



Click this button to return to the last page of the wizard.



Click this button to finish the wizard and export your data to the destination database.



Click this button to reuse a map file you previously created and saved.



Displays the current map file, if any.



Click this button to proceed to the next page of the wizard.



Displays the current record number.



This control displays lists of the fields in your database and lists of the fields in the destination database. Using 
these lists, you can change the mapping of the fields. To map fields, select the field you want to export and double-
click the corresponding row in the column at the right. A drop-down list of field names appears. Select the field to 
which you want to export the selected field. For example, you might export "Contact" to "person." You need to do 
this procedure for each field name that doesn't map to the destination field.



Click this button to restore the default mapping.



Click this button to save the current field order to a map file for later use.



Click this button to scroll through the records of the current database so you can see if the fields are mapped 
correctly for export.



Click this button to scroll through the records of the current database so you can see if the fields are mapped 
correctly for export.



Click this button to return to the previous page of the wizard.



Click this button to finish the wizard and export your data to the destination database.



Click this button to load a map file specifying how the fields are ordered.



Displays the current map file, if any.



Click this button to proceed to the next page of the wizard.



Displays the current record number.



This control displays lists of the fields in your database and lists of the fields in the destination database. Using 
these lists, you can change the mapping of the fields. To map fields, select the field you want to export and double-
click the corresponding row in the column at the right. A drop-down list of field names appears. Select the field to 
which you want to export the selected field. For example, you might export "Contact" to "person." You need to do 
this procedure for each field name that doesn't map to the destination field.



Click this button to undo any changes you made to the current unsaved map.



Click this button to save the current field order to a map file for later use.



Click this button to add the selected field to the layout.



Select this option if you want a text label to appear next to the selected field in the layout.



Select a field from the list to add to the layout.



Enter the name that you want to appear in the layout or template drop-down menu.



Enter the name that you want to appear in the layout drop-down menu.



Select this option to filter activities by date.



Choose the priority levels by which you want to filter.



Choose the types of activitiesby which you want to filter.



Select this option to display all activities regardless of their scheduled date.



Select this option to display all users' activities on lists.



Click this button to implement the selections you make in this dialog box.



Select this option to display calls.



Select this option to display all activities scheduled within a certain range of dates.



Select this option to display all activities scheduled within a certain range of dates.



Select this option to display all activities that were scheduled after today's date.



Select this option to display activities with a high priority level.



Select this option to display activities with a low priority level.



Select this option to display activities with a medium priority level.



Select this option to display meetings.



Select this option to display all activities that were scheduled before today's date.



Select this option to display only the selected users' activities on lists.



Select this option if you would like to view activities that have been cleared.



Select this option to display only activities that you want to do on a particular day at an unspecified time.



Select this option to display to-do's.



Select this option to display all activities scheduled for today's date.



Select the users for whom to display activities.



Choose the priorities of activities you want displayed in the calendar.



Choose the activity type you want displayed in the calendar.



Select this option to display all the users' activities on the calendars.



Click this button to implement the selections you make in this dialog box.



Select this option to display calls.



Select this option to display activities with a high priority level.



Select this option to display activities with a low priority level.



Select this option to display activities with a medium priority level.



Select this option to display meetings.



Select this option to apply the filter options to display the selected users' activities on the calendars. 



Select this option to display to-do's.



Select the users of whom to display activities on the calendars. 



Select this option to display all users' notes, histories, and attachments on the tab.



Select this option to display all users' notes, histories, and attachments on the tab.



Click this button to implement the options you selected.



Select this option to display attachments associated with this contact.



Select this option to display notes, histories, and attachments within a selected date range.



Select this option to display notes, histories, and attachments with dates later than today's date.



Select this option to display histories associated with this contact.



Select this option to display notes associated with this contact.



Select this option to display notes, histories, and attachments with dates previous to today's date.



Select this option to display notes, histories, and attachments within a selected date range.



Select this option to display the selected users' notes, histories, and attachments on the tab.



Select this option to display notes, histories, and attachments with today's date.



Select the users for which to display the selected user's notes, histories, and attachments on the tab.



Click this button to add the selected contacts from the list at the left to the list at the right. The list at the right of 
the dialog box displays the contacts who are members of the selected group.



Select this option to display all contacts available for selection. You can then select one or multiple contacts to add
to the group.



Select this option to display contacts from the current lookup only. You can then select one or multiple contacts to 
add to the group.



Displays the name of the group you selected in the Groups window. This is the group to which you will add 
members. You can also delete members from the group.



Choose the group you want to edit.



Lists the contacts belonging to the group shown in the Edit Group field.



Click this button to remove a contact from the group list at the right. Only the contact(s) selected in the list at right
are removed.



Click this button to select all the contacts that appear in the list at the left which consists of the selected contacts 
as specified in the Select Contacts From information above. You can then add all of the contacts to the new or 
edited group using the Add button.



Lists the contacts available for selection.



Select this option to display contacts from a specific group. You can then select one or multiple contacts to add to 
the group.



Select this option if you want to add imported items to the existing drop-down items.



Select a delimited text file you want to import. Click the Browse ("...") button to find the file and click Open.



Select this option if the delimited text contains descriptions of items.



Choose a filename and path where the file to be imported is located. If you do not know the path, click the Browse 
("...") button to open the Open dialog box, where you can choose a path.



Click this button to return to the previous wizard panel.



Click the down arrow to display a drop-down list of other import file types and select ACT! 3.0. If you do not see the
file type that you want, you may need to convert your existing file to a delimited text file.



Choose a filename and path where the file to be imported is located. If you do not know the path, click the Browse 
("...") button to open the Open dialog box, where you can choose a path.



Click this button to finish the wizard.



Click this button to proceed to the next wizard panel.



Click this button to return to the previous page of the wizard.



Select this option to import contact and group records.



Select this option to only import contact records.



Click this button to finish the wizard.



Select this option to only import group records.



Click this button to proceed to the next page of the wizard.



Click the Options button to open the Merge Options dialog box, in which you can choose additional options and 
specify how to handle duplicate records.



Click this button to return to the previous page of the wizard.



Select this option if you do not want to use a predefined map file to help you import data from other applications.



Click this button to finish the wizard.



Select the map you would like to use when you import your data.



Click this button to proceed to the next page of the wizard.



Select this option if you want to use a predefined map file when you import data from other applications.



Click this button to scroll through the records of the current database to see if the fields are mapped correctly for 
import.



Click this button to scroll through the records of the current database to see if the fields are mapped correctly for 
import.



Click this button to return to the previous page of the wizard.



Click this button to finish the wizard.



Click this button to open the Open dialog box in which you can choose a map file you previously saved, which 
specifies how the fields are ordered.



Displays the current map file, if any.



Click this button to proceed to the next page of the wizard.



Use this section to specify each field of the current database into which you want to import the corresponding 
document field.



Click this button to clear the fields in the "To this field" area and use the default map. 



Click this button to open the Save dialog box in which you can save the current field order to a map file for later 
use.



Click this button to scroll through the records of the current database to see if the fields are mapped correctly for 
import.



Click this button to scroll through the records of the current database to see if the fields are mapped correctly for 
import.



Click this button to return to the previous page of the wizard.



Click this button to finish the wizard.



Use this section to specify each field of the current database into which you want to import the corresponding 
document field.



Click this button to open the Open dialog box in which you can choose a map file you previously saved, which 
specifies how the fields are ordered.



Displays the current map file, if any.



Click this button to proceed to the next page of the wizard.



Displays the current record number.



Click this button to clear the fields in the "To this field" area and use the default map. 



Click this button to open the Save dialog box in which you can save the current field order to a map file for later 
use.



Click this button to change the invalid e-mail address.



Displays the invalid ID.



Shows the invalid e-mail message recipient's name.



Shows the e-mail system of the invalid message.



Specify how many labels appear across the page horizontally by clicking the up or down arrows or by entering a 
value directly in the field.



Specify how many labels appear down the page vertically by clicking the up or down arrows or by entering a value 
directly in the field.



Specify the amount of space between the top edge of the label and the text by clicking the up or down arrows or 
by entering a value directly in the field.



Specify the amount of space left between the outer left edge of the label and the text by clicking the up or down 
arrows or by entering a value directly in the field.



Specify the width of the label by clicking the up or down arrows or by entering a value directly in the field.



Specify the height of the label by clicking the up or down arrows or by entering a value directly in the field.



Specify the amount of vertical space between the individual labels on sheet of labels by clicking the up or down 
arrows or by entering a value directly in the field.



Specify the amount of horizontal space between the individual labels on a sheet of labels by clicking the up or 
down arrows or by entering a value directly in the field.



Specify how many labels appear across the page horizontally by clicking the up or down arrows or by entering a 
value directly in the field.



Specify how many labels appear down the page vertically by clicking the up or down arrows or by entering a value 
directly in the field.



Specify the height of the label by clicking the up or down arrows or by entering a value directly in the field.



Specify the amount of horizontal space between the individual labels on a sheet of labels by clicking the up or 
down arrows or by entering a value directly in the field.



This control shows how the various controls affect the printed label.



Select a predefined label layout from the drop-down list, or enter a new name for a label layout.



Specify the amount of space left between the outer left edge of the label and the text by clicking the up or down 
arrows or by entering a value directly in the field.



Displays a preview of the sheet of labels.



Specify the amount of space between the top edge of the label and the text by clicking the up or down arrows or 
by entering a value directly in the field.



Specify the amount of vertical space between the individual labels on sheet of labels by clicking the up or down 
arrows or by entering a value directly in the field.



Specify the width of the label by clicking the up or down arrows or by entering a value directly in the field.



Displays the current specified range of contacts that will be included in the data transfer.



Shows the date that data was last sent to a Personal Digital Assistant.



Click this button to link to a specified Personal Digital Assistant so you can send or receive ACT! data. You can use 
this option after you have completed the link setup procedure.



This displays the name of the currently selected personal digital assistant. To change this, click Setup.



Select this option if you want to receive ACT! data from a specified Personal Digital Assistant.



Shows the current selected date range that will apply when you receive data from the Personal Digital Assistant.



Select this option if you want to send ACT! data to a specified Personal Digital Assistant.



Select this option if you want to both send and receive ACT! data to and from a specified Personal Digital Assistant.



Shows the current selected date range that will apply when you send the data to the Personal Digital Assistant.



Click this button to open the Link Wizard and complete the setup procedure.



Choose your Personal Digital Assistant's baud rate.



Choose the communications port to which the Personal Digital Assistant is connected.



Click this button to return to the last page of the wizard.



Click this button to finish the Link Setup Wizard.



Click this button to proceed to the next Link Setup Wizard panel.



Click this button to specify the COM port to which the Personal Data Assistant is connected.



Select the type of Personal Data Assistant with which you want to link.



Specify which activities you want to include in the data transfer. You can specify a date range of activities or select 
None.



Select this option if you want to include the information from all contacts in the data transfer.



Click this button to return to the previous Link Setup wizard panel.



Select this option if you want to include the current contact's information in the data transfer.



Select this option if you want to include the information from the current lookup in the data transfer.



Select this option if you want to include field labels in the data transfer.



Select this option if you want to include field drop-down lists in the data transfer.



Click this button to finish the Link Setup wizard.



Select this option if you want to include only the current group's information in the data transfer.



Select this option if you want to include only the current group's information in the data transfer.



Click this button to proceed to the next Link Setup wizard panel.



Specify which notes and histories you want to include in the data transfer. You can specify a date range of 
notes/histories or select None.



Select this option if you want to include contacts from all dates when you send data to the Personal Digital 
Assistant.



Select this option if you want to include contacts from all dates when you send data to the Personal Digital 
Assistant.



Click this button to return to the previous Link Setup wizard panel.



Select this option if you want to include contacts from a specified date range when you send data to the Personal 
Digital Assistant. Click the down arrow to view a drop-down date selector from which you can choose a specified 
date range. Select the date range by dragging through the dates you want and releasing the mouse on the ending 
date. Drag off the right side of the calendar to select more than one month. Click outside the date selector to apply
the date range.



Select this option if you want to include contacts from a specified date range when you send data to the Personal 
Digital Assistant. Click the down arrow to view a drop-down date selector from which you can choose a specified 
date range. Select the date range by dragging through the dates you want and releasing the mouse on the ending 
date. Drag off the right side of the calendar to select more than one month. Click outside the date selector to apply
the date range.



Select this option if you want to include contacts from a specified date range when you receive data from the 
Personal Digital Assistant. Click the down arrow to view a drop-down date selector from which you can choose a 
specified date range. Select the date range by dragging through the dates you want and releasing the mouse on 
the ending date. Drag off the right side of the calendar to select more than one month. Click outside the date 
selector to apply the date range.



Select this option if you want to include contacts from a specified date range when you receive data from the 
Personal Digital Assistant. Click the down arrow to view a drop-down date selector from which you can choose a 
specified date range. Select the date range by dragging through the dates you want and releasing the mouse on 
the ending date. Drag off the right side of the calendar to select more than one month. Click outside the date 
selector to apply the date range.



Click this button to finish the Link Setup wizard.



Click this button to proceed to the next Link Setup wizard panel.



Use the options in this group box to select a range of contacts to receive when linking to the PDA.



Select this option if you want to include only contact data from the last link when receiving data from the Personal 
Digital Assistant.



Click this button to scroll through the records of the current database so you can see if the fields are mapped 
correctly.



Click this button to scroll through the records of the current database so you can see if the fields are mapped 
correctly.



Click this button to return to the previous Link Setup wizard panel.



Click this button to finish the Link Setup wizard.



Click this button to load a map file specifying how the fields are ordered.



Click this button to proceed to the next Link Setup wizard panel.



Match up each Personal Digital Assistant field with the appropriate field in your database.



Click this button to save the current field order to a map file for later use.



Specify the amount of time, by using the drop-down list, until users are automatically logged off the database.



Specify the amount of time, by using the drop-down list, until users are automatically logged off the database.



This control displays the users currently logged on to the database.



Enter your password for the database.



Enter your user name for the database.



Select this option if you want ACT! to remember your password the next time you log on to this database.



Select this option to add the contacts found during the current lookup to the group of contacts found during the 
previous lookup.



Enter the search criterion. This option varies, depending on the command you used to open the dialog box. For 
example, if you chose the City command, you can enter Amsterdam in the Enter the City To Be Found field.



Enter the search criterion. This option varies, depending on the command you used to open the dialog box. For 
example, if you chose the City command, you can enter Amsterdam in the Enter the City To Be Found field.



Select this option to search the already existing lookup list for contacts matching the current lookup criterion. 



Select this option to replace contacts found during the previous lookup with the contacts found during the current 
lookup.



Select this option to search for matching keywords in the activities scheduled for contacts.



Select this option to search for matching keywords in the fields of contact records.



Select this option to search for matching keywords in the e-mail addresses of contacts.



Select this option to search in groups for the specified keyword.



Type a word or phrase that you want to find. You can also use wildcards.



Select this option to search for matching keywords in the notes and history of contact records.



Select this option if you want to add the contacts found using the lookup criteria to the current lookup. Search 
results will probably create a larger lookup than the current lookup.



Select a field on which to perform a lookup from the Available Fields drop-down list. If a field is not indexed, it will 
not appear in this list.



Enter the search criteria. This option varies, depending on the field specified in Available fields. For example, if you
chose the City field in Available Fields, you can enter Chicago in the Enter the City To Be Found field.



Enter the criteria for searching the selected field.



Select this option to search the already existing lookup list for contacts matching the current lookup criterion. 



Select this option to replace the contacts found during the previous lookup with the contacts found during the 
current lookup.



Choose the contact to whom you want to send mail.



Click this button to add the matching record to the open database.



Lists the duplicate fields in the record being merged. By default, ACT! considers two contact records to be 
duplicates if they have the same company name, contact name, and phone number.



Lists the duplicate fields in the record being merged. By default, ACT! considers two contact records to be 
duplicates if they have the same company name, contact name, and phone number.



Lists the duplicate fields in the record being merged. By default, ACT! considers two contact records to be 
duplicates if they have the same company name, contact name, and phone number.



Lists the duplicate fields in the record being merged. By default, ACT! considers two contact records to be 
duplicates if they have the same company name, contact name, and phone number.



Lists the duplicate fields in the record being merged. By default, ACT! considers two contact records to be 
duplicates if they have the same company name, contact name, and phone number.



Lists the duplicate fields in the record being merged. By default, ACT! considers two contact records to be 
duplicates if they have the same company name, contact name, and phone number.



Displays the records or record in the open database that match the record being merged.



Click this button to merge this new record into the selected record in the open database.



Click this button to skip the record entirely and neither merge nor add it to the open database.



Choose to either merge activity records, replace with the source activity records, or make no change.



Choose either to add the activity records or not to add the activity records. 



Select this option if you want to review each contact or group record that matches a contact or group record in the 
open database.



Choose to either replace the contact record with the newest contact record, replace the record with the source 
contact record, or make no change.



Choose either to add the contact records or not to add the contact records.



Click this button to reset the merge options to the default settings.



Choose to replace with the newest group records, replace with the source group records, or make no change.



Choose to replace with the newest group records, replace with the source group records, or make no change.



Select this option if you want all public activities to be included in the merge.



Choose to merge notes/history, replace with the source notes/history, or make no change.



Choose to add the notes/history records or not to add the notes/history records.



Change the description of the drop-down item.



Change the description of the drop-down item.



Change the name of the drop-down item.



Select the folder you want to copy or to which you want to move the message.



The new prefix or suffix will be added to the Name prefixes and suffixes list in the Preferences dialog box, Names 
tab. You will then be able to choose this prefix or suffix when adding a new record.



Lists the file types available for creating new databases and word processor documents and templates. The file 
types displayed will be different if you choose New from the File menu while in the ACT! word processor.



Select this option to show attachments in the list below.



Click this button to view various details about the selected activity.



Select this option to show histories in the list below.



Click this button to insert a note for the current record.



Select this option to show notes in the list below.



Displays a preview of how the selected field will look using the current settings.



Displays a preview of how the selected field will look using the current settings.



This displays the data type of the selected field. You cannot change the field type in this dialog box.



Choose to what number of decimal places you want numbers to appear in the selected field.



Choose to what number of decimal places you want numbers to appear in the selected field.



This displays the name of the selected field. You cannot edit the field name in this dialog box.



Choose how you want negative numbers to appear in the selected field.



Choose how you want negative numbers to appear in the selected field.



Choose to what number of decimal places you want numbers to appear in the selected field.



Click this button to add a new area code or country code.



Select this option to show area codes in the phone number list.



Select this option to show country codes in the phone number list.



Click this button to delete an area code or country code. 



Displays a list of phone number area codes and country codes. 



Click this button to edit an area code or country code.



Click this button to implement any changes you made in the dialog box.



Choose a time increment for the Daily calendar. For example, if you choose 30 Minutes, the Daily calendar will be 
divided into 30-minute time slots.



Select this option if you want Monday to be displayed as the first day of the week on the Weekly and Monthly 
calendars.



Specify the hour that you want to appear as the starting time for the Daily and Weekly calendars.



Select this option if you want Sunday to be displayed as the first day of the week on the Weekly and Monthly 
calendars.



Choose a time increment for the Weekly calendar. For example, if you choose 1 Hour, the Weekly calendar will be 
divided into 1-hour time slots.



Select this option to have the Mini-Calendar display only one month instead of three months.



Click this button to implement any changes you made in the dialog box.



Displays the current background color in the selected window. Click the drop-down arrow and select a color from 
the palette to change the background colors.



Displays the current font used in the selected window or the font you selected in the Font dialog box.



Click this button to change the font, style, and size of text.



Select the window whose colors and fonts you want to change. You can create a unique look for each window by 
choosing different settings for each window. You can also create a uniform look for all of your windows by choosing 
the same settings for each window. 



Displays the text as you make various changes.



Select this option to have grid lines appear between rows and columns in any of the list views.



Displays the current point size used in the selected window or the point size you selected in the Font dialog box.



Displays the current font style used in the selected window or the font style you selected in the Font dialog box.



Displays the current text color in the selected window. Click the drop-down arrow and select a color from the 
palette to change colors.



Select this option if you prefer to receive a confirmation message when you delete e-mail messages.



Select this option to create a history whenever you send an e-mail message.



Choose how often you want ACT! to check for new mail.



Enter text here that will appear at the beginning of all of your e-mail messages.



Choose how often you want ACT! to notify you if there is new mail.



Select this option to have ACT! check for new mail at regular increments that you determine. When this option is 
checked and you are logged into your e-mail system, a flashing icon in the status area notifies you of new e-mail 
messages. 



Select this option to have ACT! check for new mail at regular increments that you determine. When this option is 
checked and you are logged into your e-mail system, a flashing icon in the status area notifies you of new e-mail 
messages. 



Specify the default folder location for the selected file type. Click the Browse ("...") button to display the Browse for
Folder dialog box, and specify the folder's location.



Select this option if you want the country code always to appear in the phone fields throughout ACT!.



Click this button to implement any changes you made in the dialog.



Select this option to use the Enter key to move from field to field.



Select the fax software you want from the drop-down list.



Choose the type of file whose default location you want to specify.



Specify the default folder location for the selected file type. Click the Browse ("...") button to display the Browse for
Folder dialog box, and specify the folder's location.



Select this option if you want to use the shortcut keys from ACT! 2.0 to move between records (Ctrl+Home, 
Ctrl+End, Page Down, Page Up) instead of the ACT! 3.0 shortcut keys (Alt+Home, Alt+End, Ctrl+Page Down, 
Ctrl+Page Up).



Select this option if you wish to be shown a confirmation message before exiting ACT!.



Select this option if you want ACT! to remember your password every time you open a database.



Select this option to use the tab key to move from field to field.



Select an application you want from the drop-down list. 



Click this button to add a name prefix or suffix.



Click this button to implement any changes you made in the dialog box.



Select this option if you do not want ACT! to automatically fill in a salutation when writing letters and memos.



Select this option to view, add, or delete items from a list of first name prefixes. When you Select this option, a list 
of first name prefixes appears in the box at right.



Select this option to view, add, or delete items from a list of last name prefixes. When you Select this option, a list 
of last name prefixes appears in the box at right. If you want a last name prefix to be ignored when performing 
lookups, delete the prefix from the list.



Select this option to view, add, or delete items from a list of last name suffixes. When you Select this option, a list 
of last name suffixes appears in the box at right. 



Displays a list of name prefixes and suffixes.



Click this button to remove the selected name prefix or suffix. ACT! permanently deletes the selected item when 
you click the Remove button. If you inadvertently delete an item, you will need to re-enter the item in the list by 
using the Name Prefix/Suffix dialog box.



Select this option if you want to use the contact's first name as the default salutation.



Select this option if you want to use the contact's last name as the default salutation.



Choose the type of activity for which you want to set preferences. Choose Calls, Meetings, or To-do's. 



Choose the default alarm lead time for the selected activity in the drop-down list. The alarm will sound to give you 
this amount of time before the activity takes place.



Click this button to implement any changes you made in the dialog box.



Select this option to roll over calls.



Select this option to make all new activities public by default. Public activities can be viewed by all users of a 
shared database.



Select this option to make activities timeless. A timeless activity is one you want to do on a specific day, at an 
unspecified time.



Choose the default duration for the selected activity from the drop-down list.



Select this option if you want to receive an alert message when you schedule an activity that conflicts with or 
overlaps another activity.



Select this option to dim the activity when it is cleared.



Select this option to roll over meetings.



Select a default priority for the selected activity in the drop-down list. Choose high, medium, or low. 



Select this option to delete the activity when it is cleared.



Select this option to enable the alarm by default when scheduling activities.



Select this option to strike out (show the activity with a line through it) when it is cleared.



Select this option to roll over to-do's.



Select this option if you want to begin with a specific database at startup. If you Select this option, select the 
database using the Browse ("...") button to find the database file location.



Choose a group layout that will open by default.



Choose a macro to run automatically every time ACT! starts. If you Select this option, select the macro using the 
Browse ("...") button to find the macro file location.



Choose a contact layout to use as the default every time you start ACT!.



Click this button to implement any changes you made in the dialog box.



Select a contact layout to use as the default each time you start ACT!.



Choose a group layout that will open by default.



Select this option if you want to start up with the database that was last opened.



Select this option if you want to make all new contacts private.



Select this option if you want to make all new groups private.



Select this option if you want to begin with a specific database at startup. If you Select this option, select the 
database using the Browse ("...") button to find the database file location.



Select this option if you want to start up with a specific database. If you Select this option, select the database 
using the Browse ("...") button to find the database file location.



Choose a macro to run automatically every time ACT! starts. If you Select this option, select the macro using the 
Browse ("...") button to find the macro file location.



Choose which field you want to use as the second column in the Groups window.



Click this button to implement any changes you made in the dialog box.



Select this option if you want ACT! to display a reminder if you do not perform a synchronization within a certain 
number of days. 



Select this option if you want ACT! to display a reminder if you do not perform a synchronization within a certain 
number of days. 



Select this option if you want ACT! to display a reminder if you do not perform a synchronization within a certain 
number of days. 



Choose how often you want automatic synchronization to occur between the starting and stopping times. 



Select this option if you want synchronization to occur every Friday.



Choose the time you want automatic synchronization to start.



Choose how often you want automatic synchronization to occur between the starting and stopping times. 



Choose the number of days ACT! will wait before reminding you to perform a synchronization.



Choose how often you want ACT! to clear the transaction log (the list of field-by-field changes to a database). For 
efficient synchronization, you should purge the transaction log regularly. Be sure not to purge the transaction log 
too frequently; if you purge the transaction log of changes that have not yet been synchronized, they will be lost.



Select this option if you want synchronization to occur every Monday.



Choose how often you want ACT! to clear the transaction log (the list of field-by-field changes to a database). For 
efficient synchronization, you should purge the transaction log regularly. Be sure not to purge the transaction log 
too frequently; if you purge the transaction log of changes that have not yet been synchronized, they will be lost.



Select this option if you want synchronization to occur every Saturday.



Select this option if you want synchronization to occur every Sunday.



Select this option if you want synchronization to occur every Thursday.



Select this option if you want synchronization to occur every Tuesday.



Choose the time you want automatic synchronization to stop.



Click this button to enter Wait For Calls mode in order to receive synchronization updates by modem. 



Select this option if you want synchronization to occur every Wednesday.



Select this option to create a form letter only for the active contact.



Select this option to create a form letter only for the contacts in the current lookup.



Select this option to create a form letter for all contacts in your database.



Select this option to send the merge output to a word processing document.



Select this option to send the merge output as an e-mail message.



Select this option to e-mail the form letter as an attachment or in the message body.



Select this option to send the merge output as a fax.



Select this option to send the merge output to the printer.



Enter the subject of the form letter.



Enter the subject of the form letter.



Select this option to create merged letters only for the active contact.



Select this option to create merged letters only for the contacts in the current lookup.



Select this option to create merged letters for all contacts in your database.



Select this option to create a history of your sending the document, e-mail, or fax.



Select this option to send the merge output as an e-mail message.



Select this option to send the merged letters as fax transmissions and then record a history in each contact's 
record.



Select this option to send the merge output to a specific file.



Select this option to send the all the merged letters to the printer.



Enter the subject of the form letter.



Enter the subject of the form letter.



Click this button to make changes to the selected template.



This control displays the formats available for the printout type you selected. You can choose from a variety of 
sizes and layouts for your printout, including popular formats like DayRunner, Day-Timer, Franklin, or Avery. 
European A4 and A5 paper sizes are supported for these formats.



Click this button to set options if you want to set activity and date range options for your calendar printouts. You 
can also choose whether to use the company name, print a five-week view, or add Saturday and Sunday activities.



Displays a preview of the form you want to print.



Click this button to set printer options using the Windows Print Setup dialog box.



Choose an address book, a day, week or month calendar, a report printout, a label printout, or an envelope.



Select this option if you want to see a preview of the selected print setup. The preview shows the format you 
chose.



Click this button to close the Query Helper.



Displays a list of dimmed field names. Choose a field name to insert into the query.



Click this button to place the selected item into a query. You can also double-click the operator.



Choose an operator to insert into the query.



Choose a result for the completed activity from the drop-down list. 



Enter a description for the activity, or choose a description from the drop-down list. To add more results to the list, 
choose Edit List to display the Edit List dialog box in which you can add a custom topic. You can also modify or 
delete a topic. 



Enter a description of what the macro does.



Enter a name for the macro you are creating.



Select an option to specify which events you want to record. Choose Everything, Record Clicks and Drags (mouse 
events), or Everything But Mouse Events.



Click this button to try to modify the record again.



Displays the records that could not be modified because they are locked by another user.



Enter the new name for the selected tab.



Select this option if you want to include the original attachments when you forward or reply to the message.



Select this option if you want to include the original message in your reply message.



Select this option if you want to reply to all of the people on the original distribution list. 



Displays the items that could not be deleted because they are locked by other users.



Each item will need to be unlocked by the user before you can delete it.



Displays the number of scheduled calls that have not been completed.



Displays the number of scheduled meetings that have not been completed.



Displays the number of scheduled to-do's that have not been completed.



Displays a description of the selected macro.



Select a macro that you want to run or delete from the list.



Select this option to run the macro at the same speed at which it was recorded. This option only appears if you 
choose the Run Macro command.



Select this option to copy all records in the database to a new file. The Save As dialog box appears, and you can 
enter a new name and location for this backup copy.



Select this option to copy the database formatting without copying the actual records within the database.



Click the Browse ("...") button in this field. The Select Contacts dialog box appears, and you can select one or more
contacts. Select your name to schedule personal appointments or for one-time-only activities.



Click the color swatch arrow to the right of the field to display a color palette. Click the color that you want to 
assign to the activity.



Click the color swatch arrow to the right of the field to display a color palette. Click the color that you want to 
assign to the activity.



Select Call, Meeting, or To-do from the drop-down list.



Select Call, Meeting, or To-do from the drop-down list.



Enter a lead time or choose a time from the drop-down list. For example, type 10 min or choose 10 Minutes from 
the drop-down list.



Enter a lead time or choose a time from the drop-down list. For example, type 10 min or choose 10 Minutes from 
the drop-down list.



If you want the activity to appear on a group record in addition to a contact record, select a group with which to 
associate the activity.



This field displays the date on which the activity will occur. You can change or correct the date that appears or 
select a new date using the drop-down date selector. Click the arrow to the right to display the drop-down date 
selector and click the date, or you can enter a date directly in the field.



This field displays the date on which the activity will occur. You can change or correct the date that appears or 
select a new date using the drop-down date selector. Click the arrow to the right to display the drop-down date 
selector and click the date, or you can enter a date directly in the field.



This field displays the duration of the activity. Click the arrow to the right of the field to display a duration drop-
down list and click to select a duration. You can also type a duration in the field, for example to set a duration of 
one hour and 45 minutes, type 1 hr 45 min.



This field displays the duration of the activity. Click the arrow to the right of the field to display a duration drop-
down list and click to select a duration. You can also type a duration in the field, for example to set a duration of 
one hour and 45 minutes, type 1 hr 45 min.



Select High, Medium, or Low from the drop-down list.



Select High, Medium, or Low from the drop-down list.



Select this option to prevent others from seeing your activities when they log on to your database or when you 
send synchronization updates.



Enter a description of the activity or select a description from the drop-down list.



Enter a description of the activity or select a description from the drop-down list.



Select this option to receive a prompt to send an e-mail message to a contact when you schedule or reschedule an
activity. Note that the contacts must have an e-mail address in their contact records if you want to send them an e-
mail reminder.



Select this option to set an alarm to remind you of a scheduled activity.



This field displays the time the activity will start. Click the arrow to the right of the time to display the drop-down 
date selector and click to set the starting time. You can drag to select the starting time and the duration, or you 
can enter a time directly in the field.



This field displays the time the activity will start. Click the arrow to the right of the time to display the drop-down 
date selector and click to set the starting time. You can drag to select the starting time and the duration, or you 
can enter a time directly in the field.



Click the Browse ("...") button in this field. The Select Contacts dialog box appears, and you can select one or more
contacts. Select your name to schedule personal appointments or for one-time-only activities.



Click the Browse ("...") button in this field. The Select Contacts dialog box appears, and you can select one or more
contacts. Select your name to schedule personal appointments or for one-time-only activities.



Specify the frequency of a scheduled activity.



Choose from these options to specify when the activity will recur.



Choose from these options to specify when the activity will recur.



Choose from these options to specify when the activity will recur.



Select this option to schedule activities for specific days of the month.



Select this option to schedule an activity that occurs every day, every other day, or at any interval of days. You can
specify the number of days between each occurrence of the activity and the date on which the activity will stop.



Click a date in the calendar to schedule an activity for that date. The calendar displays the days of the month and 
highlights the days on which an activity is scheduled. 



Specify the frequency of a scheduled activity.



Specify the frequency of a scheduled activity.



Specify the frequency of a scheduled activity.



Select this option to schedule the activity to occur during the first week of the month.



Select this option to schedule the activity to occur during the fourth week of the month.



Select this option to schedule the activity to occur every Friday.



Specify the frequency of a scheduled activity.



Select this option to schedule the activity to occur during the last week of each month.



Select this option to schedule the activity to occur every Monday.



Select this option to schedule an activity that occurs every month, every other month, or at any interval of 
months. You can specify the number of months between each occurrence of the activity, the weeks in the month 
when the activity is scheduled, the day of the week the activity is scheduled, and the date on which the activity 
will stop.



Choose the months during which you want the activity to occur.



Choose the days during which you want the activity to occur.



Select this option to cancel a recurring activity.



Select this option to schedule the activity to occur every Saturday.



Select this option to schedule the activity to occur during the second week of each month.



Select this option to schedule the activity to occur every Sunday.



Select this option to schedule the activity to occur during the third week of each month.



Select this option to schedule the activity to occur every Thursday.



Select this option to schedule the activity to occur every Tuesday.



Choose a date on which the activity will stop recurring. You can select a date from the drop-down date selector, or 
type a date in the field.



Choose a date on which the activity will stop recurring. You can select a date from the drop-down date selector, or 
type a date in the field.



Select this option to schedule the activity to occur every Wednesday.



Select this option to schedule an activity that occurs every week, every other week, or at any interval of weeks. 
You can specify the number of weeks between each occurrence of the activity, on which day of the week the 
activity is scheduled, and the date on which the activity will stop.



Choose which weeks of the month the activity will be repeated.



Click this button to add the chosen contacts to your selection. To add an individual contact, click once on the 
individual contact's name in the list at left, then click the Add button. The contact's name is added to the list at 
right.



Select this option to select from all contacts.



Select this option to select contacts only from the current lookup. 



Click this button to close the Third Party Scheduling section of the Select Contacts dialog box.



Click this button to display the third-party scheduling options, Scheduled for and Scheduled by. Changes to "Less" 
when third-party scheduling options are displayed.



Click this button to remove the chosen contacts from your selection. To remove an individual contact, click once on
the individual contact's name in the list at right, then click the Remove button. The contact's name is removed 
from the list at left. 



Click this button to replace the contact in the Scheduled With list with the selected contact.



Displays the user who is scheduling the activity.



Displays the user who is scheduling the activity.



Displays the contact or contacts with whom the activity is currently scheduled.



Displays the contact or contacts with whom the activity is currently scheduled.



Click this button to select all available contacts in the list.



Select this option to select contacts from a specific group. 



Select a group from which to choose contacts.



Lists the currently selected contacts.



Lists the contacts that are available from which to choose.



Click this button to schedule activities for other users of a shared database.



Click this button to add the selected contacts to the Scheduled With list. To add an individual contact, click once on
the individual contact's name in the list at left, then click the Add button. The contact's name is added to the list at
right. 



Select this option to select from all contacts in the database.



Select this option to select contacts only from the current lookup. 



Click this button to remove the chosen contacts from your selection. To remove an individual contact, click once on
the individual contact's name in the list at right, then click the Remove button. The contact's name is removed 
from the list at left.



Displays the contact or contacts with whom the activity is currently scheduled.



Click this button to select all available contacts in the list at the left. You can then add all of the contacts to the list 
of contacts for the scheduled activity, which appears in the list at the right, by clicking the Add button. 



Select this option to select contacts from a specific group.



Select this option to select contacts from a specific group.



Displays a list of the contacts in the database, the current lookup, or an existing group. By default, the All Contacts
option is selected.



Click this button to add a new entry in the address book.



Select an e-mail address to assign to the current contact.



Select an e-mail address to assign to the current contact.



Choose a contact from the list to use as the My Record.



Select this option if you want to send the fax to all contacts in the database.



Select this option to add a shortcut to the document in the history record.



Select this option to create a history record for the document.



Select this option if you want to send the fax only to the contacts in the current lookup.



Type the subject of the fax.



Click this button to remove the selected contacts from your list of fax recipients.



Click this button to send the fax to all contacts in the list, then click To.



Displays a list of contacts based on your selection. Choose the contacts you want to receive the fax from this list.



Select this option to send the fax only to the contacts from a specific group. You can select a group from the drop-
down list.



Select this option to send the fax only to the contacts from a specific group. You can select a group from the drop-
down list.



Displays a list of the contacts you selected to receive the fax.



Click this button to send the fax to the selected contact(s) in the fax recipients list.



Enter the new password you want to use. 



Enter the current password if a password has already been set.



Enter the new password again for confirmation.



Select this option to postpone the alarm for one day.



Select this option to postpone the alarm for one hour.



Select this option to postpone the alarm for one week.



Select this option to postpone the alarm for ten minutes.



Select this option to postpone the alarm for twenty minutes.



Select this option to postpone the alarm for thirty minutes.



Select this option to postpone the alarm for four hours.



Select this option to postpone the alarm for five days.



Select this option to postpone the alarm for five minutes.



Select this option to postpone the alarm for ninety minutes.



Choose the length of time you want for postponing the alarm.



Specify the third-level criterion by which the contacts will be sorted. To select a different criterion, choose an item 
from the drop-down list.



Specify the second-level criterion by which the contacts will be sorted. To select a different criterion, choose an 
item from the drop-down list.



Select this option to sort the contacts in ascending order according to the sort criteria specified. For example, a list
of names is sorted alphabetically from A to Z. You can select this option for any of the three sort levels. 



Select this option to sort the contacts in ascending order according to the sort criteria specified. For example, a list
of names is sorted alphabetically from A to Z. You can select this option for any of the three sort levels. 



Select this option to sort the contacts in ascending order according to the sort criteria specified. For example, a list
of names is sorted alphabetically from A to Z. You can select this option for any of the three sort levels. 



Select this option to sort the contacts in descending order according to the sort criteria specified. For example, a 
list of names is sorted alphabetically from Z to A. You can select this option for any of the three sort levels. 



Select this option to sort the contacts in descending order according to the sort criteria specified. For example, a 
list of names is sorted alphabetically from Z to A. You can select this option for any of the three sort levels. 



Select this option to sort the contacts in descending order according to the sort criteria specified. For example, a 
list of names is sorted alphabetically from Z to A. You can select this option for any of the three sort levels. 



Specify the first-level criterion by which the contacts will be sorted. To select a different criterion, choose an item 
from the drop-down list.



Specify the first-level criterion by which the contacts will be sorted. To select a different criterion, choose an item 
from the drop-down list.



Click this button to place the summary above the section it is summarizing. 



Click this button to place the summary below the section it is summarizing. 



Select the field whose information you want to replace and exchange with that of another field.



Select the field whose information will be exchanged with the other field.



Click this button to return to the previous panel of the wizard. 



Select this option to have ACT! synchronize data with another ACT! database. 



Click this button to finish the wizard.



Click this button to proceed to the next panel of the wizard.



Select this option to have ACT! synchronize data with another ACT! user via one of the supported e-mail systems, 
via a modem, or using a shared folder or floppy disk.



Choose a filename and path for the database with which you want to synchronize. If you do not know the filename 
and path, click the Browse ("...") button to locate the database you want. When you select the database and click 
Open, the name and location are filled in within the wizard panel.



Click this button to return to the previous panel of the wizard.



Choose a filename and path for the database with which you want to synchronize. If you do not know the filename 
and path, click the Browse ("...") button to locate the database you want. When you select the database and click 
Open, the name and location are filled in within the wizard panel.



Click this if you have finished setting up synchronization. If you click it before getting to the last Synchronization 
Setup Wizard panel, all default settings will be used.



Click this button to proceed to the next panel of the wizard. 



Click this button to return to the previous panel of the wizard. 



Click this button to finish the wizard. 



Select this option to give synchronization privileges to someone who is already set up as a user on your database.



Select this option to add a new user to your database and to give the new user synchronization privileges.



Enter the name of the user you are setting up for synchronization.



Click this button to proceed to the next panel of the wizard. 



Select a user to whom you want to give synchronization privileges.



Click this button to return to the previous panel of the wizard.



Select this option to add the person who is sending the synchronization update to your database as a new user.



Choose whether to create a new user, or to make an existing user a synchronization user.



Click this button to finish the wizard. 



Select this option to link the synchronization update to an existing user in the database.



Click this button to proceed to the next page of the wizard.



This field is filled by default with the name of the user sending you an incoming synchronization update. You can 
keep this name or change it without affecting the data being received. This field is ignored if you decide to make 
an existing user a synchronization user.



Click this button to add a new user for synchronization.



Click this button to return to the previous panel of the wizard.



Click this button to revert the list so that no users are selected.



Click this button to finish the wizard. 



Click this button to modify the selected user's attributes.



Click this button to proceed to the next panel of the wizard. 



Click this button to choose all users in the list.



Select each user by clicking his or her name in the list. A check mark appears next to the name of each selected 
user.



Select this option to synchronize all groups and contacts in your database.



Click this button to return to the previous panel of the wizard.



Click this button if you have finished setting up synchronization. If you click it before getting to the last 
Synchronization Setup Wizard panel, all default settings will be used.



Choose the groups you want to include in the synchronization.



Click this button to proceed to the next panel of the wizard. 



Select this option to include only selected groups from your database in the data synchronization.



Select this option if you want to include all groups and contacts in the data synchronization.



Select the groups you want to include in the data synchronization.



Select this option if you want to synchronize only groups you select.



Select this option to include activities in the synchronization message.



Click this button to return to the previous panel of the wizard.



Click this button to finish the wizard.



Click this button to proceed to the next panel of the wizard.



Click this button if you have finished setting up synchronization. The Finish button is available after you select 
another database with which to synchronize data, or after you finish setting up other users for synchronization. If 
you click Finish before getting to the last Synchronization Setup Wizard panel, all default settings will be used.



Enter the user's e-mail address, location, or modem number. If you do not know the information, click the Browse 
("...") button to open a dialog box where you can choose a file that contains the information, such as your 
CompuServe address book or MS Exchange settings.



Click this button to return to the previous panel of the wizard. 



Choose a connection method to use for synchronization.



Enter the user's e-mail address, location, or modem number. If you do not know the information, click the Browse 
("...") button to open a dialog box where you can choose a file that contains the information, such as your 
CompuServe address book or MS Exchange settings.



Click this button to finish the wizard.



Click this button to proceed to the next panel of the wizard.



Enter the user's e-mail address, location, or modem number. If you do not know the information, click the Browse 
("...") button to open a dialog box where you can choose a file that contains the information, such as your 
CompuServe address book or MS Exchange settings.



Click this button to return to the previous panel of the wizard. 



Click this button if you have finished setting up synchronization. If you click it before getting to the last 
Synchronization Setup Wizard panel, all default settings will be used.



Click this button to proceed to the next panel of the wizard. 



Select this option to omit private data in your synchronization updates.



Select this option to include private data in your synchronization updates.



Click this button to return to the previous panel of the wizard. 



Click this button to finish the wizard. 



Click this button to proceed to the next panel of the wizard.



Select this option if you do not want private data to be included when sending synchronization messages.



Select this option if you do not want field names, field drop-downs, and any other field definitions included when 
sending synchronization messages.



Select this option if you want private data to be included when sending synchronization messages.



Select this option if you want field names, field drop-downs, and any other field definitions included when sending 
synchronization messages.



Click this button to return to the previous panel of the wizard. 



Select this option if you want to resolve conflicts by using field definitions from the current database. 



Select this option if you want to resolve conflicts by using field definitions from the destination database. 



Click this button if you have finished setting up synchronization. If you click it before getting to the last 
Synchronization Setup Wizard panel, all default settings will be used.



Select this option if you want to resolve conflicts by using the most up-to-date field definitions, regardless of which 
database they are from.



Click this button to proceed to the next panel of the wizard. 



Select this option if you do not want to include field names, field drop-downs, and any other field definitions in your
synchronization updates.



Select this option to include field names, field drop-downs, and any other field definitions in your synchronization 
updates.



Click this button to return to the previous panel of the wizard. 



Specify a group to keep track of all contacts received from the user with whom you are synchronizing. Enter an 
existing group name, or enter a new group name to create a new group.



Click this button to finish the wizard. 



Select an existing group by clicking its name. The group name appears in the Collection Group field.



Click this button to proceed to the next panel of the wizard. 



Choose the group to which you want to add individual contacts when receiving them from the current user.



Choose a group from the list.



Click this button to return to the previous panel of the wizard.



Click this button to finish the wizard. 



Click this button to proceed to the next panel of the wizard.



Select this option if you do not want to receive private data from the user with whom you are synchronizing.



Select this option if you do not want to receive field names, field drop-downs, and any other field definitions from 
the user with whom you are synchronizing.



Select this option if you would like to receive all private data from the user with whom you are synchronizing.



Select this option if you want to receive field names, field drop-downs, and any other field definitions from the user
with whom you are synchronizing.



Click this button to return to the previous panel of the wizard. 



Click this button to finish setting up synchronization.



Click this button to proceed to the next panel of the wizard.



Select this option to send all records (for this update only).



Select this option to send all records (for this update only). After the next synchronization, the Send Only Changed 
Records option is automatically selected. After the next synchronization, the Send Only Changed Records option is 
automatically selected.



Select this option to send only records that have changed since the last update.



Select this option to have ACT! look for synchronization updates in the specified database if you are synchronizing 
directly with another database, or in your e-mail inboxes, your shared folder, your synchronization folder, or your 
briefcase. 



Select this option to have ACT! send your updates to the specified database or, if you are synchronizing with other 
users, ACT! sends your updates using the method you have specified during synchronization setup. 



Click this button to set up data synchronization using the Synchronization Setup Wizard. You can click Setup to 
make any changes to the current setup.



Click this button to begin the synchronization process with the parameters you defined in the synchronization 
setup procedure. Any updates that are found are applied to the currently open database, then your updates are 
sent to the specified database or users.



Displays the database with which you will synchronize.



Displays information about the system on which ACT! is running.



Click this button to stop the timer temporarily. The Pause button changes to the Resume button during a pause. 
You can click Resume to go on timing the call.



Click this button to reset the timer to zero and resume timing.



Click this button to start the timer. The Start button changes to the Stop button when timing begins. Click Stop to 
stop the timer. The Record History dialog box appears, and you can record a description of the result of your call.



Displays the elapsed time.



Select this option if commas were used to separate fields in the file.



Select this option if tabs were used to separate fields in the file.



Select the operating system in which the file you are importing was created. Choose from Windows (ANSI), DOS, or
Macintosh.



Select this option if you want to include the first record in the file when importing. Sometimes the first record 
contains field names rather than actual data, so you may not want to import it.



Select the operating system that the file you are importing was created in. Choose from Windows (ANSI), DOS, or 
Macintosh. 



Select this option if you want to use commas to separate fields in the file.



Select this option if you want to use tabs to separate fields in the file.



Select this option to include field names from the current database when exporting records.



Displays the modem currently chosen for sending and receiving e-mail.



Click this button to configure your modem with the Windows Modem Properties dialog box.



Use these options to change your modem settings.



Displays the modem currently chosen for sending and receiving e-mail.



Select this option if you do not want to create a lookup of the records that were deleted in the other database. If 
you do not select this option, a lookup will be created containing the records that were deleted in the other 
database. After you've applied a synchronization update, you can view these records and if you want, delete them 
from your database.



Select this option if you would like to view activities that have been cleared.



Select the type of e-mail address book in which the recipient's address is stored.



New
Choose New to create a new empty file.



Open
Choose Open to open an existing file.



Delete Database
Choose Delete Database to delete a database file.



Database Maintenance
Choose Database Maintenance to compress and reindex the database and to purge any or all of the following: 
notes, histories, attachments, transaction log, and cleared activities.



Recent File List
Choose one of the files names at the bottom of the File menu to open a document you recently worked on.



Exit
Choose Exit to close all open files and exit the program.



Help Topics
Choose Help Topics to view the ACT! Help table of contents.



How to Use Help
Choose How to Use Help to get information on how to use the ACT! Help system.



Quick Tour
Choose Quick Tour to open the ACT! Quick Tour which introduces ACT! features and gives a brief walkthrough of 
ACT!.



Live Update
Choose Live Update to access the online Symantec support center for product updates and documents.



About ACT!
Choose About ACT! to view information about the version of ACT! you are running.



Save
Choose Save to save the active file.



Save Copy As
Chose Save Copy As to save a copy of the active file with a different name.



Revert
Choose Revert to return the current file to the last saved version.



Import
Choose Import to import information into the database.



Export
Choose Export to export data from the database.



Link
Choose Link to exchange data with an external device.



Synchronize
Choose Synchronize to synchronize data.



Set Password
Choose Set Password to set or change your password.



Lock Database
Choose Lock to lock the database while performing maintenance.



Define Users
Choose Define User to set user privileges.



Print
Choose Print to print the active file.



Undo
Choose Undo to undo the last action. This option will change to Redo after you Undo an action. Choose Redo to 
reverse the undone action.



Cut
Choose Cut to remove the current selection and place it on the clipboard.



Copy
Choose Copy to copy the current selection and place the copy on the clipboard.



Paste
Choose Paste to paste the clipboard contents to the current location of the cursor.



Sort
Choose Sort to define a sort order for groups or contacts.



Filter
Choose Filter to specify which items are displayed.



Replace
Choose Replace to modify field data for the current lookup.



Define Fields
Choose Define Fields to define the database structure.



Preferences
Choose Preferences to set or change a number of ACT! preferences.



New Contact
Choose New Contact to add a contact to the database.



Duplicate Contact
Choose Duplicate Contact to insert a new contact using the fields and data from the current contact.



Delete Contact
Choose Delete Contact to delete the current contact or lookup.



Schedule Call
Choose Schedule Call to schedule a call with the current contact.



Schedule Meeting
Choose Schedule Meeting to schedule a meeting with the current contact.



Schedule To-Do
Choose Schedule To-Do to schedule a to-do with the current contact.



Clear Activity
Choose Clear Activity to clear the selected activity.



Insert Note
Choose Insert Note to insert a new note for the current contact or group.



Record History
Choose Record History to record a new history for the current contact.



E-mail Addresses
Choose E-Mail Addresses to add or edit the current contact's e-mail address.



Phone Contact
Choose Phone Contact to dial the current contact.



My Record
Choose My Record to locate the "My Record" contact.



All Contacts
Choose All Contacts to include all contacts in a lookup.



Company
Choose Company to search for a specific company.



First Name
Choose First Name to search for contacts based on a specific first name.



Last Name
Choose Last Name to search for contacts based on a specific last name.



Phone
Choose Phone to search for contacts with a specific phone number.



City
Choose City to search for contacts by city.



State
Choose State to search for contacts by a specific state.



Zip Code
Choose Zip Code to search for contacts based on zip code.



ID/Status
Choose ID/Status to search for contacts with a specific ID or status.



Other Fields
Choose Other Fields to search for contacts based on data in the indexed fields you specify.



Previous
Choose Previous to restore the previous lookup.



Keyword
Choose Keyword to search for contacts or groups based on keywords found in contact or group fields, activities, 
notes, histories, and e-mail addresses.



By Example
Choose By Example to perform custom queries.



Last Synchronized
Choose Last Synchronized to locate the most recent synchronized records.



To Be Deleted
Choose To Be Deleted to locate the synchronized records to be deleted.



Modify Menu
Choose Modify Menu to add a user-defined contact query to the menu.



Modify Menu
Choose Modify Menu to add a user-defined contact query to the menu.



Letter
Choose Letter to write a letter to the current contact or group. This command opens the ACT! word processor.



Memorandum
Choose Memorandum to write a memorandum to the current contact or group.



Fax Cover Page
Choose Fax Cover Page to write a fax cover page to the current contact or group.



E-mail Message
Choose E-Mail Message to send an e-mail message to the current contact or group.



Other Document
Choose Other Document to write a letter to the current contact or group using a specified template.



Edit Document Template
Choose Edit Document Template to edit a word-processing template.



Mail Merge
Choose Mail Merge to merge a form letter with a data file.



Modify Menu
Choose Modify Menu to add a word-processing template to the menu.



Modify Menu
Choose Modify Menu to add a user-defined word-processing template to the menu.



Contact Report
Choose Contact Report to create a report displaying all contact information including notes, history, and activities 
for each contact.



Contact Directory
Choose Contact Directory to create a report displaying the primary address and home address for each contact.



Phone List
Choose Phone List to generate a report displaying the company name, company phone number, and mobile phone
number for each contact.



Task List
Choose Task List to generate a report displaying calls, meetings, and to-do activities scheduled with each contact 
during a specified date range.



Notes/History
Choose Notes/History to generate a report displaying notes and history items for each contact during a specified 
date range.



Other Report
Choose Other Report to run the specified report.



Edit Report Template
Choose Edit Report Template to edit the specified report template.



History Summary
Choose History Summary to create a report displaying the total number of attempted calls, completed calls, 
meetings held, letters sent, and fields changed for each contact during a specified date range.



Activities/Time Spent
Choose Activities/Time Spent to create a report displaying activities scheduled and time spent with each contact 
during a specified date range.



Contact Status
Choose Contact Status to create a report displaying ID/Status, last results, and to-do activities for each contact 
during a specified date range.



Source of Referrals
Choose Source of Referrals to create a report displaying "Referred By" information for each contact.



Group Membership
Choose Group Membership to create a report displaying a list of all groups and all contacts in each group.



Modify Menu
Choose Modify Menu to add a custom report to the menu.



Design Layouts
Choose Design Layouts to create a new layout or to edit an existing layout.



Scan for Duplicates
Choose Scan for Duplicates to scan for duplicate records in the database.



Timer
Choose Timer to use the ACT! timer.



Record Macro
Choose Record Macro from the Edit menu to record a macro. Automate and execute repetitive keyboard and 
mouse actions by using macros. This will save time when performing frequently repeated procedures.



Run Macro
Choose Run Macro to specify the name and location of the macro to be run.



Delete Macro
Choose Delete Macro to select the name and location of the macro to be deleted.



Customize
Choose Customize to change the menu bar, toolbar, or shortcut keys.



Contacts
Choose Contacts to view the Contacts window. 



Contact List
Choose Contact List to view contacts in a list format.



Calendar
Choose Calendar to view the Calendar window.



Task List
Choose Task List to display the Task List window and view any scheduled activities.



Groups
Choose Groups to view the Groups window.



E-mail
Choose E-Mail to view the E-Mail window.



Mini-Calendar
Choose Mini-Calendar to view the mini-calendar.



Cascade
Choose Cascade to display all open documents in an overlapping format.



Tile Horizontal
Choose Tile Horizontal to arrange all open documents horizontally.



Tile Vertical
Choose Tile Vertical to arrange all open documents vertically.



Show Query Helper
Choose Show Query Helper to display the query helper that lets you select operators for a query.



Clear Query
Choose Clear Query to clear all fields in the currently open query.



Specify Query Sort
Choose Specify Query Sort to define a sort order for the current query.



Check Query Syntax
Choose Check Query Syntax to check the syntax in the currently open query. 



Convert to Advanced Query
Choose Convert to Advanced Query to convert the current query items to an advanced query.



Run Query
Choose Run Query to run the currently open query.



Clear All
Choose Clear All to delete all items.



Swap Fields
Choose Swap Fields to exchange field contents of one field with another.



Copy a Field
Choose Copy a Field to copy field contents of one field into another.



Apply
Choose Apply to replace the field contents as specified.



Show
Choose Field Entry Order then Show/Hide to display or hide the field entry order in the layout.



Clear
Choose Field Entry Order then Clear to clear the field entry order in the layout.



Reset
Choose Field Entry Order then Reset to reset the field entry order in the layout.



Tabs
Choose Tabs to define tab layouts.



Move to Front
Choose Move to Front to move the selected objects to the front.



Move Forward
Choose Move Forward to move the selected objects towards the front one layer.



Move to Back
Choose Move to Back to move the selected objects to the back.



Move Backward
Choose Move Backward to move the selected objects back by one layer.



Align
Choose Align to set the alignment for the selected objects.



Align to Grid
Choose Align to Grid to align the selected objects to the grid.



Make Same Height
Choose Make Same Height to make the selected objects the same height.



Make Same Width
Choose Make Same Width to make the selected objects the same width.



Add Label
Choose Add Label to add a label to the selected field.



Records
Choose Records to close the layout editing view and return to the Contact window.



Show Tool Palette
Choose Show/Hide Tool Palette to display or remove the tool palette from the window. 



Show Rulers
Choose Show/Hide Rulers to display or remove the rulers from the layout.



Show Grid
Choose Show/Hide Grid to display or remove the grid from the layout.



Snap to Grid
Choose Snap to Grid to cause objects to snap to the grid.



Ruler Settings
Choose Ruler Settings to define measurement settings.



Daily Calendar
Choose Daily Calendar to display the daily calendar.



Weekly Calendar
Choose Weekly Calendar to view the weekly calendar.



Monthly Calendar
Choose Monthly Calendar to view the monthly calendar.



Create Message
Choose Create Message to create a new e-mail message.



Read Message
Choose Read Message to read the selected e-mail message.



Reply to Message
Choose Reply to Message to reply to the current e-mail message.



Forward Message
Choose Forward Message to forward the current e-mail message to another e-mail address.



Delete Message
Choose Delete Message to delete the selected e-mail message.



Next Message
Choose Next Message to move to the next e-mail message.



Previous Message
Choose Previous Message to move to the previous e-mail message.



Send Mail Now
Choose Send Mail Now to send an e-mail message immediately.



Send Mail Later
Choose Send Mail Later to place an e-mail message in the Outbox to be sent later.



Contact
Choose Attach then Contact to attach a contact record to an e-mail message.



Group
Choose Attach then Group to attach a group of contact records to an e-mail message.



File
Choose Attach then File to attach a file to an e-mail message.



Delete Attachment
Choose Delete Attachment to remove a selected attachment from an e-mail message.



Connect
Choose Connect to log on to the selected e-mail system.



Disconnect
Choose Disconnect to disconnect from the selected e-mail system.



New Group
Choose New Group to create a new group.



Duplicate Group
Choose Duplicate Group to create a new group using the fields and data from the current group.



Delete Group
Choose Delete Group to delete the current group.



Group Membership
Choose Group Membership to specify the contacts that constitute a group.



First Contact
Choose First Contact to move to the first record of the database.



Previous Contact
Choose Previous Contact to move to the previous record.



Next Contact
Choose Next Contact to move to the next record.



Last Contact
Choose Last Contact to move to the last record of the database.



Switch Groups
Choose Switch Groups to select a different group.



Literature Rack
Choose Literature Rack to access files and folders available on an ACT! Mail server.



Create Lookup
Choose Create Lookup to create a lookup of records.



Show Newest First
Choose Show Newest First to view the newest e-mail message first.



Show Oldest First
Choose Show Oldest First to view the oldest e-mail message first.



Refresh List
Choose Refresh List to refresh the list of e-mail messages.



Add Columns
Choose Add Columns to add a column for one or more fields.



Omit Selected
Choose Omit Selected to remove the selected contacts from the contact list.



Add Columns
Choose Add Columns to add a column for one or more fields.



Show Column Headings
Choose Show Column Headings to display the column headings in the active tab. 



Add Columns
Choose Add Columns to add a column to the current window.



Add Fields
Choose Add Fields to add a new field to the report template.



Define Filters
Choose Define Filters to determine what information will be included in a report.



Move to Front
Choose Move to Front to move the selected objects to the front.



Move Forward
Choose Move Forward to move the selected objects forward by one layer.



Move to Back
Choose Move to Back to move the selected objects to the back.



Move Backward
Choose Move Backward to move the selected objects back by one layer.



Align
Choose Align to set alignment parameters for the selected objects.



Align to Grid
Choose Align to Grid to align the selected objects to the grid.



Make Same Height
Choose Make Same Height to make the selected objects the same height.



Make Same Width
Choose Make Same Width to make the selected objects the same width.



Add Label
Choose Add Label to add a label to the selected field.



Show Tool Palette
Choose Show/Hide Palette to display or remove the palette.



Show Rulers
Choose Show/Hide Rulers to display or remove rulers from the window.



Show Grid
Choose Show/Hide Grid to display or remove grid lines from the window.



Snap to Grid
Choose Snap to Grid to cause objects to snap to the grid.



Hide Section Titles
Choose Show/Hide Section Titles to display or remove section titles.



Rulers Settings
Choose Ruler Settings to specify ruler units.



Add Columns
Choose Add Columns to add a column to the current window.



Undo
Choose Undo to undo the last action.



Cut
Choose Cut to remove the selected text and place it on the clipboard.



Copy
Choose Copy to copy the selected text and place it on the clipboard.



Clear
Choose Clear to delete the selected activity. 



Select All
Choose Select All to select all items in the current field.



Align to Grid
Choose Align to Grid to make the selected fields line up with the layout grid.



File Description
Choose File Description to display a description of the selected file.



Align Text Left
Choose Align Text Left to left-align the selected text.



Align Text Center
Choose Align Text Center to center the selected text.



Align Text Right
Choose Align Text Right to right-align the selected text.



Modify Menu Items
Choose this user-defined menu item to perform the specified lookup.
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Modify Menu Items
Choose this user-defined menu item to perform the specified lookup.



Modify Menu Items
Choose this user-defined menu item to perform the specified lookup.



Modify Menu Items
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Choose this user-defined menu item to open it.



Modify Menu Items
Choose this user-defined menu item to open it.



Modify Menu Items
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Choose this user-defined menu item to open it.



Modify Menu Items
Choose this user-defined menu item to open it.



Modify Menu Items
Choose this user-defined menu item to open it.



Modify Menu Items
Choose this user-defined menu item to open it.



Stop Timer
Choose Stop Timer to stop the ACT! timer.



Close
Choose Close to shut down the current file.



Group Membership
Choose Group Membership to add contacts to or remove contacts from a group.



Clear
Choose Clear to delete the current selection.



Modify Session Settings
Choose Modify Session Settings to edit your CoumpuServe settings.



All Groups
Choose All Groups to look up all groups in the database.



Other Fields
Choose Other Fields to search for contacts based on data in the indexed fields you specify.



Modify Menu
Choose Modify Menu to add custom items to the menu.



Attach File
Choose Attach File to attach a file to a contact or group.



Page Setup
Choose Page Setup to edit page settings before you print.



Reschedule Activity
Choose Reschedule Activity to schedule the activity for another time.



Reset Timer
Choose Reset Timer to reset the timer to zero.



Define Sections
Choose Define Sections to create or edit sections of the template.



Run
Choose Run to produce a report, label, or envelope.



Properties
Choose Properties to view the properties for the background and to specify colors and pattern for the layout.



Show Grid
Choose Show Grid to have guide lines appear in the background.



Move Backward
Choose Move Backward to move the current selection back one layer.



Move Forward
Choose Move Forward to move the current selection forward one layer.



Move to Back
Choose Move to Back to move the current selection to the back layer.



Move to Front
Choose Move to Front to move the current selection to the front layer.



Properties
Choose Properties to view and edit the properties of the selected object.



Paste
Choose Paste to paste the clipboard contents to the current location of the cursor insertion point.



Show Rulers
Choose Show/Hide Rulers to display or remove the rulers from the layout.



Snap to Grid
Choose Snap to Grid to cause objects to snap to the grid.



Print Preview
Choose Print Preview to see how the current document will appear when printed.



Recent File List
Choose one of the files names at the bottom of the File menu to open a document you recently worked on.
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Choose one of the files names at the bottom of the File menu to open a document you recently worked on.



Recent File List
Choose one of the files names at the bottom of the File menu to open a document you recently worked on.



Open File List
Lists the currently open files. To activate a file, select its name from the list.
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Open File List
Lists the currently open files. To activate a file, select its name from the list.



Open File List
Lists the currently open files. To activate a file, select its name from the list.



Open File List
Lists the currently open files. To activate a file, select its name from the list.



Format
Choose Format to edit an envelope or label format.



Toolbars
Choose Toolbars to display, hide, reset, and modify the default toolbars.



Lookup Selected
Choose Lookup Selected to create a lookup of the selected records.



Large Icon & Text
Choose Large Icon & Text to display large tool icons with the corresponding tool names in the toolbar.



Large Icon Only
Choose Large Icon to display large tool icons in the toolbar.



Small Icon & Text
Choose Small Icon & Text to display small tool icons with the corresponding tool names in the toolbar.



Small Icon Only
Choose Small Icon Only to display small tool icons in the toolbar.



Text Only
Choose Text Only to display only the tool names without the corresponding icons in the toolbar.



Align dialog box
Use this dialog box to align multiple objects on the template. Choose Align from the Objects menu to open the 
Align dialog box while changing the appearance of a layout or report template. Some of the alignment options are 
not available in the report designer but are available in the layout designer.

Dialog Box Options and Controls:
None. Select this option to leave the objects' vertical alignment unchanged.
Align left edges. Select this option if you want objects aligned vertically by their left edges.
Align centers. Select this option if you want objects aligned by their centers.
Align right edges. Select this option if you want objects aligned by their right edges.
None. Select this option to leave the objects' horizontal alignment unchanged.
Align top edges. Select this option if you want objects aligned by their top edges.
Align centers. Select this option if you want objects aligned by their centers.
Align bottom edges. Select this option if you want objects aligned by their bottom edges.



Background Properties dialog box
Use this dialog box to change the color or pattern of the layout. Choose Properties from the shortcut menu to open 
the Background Properties dialog box. 

Dialog Box Options and Controls:
Color. Choose a color from the palette to use as the background.
Pattern. Choose a pattern from the palette to use as the background.
Bitmap. Choose a bitmap to use as the background. Click the Browse ("...") button to browse for a bitmap file.
Sample. Displays a preview of the background using the current settings.
Tile. Select this option to display the bitmap repeatedly until it covers the entire background area.



Object Properties dialog box, Font tab
Use the Object Properties dialog box to change all of an object's attributes at the same time. Double-click the 
object whose attributes you want to change. The Object Properties dialog box appears. Select the Font tab to set 
font options for the selected object(s).

Dialog Box Options and Controls:
Font. Choose a font to use for the text in the object.
Font style. Choose a font style to use for the text in the object.
Size. Choose a font size to use for the text in the object.
Strikeout. Choose this option if you want the text in the object to appear with a line through it.
Underline. Choose this option if you want the text in the object to be underlined.
Text color. Choose a color for the text in the object.
Sample. Displays a preview of the text using the current font settings.



Object Properties dialog box, Style tab
Use the Object Properties dialog box to change all of an object's attributes at the same time. Double-click the 
object whose attributes you want to change. The Object Properties dialog box appears. Select the Style tab to set 
various style options for the selected object(s).

Dialog Box Options and Controls:
Fill color. Choose a color for the field background.
Fill pattern. Choose a fill pattern for the object background.
Frame style. Choose a style for the object frame.
Frame color. Choose a color for the object frame.
Frame width. Choose a width for the object frame.
Sample. Displays a preview of the object using the current settings.



Ruler Settings dialog box
Use this dialog box to specify the units of measurement for the ruler and how many division markers to show for 
each unit. Choose Ruler Settings from the View menu to open the Ruler Settings dialog box. The dimensions also 
determine the grid size.

Dialog Box Options and Controls:
Inches. Select this option to set the ruler's unit of measurement to inches.
Centimeters. Select this option to set the ruler's unit of measurement to centimeters.
Points. Select this option to set the ruler's unit of measurement to text points. Points are units of 

approximately 1/72 inch, generally used to measure type sizes.
Divisions. Select how many division markers (tick marks) you want in each unit of measurement. For 

example, there are usually sixteen divisions in an inch.



Select this option if you want objects aligned by their bottom edges.



Select this option if you want objects aligned by their centers.



Select this option if you want objects aligned by their centers.



Select this option if you want objects aligned vertically by their left edges.



Select this option if you want objects aligned by their right edges.



Select this option if you want objects aligned by their top edges.



Select this option if you want fields justified left to right.



Select this option if you want fields justified top to bottom.



Select this option to leave the objects' vertical alignment unchanged.



Select this option to leave the objects' horizontal alignment unchanged.



Choose a bitmap to use as the background. Click the Browse ("...") button to browse for a bitmap file.



Choose a bitmap to use as the background. Click the Browse ("...") button to browse for a bitmap file.



Displays a preview of the background using the current settings.



Choose a color from the palette to use as the background.



Choose a pattern from the palette to use as the background.



Select this option to display the bitmap repeatedly until it covers the entire background area.



Click this button to implement any changes you made in the dialog box.



Choose a font to use for the text in the object.



Choose a font to use for the text in the object.



Displays a preview of the text using the current font settings.



Choose a font style to use for the text in the object.



Choose a font style to use for the text in the object.



Choose a font size to use for the text in the object.



Choose a font size to use for the text in the object.



Choose this option if you want the text in the object to appear with a line through it.



Choose a color for the text in the object.



Choose this option if you want the text in the object to be underlined.



Click this button to implement any changes you made in the dialog box.



Choose a color for the field background.



Choose a fill pattern for the object background.



Choose a color for the object frame.



Choose a style for the object frame.



Choose a width for the object frame.



Displays a preview of the object using the current settings.



Select this option to set the ruler's unit of measurement to centimeters.



Select how many division markers (tick marks) you want in each unit of measurement. For example, there are 
usually sixteen divisions in an inch.



Select how many division markers (tick marks) you want in each unit of measurement. For example, there are 
usually sixteen divisions in an inch.



Select this option to set the ruler's unit of measurement to inches.



Select this option to set the ruler's unit of measurement to text points. Points are units of approximately 1/72 inch, 
generally used to measure type sizes.



Field List dialog box, Activities tab
Use this dialog box to add fields that relate to activities to your report template.

Dialog Box Options and Controls:
Available fields. Select the field you want to add from the list.
Add field label. Select this option if you want a label to appear with the field you are adding.
Detail field. Select this option to create a field that will contain regular data as opposed to summary data.
Summary field. Select this option to create a field that displays information from one or more records.
Count. Select this option to create a field that counts the number of records that contain a value for the 

field.
Total. Select this option to create a summary type field that calculates the total of other field values.
Average. Select this option to create a summary type field that calculates the average of other field 

values.
Minimum. Select this option to create a summary type field that finds the lowest number, or earliest date 

or time, for a field.
Maximum. Select this option to create a summary type field that finds the highest number, or latest date 

or time, for a field.
Summary field label. Enter a label for the summary field you want to create.



Field List dialog box, Contact tab
Use this dialog box and tab to add fields that relate to contacts to your report template.

Dialog Box Options and Controls:
Available fields. Select the field you want to add from the list.
Add field label. Select this option if you want a label to appear with the field you are adding.
Use My record. Select this option if you want the data from the selected field in your My Record included 

in the report.
Detail field. Select this option to create a field that will contain regular data as opposed to summary data.
Summary field. Select this option to create a field that displays information from one or more records.
Total. Select this option to create a summary type field that calculates the total of other field values.
Average. Select this option to create a summary type field that calculates the average of other field 

values.
Count. Select this option to create a summary type field that counts the number of records that contain a 

value for the field.
Minimum. Select this option to create a summary type field that finds the lowest number, or earliest date 

or time, for a field.
Maximum. Select this option to create a summary type field that finds the highest number, or latest date 

or time, for a field.
Summary field label. Enter a label for the summary field you want to create.



Field List dialog box, Group tab
Use this dialog box and tab to add fields relating to groups to your report template.

Dialog Box Options and Controls:
Available fields. Select the field you want to add from the list.
Add field label. Select this option if you want a label to appear with the field you are adding.
Detail field. Select this option to create a field that will contain regular data as opposed to summary data.
Summary field. Select this option to create a field that displays information from one or more records.
Count. Select this option to create a summary type field that counts the number of records that contain a 

value for the field.
Total. Select this option to create a summary type field that calculates the total of other field values.
Average. Select this option to create a summary type field that calculates the average of other field 

values.
Minimum. Select this option to create a summary type field that finds the lowest number, or earliest date 

or time, for a field.
Maximum. Select this option to create a summary type field that finds the highest number, or latest date 

or time, for a field.
Summary field label. Enter a label for the summary field you want to create.



Field List dialog box, Notes/History tab
Use this dialog box and tab to add fields relating to notes and histories to your report template.

Dialog Box Options and Controls:
Available fields. Select the field you want to add from the list.
Add field label. Select this option if you want a label to appear with the field you are adding.
Detail field. Select this option to create a field that will contain regular data as opposed to summary data.
Summary field. Select this option to create a field that displays information from one or more records.
Count. Select this option to create a summary type field that counts the number of records that contain a 

value for the field.
Total. Select this option to create a summary type field that calculates the total of other field values.
Average. Select this option to create a summary type field that calculates the average of other field 

values.
Minimum. Select this option to create a summary type field that finds the lowest number, or earliest date 

or time, for a field.
Maximum. Select this option to create a summary type field that finds the highest number, or latest date 

or time, for a field.
Summary field label. Enter a label for the summary field you want to create.



Field List dialog box, System tab
Use this dialog box and tab to add fields relating to system information to your report template.

Dialog Box Options and Controls:
Available fields. Select the field you want to add from the list.
Field label. Enter a label for the field you want to add.



Run Report/Define Filters dialog box, Filter tab
Use this dialog box and tab to specify which data you want to include in your report. 

Dialog Box Options and Controls:
Notes. Select this option to include notes in the report.
History. Select this option to include histories in the report.
Attachments. Select this option to include attachments in the report.
Date range. Select a range of dates for the notes, histories, and attachments you want included in the 

report.
Custom. Click this button to select dates from a calendar.
Calls. Select this option to include calls in the report.
Meetings. Select this option to include meetings in the report.
To-do's. Select this option to include to-do's in the report.
Date range. Select a range of dates for the activities you want included in the report.
Custom. Click this button to select dates from a calendar.
All users. Select this option if you want to include data from all users in the report.
Selected users. Select this option if you want to include data only from selected users in the report.



Run Report/Define Filters dialog box, General tab
Use this dialog box and tab to specify which contacts or groups to include in the report, where to send the report, 
and whether or not to include the "My record."

Dialog Box Options and Controls:
Current contact/group. Select this option if you want to include only the current contact or group in the 

report.
Current contact/group lookup. Select this option if you want to include only the current lookup in the 

report.
All contacts/groups. Select this option if you want to include all contacts or groups in the report.
Exclude "My record." Select this option if you do not want the My Record to be included in the report.
Printer. Select this option to send the report to the printer.
Preview. Select this option if you want to see a preview of the report.
Fax. Select this option to send the report as a fax.
E-mail. Select this option to send the report as an e-mail message.
File. Select this option if you want to save the report as a file.



Object Properties dialog box, Format tab (report template)
Use this dialog box and tab to set the format properties of the selected object(s) in the repoort template.

Dialog Box Options and Controls:
Don't print if duplicated. Select this option to eliminate any duplicate fields, field labels, or text.
Close up blank space. Select this option to shorten the length of the field, field label, or text object to 

accommodate the data or text contained in it without leaving blank space. It also moves adjacent fields or objects 
to the left to eliminate extra space.

Wrap text. Select this option to automatically move text or data to the next line if it is too long to fit in 
the field or object.

Field name. Displays the name of the selected object.
Data type. Displays the data type for the selected object.
Appearance. (For numeric and date fields only) Select this option to specify how to display numbers or 

dates in fields.
Negative numbers. Select this option to specify a symbol for negative numbers in a field.
Decimal places. Select this option to specify how many decimal places will be displayed.



Run Label dialog box, Position tab
Use this dialog box and tab to specify on which label to start printing. For example, if you have already used some 
of the labels on a sheet of labels, you may want to start printing on the fifth label in the second row of labels.

Dialog Box Options and Controls:
Row. Enter the row where you would like to start printing.
Column. Enter the column where you would like to start printing.



Object Properties dialog box, Type tab
Use this dialog box and tab to set the type properties of the selected object in a report template.

Dialog Box Options and Controls:
Available fields. Select the field you want to add from the list.
Add field label. Select this option if you want a label to appear with the field you are adding.
Use My record. Select this option if you want the data from the selected field in your My Record included 

in the report.
Field name. Displays the name of the field.
Field type. Displays the type of the field.
Total. Select this option to create a summary type field that calculates the total of other field values.
Average. Select this option to create a summary type field that calculates the average of other field 

values.
Count. Select this option to create a summary type field that counts the number of records that contain a 

value for the field.
Minimum. Select this option to create a summary type field that finds the lowest number, or earliest date 

or time, for a field.
Maximum. Select this option to create a summary type field that finds the highest number, or latest date 

or time, for a field.
Summary field label. Enter a label for the summary field you want to create.



Select this option if you want a label to appear with the field you are adding.



Select the field you want to add from the list.



Select this option to create a summary type field that calculates the total of other field values.



Select this option to create a summary type field that calculates the average of other field values.



Select this option to create a field that will contain regular data as opposed to summary data.



Select this option to create a summary type field that finds the highest number, or latest date or time, for a field.



Select this option to create a summary type field that finds the lowest number, or earliest date or time, for a field.



Select this option to create a field that displays information from one or more records.



Enter a label for the summary field you want to create.



Enter a label for the summary field you want to create.



Select this option to create a field that counts the number of records that contain a value for the field.



Select this option if you want a label to appear with the field you are adding.



Select the field you want to add from the list.



Select this option to create a summary type field that calculates the average of other field values.



Select this option to create a summary type field that counts the number of records that contain a value for the 
field.



Select this option to create a field that will contain regular data as opposed to summary data.



Select this option to create a summary type field that finds the highest number, or latest date or time, for a field.



Select this option to create a summary type field that finds the lowest number, or earliest date or time, for a field.



Select this option to create a field that displays information from one or more records.



Enter a label for the summary field you want to create.



Enter a label for the summary field you want to create.



Select this option to create a summary type field that calculates the total of other field values.



Select this option if you want the data from the selected field in your My Record included in the report.



Select this option if you want a label to appear with the field you are adding.



Select the field you want to add from the list.



Select this option to create a summary type field that calculates the total of other field values.



Select this option to create a summary type field that calculates the average of other field values.



Select this option to create a field that will contain regular data as opposed to summary data.



Select this option to create a summary type field that finds the highest number, or latest date or time, for a field.



Select this option to create a summary type field that finds the lowest number, or earliest date or time, for a field.



Select this option to create a field that displays information from one or more records.



Enter a label for the summary field you want to create.



Enter a label for the summary field you want to create.



Select this option to create a summary type field that counts the number of records that contain a value for the 
field.



Select this option if you want a label to appear with the field you are adding.



Select the field you want to add from the list.



Select this option to create a summary type field that calculates the total of other field values.



Select this option to create a summary type field that calculates the average of other field values.



Select this option to create a field that will contain regular data as opposed to summary data.



Select this option to create a summary type field that finds the highest number, or latest date or time, for a field.



Select this option to create a summary type field that finds the lowest number, or earliest date or time, for a field.



Select this option to create a field that displays information from one or more records.



Enter a label for the summary field you want to create.



Enter a label for the summary field you want to create.



Select this option to create a summary type field that counts the number of records that contain a value for the 
field.



Select the field you want to add from the list.



Enter a label for the field you want to add.



(For numeric and date fields only) Select this option to specify how to display numbers or dates in fields.



(For numeric and date fields only) Select this option to specify how to display numbers or dates in fields.



Select this option to shorten the length of the field, field label, or text object to accommodate the data or text 
contained in it without leaving blank space. It also moves adjacent fields or objects to the left to eliminate extra 
space.



Displays the data type for the selected object.



Displays the data type for the selected object.



Select this option to specify how many decimal places will be displayed.



Select this option to specify how many decimal places will be displayed.



Select this option to eliminate any duplicate fields, field labels, or text.



Displays the name of the selected object.



Select this option to specify a symbol for negative numbers in a field.



Select this option to specify a symbol for negative numbers in a field.



Select this option to specify how many decimal places will be displayed.



Select this option to automatically move text or data to the next line if it is too long to fit in the field or object.



Select this option to create a summary type field that calculates the average of other field values.



Select this option to create a summary type field that counts the number of records that contain a value for the 
field.



Displays the name of the field.



Displays the type of the field.



Select this option to create a summary type field that finds the highest number, or latest date or time, for a field.



Select this option to create a summary type field that finds the lowest number, or earliest date or time, for a field.



Use these options to configure summary fields.



Select this option to create a summary type field that calculates the total of other field values.



Select this option if you want the data from the selected field in your My Record included in the report.



Enter the column where you would like to start printing.



Enter the row where you would like to start printing.



Enter the column where you would like to start printing.



Enter the row where you would like to start printing.



Select this option if you want to include data from all users in the report.



Select this option to include attachments in the report.



Select this option to include calls in the report.



Click this button to select dates from a calendar.



Click this button to select dates from a calendar.



Select a range of dates for the notes, histories, and attachments you want included in the report.



Select a range of dates for the activities you want included in the report.



Select this option to include histories in the report.



Select this option to include meetings in the report.



Select this option to include notes in the report.



Select this option if you want to include data only from selected users in the report.



Select this option to include to-do's in the report.



Select which users you want to include in the report.



Select this option if you want to include all contacts or groups in the report.



Select this option if you want to include only the current lookup in the report.



Select this option if you want to include only the current contact or group in the report.



Select this option to send the report as an e-mail message.



Select this option if you do not want the My Record to be included in the report.



Select this option to send the report as a fax.



Select this option if you want to save the report as a file.



Select this option if you want to see a preview of the report.



Select this option to send the report to the printer.



Displays the name of the selected object.



One of the most common tasks you may want to perform is changing the name of a field. The User 1 through User 
15 fields, for example, are intended to be customized by users to fit their needs. If you want to record an account 
number for each of your contacts, change the name of one of the User fields, such as the User 1 field, to Account 
Number. You could also change its field attributes so that it can contain only numbers. You are not limited to 
renaming the User fields; you can change the name of almost any field in an ACT! contact or group database.

Note
If you changed any of the field labels in an ACT! 2.0 database, only some of these field labels are saved when 
you convert your database to ACT! 3.0 format.



 Overview

To change a field name

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears. Note that this dialog box has two major tabs: Fields and Advanced. The 
Fields tab has three tabs inside it: Attributes, Drop-down, and Triggers.

2. Make sure that the Fields tab is selected.
3. From the Record Type drop-down list, choose Contact or Group.

You can modify the fields in either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field whose name you want to change.
5. In the Field Name field, enter the new name for the field.
6. (Optional) Select another field from the list and enter a new name for it in the Field Name field.
7. When you have finished renaming one or more fields, click OK.

The fields are renamed, and the new names will appear in any field lists or on any layouts in which they are 
included. Note that the field changes are made only to the currently open database.

 Related Topics



In addition to specifying a field's name, you can set several other field attributes, including Type, Size, Field 
Format, Default Value, and Entry Rules. You can also specify whether a field is a primary field, whether a history is 
generated when a field is updated, and whether data is sent from or received in a field during synchronization.



 Overview

To set field attributes

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected.
3. From the Record Type drop-down list, choose Contact or Group.

You can modify the field attributes in either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field whose attributes you want to change.
5. Set any of the field attributes.
6. (Optional) Select another field from the list and set its field attributes.
7. When you have finished modifying the attributes of one or more fields, click OK.

The fields are updated according to your specifications.
 Related Topics



Type options for non-core fields
Field type Data allowed in field
Character Alphanumeric characters. An alphanumeric 

character is a letter or a number.
Currency Numbers and decimal points only, which will 

be formatted according to the currency 
settings in the Windows Regional Settings 
control panel.

Date Dates only, which will be formatted according
to the date settings in the Windows Regional 
Settings control panel. The field will have a 
drop-down date selector in it.

Initial Capitals Alphanumeric characters, which will be 
automatically formatted with a capital letter 
at the beginning of each word.

Lowercase Alphanumeric characters, which will be 
automatically formatted in all lowercase 
letters. The Shift and Caps Lock keys have no
effect when you type in a lowercase field.

Numeric Numbers and decimal points only. If you type 
a letter in this field, it will be ignored.

Phone Numbers only.
Time Times only, which will be formatted according

to the time settings in the Windows Regional 
Settings control panel. The field will have a 
drop-down time selector in it.

Uppercase Alphanumeric characters, which will be 
automatically formatted in all uppercase 
letters. The Shift and Caps Lock keys have no
effect when you type in an uppercase field.

URL Address Alphanumeric characters. The address 
entered in the field will become an active link
to the specified URL (Uniform Resource 
Locator).

For example, you can set a field as a date field to help you keep track of when contacts last placed an order with 
your company.



For example, if you change a field that contains alphanumeric data to a date field, all existing data in that field will 
be lost.



 Overview

To specify the kind of data allowed in a field
The Type attribute controls the kind of data that can be entered in the selected field.    

Caution
Changing the field type can result in the loss of existing data.    

If you select a field in the Define Fields dialog box and the Type drop-down list contains only the Character, Initial 
Capitals, Lowercase, and Uppercase options, the selected field is a core field. You can change the names and some
attributes of core fields, but you cannot delete them. 

 Related Topics



 Overview

To specify the number of characters allowed in a field
The Size attribute lets you specify how many characters a field can hold. It does not affect the appearance of the 
field in the layout. For information about changing the physical length of a field in a layout, see Manually 
resizing an object in a template. A character field can hold up to 254 characters; a numeric field can hold up to
19 characters, including decimal points and negative number symbols. The default size of a numeric field is 19.5, 
which means that you can enter a maximum of 18 digits and a decimal point in this field, with 5 digits allowed 
after the decimal point. If you include a negative number symbol in addition to the decimal point, you can enter 
only 17 digits.
You can also specify the way numbers are displayed in numeric fields.

Caution
Be extremely careful about shortening the length of fields containing data. If you have data in a field and you 
shorten the field length so that the existing data no longer fits in the field, you will receive a warning indicating 
that you will lose all of the data that cannot fit in the field.

 Related Topics



For example, you may want to use a field for social security numbers that you need to format as ###-##-####. 
If you set a field to have this format, and you type in 111223333, it will automatically appear in the field as 111-
22-3333. Also, if you type in more characters than are specified in the field format, the extra characters will not 
appear. 



For example, if you want the percent sign to appear in a field, enter the following: \%



For example, you can enter the dashes in a social security number, and they will appear exactly as you enter 
them.



 Overview

To specify a field’s format
The Field Format attribute lets you specify how the data in a Character, Initial Capitals, Lowercase, or Uppercase 
field is automatically formatted. Note that you cannot set a format for numeric fields.    

Caution
Changing a field's format can result in the loss of existing data. Any data that does not fit in the specified field 
format will be lost.

The following table shows the characters that you can use to set the field format.
Character to use As a placeholder for this kind of character
# Numeric
@ Alphabetic
% Alphanumeric
You can also enter any characters that you want to appear in the field.    
To enter any of the three placeholder symbols as actual symbols in the field, enter them preceded by a backslash (\)
character.    

 Related Topics



For example, if you do almost all of your business in California, you could set the State field to have a default value
of California. Or, if you are a salesperson, you may want all new contacts to have an ID/Status set to Prospect.



 Overview

To specify default data to appear in a field
The Default Value attribute lets you assign a specific value that is automatically entered in a field whenever you 
create a new contact or group record. This can speed up the data entry of new records.    

 Related Topics



 Overview

To set rules for data entry in a field
The Entry Rules attribute lets you set requirements for how data must be entered into a field. The following table 
shows the Entry Rules options that you can select.
Entry Rules option to 
select

To set the following 
requirement

Protected Data cannot be entered or 
edited in this field.

Only From Drop-down Data must be selected from 
the entries in the field's drop-
down list.

Required Data is required in this field; 
the field cannot be left blank.

None There are no requirements or 
rules for data entry in this 
field.

 Related Topics



 Overview

To make a field a primary field
The Primary Field attribute lets you define any field as primary. Primary fields are used if you choose either the 
Duplicate Contact command from the Contact menu or the Duplicate Group command from the Group menu and 
then select the Duplicate Data From Primary Fields option. The default primary contact fields are Address 1, 
Address 2, Address 3, City, Company, Country, Fax, Phone, State (County, Land, Province), and Zip (Postcode). The 
default primary group fields are Address 1, Address 2, Address 3, City, Country, Description, Division, State 
(County, Land, Province), and Zip (Postcode).

 Related Topics



 Overview

To generate history when a field is modified
The Generate History attribute lets you specify whether a history entry is created when the selected field is 
modified. If you select this option, an entry appears in the Notes/History tab, indicating which field was changed, 
the date on which it was changed, and the data that was changed in the field.

 Related Topics



 Overview

To disable synchronization updates to and from a field
The Block Synchronization attribute lets you    keep a field from being updated when you apply a 
synchronization message to the database. At the same time, it allows you not to send information from the 
selected field when you send synchronization messages. 

 Related Topics



The City, Country, Department, ID/Status, Last Results, State, Title, Home City, Home Country, Home State, Asst. 
Title, 2nd Title, 3rd Title, Referred By, Public/Private and Record Manager fields in an ACT! contact database are set
up by default with drop-down lists of data to speed up data entry. 
You can add drop-down lists of data to any of the fields in a contact or group database. For example, you can set 
up a Territory field and create a list of territories that can be selected in that field.
To get items into these lists, you can type them in manually, or you can import them from a delimited text file 
created in another ACT! 3.0 database or in another application.



For example, if you have an item called "Benelux," the description could be "Belgium, Netherlands, and 
Luxembourg."



 Overview

To manually add items to a drop-down list

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected, then click the Drop-down tab.
3. From the Record Type drop-down list, choose Contact or Group.

You can add drop-down lists to fields in either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field for which you want to create a drop-down 

list.
5. Click the New button.

A blinking cursor appears in the Item column, indicating that you can type a new item.
6. Type the first item that you want to appear in the list.

After you enter items, the Item list is automatically sorted alphabetically.
7. (Optional) Press the Tab key to move to the Description column and enter a description for the item.

This can be an explanation of what the item represents.  
8. To continue, click the New button and type another item until you have typed all the items you want to appear 

in your list.
9. (Optional) Select the Allow Editing option if you want users to be able to edit the lists when they are editing 

records.
If you select this option, an Edit List item appears at the bottom of the field's drop-down list so that users can 
add, modify, or delete items in the list.

10.(Optional) Select the Show Descriptions option if you want to display the description as well as the item name 
in the drop-down list.

11.(Optional) Select another field from the list and specify the items for its drop-down list following steps 5 through
10 for each new list.

12.Click OK when you have finished entering items for one or more fields.
For information about deleting items from drop-down lists, see Deleting items from lists.

 Related Topics



If you or one of your colleagues has already created a drop-down list of items in another application or another 
ACT! 3.0 database, you can import this list into your ACT! database. For example, your company may have a 
complete list of its products, which you want to be available in a drop-down list in one of the ACT! fields. 
Make sure that the file is saved as a delimited text file (*.TXT). The delimited text file can have one or two fields: 
either the Item or the Item and the Description. 
To create a text file containing just drop-down list items, each item needs to be enclosed in quotation marks. Enter 
the items as shown here (the <CR> indicates a carriage return):
"North"<CR>
"Central"<CR>
"South"<CR>
To create a text file containing both drop-down items and descriptions, each item needs to be enclosed in 
quotation marks with commas separating the fields. Enter them as shown here:
"North","UK, Denmark, Norway, Sweden, Finland"<CR>
"Central","France, Germany, Belgium, Austria"<CR>
"South","Italy, Spain, Portugal"<CR>



 Overview

To import items into a field’s drop-down list

1. Save the file containing the drop-down list items as a comma-delimited text file.
You can do this in ACT! 3.0 or in another application. See Exporting drop-down list items to a delimited 
text file for more information about doing this in ACT!.

2. From the ACT! Edit menu, choose Define Fields.
The Define Fields dialog box appears.

3. Make sure that the Fields tab is selected, then click the Drop-down tab.
4. From the Record Type drop-down list, choose Contact or Group.

You can import items to fields in either the Contact database or the Group database.
5. From the field list on the left side of the dialog box, select the field into which you want to import items.
6. Click the Import button.

The Import dialog box appears. Note that you can use this dialog box only to import drop-down list items-you 
cannot use it to import another database.

7. Click the Browse button to the right of the Filename And Location Of Delimited (Text) File field, find the file you 
want to import, and click the Open button.

8. (Optional) If you want to overwrite the existing list with the imported list, turn off the Append Imported Items 
option.
By default, the imported items are added to the existing list.

9. (Optional) If the delimited text file contains descriptions of items, select the Import Item Descriptions option.
10.Click OK.

 Related Topics



You can export the items in a field's drop-down list to a delimited text file (*.TXT) that you can import later into 
another application, another ACT! 3.0 database, or another field in the same database.



 Overview

To export drop-down list items to a delimited text file

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected, then click the Drop-down tab.
3. From the Record Type drop-down list, choose Contact or Group.

You export drop-down list items from fields in either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field from which you want to export drop-down 

list items.
5. Click Export.

The Export Drop-down dialog box appears.
6. Click the Browse button to the right of the Delimited (Text) Filename To Export To field, find the file to which you

want to export the items or type in the name of a new file, and click Save.
7. (Optional) If you want to export the descriptions with the drop-down items, select the Export Item Descriptions 

option.
8. Click OK.

The items from the field's list are exported to a delimited text file which you can import into another 
application, another ACT! 3.0 database, or another field in the same database.

 Related Topics



Occasionally, items in your drop-down lists become obsolete, or you may enter an item by mistake. You can easily 
delete one or more items from a drop-down list.

Note
If the Allow Editing option is turned on for a field with a drop-down list, the list contains an Edit List item. You 
can choose Edit List to add, modify, or delete items from a drop-down list. If the Allow Editing option is turned 
off, you will need to delete items from a drop-down list.



 Overview

To delete items from drop-down lists

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected, then click the Drop-down tab.
3. From the Record Type drop-down list, choose Contact or Group.

You can delete drop-down list items from fields in either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field from which you want to delete one or more 

drop-down list items.
5. In the Item list, select the item you want to delete by clicking the button to the left of the item.

Shift+click or Ctrl+click to select multiple items to delete.
6. Click Delete.

The item is deleted from the list.
7. (Optional) Select additional items to delete from other fields, clicking Delete after making each selection.
8. When you have finished deleting items, click OK.

 Related Topics



At some point, you may need to add a new field to a contact or group database, rather than modifying an existing 
field. For example, if you have already used the User 1 through User 15 fields and don't want to modify any of the 
other existing fields, you can create another field.



 Overview

To create a new field

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected, then click the Attributes tab.
3. From the Record Type drop-down list, choose Contact or Group.

You can add fields to either the Contact database or the Group database.
4. Click New Field.

The Field Name field displays New Field 1.
5. In the Field Name field, type a name for the new field.
6. Set any other field attributes that you want for the new field and click OK.

The database is reindexed and the new field is now part of your database, but it is not automatically added to 
your layouts. 

 Related Topics



You can delete any field in an ACT! database except for the core fields. If you select one of the core fields in the 
Define Fields dialog box, the Delete button is dimmed, indicating that you cannot delete the selected field.

Caution
When you delete a field from a database, all data in that field is also deleted. You should only delete a field if 
you are sure that you no longer need the data in that field.



 Overview

To delete a field

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected.
3. From the Record Type drop-down list, choose Contact or Group.

You can delete fields from either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field that you want to delete.
5. Click Delete.

A message appears asking if you are sure that you want to delete the field. 
6. Click Yes.

The field is deleted from the database and the database is reindexed. 
 Related Topics



ACT! builds indexes, or tables of data, on some fields in your database to help speed up lookups, queries, and 
sorts. If you perform a lookup, query, or sort operation on an indexed field, ACT! uses the index to find or sort the 
records rather than looking through every record, one by one. Performing lookups, queries, or sorts on non-indexed
fields is substantially slower than doing the same operations on indexed fields.
The following contact fields are indexed by default: City, Company, First Name, ID/ Status, Last Name, Phone, State
(County, Land, or Province), and Zip (Postcode). The following group fields are indexed by default: Group Name, 
Priority, City, and State. You can also index other fields in the contact or group database. Keep in mind, however, 
that you should only index the fields on which you perform lookups, queries, and sorts most frequently. For 
example, if you set up one of the User fields to track sales figures, you may frequently perform lookups, queries, or
sorts on this field.

Note
Do not index too many fields in the database because the database will take up more disk space with more 
indexed fields in it, and simple actions such as saving a new record will take longer.



For example, the Company index sorts first on Company, then on Last Name, then on First Name.



 Overview

To index a field

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Click the Advanced tab.
3. From the Record Type drop-down list, choose Contact or Group.

You can index fields in either the Contact database or the Group database.
4. In the Indexes group box, click New Index.

The first available field name appears at the top of the Indexes list box. This is generally the 2nd Contact field 
because it's the first field in alphanumeric order.

5. Make sure that the 2nd Contact field (or any other field that was added to the top of the Indexes list) is 
selected.

6. Choose the field that you want to index from the Index On drop-down list.
7. (Optional) To specify secondary sort criteria to be used when ACT! performs lookups or queries on this field, 

select the fields you want to sort from the Then On drop-down lists. 
8. (Optional) Repeat steps 3 through 7 to index additional fields.
9. Click OK when you have finished specifying your indexed fields.

The database is reindexed based on your modifications.
 Related Topics



If you create additional indexes and find that you don't need them, you might want to delete them to make your 
database perform more efficiently. Note that you cannot delete the core indexes, which are City, Company, First 
Name, ID/Status, Last Name, Phone, State (County, Land, or Province), and Zip (Postcode) in the Contact database;
and City, Group Name, Priority, and State in the Group database.



 Overview

To delete one or more indexes

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Click the Advanced tab.
3. From the Record Type drop-down list, choose Contact or Group.
4. From the list of indexes on the left side of the dialog box, select the index that you want to delete.
5. Click Delete Index

A message appears asking you to confirm the deletion.
6. Click Yes to delete the index.

The index is deleted and the database is reindexed.
 Related Topics



You can set up an ACT! macro or an external application that launches when you enter or exit a field. These 
settings are called triggers. For example, you can write a program that automatically fills in the appropriate city if 
you enter a zip code (postcode). In this case, you could have ACT! automatically launch this program when you 
exit the Zip (Postcode) field.



 Overview

To automatically launch an application or macro from an ACT! field

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Make sure that the Fields tab is selected, then click the Triggers tab.
3. From the Record Type drop-down list, choose Contact or Group.

You can add triggers to fields in either the Contact database or the Group database.
4. From the field list on the left side of the dialog box, select the field for which you want to set a trigger.
5. Enter the filename and location of the program or macro you want to launch in either of the fields in the Select 

Program To group box, or use the Browse button to the right of either field to easily locate the application file or
macro.
You can choose to have the program or macro launch when you enter a field or when you exit a field. Note that 
you must select either an executable (.EXE) file or a macro (.MPR) file. If you want to select a macro, make sure
that the Macro Files option appears in the Files of Type drop-down list.

6. (Optional) Repeat steps 3 through 5 for each additional trigger you want to set.
7. Click OK when you have finished specifying field triggers.

 Related Topics



Macros are shortcuts that help you save time by automating keyboard and mouse actions that you perform 
regularly. For example, if you often run the Contact Report for all of your contacts in a certain area, you can create 
a single macro that will perform the lookup and run the report for you.
You create macros by recording the actions that you want to automate. For example, if you want to create a macro 
to send a mail-merged letter to all of your contacts whose ID/Status is Prospect, you must record the actions of 
performing the lookup, running the mail merge, printing the letter, and creating the envelopes for each of the 
letters.



For example, you may want to choose a command from the Lookup menu, enter a value on which to search, then 
choose a report from the Reports menu to create the report.



Option Name Description
Everything Records all keyboard actions 

and mouse movements. Note 
that macros including mouse 
movements may not work if 
you change monitor 
resolution or window 
positions.

Record click and drags 
[Mouse events]

Records keystrokes and 
mouse movements that you 
perform while clicking or 
pressing the left mouse 
button.

Record everything 
except mouse events

Records only actions that you 
perform on the keyboard. This
is the most reliable method of
recording macros.

 Overview

To create a macro

1. From the Tools menu, choose Record Macro, or press Alt+F5.
The Record Macro dialog box appears.

2. In the Name Macro To Record field, enter a name for the macro that you are creating.
3. (Optional) If you want to enter a description of what the macro does, enter it in the Description field.
4. From the Record Events drop-down list, choose one of the three options to specify which events you want to 

record.    
5. Click Record.

Your actions are recorded, including making and correcting mistakes, until you stop recording the macro by 
choosing Stop Recording Macro from the Tools menu or pressing Alt+F5.

6. Perform all of the actions that you want to record.    
7. When you have finished performing all the actions that you want to record, choose Stop Recording Macro 
from the Tools menu, or press Alt+F5.

Your macro is saved in the Macro folder with the extension of .MPR.
 Related Topics



Macros are shortcuts that help you save time by automating keyboard and mouse actions that you perform 
regularly. For example, if you often run the Contact Report for all of your contacts in a certain area, you can create 
a single macro that will perform the lookup and run the report for you.
When you have recorded a macro, running it is a simple procedure. If you use a macro frequently, you can select 
an icon for the macro and add it to the toolbar. For information about doing this, see Assigning an icon to an 
ACT! macro or a custom command.



 Overview

To run a macro

1. From the Tools menu, choose Run Macro.
The Run Macro dialog box appears.

2. Select the macro that you want to run from the Macros list.
3. (Optional) If you want to run the macro at the speed at which you recorded it, select the Run At Recorded 

Speed option.
If you do not select this option, ACT! runs the macro as quickly as it can be run.

4. Click Run.
All of the actions that you recorded in your macro are performed.

 Related Topics



Macros are shortcuts that help you save time by automating keyboard and mouse actions that you perform 
regularly. For example, if you often run the Contact Report for all of your contacts in a certain area, you can create 
a single macro that will perform the lookup and run the report for you.
If you find that you don't use one or more of your macros, you can simply delete any macros that you no longer 
need.



 Overview

To delete a macro

1. From the Tools menu, choose Delete Macro.
The Delete Macro dialog box appears.

2. From the Macros list, select the macro that you want to delete and click Delete.
The selected macro is deleted.

 Related Topics



You can make the ACT! startup process more efficient by specifying the following:
Which contact and group layouts to open at startup
Which database to open at startup
Which macro to run at startup

You can also specify whether all new contacts and groups should be entered as public or private records. By 
default, all contacts and groups that you create are public records. If you find that you create more private records 
than public records, you may want to change the default setting to create private records.



For example, if you have created a macro to display today's calendar, you may want that to run at startup.



 Overview

To specify startup settings

1. From the Edit menu, choose Preferences.
2. Click the Startup tab.
3. In the Contact Window group box, specify which contact layout you want opened by default.

If you want all new contacts to be private contacts, select the Make New Contact Private option.
4. In the Group Window group box, specify which group layout you want opened by default.

If you want all new groups to be private groups, select the Make New Groups Private option. You can also 
specify which field to use as the second column in the Groups window. By default, the Priority field appears.

5. In the Startup Database group box, specify which database you want to open at startup.
You can specify that the last opened database open at startup, or you can specify the name of a database to 
open at startup.

6. In the Run Macro On Startup group box, specify a macro that you want to run at startup and click OK.    
 Related Topics



To suit your personal style and preferences, you may want to change the colors or use a different font in some of 
the ACT! windows. You can change the background color, font, font style, font size, and font color for many of the 
ACT! windows using the Colors And Fonts tab of the Preferences dialog box. For all of the windows or views that 
display lists, including the Contact List, Contacts tab, Groups tab, Notes/ History tab, Activities tab, and Task List, 
you can also specify whether to display grid lines between rows and columns of data.



 Overview

To change one or more windows’ colors and fonts

1. From the Edit menu, choose Preferences.
The Preferences dialog box appears.

2. Click the Colors And Fonts tab.
3. From the Customize list on the left side of the dialog box, select the window whose colors or fonts you want to 

change.
4. Click Font to change to a different font.

The Font dialog box appears.
5. Choose the font, font style, and size from the lists and click OK.
6. Click the drop-down arrow below the Text Color label.

A drop-down palette appears.
7. Select a color that you want to use for the text in the selected window.
8. Click the drop-down arrow below the Background Color label.

A drop-down palette appears.
9. Select a color that you want to use for the background in the selected window.
10.(Optional) Select the Show Grid Lines option if you want lines displayed between rows and columns in any of 

the list views.
11.(Optional) Repeat steps 3 through 9 for each additional window whose colors or fonts you want to customize.
12.Click OK when you have finished specifying the colors and fonts.

The new settings are applied to the windows that you customized.
 Related Topics



Several of the ACT! windows or tabs within windows are lists containing fields of data in a columnar format. You 
can easily customize all of these list views by adding or removing columns, rearranging the order of the columns, 
or resizing the width of the columns.
The list views include the following:

Contact List window
Task List window
Notes/History tab in the Contact window
Activities tab in the Contact window
Groups tab in the Contact window
Notes/History tab in the Group window
Activities tab in the Group window
Contacts tab in the Group window



 Overview

To understand the columns in the list views
You can easily add or remove columns, rearrange the order of the columns, or resize the width of the columns.

Note
The Notes/History tabs in the Contact and Group windows are slightly different from the other lists because you 
can show or hide the column headings. To customize the columns in the Notes/History tab, you'll want to 
display the column headings by positioning the pointer in the Notes/History tab, pressing the right mouse 
button, and choosing Show Column Headings from the shortcut menu.

 Related Topics



Sometimes some of the columns in any of the list views are too narrow to display all of the data that they contain. 
At other times, you may find that a column is too wide, and you would like to narrow that column to make more 
room for another column. You can easily resize the columns by dragging the column dividers. The column widths 
you set are saved when you close and reopen a database.



 Overview

To change a column’s width

1. Position the pointer over the edge of the column that you want to widen or narrow.
When you are over the column edge, the pointer changes, indicating that you can resize the column.

2. Press the left mouse button and drag the edge of the column to the right or left to widen or narrow it.
 Related Topics



If you find that the columns of one of the lists are not in the ideal order, you can rearrange the column order by 
simply dragging a column and dropping it into a new position. The column order you set is saved when you close 
and reopen a database.



 Overview

To rearrange the column order

1. Position the pointer over the heading of the column that you want to move.
2. Press the left mouse button and drag the column to a new location in the list, releasing the mouse when the 

column is in the correct position.
 Related Topics



By default, the various list views may not display all of the available fields. For example, the Contact List displays 
the Address and Address 2 fields but not the Address 3 field. If you frequently have data in the Address 3 field, you 
may want to add it as a column in the Contact List.



 Overview

To add a column to a list view

1. Make sure that the list view to which you want to add a column is active.
2. Press the right mouse button and choose Add Columns from the shortcut menu.

The Add Columns dialog box appears. 
3. Do one of the following:

Double-click the field for which you want to create a column. This adds the column as the last column on 
the right.

Shift+click or Ctrl+click to select multiple fields, and click Add.
Select the field and drag it to the position you want in the list view.

4. (Optional) To add more columns, repeat the previous step for each column that you want to add. 
5. Click Close when you have finished adding columns.

 Related Topics



You can remove any of the columns from a list view.



 Overview

To remove a column from a list view

1. Position the pointer over the heading of the column that you want to remove.
2. Drag the column up and away from the list.

If you accidentally remove a column, you can add it back as described in Adding a column to a list view.
 Related Topics



The default contact or group layout may not contain all of the fields that you want to display. You can add more 
fields to any layout, as long as you can find a place to put them in the layout.

Note
To create a new field and add it to a layout, you must first create the field using the Define Fields dialog box.



 Overview

To add fields to layouts

1. Use the layout menu at the bottom of the Contact or Group window to select the layout to which you want to 
add a field.

2. From the Tools menu, choose Design Layouts.
The layout designer window appears with the selected layout displayed. You can add fields to any part of the 
layout, including the tabs.

3. Click the Field tool in the tool palette.
When you move the pointer over the layout, it turns into a crosshair pointer.

4. Position the pointer where you want to insert a field in the layout, and drag to define the field's position and 
size in the layout.
The Fields dialog box appears.

5. In the Fields dialog box, select the field that you want to add to the layout. If you do not want the field to have a
label, turn off the Add Label option.

6. Click Add.
7. (Optional) Repeat steps 5 and 6 for each field that you want to add to the layout.
8. Click Close when you have finished adding fields to the layout.

If you don't select the Add Label option and later decide that you want the field to be labeled, you can select 
the field and choose the Add Label command from the Objects menu. If the fields are not positioned exactly as 
you want them to be, you can move them and align them exactly. You can also change the style of the label, 
the field itself, and the fonts. You change the appearance of layouts in the same way that you modify report 
templates.

 Related Topics



If you have set a field's type to Numeric, you can specify how to display positive and negative numbers, and how 
many decimal places to display in the field.



 Overview

To specify how data is displayed in numeric fields

1. In the Layout Designer, select one or more numeric fields and click the right mouse button.
2. From the shortcut menu, choose Properties.

The Object Properties dialog box for numeric fields appears.
3. Select an option in the Appearance list to determine how to display all numbers in the selected field or fields.
4. From the Negatives drop-down list, choose the symbol you want to use to display all negative numbers in the 

selected field or fields.
5. From the Decimal Places drop-down list, choose the number of decimal places that you want to display in the 

selected field or fields.
6. Click OK.

 Related Topics



If you have set a field’s type to Date or Time, you can specify how to display the dates or times in the field.



 Overview

To specify how data is displayed in date and time fields

1. In the Layout Designer, select a date or time field and click the right mouse button.
2. From the shortcut menu, choose Properties.

The Object Properties dialog box appears.
3. Click the Format tab.
4. Select an option in the Appearance list, and click OK.

 Related Topics



You may want to remove unused fields from the layout in order to simplify the layout or make room for other fields 
that you want to add.



 Overview

To remove a field from a layout

1. In the Layout Designer, click the Selection tool in the tool palette.
2. Select the field and field label that you want to remove from the layout.

You can do this in two ways:
Drag a selection box around the field and the field label.
Click the field label to select it, then press the Shift key and click the field itself. This will select both the 

field and the field label. 
3. Press the Delete key.

 Related Topics 



The default contact and group layouts have multiple tabs at the bottom of the window, which contain additional 
fields. You can change the name of an existing tab, change the order in which the tabs appear, add new tabs, or 
delete existing tabs.



 Overview

To change the name of a tab

1. From the layout designer's Edit menu, choose Tabs.
The Define Tab Layouts dialog box appears.

2. Select the tab that you want to rename and click Rename.
The Rename Tab Layout dialog box appears.

3. Enter the new name for the tab and click OK.
4. (Optional) Repeat steps 2 and 3 for each tab in the layout that you want to rename.
5. When you have finished renaming one or more tabs, click OK.

 Related Topics



For example, if you want the Phone/Home tab to appear before the User Fields tab, select Phone/Home in the list 
and click Move Up.



 Overview

To change the order of the tabs

1. From the layout designer's Edit menu, choose Tabs.
The Define Tab Layouts dialog box appears.

2. Select the tab that you want to move, and click Move Up or Move Down. 
3. (Optional) Repeat step 2 for each of the tabs that you want to move.
4. When you have finished specifying the order of the tabs, click OK.

 Related Topics



 Overview

To add a new tab to a layout

1. From the layout designer's Edit menu, choose Tabs.
The Define Tab Layouts dialog box appears.

2. Click Add.
The Add Tab Layout dialog box appears.

3. Enter a name for the tab that you want to create and click OK.
The Define Tab Layouts dialog box reappears with the new tab last in the list.

4. (Optional) If you want to move the new tab up in the list, click Move Up.
5. Click OK.

The layout reappears with the new tab at the bottom of the window.
 Related Topics



 Overview

To remove a tab from a layout

1. From the layout designer's Edit menu, choose Tabs.
The Define Tab Layouts dialog box appears.

2. Select the tab that you want to remove from the layout and click Delete.
A confirmation message appears, asking if you are sure that you want to delete the tab.

3. Click Yes.
The Define Tab Layouts dialog box reappears.

4. (Optional) Repeat steps 2 and 3 for any additional tabs that you want to remove from the layout.
5. Click OK.

The tab no longer appears in the layout.
 Related Topics



ACT! includes several contact and group layouts, which you can modify to suit your needs. You can also create new
layouts of your own. When you modify or create new layouts, you can specify the colors, fonts, and graphics used 
in the layout as well as the position and order of fields in the layout. If you have created new fields for your 
database, you can add them to the layouts.
You use the Design Layouts command in the Tools menu to edit your layouts. This command opens the layout 
designer window, which has its own menus, toolbar, and tool palette. The tools are identical to those in the report 
designer.

Note
Although you can use the Text tool to change the label of a field, this does not change the actual field name. 
Changes made to the label using the Text tool in the layout designer will not be reflected in any field lists or in 
any other layouts and will not be sent if you send field attributes when you synchronize data.



 Overview

To change a layout’s background color or pattern
You can customize the appearance of a layout's background by changing its color or adding a pattern or a graphic.
1. Position the pointer anywhere in the background of the layout.

Do not click an object such as a field or a field label.
2. Click the right mouse button and choose Properties from the shortcut menu.

The Background Properties dialog box appears.
3. To change the background color, select one of the colors in the color palette.
4. To add a pattern to the background, select one of the patterns in the pattern palette.

Note that the pattern will appear in the currently selected color.
5. Click OK.

 Related Topics



 Overview

To add a graphic to a layout’s background

1. Position the pointer anywhere in the background of the layout.
Do not click an object such as a field or a field label.

2. Click the right mouse button and choose Properties from the shortcut menu.
The Background Properties dialog box appears.

3. Click the Browse button to the right of the Bitmap field.
The Open dialog box appears.

4. Locate the graphic file that you want to add to the layout's background and click Open. The file must have 
a .BMP extension.
The graphic appears in the Sample area of the Background Properties dialog box.

5. (Optional) If you want the graphic to be "tiled" or repeated throughout the layout's background, click the Tile 
option.
If you do not select this option, the graphic appears only in the upper-left corner of the layout.

 Related Topics



 Overview

To remove a graphic from a layout’s background

1. Position the pointer anywhere in the background of the layout.
Do not click an object such as a field or a field label.

2. Click the right mouse button and choose Properties from the shortcut menu.
The Background Properties dialog box appears.

3. Delete the name of the graphic file from the Bitmap field and click OK.
 Related Topics



The default contact and group layouts are set up so that you can use the Tab key to move through every field in a 
layout, top to bottom, left to right. In addition, you can use the Enter key to move to the group stop fields. A group 
stop field is a field to which you can move using the Enter key. This helps you move quickly through the fields and 
tabs in a layout. By default, the group stop fields in the contact layout are Company, Phone, Address, and User 1.
Using the layout designer, you can change the order in which you tab through the fields, and you can set or 
remove group stops in fields. This can help you make data entry more efficient, especially if you prefer to enter 
data in a certain order or if you want to enter data only in certain fields. Before you change the field entry order, 
you need to display the current order.



 Overview

To view the current field entry order in a layout
From the layout designer's Edit menu, choose Field Entry Order > Show.

The layout appears with numbers on the right side of each field. If a field is set as a group stop, it has a red 
stop sign to the left of the number.

 Related Topics



 Overview

To switch the field entry order of two fields

1. In the Layout Designer, click the first field's number.
This clears the number from the field.

2. Click the field number that you want to switch with the first field. 
The numbers are switched, changing the field entry order.

 Related Topics



 Overview

To clear the field entry order completely and enter a new order

1. From the Layout Designer's Edit menu, choose Field Entry Order > Clear.
All of the numbers and group stops are cleared.

2. Click through the fields' number squares in the exact order that you want to set as the field entry order.
The numbers appear in order as you click the squares.

 Related Topics



 Overview

To reset the original field entry order
From the Layout Designer’s Edit menu, choose Field Entry Order > Reset.

 Related Topics



 Overview

To add or remove a group stop on a field
In the Layout Designer, click the group stop square to turn on the group stop. If you want to turn it off, click

the square again.
You cannot set the order of group stops.

 Related Topics



Occasionally, you may want to create a completely new layout rather than modify an existing layout.



 Overview

To create a new layout

1. Open the layout designer by choosing Design Layout from the Tools menu.
2. From the layout designer's File menu, choose New.

A new, empty layout appears.
 Related Topics



After creating a new contact or group layout, you will want the new layout to be available in the layout drop-down 
menu at the bottom of the Contact or Groups window. In order to have your layout appear in this menu, you need 
to save the layout and assign a file description name to it.

Note
In the layout drop-down menu, ACT! displays the file description rather than the actual file name. If you do not 
change the file description, it is identical to the file name.



 Overview

To name and save a layout

1. From the layout designer's File menu, choose Save As.
The Save As dialog box appears.

2. Enter a file name for the layout and click Save.
The layout is saved. If you want to enter a longer or different name to appear in the layout drop-down menu, 
proceed to the next step.

3. Position the pointer over a blank area in the layout and click the right mouse button.
4. From the shortcut menu, choose File Description.

The File Description dialog box appears.
5. Enter the name that you want to appear in the layout drop-down menu and click OK.

The new layout now appears in the layout drop-down menu.
 Related Topics



When you are modifying a layout, you may want to return to a contact or group record. You can easily go back and 
forth between the layout designer and the contact or group records. 



 Overview

To close the layout designer
From the layout designer's View menu, choose Records.

This returns you to the last record that you were viewing before opening the layout designer. It may be a 
contact record or a group record. If you have made changes to the layout, ACT! prompts you to save your 
changes before returning to the contact or group layout.

 Related Topics



The Lookup, Write, and Reports menus all contain a Modify Menu command that lets you add your own saved 
queries, word-processing templates, and report templates to the respective menus. You can add query files to the 
Lookup menu, word-processing templates to the Write menu, and report, label, and envelope templates to the 
Reports menu. Note that you must first save the custom queries or templates before you can add them to the 
menus.



 Overview

To add a command to the Lookup, Write, or Reports menus

1. From the Lookup, Write, or Reports menu, choose Modify Menu.
The Modify Menu dialog box appears.

2. Click Add Item.
The Add Custom Menu Item dialog box appears.

3. Click the Browse button to the right of the Filename And Location field, find the query file, word-processing 
template, report template, label template, or envelope template you want to add to the appropriate menu, then
click Open.

4. In the Command Name To Display In Menu field, enter the text that you want to appear in the menu and click 
OK.
The new command appears in the Modify Menu dialog box.

5. Click OK again.
The new command appears in the appropriate menu.

 Related Topics



 Overview

To rearrange or delete custom commands

1. From the Lookup, Write, or Reports menu, choose Modify Menu.
The Modify Menu dialog box appears, displaying a list of the commands that you have added.

2. Rearrange the custom commands in any of the following ways:
Select a command and click Separator to add a separator line above the selected command.
Select a command and click Move Up to move it up in the menu.
Select a command and click Move Down to move it down in the menu.

3. Select a command and click Delete to remove it from the menu.
 Related Topics



You can modify any of the menus in any of the ACT! windows. You may want to rearrange the order of the 
commands in the menus, add new commands to the menus, remove commands that you rarely use, add a custom 
submenu, or add separators between groups of commands. 
You use the Menus tab of the Customize ACT! dialog box to modify the menus.



 Overview

To get started customizing the menus

1. From the Tools menu, choose Customize.
The Customize ACT! dialog box appears.

2. Click the Menus tab if it is not already selected.
 Related Topics



 Overview

To change the order of commands in a menu

1. From the Menu drop-down list, select the window containing the menu that you want to customize.
The menu preview area displays the menus for the selected window. 

2. If necessary, scroll vertically through the menus to find the one that you want to modify.
3. Do one of the following:

Drag a menu command and drop it into a new position in the same menu or in a different menu.
Select the menu command that you want to move and click the up or down arrow buttons to move it up or 

down in the menus.
4. Click Save to save changes to the menus.

 Related Topics



 Overview

To add a command to a menu

1. From the Menu drop-down list, select the window containing the menu that you want to customize.
The menu preview area displays the menus for the selected window. 

2. If necessary, scroll vertically through the menus to find the one that you want to modify.
3. Click an item in the menu below which you want to add a command.
4. From the Commands list at the bottom of the dialog box, select the command that you want to add to the 

menu.
5. Click Insert.

The command is added to the menu in the position that you specified.
6. Click Save to save changes to the menu.

 Related Topics



 Overview

To add a custom submenu to a menu

1. From the Menu drop-down list, select the window containing the menu that you want to customize.
The menu preview area displays the menus for the selected window. 

2. If necessary, scroll vertically through the menus to find the one that you want to modify.
3. Click in the menu to specify the position where you want to add a submenu.
4. Click the Add Submenu button.

A submenu appears in the specified position.
5. Type a name for the custom submenu by typing directly over the "Custom Menu" name.

The "&" symbol in front of the Custom Menu name means that the first letter of the submenu name will be an 
accelerator key, indicating that you can type that letter to select the submenu. If you do not want to define an 
accelerator key for the submenu, delete the "&" symbol.
You can now add commands to the submenu.

 Related Topics



 Overview

To add separator to a menu

1. From the Menu drop-down list, select the window containing the menu that you want to customize.
The menu preview area displays the menus for the selected window. 

2. If necessary, scroll vertically through the menus to find the one that you want to modify.
3. Click in the menu to specify the position above which you want to add a separator.
4. Click the Add Separator button.

A separator appears in the specified position.
5. Click Save to save changes to the menu.

 Related Topics



 Overview

To remove a menu command or separator

1. From the Menu drop-down list, select the window containing the menu that you want to customize.
The menu preview area displays the menus for the selected window. 

2. If necessary, scroll vertically through the menus to find the one that you want to modify.
3. Select the command or separator that you want to remove.
4. Click Delete.

The command or separator is removed from the menu.
5. Click Save to save changes to the menu.

 Related Topics



 Overview

To reset the original menus

1. From the Menu drop-down list, select the window containing the menus that you want to reset to their original 
state.

2. Click Reset.
A message appears saying that you will lose all changes you have made and asking if you are sure you want to 
reset the default menus.

3. Click Yes.
The default menus are restored.

 Related Topics



You can modify any of the toolbars in any of the ACT! windows. You may want to rearrange the order of the tools in 
the toolbar, add new tools to the toolbar, remove tools that you rarely use, or add space between tools.
In addition to adding, removing, or rearranging tools in the toolbar, you can also specify how toolbars are 
displayed. You can choose to display large or small icons, with or without text, or you can choose text-only 
toolbars. You can also specify whether to display tooltips when you move the pointer over a tool in the toolbar.

Note
Before customizing a toolbar, you must open the window containing the toolbar that you want to modify. For 
example, if you want to modify the toolbar that appears in the Groups window, open the Groups window by 
choosing Groups from the View menu.

You use the Toolbars tab of the Customize ACT! dialog box to modify the toolbars.



 Overview

To get started customizing the toolbars

1. Open the window containing the toolbar you want to customize.
2. From the Tools menu, choose Customize.

The Customize ACT! dialog box appears.
3. Click the Toolbars tab if it is not already selected.

The toolbar preview area displays the toolbar for the selected window.
 Related Topics



 Overview

To change the position of tools in a toolbar

1. With the Toolbars tab active in the Customize ACT! dialog box, do one of the following:
Drag the tool that you want to move and drop it into a new position in the toolbar.
Select the tool that you want to move and click the right or left arrow buttons to move the tool to the right 

or left in the toolbar.
2. Click Save to save the changes to the toolbar.

 Related Topics



 Overview

To add a tool to a toolbar

1. With the Toolbars tab active in the Customize ACT! dialog box, click in the toolbar to specify where you want to 
insert the new tool.
The new tool will be placed to the left of the position that you click.

2. From the Commands list at the bottom of the dialog box, select the command for the new tool.
3. Click Insert.

The new tool appears in the toolbar.
4. Click Save to save the changes to the toolbar.

 Related Topics



 Overview

To remove a tool from a toolbar

1. With the Toolbars tab active in the Customize ACT! dialog box, select the tool that you want to remove from the
toolbar.

2. Click Delete.
The tool is removed from the toolbar.

3. Click Save to save the changes to the toolbar.
 Related Topics



 Overview

To add space between tools in a toolbar

1. With the Toolbars tab active in the Customize ACT! dialog box, click in the toolbar to specify the place where 
you want to add space between tools.

2. Click the Insert Space button.
A space appears in the position that you specify.

3. Click Save to save the changes to the toolbar.
 Related Topics



 Overview

To reset a toolbar to its default settings

1. With the Toolbars tab active in the Customize ACT! dialog box, click Reset.
A message appear asking if you want to restore the default toolbar.

2. Click Yes to reset the toolbar.
3. Click Save to save the changes to the toolbar.

 Related Topics



 Overview

To change the display of the toolbar

1. Open the window containing the toolbar you want to display differently.
For example, if you want the E-mail window's toolbar to display small icons with text, open the E-mail window 
by choosing E-mail from the View menu.

2. Using the right mouse button, click a blank area in the toolbar.
A shortcut menu appears.

3. Choose one of the commands to specify the kinds of buttons that you want to appear in the toolbar.
4. (Optional) Choose Toolbars from the shortcut menu.

The Toolbars dialog box appears.
5. (Optional) Choose Customize from the shortcut menu if you want to add, remove, or rearrange tools in the 

toolbar.
 Related Topics



Many of the ACT! commands have shortcut keys that you can use instead of choosing commands from a menu. For
example, the shortcut key for the File > Open command is Ctrl+O. You can modify the existing shortcut keys or 
add new shortcut keys of your own.
You use the Keyboard tab of the Customize ACT! dialog box to modify the shortcut keys.



 Overview

To get started customizing the shortcut keys

1. From the Tools menu, choose Customize.
The Customize ACT! dialog box appears.

2. Click the Keyboard tab if it is not already selected.
 Related Topics



 Overview

To add new shortcut keys

1. From the Shortcut Keys drop-down list, select the window to which you want to add shortcut keys.
The shortcut key list displays the shortcut keys assigned to the selected window.

2. From the Commands list at the bottom of the dialog box, select the command for which you want to create a 
shortcut key.

3. Click in the Shortcut Key field.
4. Enter the key combination that you want to assign to the selected command.

If the key combination is not assigned to another command, the Insert button is available. If the key 
combination is assigned to another command, the Replace button is available.

5. Click Insert or Replace.
The new shortcut key appears in the list.

6. Click Save to save your shortcut keys.
 Related Topics



 Overview

To delete a shortcut key

1. From the Shortcut Keys drop-down list, select the window from which you want to delete one or more shortcut 
keys.
The shortcut key list displays the shortcut keys assigned to the selected window.

2. In the shortcut key list, select the shortcut key that you want to delete.
3. Click Delete.

The shortcut key is removed from the list.
4. Click Save to save your changes.

If you change your mind or make a mistake, you can simply reset the default shortcut keys.
 Related Topics



 Overview

To reset the original shortcut keys

1. From the Shortcut Keys drop-down list, select the window for which you want to restore the original shortcut 
keys.
The shortcut key list displays the shortcut keys assigned to the selected window.

2. Click Reset.
A message appears saying that you will lose all changes you have made and asking if you are sure you want to 
reset the default shortcut keys.

3. Click Yes.
The default shortcut keys are restored to the selected window.

 Related Topics



You can create custom commands that perform actions outside of ACT!, such as launching another application or 
opening a file. You can also create a custom command for an ACT! macro, then add it to a menu or toolbar, or 
create a shortcut key for it. 
The custom commands that you create appear in the Commands list in the Toolbar, Menu, and Keyboard tabs of 
the Customize dialog box, allowing you to add the custom commands to the toolbars or menus, and letting you 
assign shortcut keys for them. For example, if you frequently use the Windows Calculator while using ACT!, you 
can create a custom command to open the Calculator and add it to a toolbar or menu or create a shortcut key for 
it.

Note
After you add a custom command, you'll need to add it to the menu or toolbar where you want it to appear, or 
assign a shortcut key to it.

You use the Commands tab of the Customize ACT! dialog box to create custom commands. 



 Overview

To get started customizing commands

1. From the Tools menu, choose Customize.
The Customize ACT! dialog box appears.

2. Click the Commands tab if it is not already selected.
 Related Topics



 Overview

To create a new custom command

1. In the Commands tab, click New.
A "Generic Custom Command" appears in the Commands list.

2. In the Command Name field, type the name that you want to assign to this command.
This text will appear in the lists of commands in the Toolbar, Menu, and Keyboard tabs of the Customize ACT! 
dialog box.

3. In the Command Line field, enter the exact filename and location of the application's executable file or 
document file that you want to be able to open.
If you prefer, you can click the Browse button ("...") to locate the file.

4. (Optional) In the Start In field, enter the name of the folder that contains the data files associated with the 
specified application.
You can also use the Browse button to locate the folder. If you leave this field empty, ACT! looks for the 
application's data files in the same location as the executable file.

5. In the Description field, enter a description of the command.
The Description text appears on the status bar when you use this command.

6. In the Button/Tooltip Text field, enter a short title to appear on a button for this command.
This text is used in the tooltip for the command if you add the command to a toolbar and in the tools 
themselves if you display text in the toolbar.

7. In the Menu Text field, enter the name that you want to appear in menus if you add this command to a menu.
8. From the Run drop-down list, select one of the following options to determine how the launched application will 

run:
Normal. Runs the application normally
Minimized. Minimizes the application when it runs
Maximized. Maximizes the application when it runs

9. Click Save to save the custom command.
 Related Topics



 Overview

To copy and modify a custom command

1. In the Commands list, select the custom command that you want to copy.
2. Click Copy.

A new command is created with the information from the command you copied.
3. Modify any or all of the information and click Save to save the new command.

 Related Topics



 Overview

To delete a custom command

1. In the Commands list, select the custom command you want to delete.
2. Click Delete.

The command is deleted from the list.
3. Click Save to save your changes.

 Related Topics



If you create a custom command or an ACT! macro and you want to put a tool for the command or macro on the 
toolbar, you must select an icon to use for that command or macro.



 Overview

To assign an icon to a custom command or macro for use on a toolbar

1. In the Commands list, select the custom command or macro to which you want to assign an icon.
2. Click Icon.

The Select Icon dialog box appears. If an icon is already associated with the command or macro, it appears 
in the Available Icons list.

3. Use the Browse button to find the icon that you want to select and click Open.
Note
You must select a file with an .EXE, .ICO, or .DLL extension. EXE (executable) files generally contain multiple 
icons.

4. Select the icon that you want to assign to the command or macro and click OK.
You can now add the command to a toolbar.

 Related Topics



You can import data into your current database from another ACT! database or from another application. In order 
to consolidate all your records into one database, you may want to import records from another ACT! database. Or,
you may need to import data from another software application if you have just begun to use ACT! to manage your
contacts. Occasionally, you may purchase an electronic mailing list and want to import the contacts from the 
mailing list into your ACT! database.
Some users initially create more than one ACT! database and later realize that they would prefer to have all the 
data in one database. You can easily merge two ACT! 3.0 databases by importing the data from one database into 
the other database. If you want to import a database from an earlier ACT! version, you must first convert the 
database to ACT! 3.0 format.

Note
If you were an ACT! 2.0 user, you probably are familiar with the Merge command. The Import command 
includes the Merge functionality of ACT! 2.0.



 Overview

To get started importing another ACT! database

1. Open the ACT! database into which you want to import data.
2. From the File menu, choose Data Exchange > Import.

The first panel of the Import Wizard appears, asking you the type of file that you want to import and the 
name and location of the file. By default, the file type is set to ACT! 3.0 (*.DBF).

3. From the File Type drop-down list, choose ACT! 3.0 (*.DBF).
This specifies that you are importing ACT! 3.0 data.

4. Click the Browse button to the right of the Filename And Location field, locate the ACT! database that you want 
to import, and click Open.
The exact location and name of the selected database appear in the Filename And Location field.

5. Click Next.
If you have a password for the database you are importing, you will be prompted to log on to the database. 
Enter your name and password and click OK. 
The next panel of the Import Wizard appears, asking which kinds of records you want to import.

6. Specify whether to import contact records, group records, or both contact and group records.
7. If you do not want to set any specific merge options, skip to To finish importing another ACT! database.

 Related Topics



 Overview

To specify merge options

1. To specify how ACT! merges the imported data, click Options in the second Import Wizard panel. 
The Merge Options dialog box appears. 

2. Select one or more of the following options:
In the If Source Records Match Destination Records group box, specify how you want ACT! to handle 

duplicate records. When you are importing one ACT! database into another, one or more records may be duplicated 
in both databases. By default, ACT! considers two contact records to be duplicates if they have the same contact 
name, company name, and phone number. In this case, ACT! needs to know how to treat the duplicate records. You 
can decide which contact records, notes/ history records, activity records, and group records to use if duplicates are 
found. Note that the "source records" are the records in the database from which you are importing data; the 
"destination records" are the records in the currently open database into which you are importing data.

In the If Source Records Do Not Match Destination Records group box, specify how you want to import 
different record types. You can decide whether or not to import contact records, notes/history records, activity 
records, and group records.

Select the Confirm Each Match option if you want to review each contact or group prior to merging it into 
the current database. If you select this option, the Merge Confirmation dialog box appears during the import 
operation for each contact or group that matches a contact or group in the open database. You can decide to merge
the matching record into the existing record, add a new record, or skip the record completely.

Select the Include Other Users' Public Activities option if you want to import public activities from other 
users of the database. This option has no effect if the database you are importing is a single-user database. You do 
not need to select this option to import your own public activities. You will always get them.
3. After you select one or more options, click OK.

Note
If you decide to reset all of the merge options to their default settings, click the Default button in the Merge 
Options dialog box, then click OK.

 Related Topics



 Overview

To finish importing another ACT! database

1. Click Next in the Import Wizard panel.
The next panel appears, displaying the map of how the fields in the source database are being assigned to 
fields in the destination database. If the fields in both databases are identical, you do not have to map them.
If you specified that you wanted to import both contacts and groups, a Group Map panel appears after the 
Contact Map panel.

2. Do one of the following:
If the fields are properly mapped, click Finish.
If some of the fields are not mapped correctly, map them using the procedure described in Mapping 

fields from an import file to fields in an ACT! database. When you have finished mapping fields, click Finish.
The data is merged into your currently open database.

 Related Topics



If you want to import contact data into ACT! from another application, you must open the data file in its original 
application and save it as an export file. ACT! will accept data in any of the following formats:

Delimited Text
dBASE III-V
Symantec Q&A 4.0 to 5.0

For information about saving export files in these formats, consult your other application's documentation.
When you bring contact data into ACT! from another application, you need to assign, or "map" the data to the 
appropriate ACT! fields. 



Predefined maps provided by ACT!
ACT! includes predefined maps for the following applications so that you do not have to manually map the fields 
from these applications to the appropriate ACT! fields:

ECCO
FedEx Ship
GoldMine
Janna Contact
Lotus Organizer
Maximizer
Microsoft Schedule+
Sidekick
Sharkware
Tracker

If you have customized a database in any of these applications, the predefined map will not map the customized 
fields, so you will have to map these fields manually. For more information, see Mapping fields from an import 
file to fields in an ACT! database.
Note
If the Enable Duplicate Checking option is turned on in the Advanced tab of the Define Fields dialog box, duplicate 
records will be merged with existing records when you import them. If you turn off the Enable Duplicate Checking 
option, duplicate records will be added as new records when you import them.

 Related Topics



 Overview

To get started importing data from another application

1. Open the application from which you want to import data.
2. Open the file containing the data that you want to import to an ACT! database.
3. Save the data in either Delimited Text, dBASE III-V, or Symantec Q&A 4.0 to 5.0 format.

 Related Topics



 Overview

To import contact data from another application

1. From the ACT! File menu, choose Data Exchange > Import.
The first panel of the Import Wizard appears, asking you the type of file that you want to import and the 
name and location of the file.

2. From the File Type drop-down list, select the format that you used to save your file.
3. Click the Browse button to the right of the Filename And Location field, locate the file you want to import, and 

click Open.
The exact location and name of the selected file appear in the Filename And Location field.

4. Click Next.
The next Import Wizard panel asks you what kind of records you want to import. You can import contact records
or group records from other applications that support group records, but you cannot import both at the same 
time. If you want to import both record types, you must go through the import process twice. To do this, save a 
file containing your contact records and import that file, then save a file containing your group records and 
import that file.

5. Select the kinds of records that you want to import. 
If you are importing a Q&A file, click Next and skip to step 9.

6. If you are importing a delimited text (*.TXT) or a dBASE file, click Options to set additional import options. 
The Import Text File Options dialog box or the Import dBase File Options dialog box appears, 
depending on what type of file you are importing.

7. (Optional) Select the appropriate options in the Import Options dialog box and click OK.
If the delimited text file that you are importing was created in a Macintosh or MS-DOS application, select the 
corresponding character set from the Character Set drop-down list in the Import Options dialog box.

8. In the Import Wizard panel, click Next.
The next Import Wizard panel asks you if you want to use a predefined map file to map data from the file that 
you are importing to fields in the ACT! database. The available maps are displayed in the list at the bottom of 
the panel.

9. Do one of the following:
If you are importing data from one of the applications for which there is a predefined map, select the Use 

Predefined Map option, select the map that you want to use, then click Next. 

If you are importing data from an application that does not appear in the list of maps, select the Don't Use 
Predefined Map option, then click Next.

The next panel lets you verify or change the mapping of the fields in the database that you're importing to the 
fields in the ACT! 3.0 database.

10.Do one of the following:
If you do not need to change the mapping, click Finish. The data is imported into your ACT! 3.0 database.
If you need to change the mapping, follow the instructions in the Mapping fields from an import file to 

fields in an ACT! database.
 Related Topics



When you import a database or a file that was created in another application, you need to specify how to put the 
incoming information into the fields in the currently open ACT! database. ACT! attempts to automatically map as 
many fields as it can, so you may notice that some of the fields are already correctly mapped.



For example, if the incoming field is called "Person," you would select "Contact" in the To This Field column.



 Overview

To map fields from an import file to fields in an ACT! database

1. Follow the panels in the Import Wizard, as described in Importing data from another application.
The Contact Map panel of the Import Wizard appears. If you are importing groups, the Group Map panel 
appears.

2. Select the field you want to map in the Map This Field column, and double-click in the corresponding row in the 
right column.
A drop-down list of field names appears.

3. Select the field to which you want to map the incoming field.    
4. (Optional) If you do not want to import data from one or more fields, select the Do Not Map option from the
drop-down list of field names.
5. Repeat steps 2 through 3 for all of the fields in the left column.

Note
Be aware that if you inadvertently try to map more than one field in the imported file to a single field in the 
ACT! database, the second mapping will overwrite the first mapping.

6. (Optional) If you want to start from the beginning again or you make a mistake, you can restore the default 
mapping by clicking Reset.

7. Do one of the following:
If you want to save the map so that you can reuse it later, follow the instructions in Saving a map.
If you do not want to save the map, click Finish to import the data.

 Related Topics



When you manually map fields as described in the previous procedures, you can save your maps so that you can 
reuse them when you import data in the future. Also, if you select one of the predefined maps and make some 
changes to that map, you can save the revised map. Map files are stored in the ACT! folder with a .MAP extension.



 Overview

To save a map

1. In the Contact Map or Group Map panel of the Import Wizard, map fields as described in Mapping fields from 
an import file to fields in an ACT! database.

2. Click Save Map.
The Save As dialog box appears.

3. Enter a name in the File Name field and click Save.
The map is saved so that you can use it when you import data in the future.

4. Click Finish to import the data.
 Related Topics



 Overview

To reuse a saved map

1. In the Contact Map or Group Map panel of the Import Wizard, click Load Map.
The Open dialog box appears.

2. Locate the map file that you want to use and click Open.
The map is applied to the data you are importing.

3. Click Finish to import the data.
 Related Topics



You can export ACT! data from your current database to another ACT! 3.0 database or to a delimited text file for 
use in another application. When you export data, you can choose to export contact records, group records, or 
both, and you can specify whether to export only the current lookup, the current record, or all records. 
Sometimes you may want to move some of your contact records to another ACT! database. For example, if your 
database is very large and you find that many of your contacts are inactive, you may want to export the inactive 
contact records to another database, then delete them from the original database. In this way, you can reduce the 
size of your current database and get rid of contacts that you don't need, but you have easy access to their 
records if you need them again. If you have not yet created the other database, you can do so during the export 
process.

Note
If you were an ACT! 2.0 user, you probably are familiar with the Transfer command. The Export command 
includes the Transfer functionality of ACT! 2.0 although it does not give you the option of deleting the contacts 
from the open database after you export them.



 Overview

To get started exporting data to another ACT! database

1. If you want to export a single contact or group record, go to that record. If you want to export a specific set of 
contacts, create a lookup of those contacts.

2. From the File menu, choose Data Exchange > Export.
The first panel of the Export Wizard appears, asking you the type of file that you want to export and the name
and location of the file to which you want to export it.

3. From the File Type drop-down list, choose ACT! 3.0 (*.DBF) if it is not already selected.
4. Click the Browse button to the right of the Filename And Location field, locate the database to which you want 

to export your data, and click Open.
If you want to export data to a new ACT! 3.0 database, enter the name of the database that you want to create.

5. Click Next.
If you have a password for the database to which you are exporting data, you will be prompted to log on to the 
database. Enter your name and password, and click OK.
The next Export Wizard panel asks you what kind of records you want to export.

6. Specify whether to export contact records, group records, or both contact and group records.
 Related Topics



 Overview

To specify merge options

1. To specify how ACT! merges the exported data into the destination database, click Options. Note that the 
Options button is dimmed if you created a new database in step 4 of Getting started exporting data to 
another ACT! database.
The Merge Options dialog box appears. 

2. Select one or all of the following options:
In the If Source Records Match Destination Records group box, specify how you want ACT! to handle 

duplicate records.
When you are exporting one ACT! database into another, one or more records may be duplicated in both 
databases. By default, ACT! considers two contact records to be duplicates if they have the same contact 
name, company name, and phone number. In this case, ACT! needs to know how to treat the duplicate 
records. You can decide which contact records, notes/ history records, activity records, and group records to 
use if duplicates are found. Note that the "source" database is the currently open database from which you 
are exporting data; the "destination" database is the database to which you are exporting data.

In the If Source Records Do Not Match Destination Records group box, specify how you want to export 
different record types. You can decide whether or not to export contact records, notes/history records, activity 
records, and group records.

Select the Confirm Each Match option if you want to review each record prior to merging it into the 
destination database. If you select this option, the Merge Confirmation dialog box appears for each contact or 
group that matches a contact or group in the destination database. You can decide to merge the matching record 
into the existing record, add a new record, or skip the record completely.

Select the Include Other Users' Public Activities option if you want to export public activities from other 
users of the database. This option has no effect if you are the only user of the database you are exporting. You do 
not need to select this option to export your own public activities-they are always exported.

Note
If you decide to reset all of the merge options to their default settings, click the Default button in the Merge 
Options dialog box.

3. After you select one or more options, click OK.



 Overview

To finish exporting data to another ACT! database

1. Click Next in the Wizard panel.
The next Export Wizard panel asks you which contact or group records you want to export.

2. Specify whether to export the current record, the current lookup, or all records and click Next.
The next Export Wizard panel asks you to verify or change the mapping of the fields in the database you are 
exporting to the fields in the destination database. Note that this panel does not appear if you created a new 
database in step 4 of Getting started exporting data to another ACT! database.

3. (Optional) Change the mapping of the fields as described in Mapping fields from an import file to fields in 
an ACT! database, and click Next.
If you have already saved an export map, you can reuse it by clicking Load Map and selecting the map that you
want to use.
If you are exporting both contact and group records, a second panel will appear in which you can map the 
group fields.

4. Click Finish.
The records are exported to the destination database.



You can export ACT! data from your current database to another ACT! database or to a delimited text file for use in
another application. When you export data, you can choose to export contact records, group records, or both, and 
you can specify whether to export only the current lookup, the current record, or all records. 
Occasionally, you may need to export ACT! data so that you can use it in another application. For example, you 
may want to export your data so that you can put it into a spreadsheet program.



 Overview

To export data for use in another application

1. From the File menu, choose Data Exchange > Export.
The first panel of the Export Wizard appears, asking you the type of file that you want to export and the name
and location of the file to which you want to export it.

2. From the File Type drop-down list, choose Text-Delimited.
3. Click the Browse button to the right of the Filename And Location field, locate the file to which you want to 

export your data and click Save.
You can enter the name of a new file, and ACT! will create the new file for you.

4. Click Next.
The next Export Wizard panel asks what kinds of data you want to export. You can export contact records or 
group records, but you cannot export both record types at the same time. If you want to export both record 
types, you will have to go through the export process twice by first saving and exporting contact records, then 
saving and exporting group records.

5. Specify whether to export contact records or group records.
6. (Optional) To specify how ACT! exports the data, click Options.

The Export Options dialog box appears.
7. (Optional) Specify the field separator that you want to use when creating your export file, and specify whether 

to export field names, then click OK.
By default, ACT! uses a comma to separate fields when it creates a delimited text file. If the application into 
which you plan to import the file requires tab-separated fields, select Tab. If you select the Export Field Names 
option, the first line of the export file will contain the ACT! field names. This can be useful for mapping fields 
when you import the file into another application.

8. Click Next in the wizard panel.
The next Export Wizard panel asks you which contact or group records you want to export.

9. Specify whether to export the current record, the current lookup, or all records in the database, and click Finish.
The data is exported to a delimited text file.

 Related Topics



You can exchange ACT! data on your desktop personal computer with ACT! databases running on several hand-
held devices, including the HP Palmtop and the Newton MessagePad devices. These hand-held devices are also 
called personal digital assistants, or PDAs. By exchanging data between ACT! on your desktop computer and ACT! 
on your PDA, you can ensure that wherever you are, you have access to the most up-to-date information about 
your contacts.
For example, when making sales calls, you might use ACT! for Newton to add notes or new activities to your 
contact records. When you return to the office, you can send this new information from ACT! for Newton to your 
desktop version of ACT! so that both of your databases contain the same information.
To exchange ACT! data between your desktop computer and your PDA, you must connect the two machines using 
the appropriate serial cable connected to a communications (COM) port. For information about the kind of cable 
you need, see the documentation for your PDA.
Before you can exchange data with a PDA for the first time, you must specify some setup parameters. For 
subsequent data exchanges, you can bypass the setup procedure unless you need to change one or more of the 
settings.



 Overview

To set up data exchange with hand-held devices

1. If you want to exchange a single contact or group record with the PDA device, go to that record. If you want to 
exchange a specific set of contacts, create a lookup of those contacts.

2. From the File menu, choose Data Exchange > Link.
The Link dialog box appears. 

3. Select one of the options in the Link group box.
You can set options for how to send data, how to receive data, or how to do both.
Note
If you are exchanging data with a Newton MessagePad PDA, you can only use the Send And Receive option. The
Send option and the Receive option are not available when linking with the Newton PDA.

4. Click Setup.
The first panel of the Link Setup Wizard appears.

5. Select the type of PDA with which you are exchanging data.
6. Click the Options button to specify the COM port to which the PDA is connected and your PDA's baud rate and 

click OK.
7. Click Next.

The next Link Setup Wizard panel asks you to specify which information to send to the PDA database. You may 
want to send only certain records to your PDA database to conserve space. 

8. In the Contact Selection group box, specify whether you want to send the current contact, the current lookup, 
all contacts, or a selected group to the PDA database.

9. In the Data Selection group box, specify the date range of notes/history and activities to send to the PDA 
database.
If you do not want to send notes/history or activities, select the None option.

10.In the Additional Items To Send group box, select the items you want to send to the PDA database and click 
Next.

If you select the Field Labels option, ACT! sends the field labels used in your ACT! for Windows database to 
the PDA database. 

The Field Drop-downs option is available only for the HP Palmtop devices. If you select this option, ACT! 
sends any items you have defined for your field drop-down lists in your ACT! for Windows database to the PDA 
database.

The next Link Setup Wizard panel asks you to specify a date range for the contacts that you want to send and 
receive. The date refers to the date that the contact record was last modified. 

11.In the Send group box, specify the date range of contact records that you want to send to the PDA database.
You can choose to send all contact records or only contact records added or modified within a certain date 
range. If you select the Date Range option, a drop-down date selector appears.
Select the date range by dragging through the dates you want and releasing the mouse when you have 
specified the end date. To select more than one month, drag through the first month that you want to include, 
then drag off the right side of the calendar. The date selector will scroll through the next months until you move
the pointer back over the date selector. Click outside of the date selector to apply the date range.

12.In the Receive group box, specify which contacts you want to receive from the PDA database. You can select 
one of the following:

Receive all contact records.
Receive contact records that were added or modified since the last time you linked with the PDA database.
Receive contact records that were added or modified within a certain date range. If you select the Date 

Range option, select the date range from the drop-down date selector, as described in step 11.



13.Click Finish.
The Link dialog box reappears, indicating that you have completed the setup procedure and are ready to 
exchange data with a PDA.

 Related Topics



When you have specified how you want to exchange data with a PDA, you are ready to send and receive data. You 
now have three options:

You can send data from your ACT! for Windows database to the PDA database.
You can receive data from the PDA database.
You can send data to the PDA database and receive data from the PDA database simultaneously.

You need to decide which option to select based on which database has been updated since the last time you 
exchanged data. For example, if you recently added contact records to your ACT! for Windows database on your 
desktop computer and are about to go on a business trip, you will want to send data to your PDA database. On 
your trip, you will add more contact data to your PDA database and will want to receive data from your PDA 
database when you return to your office. Sometimes, however, you may update records on both the desktop 
computer's ACT! database and on the PDA's ACT! database; in this case, you will send and receive data 
simultaneously.



 Overview

To perform data exchange with a PDA (Personal Digital Assistant)

1. From the File menu, choose Data Exchange > Link.
The Link dialog box appears. 

2. In the Link group box, select the Send option, the Receive option, or the Send And Receive option.
3. Click Link. 

The data exchange may take some time, especially if you are exchanging large quantities of data.
 Related Topics



If you are one of the many sales professionals and executives who use ACT! and are frequently away from your 
office, you can easily share contact information with your colleagues. ACT! 3.0 includes a data synchronization 
feature that lets you exchange contact data with another ACT! 3.0 user so that the contacts in your database 
match the contacts in the other user's database. This ensures that you and your colleagues have the most up-to-
date information about all of your contacts and groups of contacts, including their notes, histories, and activities.
For example, if you travel on business, you may add new contacts, schedule activities, or record notes about your 
contacts using the ACT! database on your laptop computer. Your main office may have a central ACT! database of 
contacts from all of the company's personnel. Using the ACT! synchronization feature while you are on the road, 
you can send your most current contact information to the central database and receive updated contact 
information from the central database.
Even if you don't need to share data with other ACT! users, you may need to synchronize data between a laptop 
and a desktop computer. For example, if you travel with a laptop computer and have a desktop computer at your 
office, you can synchronize data between the laptop and the desktop computers when you return to your office.



For example, if you changed a contact's telephone number, and someone else changed the same contact's fax 
number, ACT! merges both changes into the contact record. Also, if two users have changed the same contact's 
fax number and the changed fax numbers do not match, ACT! applies only the most recently changed fax number,
ensuring that you have the latest information.



 Overview

To understand data synchronization
Although the data synchronization process is easy to perform, it is helpful if you understand some basic concepts 
before you get started. 
When you use the data synchronization feature, ACT! performs the following tasks:

Receives any updates that have been sent to you and applies them to your database
Consolidates all of the changes from your database and creates an update file containing these changes
Sends the update file to another user or directly to another database

When you synchronize data with another database or with another user, ACT! applies the most current information
on a field-by-field basis.    

 Related Topics



There are two basic ways to send and receive synchronization updates:
Synchronizing directly with another database over a LAN
Synchronizing with a local user or a remote user by means of an e-mail system, a modem, or a shared 

folder on a LAN
You can decide which method is most appropriate for your situation.



For example, if you take your laptop computer on the road and have a desktop computer in the office, you can 
synchronize your data when you come back to the office. Another common use for direct synchronization is with a 
small group of people who work together.



 Overview

To synchronize directly with another database
When you synchronize directly with another database on a LAN, you send your latest updates to the other 
database as you simultaneously receive the latest updates from that database. This is a simple and convenient 
way to synchronize your data. 
You may find this synchronization method more useful if you want to synchronize data between your desktop and 
your laptop computer.    
Following are the requirements to use this synchronization method:

You must have exclusive access to both the local database and the database with which you are 
synchronizing data. All other users will be automatically logged off both databases.

You must have Administrator security level for both the local database and the database with which you 
are synchronizing data. This is not usually a problem with small workgroups, but it may not be desirable for 
everyone to have Administrator security level in large workgroups.

This method is inefficient if you are a remote user dialing into a LAN over a modem or over a WAN (wide 
area network). If you are a remote user, you may want to use one of the methods described in Synchronizing 
with another user.

 Related Topics



 Overview

To synchronize with another user
Synchronizing data remotely with another user is the more flexible method of sending and receiving contact 
updates. Although you do need exclusive access to your own database, you do not need exclusive access to the 
database with which you want to synchronize data. You can use any of the following methods to send and receive 
synchronization updates:

Send and receive updates using an e-mail system.
You must have one of the following products: cc:Mail, cc:Mail Mobile, MS Exchange, MS Exchange Remote, 
CompuServe, or Lotus Notes.

Send and receive updates using a modem.
You need to coordinate with another person to schedule a time when you will send and receive 
synchronization updates. When you are ready to send and receive updates, you or the other user need to put
your modem into "wait for calls" mode. You cannot use the modem while it is waiting for synchronization 
calls.

Send and receive updates using a shared folder on a network.
Each user with whom you synchronize data must have his or her own synchronization folder set up before 
you can start the synchronization process. You need to know the name and location of each user's folder. If 
you want to receive synchronization updates from other users, you need to set up a synchronization folder 
for yourself. By default, your synchronization folder is called Sync and is located in the ACT folder on your 
hard drive. You may need to change the name and location of this folder so that other users can access it.

Send and receive updates using a floppy disk.
If you do not have access to an e-mail system, a modem, or a shared folder on a network, you can exchange 
synchronization updates with another user by means of floppy disks. You set up floppy disk synchronization 
just as you set up a shared folder for synchronization. Instead of specifying the location of a shared folder, 
you specify the location or drive letter of the floppy disk drive.

 Related Topics



Before you send or receive a synchronization update for the first time, you need to run through a setup procedure. 
The setup requires you to specify the following parameters:

The user or database with which you will synchronize data
The method you will use to send and receive updates when you synchronize data with another user
The contacts you want to include in a synchronization update
The types of data that you want to include in a synchronization update

You must be the only user logged on to your database and the database with which you are synchronizing data, 
and you need to have Administrator security level for the database.



For example, you may have changed the drop-down list entries for a field, and the owner of the other database 
may have changed the drop-down list entries for the same field since you last synchronized with that database. 



 Overview

To set up direct synchronization with another database

1. From the File menu, choose Synchronize.
The Synchronize dialog box appears. 

2. Click the Setup button.
The first panel of the Synchronization Setup Wizard appears.

3. Select the Direct Synchronization With Another Database option and click Next.
The next panel of the wizard asks you to specify the database with which you want to synchronize data.

4. Enter the exact location and name of the database, or click the Browse button to the right of the Filename And 
Location field.
The Open dialog box appears, which lets you move up and down through folders to locate the database that 
you want to specify.

5. Locate the database with which you want to synchronize and click Open.
The Synchronization Setup Wizard panel reappears with the correct filename in the Filename And Location field.

6. Click Next.
The next panel of the wizard asks you to specify the types of data that you want to include in the 
synchronization message. By default, ACT! includes notes, histories, and activities. If you turn off these options,
ACT! sends only the basic contact information, such as name, address, telephone numbers, and so on.

7. Select the types of data that you want to include, and click Next.
The next panel of the wizard asks you to specify which of your groups you want to include in the 
synchronization update. You can choose to synchronize all of your contacts and groups or only the selected 
groups.

8. Select either the All Groups And All Contacts option or the Selected Groups option, and click Next.
If you select the Selected Groups option, select the names of the groups that you want to synchronize with this 
user.
The next panel of the wizard asks you to specify whether or not to send and receive private data when you 
synchronize with this database. Private data includes contacts marked as private, private activities, and 
histories of private activities.

9. Specify whether to include private data in your synchronization updates and click Next.
The next panel of the wizard asks whether or not you want to send and receive database field definitions. 
Database field definitions include field names, drop-down lists associated with fields, and any of the definitions 
that you have set for fields in your database. 

10.Specify whether or not to send and receive field definitions.
If you select the Don't Send And Receive Database Field Definitions option, click Next. If you select the Send 
And Receive Database Field Definitions, you must specify which database field definitions to apply if there are 
conflicts, and then click Next.    

You must decide which drop-down list entries you want to apply in the update.
Select the Field Definitions From My Database option to make sure that the definitions from your database 

are applied.
Select the Field Definitions From Other Database option to make sure that the definitions from the 

database with which you are synchronizing data are applied.
Select the Newest Field Definitions From Either Database option to make sure that the most up-to-date 

field definitions are applied, no matter which database they come from.
The next panel asks whether you want to send all records when you synchronize with the selected database, or 
only the records that have been modified since the last synchronization.
Unless this is the first time you are synchronizing data with this database, you should generally select the Send 



Only Changed Records option. If you select the Send All Records option, the synchronization process will take 
much longer.

11.Specify which records you want to include in the synchronization message, and click Finish.
The Synchronize dialog box reappears. You have finished setting up your synchronization and are ready to 
synchronize data.

 Related Topics



You can synchronize data with other ACT! users by means of one of the supported e-mail systems, a modem, a 
shared folder on a LAN, or a floppy disk. When you are setting up synchronization with one or more users, you 
should arrange with your colleagues to determine who is doing the setup and sending the first synchronization 
update. One of you should first set up the other user as a synchronization user and send a synchronization update 
to that user. When the user receives the synchronization update, he or she will receive notification that this is an 
update from a new user, and will have to go through the setup procedure. From that point on, you can send 
synchronization updates back and forth without any further setup procedure.

Note
If you are synchronizing data with other users via an e-mail system, you must first set up your e-mail address 
for that system in the My Record.



 Overview

To set up synchronization with one or more users

1. From the File menu, choose Synchronize.
The Synchronize dialog box appears. 

2. Click the Setup button.
The first panel of the Synchronization Setup Wizard appears.

3. Select the Synchronization With Other Users option and click Next.
The next panel of the wizard shows you a list of the users who are already set up for synchronization. If no 
users are set up for synchronization, the list is empty.

4. Do one of the following:
Click Select All, then click Next if you want to synchronize data with all the users in the list.
Double-click one or more user names to select or deselect them, and click Next. A user is selected if a 

checkmark appears to the left of the user's name in the list. If you deselect users, you will not synchronize data with
them during the next synchronization procedure. 

Click Add User if you need to set up one or more users for synchronization.
Select a user and click Modify User if you need to change any settings for an existing user. 

If you select one or more users and click Next, a panel appears asking you to specify the types of data that you 
want to include in the synchronization update. By default, a synchronization update includes notes, histories, 
and activities. If you turn off these options, ACT! sends only the basic contact information, such as name, 
address, telephone numbers, and so on. 

5. Select the types of data that you want to include, and click Finish.
The Synchronize dialog box appears, and you are ready to synchronize data with the selected users. 

 Related Topics



Before you can synchronize data with another user, you must first set up the other user as a synchronization user 
of your database. You also need to specify how to connect with the user, which groups of contacts to synchronize 
with the user, and what kinds of data to send to and receive from the user.

Note
An easy way to set up multiple users for synchronization is to use the Define Users dialog box.



What you can select and what you need to enter in the E-mail Address Or Location field
Connect Via option Enter the following:
cc:Mail, Lotus Notes, 
CompuServe, MS 
Exchange

User's e-mail address. You can click 
the Browse button to select the user's
name from your e-mail system's 
address book.

Modem User's modem number, including any 
required dialing prefixes (such as 9) 
to access an outside line, area codes, 
and country codes.

Shared Folder Location and name of folder or floppy
disk that the user has set up for 
synchronization.

For example, all of Robert's contacts go in the Robert group. When you enter a new group name, ACT! creates the 
new group.



For example, if you have added a new field to your database and you include field definitions in your 
synchronization update, the field is automatically added to the other users' databases if they choose to receive 
field definitions when they apply your synchronization update.



 Overview

To set users' synchronization privileges

1. From the File menu, choose Synchronize.
The Synchronize dialog box appears. 

2. Click the Setup button.
The first panel of the Synchronization Setup Wizard appears.

3. Select the Synchronization With Other Users option and click Next.
4. Click Add User.

The next panel asks whether to create a new user or to make an existing user a synchronization user.
5. Select either the New User Name option or the Make Existing User A Synchronization User option.

The New User Name option lets you add a new user to your database and give the user synchronization 
privileges. The Make Existing User A Synchronization User option lets you give synchronization privileges to 
someone who is already set up as a user of your database.

If you select the New User Name option, enter the new user's name and click Next.
If you select the Make Existing User A Synchronization User option, select the existing user's name and 

click Next.
The next panel asks how you want to connect with the selected user.

6. Select your connection method from the Connect Via drop-down list, enter the appropriate information in the E-
mail Address, Location, or Modem Number field, and click Next.    
The next panel asks you to specify to which collection group you want to add the contacts that you receive 
from this user. The group that you specify here will keep track of all contacts received from a particular user, 
whether or not the contacts are members of other groups. The collection group can be useful if you later want 
to run reports on the contacts that you received from a specific user. Note that you are not required to specify a
collection group. If you do not want a collection group, delete the default collection group name.

7. Select an existing group from the Collection Group list or enter a new group name in the Collection Group field, 
and click Next.
You may find it convenient to use the user's name as the collection group name.    

The next panel asks which of your contact groups you want to synchronize with the selected user.
8. Select either the All Groups And All Contacts option or the Selected Groups option, and click Next.

If you select the Selected Groups option, select the names of the groups that you want to synchronize with this 
user.
The next panel of the wizard asks you to specify whether or not to include private data, including private 
contacts, activities, and histories, when you synchronize with this user, and whether or not to send database 
field definitions.
Database field definitions include field names, drop-down lists associated with fields, and any of the definitions 
that you have set for fields in your database.    
Note
When a new field is received during a synchronization update, the field does not automatically appear in the 
layout. The recipient of the new field must manually add the field to the appropriate layout. For information 
about doing this, see Adding fields to layouts.

9. Specify whether to include private data and database field definitions in your synchronization updates and click
Next.
The next panel asks you whether you want to receive private data and database field definitions from the 
selected user. Field definitions include field names, drop-down lists associated with fields, and any of the 
definitions that you have set for fields in your database. 



Note
Accepting database field definitions can affect your database structure. If you are concerned about this, select 
the Don't Accept Database Field Definitions option.

10.Specify whether you want to receive either or both private data and field definitions from this user and click 
Next.
The next panel asks whether you want to send all records when you synchronize with the selected users or to 
send only the records that have been modified since the last synchronization.
Unless this is the first time you are performing a synchronization, you should generally select the Send Only 
Changed Records option. If you select the Send All Records option, the synchronization process will take much 
longer.

11.Specify which records you want to include in the synchronization message and click Finish.
You are returned to the panel that lets you select users for synchronization.

12.Do one of the following:
Click Next if you do not need to set up additional users for synchronization.
Repeat steps 4 through 11 if you need to set up additional synchronization users. When you have set up all

of your synchronization users, click Next.
The next panel of the wizard asks you to specify the types of data that you want to include in the 
synchronization message. By default, ACT! includes notes, histories, and activities. If you turn off these options,
ACT! sends only the basic contact information, such as name, address, telephone numbers, and so on.

13.Select the types of data that you want to include and click Finish.
The Synchronize dialog box appears, and you are ready to synchronize data with the selected users. 

 Related Topics



Although you can set up users for synchronization using the Synchronization Setup Wizard, you may find it more 
convenient to set up all of your users at one time in the Define Users dialog box. All of the synchronization options 
in the Define Users dialog box are also available in the Synchronization Setup Wizard. For additional information 
about any of these options, see Setting users' synchronization privileges.



 Overview

To specify user settings for synchronization

1. From the File menu, choose Administration > Define Users.
The Define Users dialog box appears with the User Settings tab active. If this is the first time you are adding 
users to the database, only your name appears in the list.

2. Click Add User.
3. Enter a name for the user in the User Name field.
4. Select the Enable Synchronization option.
5. (Optional) Enter a password for the user in the Password field.

You should assign a password only if you are giving the user logon privileges. If you do enter a password, be 
sure to make a note of this so that you can tell the user his or her password. Users can change their passwords 
later if they want.

6. (Optional) Select an option from the Security Level drop-down list.
This option is available only if you select the Enable Logon option. If you are setting up this user only for the 
purpose of synchronization, select the Browse option.

7. (Optional) Select the Enable Logon option.
If you are setting up this user only for the purpose of synchronization, do not select this option; however, if you 
want this user to be able to log on to the database, select this option.

8. Repeat steps 1 through 7 for each user you want to set up for synchronization.
9. Follow the instructions to specify how to send and receive synchronization messages from users.

 Related Topics



 Overview

To specify how to send synchronization messages to a user

1. In the Define Users dialog box, click the Send tab.
2. Select the user that you are setting up for synchronization.
3. Select an option from the Connect Via drop-down list.

This option determines how you will send synchronization updates to the selected user.
4. Enter the e-mail address, shared folder location, modem phone number, or floppy disk drive location in the next

field.
If you selected an e-mail system or a shared folder in the Connect Via drop-down list, you can use the Browse 
button to the right of the E-mail Address Or Location field to locate and select the e-mail address or shared 
folder.

5. Specify which groups you want to include when you send synchronization updates to the selected user.
6. (Optional) Select the Send Database Field Definitions option.

This option determines whether or not to send database field definitions, including new fields, modified fields, 
and field drop-down list definitions, when you synchronize data with the selected user.

7. (Optional) Select the Send Private Data option.
This option determines whether or not to send private data when you synchronize with the selected user.

8. (Optional) Select the Send All Records option.
In general, you should select this option only the first time you synchronize data with the selected user. When 
this option is turned off, ACT! sends only the records that have changed since the last synchronization with this 
user, which is more efficient than sending all records each time you synchronize with the selected user.

9. Repeat steps 3 through 8 for each user to whom you want to send synchronization updates.
Next you must specify how you want to receive synchronization messages from the users.

 Related Topics



 Overview

To specify how to receive synchronization messages from a user

1. In the Define Users dialog box, click the Receive tab.
2. Select the user that you are setting up for synchronization.
3. (Optional) From the Collection Group drop-down list, select the group to which you want to add the contacts you

receive from this user. Note that the collection group field can be cleared by clicking the No Group button in the
drop-down list.

4. (Optional) Select the Receive Private Data option.
This option determines whether or not to accept private data when you receive synchronization updates from 
the selected user.

5. (Optional) Select the Accept Database Field Definitions option.
This option determines whether or not to accept database field definitions when you receive synchronization 
updates from the selected user. Database field definitions include new fields, modified fields, and field drop-
down list definitions.
Note
Accepting field attributes can affect your database structure. If you are concerned about this, select the Don't 
Accept Database Field Definitions option.

6. Repeat steps 2 through 5 for each user from whom you will receive synchronization updates.
7. When you have finished setting up the users for synchronization, click OK.

 Related Topics



You can exchange synchronization updates with another user by means of a shared folder on a networked 
computer or server. The shared folder acts as an "inbox" for receiving synchronization updates. If you want to 
synchronize data back and forth with a user, each of you needs your own synchronization folder. You need to 
create the folders before you use the Synchronization Setup Wizard. 

Note
You must have full access privileges for the folder to which you will send synchronization updates. For 
information about setting up folder access privileges, contact your system administrator.

When you set up a user for synchronization in the Synchronization Setup Wizard, you specify the name and 
location of the user's shared synchronization folder. You specify the name and location of your own shared 
synchronization folder in the Preferences dialog box.
If you do not have access to a shared folder on a network, you can synchronize with another user via a floppy disk.
You can set this up exactly as you set up a shared folder. When you are prompted to enter the location of the 
shared folder, enter the drive letter for the floppy drive.



 Overview

To specify the location of your synchronization folder or floppy disk

1. In Microsoft Windows, create a folder in which you will receive synchronization updates.
Note
Your synchronization folder must be accessible to all users with whom you plan to synchronize data.
If you need information about creating folders, see your Windows online help.

2. Set up the appropriate access rights for your folder.
Contact your system administrator if you need help assigning access rights.

3. From the ACT! Edit menu, choose Preferences.
4. Click the General tab if it is not already selected.
5. From the File Type drop-down list in the Default Locations group box, choose Synchronize.
6. In the Location field, enter the name of the your synchronization folder or the location of your floppy disk drive 

and click OK.
You can also use the Browse button ("...") to the right of the location field to locate and select your folder.

 Related Topics



You can send and apply synchronization updates at the same time, or you can perform either task separately. 
Note
If you are synchronizing data directly with another database and other users are logged on to the target 
database, they will be automatically logged off.



 Overview

To send and apply synchronization updates

1. From the File menu, choose Synchronize.
The Synchronize dialog box appears.
The Current Setup group box displays your current synchronization method. If you need to change any of the 
settings, click the Setup button and make any necessary changes. When you finish the setup, the Synchronize 
dialog box reappears.

2. Select either or both of the Apply Updates and Send Updates options.
The Apply Updates option performs the following functions:

If you are synchronizing directly with another database, ACT! looks for updates in the specified database 
and applies them to your database. 

If you are synchronizing with other users, ACT! looks for updates in your e-mail inboxes, your shared folder,
your synchronization folder (by default, the ACT\SYNC folder), and your Briefcase. You will be prompted to log on to 
all the e-mail systems for which you have an e-mail address.

The Send Updates option performs the following functions:
If you are synchronizing directly with another database, ACT! sends your updates to the specified 

database.
If you are synchronizing with other users, ACT! sends your updates using the method you have specified. If

you are sending updates using e-mail, you will be prompted to log on to the appropriate e-mail system.
3. If you are synchronizing with another user by modem, make sure that the other user's system is in Wait For 

Calls mode.
You turn on Wait For Calls mode in the Synchronization tab of the Preferences dialog box.

4. Select the Clear The Synchronized Records To Be Deleted option if you do not want to create a lookup of the 
records that were deleted in the other database.
If you do not select this option, a lookup will be created containing the records that were deleted in the other 
database. After you’ve applied a synchronization update, you can view these records and if you want, delete 
them from your database.

5. Click Synchronize.
Any updates that are found are applied to the currently open database, then your updates are sent to the 
specified database or users.

 Related Topics



What happens when you send synchronization updates using different setup options
Synchronization Setup What happens when you send 

updates
Direct synchronization 
with another database

ACT! opens the other database and
applies the synchronization 
updates.

Synchronization with a 
local or remote user via 
e-mail

ACT! attaches your synchronization
update file to an e-mail message 
and sends the update file using the
specified e-mail system. Note that 
if you are using cc:Mail Mobile or 
MS Exchange Remote, the 
synchronization updates are not 
sent until you dial in to send e-mail 
messages.

Synchronization with a 
local or remote user via 
shared folder

ACT! places your synchronization 
update file in the synchronization 
folder you have specified for each 
user.

Synchronization with a 
remote user via modem

ACT! dials the modem number that 
you have specified for the user and
sends your updates over the 
modem line, then receives updates 
from the other user's database.

 Overview

To understand what happens when you send updates
Depending on your synchronization setup, different events occur when you send synchronization updates.    

 Related Topics



 Overview

To understand what happens when receiving updates directly from another database
When you receive synchronization updates directly from another database, the updates are applied immediately to
your currently open database. If you select both the Apply Updates and the Send Updates options, your database 
and the other database are updated simultaneously. You must be the only user currently logged on to both 
databases. If users are logged on, they will be automatically logged off.

 Related Topics



When you receive synchronization updates from another user via e-mail, the updates appear in your ACT! e-mail 
inbox. ACT! uses the e-mail addresses that you have set in your My Record to determine which inboxes it should 
check for updates. If you are using cc:Mail Mobile or MS Exchange Remote, you must dial in to your e-mail system 
from ACT! to receive synchronization updates. 
When you select the Apply Updates option in the Synchronize dialog box, any updates that you have received via 
e-mail are automatically applied to the open database, unless you are receiving updates from a user with whom 
you have never synchronized data. If this is the first time you are receiving an update from a user, you will be 
prompted to set up the new user for synchronization. 

Note
When a synchronization update is not correctly applied from an e-mail message, the update is automatically 
moved to the Briefcase. This can happen if a synchronization update is out of sequence or if it is applied to the 
wrong database. You can apply the message in your Briefcase by selecting the Apply Updates option and 
clicking Synchronize in the Synchronize dialog box. You can also apply updates manually from an e-mail 
message.



 Overview

To apply updates manually from an e-mail message

1. In the ACT! E-mail window, open the e-mail message containing the synchronization updates.
The synchronization updates appear in the Attachments area of the e-mail message.

2. Double-click the synchronization message in the Attachments area.
The updates are applied to the currently open database.

 Related Topics



 Overview

To understand what happens when receiving updates from a remote user via shared folder
When you receive synchronization updates from a remote user via a shared folder, the updates appear in the 
folder that you have set up as your shared synchronization folder. When you select the Apply Updates option in the
Synchronize dialog box, ACT! looks in the specified folder for any synchronization updates and applies them to the 
open database.

 Related Topics



When you exchange synchronization updates with another user via modem, you should either set a time to send 
and receive updates or simply let the other user know when you are about to call to exchange updates. The person
whose modem will answer the call must put ACT! into Wait For Calls mode so that the modem will answer. Updates
are sent and received during a single call, whether you made or received the call. 

Note
When you receive synchronization updates via modem, the updates are not applied automatically. They are 
stored in your synchronization folder until you select the Apply Updates option in the Synchronize dialog box 
and click Synchronize.

When you are in Wait For Calls mode, a dialog box appears with information about synchronization status. You can 
continue to work in ACT! or in another application while you are in Wait For Calls mode; however, you cannot use 
the modem for other tasks such as sending fax messages while you are in this mode.



 Overview

To receive a synchronization message via modem

1. From the Edit menu, choose Preferences.
2. Select the Synchronization tab.
3. If the modem you want to use is not already selected, select a modem from the Currently Selected Modem 

drop-down list.
4. (Optional) If you need to change your modem settings, click Modem Properties.

The Windows Modem Properties dialog box appears where you can specify settings for your modem. For more 
information about the options available in the Modem Properties dialog box, see the Windows online help.

5. Click Wait For Calls.
A Waiting For Calls button appears in the taskbar.

6. When you have finished exchanging updates, click the Waiting For Calls taskbar button.
The Waiting For Calls dialog box appears.

7. Click Cancel.
 Related Topics



After you apply a synchronization update, you may want to see what changes you have received. When you apply 
an update, a history is automatically entered in your My Record, indicating the changes that you received. If you 
want to see which contacts have been changed or added since the last synchronization update, you can use 
commands in the Lookup menu. If you did not select the Clear The Synchronized Records To Be Deleted option in 
the Synchronize dialog box, you can also see which contacts have been deleted in the other database, and if 
you want, you can delete those contacts from your database.



 Overview

To check changes and see which contacts have been added or changed
From the Lookup menu, choose Synchronized Records > Last Synchronized.

The records that were added or changed during the last synchronization are now the current lookup.
 Related Topics



 Overview

To check changes and see which contacts have been deleted in the other database
From the Lookup menu, choose Synchronized Records > To Be Deleted.

The records deleted from the database with which you last synchronized are now the current lookup. You can 
delete them by choosing Delete Contact from the Contact menu.
Note
If you delete several contact records, you may want to reindex your database.

 Related Topics



You may want to make sure that you synchronize data at least once a week, once a month, or at another interval 
to ensure that your database and your colleagues' databases are up to date. You can have ACT! bring up a 
reminder dialog box if you have not synchronized data for a certain number of days.



 Overview

To receive synchronization reminders

1. From the Edit menu, choose Preferences.
2. Click the Synchronization tab.
3. Select the Display Reminder If You Have Not Synchronized In __ Day(s) option.
4. Enter a number of days or use the scroll arrows to select a number of days, and click OK.

If you do not synchronize data within the specified number of days, a dialog box will appear, reminding you to 
synchronize your data.

 Related Topics



You may have certain fields in your database that you do not want to be updated by anyone else, and from which 
you do not want to send updates. For example, you may not want the ID/Status field to be updated because you 
use this field for specific information needed only by you. You can block synchronization for any field in your 
database. This means that no information will be sent from this field and no updates will be applied to this field 
when you synchronize data.



 Overview

To keep a field from being updated when you synchronize data

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box, Fields tab, Advanced tab appears.

2. From the Record Type drop-down list, select Contact or Group.
3. In the field list, select the field on which you want to block synchronization.

You can select only one field at a time.
4. Select the Block Synchronization option.
5. (Optional) Repeat steps 3 and 4 for any additional fields on which you want to block synchronization.
6. Click OK when you have finished.

 Related Topics



You may find it useful to set up a regular schedule for synchronizing your data, and have ACT! automatically 
perform the synchronization. With automatic synchronization, you can leave your computer unattended and still 
receive and send updates. If you use a modem to send and receive updates, you can set a time for synchronization
when telephone rates are lowest. Note, however, that if you are synchronizing data using a remote e-mail system 
such as cc:Mail Mobile, you must connect to your e-mail system and stay connected during the scheduled 
automatic synchronization times.

Note
You cannot use automatic synchronization if you connect to other users via CompuServe.



For example, if you want to synchronize data twice a day, enter 12 in the Every __ Hours field.



 Overview

To set up automatic synchronization

1. From the Edit menu, choose Preferences.
2. Click the Synchronization tab.
3. In the Every __ Hours field, enter the frequency with which you want to synchronize data.

This specifies how often you want to synchronize data between the start and stop times.    
4. In the From field, select a time from the drop-down list.

This specifies the hour at which you want to start the synchronization process.
5. In the Until field, select a time from the drop-down list.

This specifies the hour at which you want to stop the synchronization process.
6. Select the day or days of the week on which you want synchronization to occur and click OK.

Note
You must specify at least one day of the week to schedule automatic synchronization. If you do not select a 
day, automatic synchronization will not occur.

7. Leave the database open.
If you are synchronizing via modem, you must turn on the Wait For Calls option in the Synchronize tab of the 
Preferences dialog box.
Synchronization updates will be sent and received automatically at the specified times and intervals. Note that 
if you are using cc:Mail Mobile or MS Exchange Remote, ACT! puts outgoing updates in your outbox and sends 
them the next time you connect to your e-mail system.
Note
If you receive updates from a user who is not already set up as a synchronization user of your database, ACT! 
puts the incoming updates in your e-mail Briefcase and sends you a message informing you of the update. You 
can apply the message in your Briefcase by selecting the Apply Updates option and clicking Synchronize in the 
Synchronize dialog box.

 Related Topics



Every time you modify ACT! data, ACT! automatically tracks the field-by-field changes to a database in a 
transaction log. The transaction log gets significantly larger with each synchronization and takes up more and 
more disk space. After a certain amount of time, you should clear the transaction log.

Note
If for some reason you do not want changes tracked in the transaction log, you can turn off the Enable 
Transaction Logging option in the Advanced tab of the Define Fields dialog box.

You can clear the transaction log on a regular schedule by setting the Purge Transaction Log After __ Day(s) option 
in the Synchronization tab of the Preferences dialog box. You can also clear the transaction log at any time by 
selecting the Transaction Log option in the Database Maintenance dialog box.



 Overview

To set a schedule for clearing the synchronization transaction log

1. From the Edit menu, choose Preferences.
2. Click the Synchronization tab.
3. Select the Purge Transaction Log After __ Day(s) option.
4. Enter a number of days and click OK.

 Related Topics



 Overview

To clear the synchronization transaction log immediately

1. From the File menu, choose Administration > Database Maintenance.
The Database Maintenance dialog box appears.

2. In the Purge group box, select Transaction Log.
The Before field appears to the right of the Transaction Log option.

3. From the Before drop-down calendar, select a date. 
Caution
All changes in the transaction log prior to the specified date will be purged. Be sure not to specify a too-recent 
date; if you purge the transaction log of changes that have not yet been synchronized, they will be lost.

 Related Topics



When you create an ACT! database, you are automatically the administrator of that database. As the database 
administrator, you can set up other ACT! users so that they have access to your database. You are also responsible
for keeping your data safe by performing regular database maintenance and backing up the data. Even if you are 
the only user of a database, you should still perform regular backups and maintenance of your data. 
Even if you are the only user of your database, you may want to set a password for it. This ensures that no one 
else can view or make changes to your data if they are using your computer. In a multiuser database, all users 
should have their own passwords.

Note
Please make a note of your password and keep it safe so that you can find it easily if you forget it. If you lose 
your password, you will not be able to open your database, and ACT! Technical Support might not be able to 
help you restore the password.



  Overview

To set a password for your database

1. From the File menu, choose Administration > Set Password.
The Set Password dialog box appears.

2. Enter the password in the New Password field, retype the password in the next field and click OK.
If a password has already been set, you need to enter the old password in the Old Password field.

 Related Topics



When you first create a database, you are the only user of that database. If you want, you can set up your 
database so that other users have access to it. For example, you may be a sales manager with an assistant who 
schedules your appointments and a group of sales representatives in the field. All of you may need access to the 
same database. You can set up your assistant and your sales representatives as users of your database.

Note
Do not confuse the term user with the term contact. A user is someone who has access privileges to your 
database; a contact is a record contained in the database.

The shared database must be on a networked computer to which the other users have access. When you add 
access for other users, you can specify their security level, which determines what actions they can perform when 
they log on to the database. Each user of the database will have his or her own My Record in that database.
If you use the ACT! synchronization feature, you can quickly set up the users with whom you want to synchronize 
data.



 Overview

To add users to a database

1. From the File menu, choose Administration > Define Users.
The Define Users dialog box appears with the User Settings tab active. If this is the first time you're adding 
users to the database, only your name appears in the list.

2. Click Add User.
3. Enter a name for the user in the User Name field.
4. Enter a password for the user in the Password field.

Note
Be sure to make a note of this so that you can tell the user his or her password. If users lose their passwords, 
they will not be able to open their databases, and ACT! Technical Support might not be able to help restore the 
passwords.

5. (Optional) Select the Enable Logon option.
In most cases, you will turn on this option; however, if you are setting up a user only for synchronization 
purposes, you may not want this user to be able to log on to the database.

6. If you selected the Enable Logon option in the previous step, select an option from the Security Level drop-
down list.

A user with Browse security level can see the records in the database, but cannot add, modify, or delete 
records.

A user with Standard security level can see the records in the database and can add, delete, and modify 
records; however, standard users cannot add new users to the database, synchronize with another database or 
user, perform maintenance on the database, or modify the database fields.

A user with Administrator security level can perform any database function, including adding new users, 
synchronizing data, performing database maintenance, and modifying the database fields.
7. (Optional) Select the Enable Synchronization option if you want to be able to synchronize data with this user.

Note
If you select the Enable Synchronization option, you must specify how to exchange synchronization 
updates with this user. 

8. Repeat steps 2 through 7 for each user that you want to set up. Click OK when you have finished adding users.
 Related Topics



At some point, you may want to remove a user's access privileges to your database. This may occur if an 
employee leaves the company or is transferred to another division and no longer needs access to the database. 
You can do this by deleting the user's name from the list of authorized users. When you delete a user from your 
database, you can either transfer that user's records to another user or delete the user's records entirely.



 Overview

To delete a user from your database

1. From the File menu, choose Administration > Define Users.
2. Select the user whose privileges you want to remove.
3. Click Delete User.

The Delete User dialog box appears.
4. Do one of the following:

Select the Delete Records option and click OK if you simply want to delete the user's records.
Select the Reassign To Another User option, then select the user to whom you want to transfer the deleted 

user's records and click OK.
A confirmation message appears asking if you want to delete the user.

5. Click Yes to delete the user.
 Related Topics



As with all electronic data, it is advisable to make frequent backups of your ACT! database. If you do this, you will 
be able to recover from unexpected disasters. An easy way to make a backup of an ACT! database is to use the 
Save Copy As command and save the database under a new name. You can also manually copy the database files 
to another location using Windows Explorer, or you can use the Windows 95 Backup program.



 Overview

To back up an ACT! database

1. From the ACT! File menu, choose Save Copy As.
The Save Copy As dialog box appears, asking whether you want to save all the records in the database or 
create an empty copy of the database.

2. Select the Copy Database option and click OK.
The Save As dialog box appears.

3. Select a location, enter a file name for the copied database, and click Save.
You now have a backup of the database.

 Related Topics



For example, if your database is called Contacts, you will need to copy all of the files named Contacts in the 
Database folder.



 Overview

To back up a database manually

1. From Windows Explorer, open the ACT! folder. If you used a different folder name when you installed ACT!, open
that folder.

2. In the ACT! folder, locate the folder where you keep your database.
In most cases, this is the Database folder.

3. Select the database files that you want to back up.
An ACT! database is not a single file-it is made up of more than 15 different files. To back up your database 
manually to another location, you need to copy all of these files.    

To be sure that all of the files are displayed before you attempt to copy them, use the View > Options command in 
the Windows Explorer, and select the Show All Files option. For more information, see your Windows online help. 
Note that an ACT! database might be too large to back up to a single floppy disk, so you will need to back it up to 
another drive, to a network server, or to multiple floppy disks. You might want to use a compression application to 
compress the ACT! database files and save them onto multiple floppy disks.
4. Copy the files to a new location.

You can use the Windows Copy command, the Windows 95 Backup program, or another backup program. If you 
need help with this, see your Windows online help.

 Related Topics



In rare instances, you may need to restore your backup copy of a database. For example, you may have 
inadvertently purged records that you need to see again. Alternatively, a hardware or software problem could have
corrupted your data. Restoring the backup database is as simple as opening the backup copy and saving it to the 
original location from which you backed it up. 



 Overview

To restore a backup copy of a database

1. From the ACT! File menu, choose Open.
2. Locate the backup copy of the database, and click Open.

The backup copy of the database opens.
3. From the File menu, choose Save Copy As.

Save the backup copy using the same name and location as the original database. This will overwrite the 
damaged database and put the backup copy in its place. If you don't want to overwrite the original database, 
save the backup database using a different name.

 Related Topics



If you have Administrator security level, you can lock a database so that other users of the database cannot access
it temporarily. This is useful if you have maintenance tasks that you want to perform on the database. When you 
no longer need exclusive access to the database, you can unlock it so that other users can open it again.



 Overview

To lock other users out of your database

1. From the File menu, choose Administration > Lock Database.
If no other users are currently logged on to the database, the database is locked immediately. If other users are 
logged on to the database, the Lock Database dialog box appears and displays the list of users currently 
logged on to the database.

2. Specify the amount of time until the other users are automatically logged off of the database and click Lock.
The other users receive notification that they must log off the database or be automatically logged off.

 Related Topics 



 Overview

To unlock a database
From the File menu, choose Administration > Unlock Database.

 Related Topics 



You should perform regular maintenance to keep your ACT! database running efficiently. If you do not perform 
database maintenance, you may find that your database performance slows down. 
As you delete records and activities from your database, the database still uses the disk space that was taken up 
by the deleted records. Also, the index still contains references to the deleted records, which can slow down the 
performance of lookup and query procedures. To make your database run more efficiently, you can use the 
Database Maintenance command to rebuild the indexes and delete the empty spaces in the database. In addition, 
you can clean up your database by deleting notes or histories prior to a specified date. You can also delete entries 
in the synchronization transaction log and activities that you have cleared.
It is always good practice to back up your database before you perform maintenance on it. This ensures that you 
will be able to retrieve data that you purge when you perform maintenance.
To use the Database Maintenance command, you must be the only user logged on to the database and you must 
have Administrator security level. If you are the administrator of a multiuser database, you need to lock the 
database before performing maintenance. 

Note
If you are unsure of your security level, choose About ACT! from the Help menu. The About ACT! dialog box 
displays your user name and security level.



For example, if you select the Notes option and select 11/15/96, all notes created prior to November 15, 1996 will 
be deleted from the database.



 Overview

To perform database maintenance

1. From the File menu, choose Administration > Database Maintenance.
The Database Maintenance dialog box appears.

2. From the Reindex group box, select one of the following options:
The Do Not Reindex option leaves the indexes unchanged. You may want to select this option if you quickly

want to purge notes, histories, and so on without taking the time to reindex the database.
The Reindex Database option deletes and rebuilds all the index files. To keep your ACT! database running 

efficiently, you should use this option as often as once a week if you are using the database daily.
The Compress and Reindex Database option deletes and rebuilds all the index files, and recovers space 

from deleted records. You should use this option if you have deleted or merged a number of records. Although this 
is the most time-consuming maintenance operation, this option does the most to optimize the performance of your 
database.
3. (Optional) From the Purge group box, select the items that you want to delete from the database. 

When you select any of the Purge options, the Before field appears to the right of the option name. This lets 
you specify which notes, histories, transaction log, or cleared activities you want to delete.    

The Notes option lets you delete all of the notes created prior to the specified date. 
The Histories option lets you delete all of the history entries created prior to the specified date. 
The Attachments option lets you delete the links to all of the attachments created prior to the specified 

date. Note that the files themselves are not deleted. Only the links to the files are removed.
The Transaction Log option lets you delete synchronization transaction log entries prior to the specified 

date.
The Cleared Activities option lets you delete any activities that you cleared prior to a specified date. When 

you complete activities and clear them, the records of the cleared activities still remain in your database. Also, the 
cleared activities still appear on calendars and activity lists if you specify that you want cleared activities to be 
grayed or struck through. Purging cleared activities removes them completely.
4. Click OK.

 Related Topics 



When you have many contact records in your database, you may find that you have accidentally entered the same
contact more than once-instead of having a single record, you have two or more records for the same person. You 
may also have inadvertently created duplicate group records. ACT! lets you scan your database for duplicate 
contact or group records. If it finds duplicate records, you can decide whether to delete one or more of them. 

Note
You cannot automatically merge duplicate records into one composite record. However, you can copy and paste
data between fields in different records. You can also export one of the duplicate records to a new database, 
then import it back in and merge the duplicate records. 

By default, ACT! uses the following three criteria to find duplicate contact records:
Company name
Contact name
Phone number

If all three of these items are identical in any two contact records, ACT! considers them to be duplicate contact 
records.
By default, when ACT! scans for duplicate group records, it uses the following two criteria to find duplicate records:

Group name
Record creator

If these items are identical in any two group records, ACT! considers them to be duplicate group records.
If you want ACT! to search for different criteria when it checks for duplicate contact or group records, you can 
specify different criteria. For information about this, see Specifying how ACT! checks for duplicate records.



 Overview

To scan for duplicate records in your database

1. Make sure that you are in either the Contact or the Group window, depending on which type of records you 
want to check for duplicates.

2. From the Tools menu, choose Scan for Duplicates.
If ACT! finds duplicate records, it creates a lookup of these records. You can decide whether or not to delete the 
lookup.

 Related Topics



ACT! considers records to be duplicate records if three fields contain identical data. You can specify which three 
fields ACT! searches for duplicate data.



For example, if you select Contact in the first field, Contact is not available in the other two fields. 



 Overview

To specify how ACT! checks for duplicate records

1. From the Edit menu, choose Define Fields.
The Define Fields dialog box appears.

2. Click the Advanced tab.
3. From the Record Type drop-down list, choose Contact.

This lets you specify how ACT! checks for duplicate contact records.
4. In the Match Duplicates Using group box, select the three fields that you want ACT! to search for duplicate 

contact data.
5. (Optional) In the Record Type field, choose Group.

This lets you specify how ACT! checks for duplicate group records.
6. (Optional) In the Match Duplicates Using group box, select the three fields that you want ACT! to search for 

duplicate group data.
7. (Optional) Select the Enable Duplicate Checking option if it is not selected.

When this option is turned on, ACT! notifies you if you enter duplicate contacts or groups.
8. When you have selected the contact or group fields in the Match Duplicates Using group box, click OK.

Note
To specify how ACT! checks for duplicate records, you do not need to make any changes to the settings in the 
Indexes group box in the Advanced tab of the Define Fields dialog box.

 Related Topics



Looking into the database folder
The Database folder contains files with the following set of extensions for the ACTDEMO sample database and each
database you create. You should regularly back up the files for databases you create.
Extension File Description
.ADB Activity database
.ADX Index for the activity database
.BLB Binary large object database
.DBF Contact database
.DDF Database definition file
.EDB E-mail database
.EDX Index for the e-mail database
.GDB Group database
.GDX Index for the group database
.HDB History/notes database
.HDX Index for the history/notes database
.LCK Record locking file for ACT! multiuser databases
.MDX Index for the contact database
.REL Relational table for ACT! databases
.REX Index for the relational table
.TDB Transaction synchronization log database
.TDX Index for the transaction synchronization log 

database
 Related Topics



Looking into the document folder
The Document folder is created to contain files such as letters, fax cover pages, and memos that you create in the 
word processing application you specified for use in ACT! Extensions used are .WPA for ACT! word processor 
documents, .DOC for Microsoft Word documents, and .WPD for WordPerfect documents. You should regularly back 
up any critical documents you create.

 Related Topics



Looking into the layout folder
The Layout folder contains default and alternate contact and group layouts, which define how contact and group 
information is displayed and which fields are displayed. You can modify the layouts or create your own, and save 
them in this folder with an extension of .CLY for contact or .GLY for group. You may want to back up any layouts 
you modify or create.
File Name File Description
ALTERNAT.CLY Alternate contact layout that follows the 

ACT! 3.0 default layout, but has different 
borders.

CONTACT1.CLY Alternate contact layout that displays the 
ACT! 2.0 Contact 1 window.

CONTACT2.CLY Alternate contact layout that displays the 
ACT! 2.0 Contact 2 window.

DEFAULT.CLY The default contact layout for ACT! 3.0.
DEFAULT.GLY The default group layout for ACT! 3.0. This

is a full-function layout that displays all 
group record fields.

LRGFONT.CLY Alternate contact layout that follows the 
ACT! 3.0 default contact layout, but uses 
larger fonts for easier legibility.

LRGFONT.GLY Alternate group layout that follows the 
ACT! 3.0 default group layout, but uses 
larger fonts for easier legibility.

ROTARY.CLY Alternate contact layout that combines 
the ACT! 2.0 Rotary 1 and Rotary 2 
windows. Displays contact fields 
formatted as a rotary card.

 Related Topics



Looking into the macro folder
The Macro folder is created to contain macros you create and want to save for later use. The file extension for 
macros is .MPR. You may want to back up any macros you create.

 Related Topics



Looking into the query folder
The Query folder is created to contain queries you create and want to save for later use. The file extension for 
queries is .QRY. You may want to back up any queries you create.

 Related Topics



Looking at the report templates
ACT! supplies report templates that let you view and print information about your contacts and groups. Report 
templates are contained in the Report folder. You can modify the report templates or create your own, and save 
them to a file in the \REPORT folder with an extension of .REP. Reports you save to a file are given the 
extension .RPT. You may want to back up any report templates you modify or create.
File Name Report Type File Description
ACTIVITY.REP Contact Activities/Time Spent 

Report
CONTACT.REP Contact Contact Report
DIRECTRY.REP Contact Contact Directory Report
GROUP.REP Group Group Report
GRPLST.REP Group Group List Report
GRPMEMBR.REP Group Group Membership Report
HISTORY.REP Contact History Summary Report
NOTEHIST.REP Contact Notes/History Report
PHONELST.REP Contact Phone List Report
REFERRAL.REP Contact Source of Referrals Report
STATUS.REP Contact Contact Status Report
TASKLIST.REP Contact Task List Report

 Related Topics



Looking at the label templates for the United States and Canada
ACT! supplies templates for creating and printing labels. Label templates are contained in the Report folder. You 
can modify the label templates or create your own, and save them in the \REPORT folder with an extension of .LBL.
Labels listed are for laser or ink jet printers, unless dot matrix is specified. You may want to back up any label 
templates you modify or create.
File Name Description
 2160.LBL Address, mini-sheets, 1 across, 8 down
2162.LBL Address, mini-sheets, 1 across, 6 down
2163.LBL Small shipping, mini-sheets, 1 across, 4 

down
4014.LBL Address, dot matrix, 1 across
4143.LBL Address, dot matrix, 2 across
4144.LBL Address, dot matrix, 3 across
4145.LBL Address, dot matrix, 1 across
4146.LBL Small shipping, dot matrix, 1 across
4161.LBL Shipping, red border, dot matrix, 1 across
5160.LBL Address, 3 across, 10 down
5161.LBL Address, 2 across, 10 down
5162.LBL Address, 2 across, 7 down
5163.LBL Small shipping, 2 across, 5 down
5164.LBL Shipping, 2 across, 3 down
5385.LBL Rotary card, 2 across, 4 down
CUSTOM.LBL Custom label

 Related Topics



Looking at the label templates for Europe and Latin America
ACT! supplies templates for creating and printing labels. Label templates are contained in the Report folder. You 
can modify the label templates or create your own, and save them in the \REPORT folder with an extension of .LBL.
You may want to back up any label templates you modify or create.
File Name Description
CSTMELA.LBL Custom label
L7159ELA.LBL Address, 3 across, 8 down
L7160ELA.LBL Address, 3 across, 7 down
L7161ELA.LBL Address, 3 across, 6 down
L7162ELA.LBL Address, 2 across, 8 down
L7163ELA.LBL Address, 2 across, 7 down
L7164ELA.LBL Address, 3 across, 4 down
L7165ELA.LBL Parcel, 2 across, 4 down
L7166ELA.LBL Parcel, 2 across, 3 down
L7168ELA.LBL Shipping, 1 across, 2 down
L7169ELA.LBL Parcel, landscape, 2 across, 2 

down
L7173ELA.LBL Shipping, 2 across, 5 down

 Related Topics



Looking at the label templates for the United Kingdom, Australia, and Asia
ACT! supplies templates for creating and printing labels. Label templates are contained in the Report folder. You 
can modify the label templates or create your own, and save them in the \REPORT folder with an extension of .LBL.
You may want to back up any label templates you modify or create.
File Name Description
CSTMUKA.LBL Custom label
L7159UKA.LBL Address, 3 across, 8 down
L7160UKA.LBL Address, 3 across, 7 down
L7161UKA.LBL Address, 3 across, 6 down
L7162UKA.LBL Address, 2 across, 8 down
L7163UKA.LBL Address, 2 across, 7 down
L7164UKA.LBL Address, 3 across, 4 down
L7165UKA.LBL Parcel, 2 across, 4 down
L7166UKA.LBL Parcel, 2 across, 3 down
L7168UKA.LBL Shipping, 1 across, 2 down
L7169UKA.LBL Parcel, landscape, 2 across, 2 

down
L7173UKA.LBL Shipping, 2 across, 5 down

 Related Topics



Looking at the envelope templates for the United States and Canada
ACT! supplies templates for printing envelopes. Envelope templates are contained in the Report folder. You can 
modify the envelope templates, or create your own and save them in the \REPORT folder with an extension of .ENV.
You may want to back up any envelope templates you modify or create.
File Name Description
 6.ENV 3 5/8 x 6 1/2 inches
9.ENV 3 7/8 x 8 7/8 inches
10.ENV 4 1/8 x 9 1/2 inches
11.ENV 4 1/2 x 10 3/8 inches
12.ENV 4 3/4 x 11 inches
MONARCH.ENV 3 7/8 x 7 1/2 inches

 Related Topics



Looking at the envelope templates for Europe and Latin America
ACT! supplies templates for printing envelopes. Envelope templates are contained in the Report folder. You can 
modify the envelope templates, or create your own and save them in the \REPORT folder with an extension of .ENV.
You may want to back up any envelope templates you modify or create.
File Name Description
C4ELA.ENV 229 x 324 mm
C5ELA.ENV 162 x 229 mm
C6ELA.ENV 114 x 162 mm
C65ELA.ENV 114 x 229 mm
DLELA.ENV 110 x 220 mm

 Related Topics



Looking at the envelope templates for the United Kingdom, Australia, and Asia
ACT! supplies templates for printing envelopes. Envelope templates are contained in the Report folder. You can 
modify the envelope templates, or create your own and save them in the \REPORT folder with an extension of .ENV.
You may want to back up any envelope templates you modify or create.
File Name Description
C4UKA.ENV 229 x 324 mm
C5UKA.ENV 162 x 229 mm
C6UKA.ENV 114 x 162 mm
C65UKA.ENV 114 x 229 mm
DLUKA.ENV 110 x 220 mm

 Related Topics



Looking into the template folder
The Template folder contains ACT!, Microsoft Word, and WordPerfect word processor templates for documents, 
including letters, memos, fax cover pages, and forms. You can modify the templates or create your own, and save 
them in this folder. These extensions are used for word processor templates: .TPL for ACT! word processor 
templates, .ADT for Microsoft Word templates, and .APT for WordPerfect templates. You may want to back up any 
templates you modify or create.
File Name File Description
FAXCOVER.TPL, .ADT, .A
PT

Format for creating a fax cover page
using the ACT! word processor, 
Microsoft Word, or WordPerfect.

LETTER.TPL, .ADT, .APT Format based on the country 
specified when you installed ACT! for
creating a letter using the ACT! word
processor, Microsoft Word, or 
WordPerfect.

LTTRELA.TPL, .ADT, .APT Format for creating a letter to send 
within Europe or Latin America, 
using the ACT! word processor, 
Microsoft Word, or WordPerfect.

LTTRUKA.TPL, .ADT, .APT Format for creating a letter to send 
within the United Kingdom, 
Australia, or Asia, using the ACT! 
word processor, Microsoft Word, or 
WordPerfect.

LTTRUSC.TPL, .ADT, .APT Format for creating a letter to send 
within the United States or Canada, 
using the ACT! word processor, 
Microsoft Word, or WordPerfect.

MEMO.TPL, .ADT, .APT Format for creating a memo using 
the ACT! word processor, Microsoft 
Word, or WordPerfect.

 Related Topics



Looking into the other folders
ACT! has other folders used for the ACT! application software and for other special purposes. Files in these folders 
are used internally by ACT! and do not require special backups.
Folder Name Folder Description
\ACT ACT! application software files
\BRFCASE E-mail files to transfer to another 

computer
\MAIL CompuServe script files
\OUTBOX Outgoing e-mail files that were entered

remotely
\SPELL Spelling dictionary files
\SYNC Database synchronization files

 Related Topics



The default name of the field, as shown in an ACT! layout. You can use Define Fields to change most field names.



The default type of information contained in the field, such as character (text), phone number, or date. You can use
Define Fields to change most field types.



The maximum number of characters allowed for the field. You can use Define Fields to change the size of most 
fields. Some fields have a fixed size, and can't be modified.



Description of the contents of the field.



Contact Database field descriptions
Field Name Type Size Description

2nd Contact Char 50 Second contact's name.
2nd Last Reach Date (fixed) Date of the last completed 

call to the second contact. 
(This field displays by 
default only in the Classic 
Contact 2 layout, but can be 
added to other layouts in 
Design Layouts.)

2nd Phone Phone (fixed) Second contact's phone 
number.

2nd Phone Ext. 
(Ext. displays)

Char 8 Extension for the second 
contact's phone number.

2nd Title Char 50 Second contact's title.
3rd Contact Char 50 Third contact's name.
3rd Last Reach Date (fixed) Date of the last completed 

call to the third contact. 
(This field displays by 
default only in the Classic 
Contact 2 layout, but can be 
added to other layouts in 
Design Layouts.)

3rd Phone Phone (fixed) Third contact's phone 
number.

3rd Phone Ext. 
(Ext. displays)

Char 8 Extension for the third 
contact's phone number.

3rd Title Char 50 Third contact's title.
Address 1 
(Address 
displays)

Char 50 Line one of the contact's 
primary address.

Address 2
(no label 
displays)

Char 30 Line two of the contact's 
primary address.

Address 3
(no label 
displays)

Char 30 Line three of the contact's 
primary address.

Alt Phone Phone (fixed) Contact's alternate phone 
number. (This field is blank 
when an ACT! 2.0 database 
is converted to ACT! 3.0 
format.)

Alt Phone Ext. 
(Ext. displays)

Char 8 Extension for the contact's 
alternate phone number. 
(This field receives the 
extension for the contact's 
home phone number when 



an ACT! 2.0 database is 
converted to ACT! 3.0 
format.)

Assistant Char 50 Name of the contact's 
assistant.

Asst. Phone Phone (fixed) Phone number of the 
contact's assistant.

Asst. Phone 
Ext.
(Ext. displays)

Char 8 Extension for the phone 
number of the contact's 
assistant.

Asst. Title Char 50 Title of the contact's 
assistant.

City Char 30 City in the contact's address.
Company Char 50 Contact's company name.
Contact Char 50 Contact's name.
Contact Type 
(no label or 
field displays)

Numeric 1 Identifies "My Record" to the
database.

Country Char 25 Country in the contact's 
address.

Create Date Date (fixed) Date the contact record was 
created.

Department Char 50 Department in the contact's 
address.

Edit Date Date (fixed) Date the contact record was 
last modified.

Fax Phone (fixed) Contact's fax number.
Fax Ext. Char 8 Extension for the contact's 

fax number. (This field is not 
displayed unless added in 
Design Layouts.)

First Name Char (fixed) Contact's first name. (This 
field is not displayed unless 
added in Design Layouts.)

Home Address 
1

Char 50 Line one of the contact's 
home address.

Home Address 
2

Char 30 Line two of the contact's 
home address.

Home City Char 30 City in the contact's home 
address.

Home Country Char 25 Country in the contact's 
home address.

Home Phone Phone (fixed) Contact's home phone 
number. (This field receives 
the contact's home phone 
number when an ACT! 2.0 



database is converted to 
ACT! 3.0 format. Any 
extension for the contact's 
home phone in ACT! 2.0 is 
placed in the ACT! 3.0 Alt. 
Phone Ext. field by the 
conversion.)

Home State 
(County / 
Land / 
Province)

Char 20 State in the contact's home 
address.

Home Zip 
(Postcode)

Uppercase 10 Zip code in the contact's 
home address.

ID/Status Char 25 Category assigned to the 
contact.

Last Attempt Date (fixed) Date of the last attempt to 
call the contact.

Last Meeting Date (fixed) Date of the last meeting with
the contact.

Last Name Char (fixed) Contact's last name. (This 
field is not displayed unless 
added in Design Layouts.)

Last Reach Date (fixed) Date of the last completed 
call to the contact.

Last Results Char 75 Description of the last 
results with the contact.

Letter Date Date (fixed) Date of the last letter sent to
the contact.

Logon
Carrier
(E-mail Address
displays)

Char -- E-mail address of the 
contact. (This field is stored 
in the E-mail database.)

Merge Date Date (fixed) Date the contact record was 
imported into ACT!, exported
from ACT!, or synchronized 
with another ACT! database.

Mobile Phone Phone (fixed) Contact's mobile phone 
number. (Car Phone displays
when an ACT! 2.0 database 
is converted to ACT! 3.0 
format.)

Owner Char (fixed) The company name of the 
user who created the 
contact record. (This field 
displays by default only in 
the Classic Contact 2 layout, 
but can be added to other 



layouts in Design Layouts.)
Pager Phone (fixed) Contact's pager number.
Phone Phone (fixed) Contact's primary phone 

number.
Phone Ext.
(Ext. displays)

Char 8 Extension for the contact's 
primary phone number.

Public/Private Char (fixed) Access level for the contact. 
Access is public or private. 
(The default of Public is set 
for all contacts when an 
ACT! 2.0 database is 
converted to ACT! 3.0 
format.)

Record Creator Char (fixed) The user who created the 
contact record.

Record 
Manager

Char (fixed) The user permitted to access
and change the status of 
private contacts. (The User 
Name of the logged-on user 
is used when an ACT! 2.0 
database is converted to 
ACT! 3.0 format.)

Referred By Char 30 Description of the contact's 
referral source.

Salutation Char 30 Contact's letter greeting 
name. (Dear displays when 
an ACT! 2.0 database is 
converted to ACT! 3.0 
format.)

Spouse Char 50 Name of the contact's 
spouse.

State (County / 
Land / 
Province)

Char 20 State in the contact's 
address.

Title Char 50 Contact's title.
Unique Id
(no label or 
field displays)

Char 12 Unique system identification 
number.

User 1 Char 50 User-definable field 1.
User 2 Char 50 User-definable field 2.
User 3 Char 50 User-definable field 3.
User 4 Char 50 User-definable field 4.
User 5 Char 50 User-definable field 5.
User 6 Char 50 User-definable field 6.
User 7 Char 75 User-definable field 7.
User 8 Char 75 User-definable field 8.



User 9 Char 75 User-definable field 9.
User 10 Char 50 User-definable field 10.
User 11 Char 50 User-definable field 11.
User 12 Char 50 User-definable field 12.
User 13 Char 50 User-definable field 13.
User 14 Char 50 User-definable field 14.
User 15 Char 50 User-definable field 15.
Web Site URL 

address
75 Contact's Web site URL 

address.
Zip (Postcode) Uppercase 10 Zip code in contact's 

address. (ZIP Code displays 
when an ACT! 2.0 database 
is converted to ACT! 3.0 
format.)

 Related Topics



The default name of the field, as shown in an ACT! layout. You can use Define Fields to change most field names.



Indicates that the field is required by ACT! You cannot change the basic field type attributes of a core field or 
delete a core field.



Indicates that the field has a default index.



Indicates that the ACT! 2.0 field label is displayed in ACT! 3.0 for an ACT! 2.0 database that has been converted to 
ACT! 3.0 format.



Indicates that you can type directly into the field or select the contents of the field from a drop-down list.



Indicates that the field is used by the system and does not appear in Define Fields.



Contact Database field attributes
Field Name Core 

Field
Default 
Index

Convert 
ACT! 2.0 
Field Label

Edit Field 
Contents

System 
Field

2nd Contact N N N Y N
2nd Last Reach N N N Y N
2nd Phone N N N Y N
2nd Phone Ext. N N N Y N
2nd Title N N N Y N
3rd Contact N N N Y N
3rd Last Reach N N N Y N
3rd Phone N N N Y N
3rd Phone Ext. N N N Y N
3rd Title N N N Y N
Address 1 Y N Y Y N
Address 2 Y N Y Y N
Address 3 Y N Y Y N
Alt Phone N N N Y N
Alt Phone Ext. N N N Y N
Assistant Y N Y Y N
Asst. Phone Y N N Y N
Asst. Phone Ext. Y N N Y N
Asst. Title Y N N Y N
Logon Y N N Y N
Carrier
(E-mail Address 
displays)

Y N N Y N

City Y Y Y Y N
Company Y Y Y Y N
Contact Y N Y Y N
Contact Type
(no label or field 
displays)

Y N N N Y

Country Y N N Y N
Create Date Y N N N Y
Department Y N N Y N
Edit Date Y N N N Y
Fax Y N Y Y N
Fax Ext. Y N N Y N
First Name Y Y N N Y
Home Address 1 N N N Y N
Home Address 2 N N N Y N
Home City N N N Y N



Home Country N N N Y N
Home Phone N N Y Y N
Home State 
(County / Land / 
Province)

N N N Y N

Home Zip    
(Postcode)

N N N Y N

ID/Status Y Y Y Y N
Last Attempt Y N N N Y
Last Meeting Y N N N Y
Last Name Y Y N N Y
Last Reach Y N N N Y
Last Results Y N Y Y N
Letter Date Y N N N Y
Logon Y N N Y N
Merge Date Y N N N Y
Mobile Phone N N Y Y N
Owner Y N N Y N
Pager N N N Y N
Phone Y Y Y Y N
Phone Ext. Y N N Y N
Public/Private Y N N Y Y
Record Creator Y N N N Y
Record Manager Y N N Y Y
Referred By Y N Y Y N
Salutation Y N Y Y N
Spouse N N N Y N
State (County / 
Land / Province)

Y Y Y Y N

Title Y N Y Y N
Unique Id
(no label or field 
displays)

Y N N N Y

User 1 N N Y Y N
User 2 N N Y Y N
User 3 N N Y Y N
User 4 N N Y Y N
User 5 N N Y Y N
User 6 N N Y Y N
User 7 N N Y Y N
User 8 N N Y Y N
User 9 N N Y Y N



User 10 N N Y Y N
User 11 N N Y Y N
User 12 N N Y Y N
User 13 N N Y Y N
User 14 N N Y Y N
User 15 N N Y Y N
Web Site N N N Y N
Zip (Postcode) Y Y Y Y N

 Related Topics



The default name of the field, as shown in an ACT! layout. You can use Define Fields to change most field names.



Indicates that the field can be mapped when a delimited text file is imported into ACT! 3.0.



Indicates that the field can be mapped when a delimited text, dBase III-V, or Symantec Q&A 4.0 to 5.0 file is 
imported into ACT! 3.0.



Indicates that the field can be exported from an ACT! 3.0 Contact database to a text delimited file. See the online 
help topic "Contact Database delimited text export fields" for a listing of the fields in the order in which they 
appear in the output file.



Contact Database delimited text import field mapping
Field Name Delimited text

import
mapping

Comments

2nd Contact Y
2nd Last Reach Y
2nd Phone Y
2nd Phone Ext. Y
2nd Title Y
3rd Contact Y
3rd Last Reach Y
3rd Phone Y
3rd Phone Ext. Y
3rd Title Y
Address 1 Y
Address 2 Y
Address 3 Y
Alt Phone Y
Alt Phone Ext. Y
Assistant Y
Asst. Phone Y
Asst. Phone Ext. Y
Asst. Title Y
City Y
Company Y
Contact Y
Contact Type
(no label or field 
displays)

N System field defined by 
ACT!.

Country Y
Create Date N The current date is used.
Department Y
Edit Date N The current date is used.
E-mail Login
E-mail System
(E-mail Address 
displays)

Y
Y

Fax Y
Fax Ext. Y
First Name Y
Home Address 1 Y
Home Address 2 Y
Home City Y



Home Country Y
Home Phone Y
Home State 
(County / Land / 
Province)

Y

Home Zip (Postcode) Y
ID/Status Y
Last Attempt N Field is blank.
Last Meeting N Field is blank.
Last Name Y
Last Reach N Field is blank.
Last Results Y
Letter Date N Field is blank.
Merge Date N The current date is used.
Mobile Phone Y
Note
(for Regarding field 
in History/Notes 
database)

Y

Owner Y
Pager Y
Phone Y
Phone Ext. Y
Public/Private N The default of public is 

used.
Record Creator N The User Name of the 

logged-on user is used.
Record Manager N The User Name of the 

logged-on user is used.
Referred By Y
Salutation Y
Spouse Y
State (County / 
Land / Province)

Y

Title Y
Unique Id
(no label or field 
displays)

N System field defined by 
ACT!.

User 1 Y
User 2 Y
User 3 Y
User 4 Y
User 5 Y



User 6 Y
User 7 Y
User 8 Y
User 9 Y
User 10 Y
User 11 Y
User 12 Y
User 13 Y
User 14 Y
User 15 Y
Web Site Y
Zip (Postcode) Y

 Related Topics



The sequential number of the field as it appears in the delimited text export output file.



The default name of the field, as shown in an ACT! layout. You can use Define Fields to change most field names.



Contact Database delimited text export field order
Field No. Field Name Field No.Field Name

1 Public/Private 39 User 13
2 Record Manager 40 User 14
3 Company 41 User 15
4 Contact 42 Home Address 1
5 Address 1 43 Home Address 2
6 Address 2 44 Home City
7 Address 3 45 Home State 

(County / Land / 
Province)

8 City 46 Home Zip 
(Postcode)

9 State (County / Land / 
Province)

47 Home Country

10 Zip (Postcode) 48 Alt Phone
11 Country 49 2nd Contact
12 ID/Status 50 2nd Title
13 Phone 51 2nd Phone
14 Fax 52 3rd Contact
15 Home Phone 53 3rd Title
16 Mobile Phone 54 3rd Phone
17 Pager 55 First Name
18 Salutation 56 Last Name
19 Last Meeting 57 Phone Ext.
20 Last Reach 58 Fax Ext.
21 Last Attempt 59 Alt Phone Ext.
22 Letter Date 60 2nd Phone Ext.
23 Title 61 3rd Phone Ext.
24 Assistant 62 Asst. Title
25 Last Results 63 Asst. Phone
26 Referred By 64 Asst. Phone Ext.
27 User 1 65 Department
28 User 2 66 Spouse
29 User 3 67 Record Creator
30 User 4 68 Owner
31 User 5 69 2nd Last Reach
32 User 6 70 3rd Last Reach
33 User 7 71 Web Site
34 User 8 72 Create Date
35 User 9 73 Edit Date
36 User 10 74 Merge Date



37 User 11 75 E-mail Login
(from E-mail 
database)

38 User 12 76 E-mail System
(from E-mail 
database)

These ACT! Contact database fields can be exported (unmapped) to a delimited text file, in the output file field 
order listed above. The only contact database fields that cannot be exported are system fields Contact Type and 
Unique Id.

 Related Topics



Group Database field descriptions
Field Name Type Size Description

Address 1 Char 50 Line one of the group's 
address.

Address 2 Char 30 Line two of the group's 
address.

Address 3 Char 30 Line three of the group's 
address.

City Char 30 City in the group's 
address.

Contact Count
(no label or field 
displays)

Numeric 6 Total number of contacts 
in the group.

Country Char 25 Country in the group's 
address.

Create Date Date (fixed) Date the group record 
was created.

Description Char 100 Description of the group.
Division Char 50 Division in the group's 

business address.
Edit Date Date (fixed) Date the group record 

was last modified.
Group Name Char 75 Name of the group.
Merge Date Date (fixed) Date the group record 

was imported into ACT!, 
exported from ACT!, or 
synchronized with 
another ACT! database.

Priority Char 25 User defined description 
of the group's priority. 
Default selections are 
High, Medium, or Low.

Public/Private Char (fixed) Access level for the 
group. Access is public or
private. (Public is set for 
all groups when an ACT! 
2.0 database is 
converted to ACT! 3.0 
format.)

Record Creator Char (fixed) The user who created the
group record.

Record Manager Char (fixed) The user permitted to 
access and change the 
status of private groups. 
(The User Name of the 
logged-on user is used 



when an ACT! 2.0 
database is converted to 
ACT! 3.0 format.)

State (County / 
Land / Province)

Char 20 State in the group's 
address.

Unique Id 
(no label or field 
displays)

Char 12 Unique system 
identification number.

User 1 Char 50 User-definable field 1.
User 2 Char 50 User-definable field 2.
User 3 Char 50 User-definable field 3.
User 4 Char 50 User-definable field 4.
User 5 Char 50 User-definable field 5.
User 6 Char 75 User-definable field 6.
Zip (Postcode) Uppercase 10 Zip code in the group's 

address.
 Related Topics



Group Database field attributes
Field Name Core 

Field
Default 
Index

Edit Field
Contents

System 
Field

Address 1 N N Y N
Address 2 N N Y N
Address 3 N N Y N
City N Y Y N
Country N N Y N
Contact 
Count
(no label or 
field 
displays)

Y N N Y

Create Date Y N N Y
Description Y N Y N
Division N N Y N
Edit Date Y N N Y
Group Name Y Y Y N
Merge Date Y N N Y
Priority Y Y Y N
Public/Private Y N Y Y
Record 
Creator

Y N N Y

Record 
Manager

Y N Y Y

State 
(County / 
Land / 
Province)

N Y Y N

Unique Id
(no label or 
field 
displays)

Y N N Y

User 1 N N Y N
User 2 N N Y N
User 3 N N Y N
User 4 N N Y N
User 5 N N Y N
User 6 N N Y N
Zip 
(Postcode)

N N Y N

 Related Topics



Group Database delimited text import field mapping
Field Name Delimited text 

import 
mapping

Comments

Address 1 Y
Address 2 Y
Address 3 Y
City Y
Country Y
Contact Count N System field defined by 

ACT!.
Create Date N The current date is used.
Description Y
Division Y
Edit Date N The current date is used.
Group Name Y
Merge Date N The current date is used.
Note
(for Regarding 
field in 
History/Notes 
database)

Y

Priority Y
Public/Private N The default of public is 

used.
Record Creator N The User Name of the 

logged-on user is used.
Record Manager N The User Name of the 

logged-on user is used.
State (County / 
Land / Province)

Y

Unique Id N System field defined by 
ACT!.

User 1 Y
User 2 Y
User 3 Y
User 4 Y
User 5 Y
User 6 Y
Zip (Postcode) Y

 Related Topics



Group Database delimited text export field order
Field No. Field Name Field No. Field Name

1 Public/Private 13 User 1
2 Record Manager 14 User 2
3 Group Name 15 User 3
4 Division 16 User 4
5 Address 1 17 Description
6 Address 2 18 User 5
7 Address 3 19 User 6
8 City 20 Record Creator
9 State (County / 

Land / Province)
21 Create Date

10 Zip (Postcode) 22 Edit Date
11 Country 23 Merge Date
12 Priority
These ACT! Group database fields can be exported (unmapped) to a delimited text file, in the output file field order
listed above. The only group database fields that cannot be exported are system fields Contact Count and Unique 
Id.

 Related Topics



Shortcut keys for all ACT! windows
To do the following: Press these keys:
Add a new contact or group. Insert
Apply field changes (Replace window only). Ctrl+A
Attach a file to a contact or group record. Ctrl+I
Bring up the Timer on the screen. Shift+F4
Clear an activity. Ctrl+D
Close a menu or dialog box. Esc
Close the current file or database. Ctrl+W
Copy the selected items or text. Ctrl+C
Cut the selected items or text. Ctrl+X
Delete a contact or group. Ctrl+Delete
Delete the character to the left of the pointer. Backspace
Delete the character to the right of the pointer. Delete
Display an Edit List dialog box, if the field has a 
drop-down list.

F2

Exit from ACT! Alt+F4
Get ACT! online help topics. Shift+F1
Get online help for the current window. F1
Import data from another file or database. Alt+F12
Insert a note for the current contact or group. F9
Make a field blank when you are replacing the field 
contents. Insert a null value (<< >>) for a search.

Ctrl+F5

Move the selected object to the back (Report, 
Label, Envelope, and Layout Design windows only).

Ctrl+B

Move the selected object to the front (Report, 
Label, Envelope, and Layout Design windows only).

Ctrl+F

Open a new file or database. Ctrl+N
Open an existing file or database. Ctrl+O
Paste the items or text last cut or copied. Ctrl+V
Print the information in the current file. Ctrl+P
Record an activity history for the current contact. Ctrl+H
Record or stop recording a macro. Alt+F5
Run a query (Query window only). Ctrl+R
Save a copy of the current file or database with a 
new name.

F12

Save the current file or database. Ctrl+S
Schedule a call. Ctrl+L
Schedule a meeting. Ctrl+M
Schedule a to-do. Ctrl+T
Switch between open windows. Ctrl+F6
Switch between the Timer and the current window. Alt+F6



Switch to the previous layout. F6
Undo your last action. Ctrl+Z
View a mini-calendar. F4
View the contact list. F8
View the task list. F7

Shortcut keys for the ACT! menus
You can use shortcut keys to navigate within a window and quickly perform many tasks. You use shortcut keys for 
ACT! menus and drop-down lists in the following ways:

To display a menu, press Alt in combination with the underlined letter in a word on the menu. For example, 
press Alt+F to display the File menu or Alt+E to display the Edit menu.

To choose a menu command using the keyboard, display the menu using the Alt key in combination with 
the appropriate letter, then press Shift in combination with the underlined letter in the menu command. For 
example, press Alt+F to display the File menu, then press Shift+N to choose the New command.



Shortcut keys for the ACT! calendars
To do the following: Press these keys:
Move between activities scheduled for the same 
time period (weekly or daily calendar).

Shift+Down Arrow/
Shift+Up Arrow

Move the pointer down one week (monthly 
calendar), one hour (weekly calendar), or 30 
minutes (daily calendar).

Down Arrow

Move the pointer up one week (monthly calendar), 
one hour (weekly calendar), or 30 minutes (daily 
calendar).

Up Arrow

View a mini-calendar. F4
View the calendar for the next month (monthly 
calendar), week (weekly calendar), or day (daily 
calendar).

Page Down

View the calendar for the previous month (monthly
calendar), week (weekly calendar), or day (daily 
calendar).

Page Up

View the daily calendar. Shift+F5
View the monthly calendar. F5
View the weekly calendar. F3

Shortcut keys for e-mail
To do the following: Press these keys:
Create an e-mail message. Ctrl+E
Delete an e-mail message. Delete
Forward an e-mail message. Ctrl+F
Put e-mail message(s) in the outbox for later 
delivery.

Ctrl+Shift+Enter

Reply to an e-mail message. Ctrl+Y
Send e-mail message(s) now. Ctrl+Enter

Shortcut keys for the ACT! word processor
To do the following: Press these keys:
Insert a carriage return. Enter
Insert a page break. Shift+Enter
Move the cursor and text one tab stop to the right. Tab
Move the cursor down one line. Down Arrow
Move the cursor down one screen. Page Down
Move the cursor to the beginning of the current 
line.

Home

Move the cursor to the beginning of the current 
paragraph.

Ctrl+Up Arrow

Move the cursor to the beginning of the document. Ctrl+Home



Move the cursor to the beginning of the next 
paragraph.

Ctrl+Down Arrow

Move the cursor to the beginning of the next word. Ctrl+Right Arrow
Move the cursor to the beginning of the previous 
word.

Ctrl+Left Arrow

Move the cursor to the bottom of the current 
screen.

Ctrl+Page Down

Move the cursor to the end of the current line. End
Move the cursor to the end of the document. Ctrl+End
Move the cursor to the top of the current screen. Ctrl+Page Up
Move the cursor up one line. Up Arrow
Select all the text in the current document. Ctrl+A

Navigation shortcut keys for ACT! fields
You can use navigation shortcut keys to move quickly within and between ACT! fields and between contact records
or group records.
The default Sort Contacts By order is alphabetical by company, then alphabetical by last name for contacts in the 
company. The default Sort Groups By order is alphabetical by group name. You can use Sort Contacts By and Sort 
Groups By to change the sort order of contacts and groups.
By default you can use ACT! 2.0 shortcut keys in ACT! 3.0, in addition to new navigation shortcut keys for ACT! 3.0.
To use Page Up/Page Down in drop-drop lists and Ctrl+Home/Ctrl+End in multi-line fields (and disable ACT! 2.0 
navigation shortcut keys), deselect the Move Between Records Using ACT! 2.0 Shortcut Keys option in General 
Preferences. To enable ACT! 2.0 navigation shortcut keys, retain the default selection of Move Between Records 
Using ACT! 2.0 Shortcut Keys.

To do the following: Press these keys:
Move the pointer one character to the left. Left Arrow
Move the pointer one character to the right. Right Arrow
Move the pointer to the beginning of the first line 
in a multi-line field. (Use only if the Move Between 
Records Using ACT! 2.0 Shortcut Keys option has 
been deselected.)

Ctrl+Home

Move the pointer to the beginning of the line. Home
Move the pointer to the end of the last line in a 
multi-line field. (Use only if the Move Between 
Records Using ACT! 2.0 Shortcut Keys option has 
been deselected.)

Ctrl+End

Move the pointer to the end of the line. End
Move the pointer to the first selection in the visible
part of the window of a drop-down list. (Use only if 
the Move Between Records Using ACT! 2.0 
Shortcut Keys option has been deselected.)

Page Up

Move the pointer to the last selection in the visible 
part of the window of a drop-down list. (Use only if 
the Move Between Records Using ACT! 2.0 

Page Down



Shortcut Keys option has been deselected.)
Move the pointer to the next field or selection. Tab
Move the pointer to the next group stop field. Enter
Move the pointer to the previous field or selection. Shift+Tab
Move the pointer to the previous group stop field. Shift+Enter

Navigation shortcut keys for records in Contact and Group windows
To use these shortcut keys to move between records, place the pointer in a field in the Contact or Group window. 
By default you can use ACT! 2.0 shortcut keys in ACT! 3.0, in addition to the new navigation shortcut keys for ACT! 
3.0. See Navigation shortcut keys for ACT! fields for more information on the Move Between Records Using 
ACT! 2.0 Shortcut Keys option, and on changing the sort order for contacts and groups.

To do the following: Press these keys: Press these 
ACT! 2.0 keys:

Display the first contact or group in
the current database or group.

Alt+Home Ctrl+Home

Display the last contact or group in 
the current database or group.

Alt+End Ctrl+End

Display the next contact or group in
the current database or group.

Ctrl+Page Down Page Down

Display the previous contact or 
group in the current database or 
group.

Ctrl+Page Up Page Up

Scroll rapidly through contact or 
group records by jumping to the 
company or group starting with the
next letter alphabetically.

Alt+Page Down Shift+Page 
Down

Scroll rapidly through contact or 
group records by jumping to the 
company or group starting with the
previous letter alphabetically.

Alt+Page Up Shift+Page Up



Click the Browse ("...") button to select a contact if you know that the number you want to conference with or 
transfer to is in your ACT! database.



Click the Browse ("...") button to select a contact if you know that the number you want to conference with or 
transfer to is in your ACT! database.



Click the Browse ("...") button to select a contact if you know that the number you want to conference with or 
transfer to is in your ACT! database.



Type the number here if you know the number you want to conference with or transfer to, or if the number is not in
your ACT! database.



Select a phone number for the current contact from the drop-down list.



Click this button to choose a new contact.



Click these buttons to dial, hang up, forward, hold/unhold, conference, or transfer a phone call. These buttons will 
change depending on the stage of your phone call, and on your computer's dialing capabilities.



Click these buttons to dial, hang up, forward, hold/unhold, conference, or transfer a phone call. These buttons will 
change depending on the stage of your phone call, and on your computer's dialing capabilities.



Click these buttons to dial, hang up, forward, hold/unhold, conference, or transfer a phone call. These buttons will 
change depending on the stage of your phone call, and on your computer's dialing capabilities.



Click this button to close the dialer without making a call.



Displays the contact that you will call with the dialer. Use the Browse button ("...") to choose a new contact.



Click these buttons to dial, hang up, forward, hold/unhold, conference, or transfer a phone call. These buttons will 
change depending on the stage of your phone call, and on your computer's dialing capabilities.



Select the location you are calling from. You can set dialer settings that are different for different locations using 
the Dialer tab of the Preferences dialog box.



Select the location you are calling from. You can set dialer settings that are different for different locations using 
the Dialer tab of the Preferences dialog box.



Displays the number you chose in the Phone Field List with all dialing preferences applied. You can edit this 
number manually. If you know the number, you can simply type it in, being certain to enter all characters for your 
present location.



Displays all the phone fields and telephone numbers associated with the contact.



Click the Browse ("...") button to select a contact if you know that the number to which you want to forward the 
call is in your ACT! database.



Select an option for forwarding your calls from the drop-down list. You can automatically forward all calls to 
another number or forward calls only when your line is busy or not answering. You can also select an option that 
cancels call forwarding.



Click the Browse ("...") button to select a contact if you know that the number to which you want to forward the 
call is in your ACT! database.



Displays the current forwarding status.



Type the number here if you know the number to which you want to forward your calls, or if the number is not in 
your ACT! database.



Select a phone number for the current contact from the drop-down list.



Select the telephone extension or modem address you want to use from the drop-down list. A telephone or modem
"address" is a telephone number. A telephone line may support multiple addresses. For example, the telephone 
line in your office might have two extensions. Each of those extensions is a separate address.



Select the telephone extension or modem address you want to use from the drop-down list. A telephone or modem
"address" is a telephone number. A telephone line may support multiple addresses. For example, the telephone 
line in your office might have two extensions. Each of those extensions is a separate address.



Select this option if you want the dialer to be hidden after dialing a call.



Select a location from the drop-down list.



Select a location from the drop-down list.



Select this option if Caller ID is available in your area. When you select this option, ACT! identifies the telephone 
number of an incoming call and searches your database for a matching number. If a matching telephone number is
found, ACT! automatically displays the contact record that contains the telephone number.



Select this option if your modem has speaker phone capabilities.



Select the modem or telephone line you want to use from the drop-down list.



Select the modem or telephone line you want to use from the drop-down list.



Click this button to set location properties using the Windows Dialing Properties dialog box.



Click this button to set modem properties using a dialog box for your modem or telephony service provider.



Select this option if you want ACT! to automatically time and record histories of your outgoing calls.



Select this option to turn on the dialer.



Select the contact you want to call from the list of available contacts.



This field displays the name of the person with whom you are synchronizing data.



This field displays the status of your call.



If you are in Waiting For Calls mode, you can select this option to take ACT! out of Wait For Calls mode after the 
next call. If you are in Calling Out mode, you can select this option to cancel the synchronization after the current 
call. If you are synchronizing with multiple users, ACT! will not call the remaining users.



Select this option if you are required to dial a 1 before a number that has the same area code as your current 
location.



Dialer dialog box
Use the ACT! dialer to dial your telephone and manage your telephone calls from within ACT!. The Dialer dialog 
box allows you to choose a contact, location, and number to dial. Depending on the type of telephone system or 
modem you use, some of the call management features may not be available.

Dialog Box Options and Controls:
Contact. Displays the contact that you will call with the dialer. Use the Browse button ("...") to choose a 

new contact.
Phone field list. Displays all the phone fields and telephone numbers associated with the contact.
Dialing from. Select the location you are calling from. You can set dialer settings that are different for 

different locations using the Dialer tab of the Preferences dialog box.
Number to dial. Displays the number you chose in the Phone Field List with all dialing preferences 

applied. You can edit this number manually. If you know the number, you can simply type it in, being certain to 
enter all characters for your present location.

Dial as a toll call. Select this option if you are required to dial a 1 before a number that has the same 
area code as your current location.

Dial. Click this button to dial the selected number.
Hang Up. Click this button to disconnect a call.
Forward. Click this button to forward a call to another number.
Hold / Unhold. Click this button to put a call on hold. The button changes to Unhold after someone is put 

on hold.
Transfer. Click this button to transfer a call to another number.
Conference. Click this button to place a conference call.
Close. Click this button to close the dialer without making a call.



Select Contact dialog box
Use this dialog box to choose which contact you want to call using the ACT! Dialer. This dialog box contains a list of
all the contacts in your database. You open this dialog box from the Dialer dialog box, Contact field.

Dialog Box Options and Controls:
Available contacts. Select the contact you want to call from the list of available contacts.



Preferences dialog box, Dialer tab
Use this dialog box and tab to turn on the ACT! Dialer and to set preferences for how it will work with your 
telephone or modem.

Dialog Box Options and Controls:
Use dialer. Select this option to turn on the dialer.
Modem or line. Select the modem or telephone line you want to use from the drop-down list.
Setup. Click this button to set modem properties using a dialog box for your modem or telephony service 

provider.
Location. Select a location from the drop-down list.
Properties. Click this button to set location properties using the Windows Dialing Properties dialog box.
Address. Select the telephone extension or modem address you want to use from the drop-down list. A 

telephone or modem "address" is a telephone number. A telephone line may support multiple addresses. For 
example, the telephone line in your office might have two extensions. Each of those extensions is a separate 
address.

Hide dialer after dialing. Select this option if you want the dialer to be hidden after dialing a call.
Lookup contact using Caller ID. Select this option if Caller ID is available in your area. When you select 

this option, ACT! identifies the telephone number of an incoming call and searches your database for a matching 
number. If a matching telephone number is found, ACT! automatically displays the contact record that contains the 
telephone number.

Start timer automatically on outgoing calls. Select this option if you want ACT! to automatically time 
and record histories of your outgoing calls.

Modem has speaker phone capabilities. Select this option if your modem has speaker phone 
capabilities.



Forward Calls dialog box
Use this dialog box to set different options for forwarding your telephone calls. The type of telephone system you 
use determines which options are available.

Dialog Box Options and Controls:
Forwarding status. Displays the current forwarding status.
Choose new forwarding mode. Select an option for forwarding your calls from the drop-down list. You 

can forward all calls to a number or forward call only when your line is busy or not answering. You can also select an
option that cancels call forwarding.

Forward to. Click the Browse ("...") button to select a contact if you know that the number to which you 
want to forward the call is in your ACT! database.

Phone field. Select a phone number for the current contact from the drop-down list.
Number. Type the number here if you know the number to which you want to forward your calls, or if the 

number is not in your ACT! database.



Conference/Transfer Call dialog box
Use this dialog box to transfer a telephone call to another number. You can also begin a conference call from this 
dialog box. The type of telephone system you use determines which options are available.

Dialog Box Options and Controls:
Contact. Click the Browse ("...") button to select a contact if you know that the number you want to 

conference with or transfer to is in your ACT! database.
Phone field. Select a phone number for the current contact from the drop-down list.
Number to dial. Type the number here if you know the number you want to conference with or transfer 

to, or if the number is not in your ACT! database.



Waiting For Calls/Calling Out dialog box
This dialog box contains information about the status of the synchronization. This dialog box changes from 
"Waiting For Calls" to "Calling Out" depending on the status of your call.

Dialog Box Options and Controls:
Current caller. This field displays the name of the person with whom you are synchronizing data.
Status. This field displays the status of your call.
Cancel after next call/Cancel after this call. If you are in Waiting For Calls mode, you can select this 

option to take ACT! out of Wait For Calls mode after the next call. If you are in Calling Out mode, you can select this 
option to cancel the synchronization after the current call. If you are synchronizing with multiple users, ACT! will not
call the remaining users.



Define Users dialog box, Send tab
Use this dialog box and tab to specify settings for the user when sending contact data.

Dialog Box Options and Controls:
Users. Shows which users have access to the shared database. To modify a user account, click the desired

user's name in this list. The name will be highlighted until you click another name, delete the user's account, or add
a new account. While a name is highlighted, all changes you make apply only to the highlighted user's account.

Connect via. Select a method to use for connecting to another user when sending contact information.
E-mail address or location. Enter the e-mail address or location of a shared folder, depending on your 

connection method.
All contacts and groups. Select this option to include all contacts and groups when sending contact 

information.
Selected groups. Select this option to include only specific groups when sending contact information.
Send database field definitions. Select this option to include database field definitions when sending 

contact data.
Send private data. Select this option to include private data when sending contact information.
Send all records (next update only). Select this option to include all records the next time the user 

sends contact data.
Last sent. Shows when the user last sent contact information.
Add User. Click this button to add the selected user to the database.
Delete User. Click this button to delete the selected user from the database.



Schedule Activity dialog box, Activity Information tab
Use this dialog box and tab to schedule calls, meetings, and to-do's.

Dialog Box Options and Controls:
Activity type. Select a type for the activity. Choose either Call, Meeting, or To-do from the drop-down list.
Date. Enter a date for the activity. The arrow on the right displays a drop-down date selector.
Time. Enter a time for the activity. The arrow on the right displays a drop-down date selector. Click to 

select a starting time and drag to select a starting time and duration.
Duration. Enter the duration of the activity (for example, type 1hr 15min for one hour and fifteen 

minutes), or choose a time period from the drop-down list.
Priority. Select a priority for the activity. Choose High, Medium, or Low from the drop-down list.
With. Specify the contact with whom the activity is scheduled by clicking the Browse ("...") button and 

selecting one or more contacts. Select your name to schedule your personal appointments.
Regarding. Enter a description for the activity or select a description from the drop-down list.
Associate with group. If you want the activity to appear on a group record in addition to a contact 

record, choose a group with which to associate the activity.
Activity color. Select the color in which to display an activity.
Set alarm. Select this option to set an alarm to remind you of a scheduled activity.
Alarm lead time. Select how soon an alarm will sound before a scheduled activity.
Private activity. Select this option if you do not want others to be able to see the activity when they log 

on to your database or when you send them synchronization updates.
Send e-mail reminder. Select this option if you want to be prompted to send e-mail messages to the 

contact(s) when you schedule or reschedule an activity.



Schedule Activity dialog box, Recurring Settings tab
Use this dialog box and tab to choose how frequently your recurring activity will occur.

Dialog Box Options and Controls:
Once. Select this option to cancel a recurring activity.
Daily. Select this option to schedule an activity that occurs every day, every other day, or at any interval 

of days. You can specify the number of days between each occurrence of the activity and the date on which the 
activity is terminated.

Weekly. Select this option to schedule an activity that occurs every week, every other week, or at any 
interval of weeks. You can specify the number of weeks between each occurrence of the activity, on which day of 
the week the activity is scheduled, and the date on which the activity is terminated.

Monthly. Select this option to schedule an activity that occurs every month, every other month, or at any 
interval of months. You can specify the number of months between each occurrence of the activity, the weeks in the
month when the activity is scheduled, the day of the week the activity is scheduled, and the date on which the 
activity is terminated.

Custom. Click this button to schedule activities for specific days of the month.
Activity occurs every. Specify the frequency of a scheduled activity.
Until. Select a date to stop the activity from recurring.
Repeat on these days. Select which days of the week the activity will be repeated.
Repeat on these weeks in the month. Select which weeks of the month the activity will be repeated.



Define Users dialog box, Receive tab
Use this dialog box and tab to specify settings for the user when receiving contact data.

Dialog Box Options and Controls:
Users. Shows which users have access to the shared database. To modify a user account, click the desired

user's name in this list. The name will be highlighted until you click another name, delete the user's account, or add
a new account. While a name is highlighted, all changes you make apply only to the highlighted user's account.

Collection group. Select the group to which you want to add contacts that you receive from the current 
user.

Receive private data. Select this option if you want to receive private data when you receive 
synchronization updates from the current user.

Accept database field definitions. Select this option if you want to receive database field definitions 
when you receive synchronization updates from the current user.

Last received. Shows when you last received contact information. 
Add User. Click this button to add the selected user to the database.
Delete User. Click this button to delete the selected user from the database.



Select this option if you want to receive database field definitions when you receive synchronization updates from 
the current user.



Select the group to which you want to add the contacts that you receive from the current user.



Shows when you last received contact information. 



Select this option if you want to receive private data when you receive synchronization updates from the current 
user.



Enter the e-mail address or location of a shared folder, depending on your connection method.



Select this option to include all contacts and groups when sending contact information.



Select a method to use for connecting to another user when sending contact information.



Enter the e-mail address or location of a shared folder, depending on your connection method.



Enter the e-mail address or location of a shared folder, depending on your connection method.



Shows when the user last sent contact information.



Select which groups to include when sending contact information.



Select this option to include only specific groups when sending contact information.



Select this option to include all records the next time the user sends contact data.



Select this option to include database field definitions when sending contact data.



Select this option to include private data when sending contact information.



Specify the contact with whom the activity is scheduled by clicking the Browse ("...") button and selecting one or 
more contacts. Select your name to schedule your personal appointments.



Select the color in which to display an activity.



Select a type for the activity. Choose either Call, Meeting, or To-do from the drop-down list.



Select a type for the activity. Choose either Call, Meeting, or To-do from the drop-down list.



Specify how soon an alarm will sound before a scheduled activity.



Specify how soon an alarm will sound before a scheduled activity.



Choose a group with which to associate the activity you want to appear on a group record in addition to a contact 
record.



Select the color in which to display an activity.



Enter a date for the activity. The arrow on the right displays a drop-down date selector.



Enter a date for the activity. The arrow on the right displays a drop-down date selector.



Enter the duration of the activity ,for example, type 1 hr 15 min for one hour and fifteen minutes, or choose a 
time period from the drop-down list.



Enter the duration of the activity, for example, type 1 hr 15 min for one hour and fifteen minutes, or choose a 
time period from the drop-down list.



Select a priority for the activity. Choose High, Medium, or Low from the drop-down list.



Select a priority for the activity. Choose High, Medium, or Low from the drop-down list.



Select this option if you do not want others to be able to see the activity when they log on to your database or 
when you send them synchronization updates.



Enter a description for the activity or select a description from the drop-down list.



Enter a description for the activity or select a description from the drop-down list.



Select this option if you want to be prompted to send e-mail messages to the contact(s) when you schedule or 
reschedule an activity.



Enter a time for the activity. The arrow on the right displays a drop-down date selector. Click in the date selector to
select a starting time and drag to select a starting time and duration.



Enter a time for the activity. The arrow on the right displays a drop-down date selector. Click in the date selector to
select a starting time and drag to select a starting time and duration.



Specify the contact with whom the activity is scheduled by clicking the Browse ("...") button and selecting one or 
more contacts. Select your name to schedule your personal appointments.



Specify the contact with whom the activity is scheduled by clicking the Browse ("...") button and selecting one or 
more contacts. Select your name to schedule your personal appointments.



Specify the frequency of a scheduled activity.



Choose from these options to specify when the activity will recur.



Choose from these options to specify when the activity will recur.



Choose from these options to specify when the activity will recur.



Click this button to schedule activities for specific days of the month.



Select this option to schedule an activity that occurs every day, every other day, or at any interval of days. You can
specify the number of days between each occurrence of the activity and the date on which the activity is 
terminated.



Click a date in the calendar to schedule an activity for that date. Displays the days of month and highlights the 
days on which an activity is scheduled. 



Specify the frequency of a scheduled activity.



Specify the frequency of a scheduled activity.



Specify the frequency of a scheduled activity.



Specify the frequency of a scheduled activity.



Select this option to schedule the activity to be repeated during the first week of the month.



Select this option to schedule the activity to be repeated during the fourth week of the month.



Select this option to schedule the activity to be repeated every Friday.



Select this option to schedule the activity to be repeated during the last week of the month.



Select this option to schedule the activity to be repeated every Monday.



Select this option to schedule an activity that occurs every month, every other month, or at any interval of 
months. You can specify the number of months between each occurrence of the activity, the weeks in the month 
when the activity is scheduled, the day of the week the activity is scheduled, and the date on which the activity is 
terminated.



Choose the months in which you want the activity to occur.



Select this option to cancel a recurring activity.



Select which days of the week the activity will be repeated.



Select which days of the week the activity will be repeated.



Choose from these options to set when the activity will occur.



Select this option to schedule the activity to be repeated every Saturday.



Select this option to schedule the activity to be repeated during the second week of the month.



Select this option to schedule the activity to be repeated every Sunday.



Select this option to schedule the activity to be repeated during the third week of the month.



Select this option to schedule the activity to be repeated every Thursday.



Select this option to schedule the activity to be repeated every Tuesday.



Select a date on which the activity will stop recurring.



Select a date on which the activity will stop recurring.



Select this option to schedule the activity to be repeated every Wednesday.



Select this option to schedule an activity that occurs every week, every other week, or at any interval of weeks. 
You can specify the number of weeks between each occurrence of the activity, on which day of the week the 
activity is scheduled, and the date on which the activity will stop.



Choose the weeks in which you want the activity to occur.



If you experience a problem while using ACT!, refer to this troubleshooting information before you call Technical 
Support. This information may help you solve some problems yourself or better identify a problem before you call 
Symantec Technical Support.
A problem that you experience while using ACT! may often be the result of a problem with your Windows operating
system or your hard disk. 
If you need more information on how to resolve specific problems in Windows, refer to the Windows online help.



 Overview
Windows, and Windows applications such as ACT!, create temporary files. Sometimes these temporary files can 
become damaged or may not be deleted when they should be. This can occur if you reboot or turn off your 
computer without properly exiting Windows.

To delete Windows temporary files:

1. Close any applications that you are currently using.
2. From the Windows Start menu, choose Run.
3. In the Run dialog box, enter DOSPRMPT.

An MS-DOS prompt appears.
4. At the command prompt, type SET and press the Enter key. 

The environment variables for your computer system are displayed.
5. Change to the subdirectory identified in the TEMP= line of the display.
6. Type DEL *.TMP.

All temporary files are deleted.
7. To return to Windows, type exit at the command prompt.

 Related Topics



 Overview
You can use the ScanDisk utility to locate and repair file system errors on your hard disk. This procedure should be 
part of your regular system maintenance for Windows. Before using ScanDisk, refer to your Windows online help for 
more information.

Note
If you use a disk compression program, check the program's user's guide to see if using ScanDisk is 
recommended.

To run ScanDisk:

1. On the Windows desktop, double-click My Computer.
2. From the list of available drives, select the disk drive you want to scan.

Normally, this will be your c: drive.
3. From the File menu, choose Properties. 

The Properties dialog box for the disk drive you selected appears.
4. Click the Tools tab.
5. In the Error-checking Status group box, click the Check Now button. 

The ScanDisk dialog box appears.
6. Select the disk drive you want to scan.
7. In the Type of Test Group box, select the Thorough option.
8. Select the Automatically Fix Errors option.
9. Click the Start button. 

ScanDisk checks the disk and repairs any errors.
 Related Topics



 Overview
You should disable any Windows 3.1 (16-bit) or DOS versions of screen savers, anti-virus software or other memory-
resident programs. These 16-bit programs can interfere with your Windows 95 setup, or in the case of anti-virus 
programs, can damage the Windows 95 registry.

To disable 16-bit memory-resident programs:

1. Make backup copies of your AUTOEXEC.BAT, CONFIG.SYS and WIN.INI files.
2. From the Windows Start menu, choose Run. 

The Run dialog box appears.
3. In the Open field, type SYSEDIT and click OK. 

The system configuration editor opens and displays your system configuration files.
4. Click the title bar of the AUTOEXEC.BAT window.
5. In your AUTOEXEC.BAT file, disable all 16-bit drivers, programs, and TSR (Terminate and Stay Resident) 

programs not necessary for the computer to run. TSR's are programs (such as the CD ROM driver on your 
computer) that use your computer's memory to continuously run in the background.

6. Log on to your network (if applicable). Type REM followed by a space at the beginning of the line for each 
program you want to disable.

7. Click the title bar of the CONFIG.SYS window, and repeat step 5 to disable 16-bit programs and TSR's in this file.
8. Click the title bar of the WIN.INI window. In the [windows] section of the WIN.INI file, disable the LOAD= line by 

typing a semicolon at the beginning.
9. From the System Configuration Editor File menu, choose Save, and then choose Exit.
10.Exit and restart Windows, and repeat the steps relating to the initial problems.

If the problems have been corrected, you can restore one of the lines from your AUTOEXEC.BAT file on your 
computer hard disk (delete the REM at the beginning of the line). Restart the computer, launch Windows and 
repeat the steps that produce the initial problem. Repeat this sequence, restoring one line at a time from 
AUTOEXEC.BAT, CONFIG.SYS and WIN.INI until you determine which line is the source of the problems.

 Related Topics



This section provides examples of problems you may encounter and offers possible solutions for each problem. If 
you require more information on problems related to Windows, refer to the Windows online help.



 Overview

I'm having printing problems
Check to see if you can print from other Windows 95 applications.
Check the power supply to your printer.
Check the cable between your printer and your computer.
Make sure that your printer has enough paper.
Reinstall the printer driver.
Make sure that you are using the most recent version of your printer driver. Contact your printer 

manufacturer for an update if necessary.
Make sure that you are using the most recent version of your video driver. Contact your monitor 

manufacturer for an update if necessary.
 Related Topics



 Overview

When I want to print, there are no available printers
Make sure that you have a printer driver installed.
Make sure that you have the selected printer correctly mapped and that you have rights to print to that 

printer.
 Related Topics



 Overview

I'm receiving low disk space errors
Make sure that you have enough free disk space on your active disk drive. 
Delete files as necessary to free up disk space.
Delete Windows temporary files
Run a defragmentation utility such as Norton SpeedDisk or Defrag for Windows. See the relevant utility's 

documentation for more information.
 Related Topics



 Overview

I'm receiving low memory errors
Check for unnecessary programs that might be running.
Check conventional memory and remove unnecessary TSR's.
Close all applications and restart Windows.

 Related Topics



 Overview

My modem is not dialing from ACT!
Check the Windows Modems Properties dialog box to verify that your modem is set up correctly.
Check your modem settings in the ACT! Dialer Preferences tab.

 Related Topics



 Overview

I'm unable to create, open, or save a database to a network location
Check your access rights on the network on which ACT! is located. Make sure that you have Read, Write, 

Create, Erase, Modify, and Scan rights (or similar rights depending on your network).
Check the available disk space on your network.
Try the operation on your local hard drive. If this operation works on your local hard drive, there may be a 

problem with your network.
 Related Topics



 Overview

When I choose Open from the File menu, I cannot see my databases
Make sure that you are looking in the correct folder.
Be sure to choose ACT! 3.0 Database (*.dbf) from the Files Of Type drop-down list in the Open dialog box.

 Related Topics



 Overview

The date format in my ACT! word processing documents is incorrect
Set the appropriate date format in the Windows Regional Settings control panel.

 Related Topics



 Overview

My user name is not accepted when I try to open a database
Make sure that you are typing your name and/or password correctly (note that passwords are not case-

sensitive).
Make sure that you are set up as a user of that database.

 Related Topics



 Overview

When I try to run ACT! from the icon, a different application launches
Check the properties of the ACT! icon, and make sure that the ACT.EXE file is specified.
To check the properties, click the ACT! icon with the right mouse button.

 Related Topics



 Overview

I cannot type characters in one of my fields
From the Edit menu, choose Define Fields, and check the attributes for that field in the Attributes tab of the

Define Fields dialog box.
 Related Topics



 Overview

I cannot delete a contact from the database
Make sure that you have Standard or Administrator security level in the database.
The contact may be a record for a user of the database, in which case the contact cannot be deleted.
If the contact is being edited by another user of the database, the contact record is locked and cannot be 

deleted. In this case, you will see a message informing you that the contact is in use by another user.
 Related Topics
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I cannot insert a new contact
Make sure that you have Standard or Administrator security level in the database.

 Related Topics



 Overview

Tool icons are missing and/or options are dimmed
Check your security level. If you're using a multiuser database, contact your database administrator to 

check your security level.
Close down any applications that you're not currently using.

 Related Topics



 Overview

My database needs repair
Try compressing and reindexing the database.
Contact the Customer Service fax retrieval system and request the document about database repair.
Restore your database from a backup copy.

 Related Topics



 Overview

I'm having graphics problems
Change the display type to a lower resolution. 
Change the video mode to Standard VGA.
Try starting Windows in Safe Mode.
Deselect the video driver and let Windows reselect it.

 Related Topics



 Overview

I'm unable to synchronize my database
Make sure that you have Administrator security level.
Make sure that you have defined the synchronization recipients.
Have 2.5 times (or more) the size of the database memory available on the hard drive.
Purge the transaction log. 
Make sure that your modem is properly set up and selected in ACT! and Windows, and make sure there are

no modem conflicts.
Make sure that the synchronization folders are properly defined and set up.
Make sure that you can access your e-mail system through ACT!.
Check to see if the modem is in Wait for Calls mode in order to receive synchronization updates.

 Related Topics



 Overview

I'm getting a GPF or Exception Error
Check system resources.
Determine the module (print driver or video) and make necessary modifications. See I'm having graphics

problems and I'm having printing problems. 
Try exporting and reimporting the database.
Try exporting the current lookup to a new database.

 Related Topics



If you experience a problem while using ACT!, refer to this troubleshooting information before you call Technical 
Support. This information may help you solve some problems yourself or better identify a problem before you call 
Symantec Technical Support.



 Overview

What you need to know before calling Technical Support
You should have the following information ready before you call Technical Support. This information will help 
expedite your call and will help the technician to better understand your problem.

Version of ACT! you are using (you can find the version by choosing About ACT! from the ACT! Help menu)
Name and location of the ACT! database you are using
Type of computer you are using
Amount of RAM on your computer
Amount of free disk space on your computer
Operating system (including version) you are using
Type or version of network software you are using (if applicable)
Video card driver and manufacturer
Printer brand and model (if applicable)
Modem brand, model, and COM port (if applicable)

 Related Topics



Symantec is committed to excellent service worldwide. Our goal is to provide you with professional assistance in 
the use of our software, wherever you are located.
Technical Support and Customer Service solutions vary by country.



 Overview

Registering your Symantec product
To register your Symantec product, please complete the registration card included with your package and drop the 
card in the mail. You can also register via your modem during the installation process if your software offers this 
feature or send via fax to (800) 800-1438 or (541) 334-7400.

 Related Topics



Symantec's Technical Support department offers expanded support options designed for your individual needs and 
to help you get the most out of your software investment. For support telephone numbers, please see the back of 
the printed manual.



 Overview

StandardCare Support
Symantec's StandardCare Support is designed for customers who need assistance getting started with their new 
software. This support option offers 90 days of telephone technical support (from the date of your first call), and 
access to a wealth of automated and online services to keep you up-to-date on the latest information regarding 
your software.
StandardCare Support is provided at no charge to all registered users of Symantec software, and is available 
Monday through Friday, 7:00 a.m. to 4:00 p.m. Pacific Time. See the back of the printed manual for the support 
telephone number for your product.
For more information on Symantec Support Solutions, including PriorityCare and PremiumCare Support, please call 
our automated fax retrieval service, located in the United States, at (800) 554-4403 or (541) 984-2490, and 
request document 070. Alternatively, visit Symantec on the World Wide Web at www.symantec.com and select the 
Service and Support option.

 Related Topics



Symantec's Technical Support department offers expanded support options designed for your individual needs and 
to help you get the most out of your software investment.
Technical information is available through several online services 24 hours a day. All registered Symantec 
customers have unlimited access to this information.



 Overview

CompuServe and America Online
Exchange information and ideas with Symantec representatives and other users of Symantec products in the 
Symantec forums on CompuServe (GO SYMANTEC) and America Online (Keyword: SYMANTEC).
For additional information, data communications settings, or to subscribe to these services in the United States 
and Canada call:

America 
Online

U.S. and Canada (800) 227-6364

CompuServe U.S. and Canada (800) 848-8199

All Other 
Locations

+1 (614) 529-
1340

 Related Topics



 Overview

World Wide Web, FTP, and Internet Technical Support
Symantec's Internet access provides unlimited access to company and product information. You can access 
Symantec's World Wide Web home page at:
http://www.symantec.com
You can FTP directly to this site to download technical notes and software patches at:
ftp.symantec.com
You can get ACT! technical support on the internet at:
http://www.symantec.com/techsupp/act.html

 Related Topics



 Overview

Symantec Bulletin Board Service (BBS)
The Symantec BBS provides a customer service forum, technical suport newsgroups, shareware and public domain
software, "Frequently Asked Questions" (FAQs), and a download service for the latest antivirus definitions and 
software patches. 
Settings for the Symantec BBS are 8 data bits, 1 stop bit, no parity.

300- through 14,400-baud 
modems

(541) 984-
5366

300- through 28,800-baud 
modems

(541) 484-
6669

 Related Topics



 Overview

Automated fax retrieval system
You can use Symantec's automated fax retrieval system 24 hours a day to receive product information on your fax 
machine.
For general product information, fact sheets and product upgrade order forms, please call our Customer Service 
fax retrieval system on (800) 554-4403 or (541) 984-2490.
For technical application notes, please call our Technical Support fax retrieval system on (541) 984-2490 and select
option 2.

 Related Topics



 Overview

Old version support
When a new version of this software is released, registered users will receive upgrade information in the mail. 
Telephone support will be provided for the previous version for 6 months after the release of the new version. 
Technical information may still be available on the electronic services and automated fax retrieval system. 

 Related Topics



 Overview

Discontinued product support
When Symantec announces that a product will no longer be marketed or sold, telephone support will be 
discontinued 60 days later. Support will only be available for discontinued products through services such as our 
automated fax retrieval system or through documentation posted on electronic services such as the Symantec 
BBS, CompuServe, America Online, Microsoft Network, or the Internet.

 Related Topics



Symantec's Customer Service department can assist you with your non-technical questions. Call Customer Service 
to:

Order an Upgrade.
Subscribe to the technical support solution of your choice.
Fulfill your request for product literature or demonstration disks.
Find out about dealers and consultants in your area.
Replace missing or defective pieces (disks, manuals etc.) from your package.
Update your product registration with address or name changes.



 Overview

Customer Service
Symantec's Service and Support Center for North America is located at:

Symantec 
Corporation

Tel: (800) 441-7234 
(in USA & Canada)

175 W. Broadway
Eugene, OR 97401

Tel: (541) 334-6054 
(for all other locations)
Fax: (541) 334-7400

 Related Topics



Symantec provides technical support and customer service worldwide. Services vary by country and include 
International Partners who represent Symantec in regions without a Symantec office.



 Overview

Worldwide Service and Support

EUROPE:
Symantec Europe Ltd.
Kanaalpark 145
2321 JV Leiden
The Netherlands
Tel: +31 (0)71 5353111
Fax: +31 (0)71 5353150

Automated Fax Retrieval:
Tel: +31 (0)71 5353255

ASIA/
PACIFIC RIM:
Symantec Australia Pty. Ltd.
408 Victoria Road
Gladesville, NSW 2111
Tel: +61(2)879 6577
Fax: +61(2)879 6805

Automated Fax Retrieval:
Tel: +61(2)817 4550
Most International Partners provide customer service and technical support for Symantec products in your local 
language. For more information on other Symantec and International Partner locations, please call our Technical 
Support automated fax retrieval service, in the United States at (541) 984-2490, choose Option 2, and request 
document 1400.
Every effort has been made to ensure the accuracy of this information. However, the information contained herein 
is subject to change without notice. Symantec Corporation reserves the right for such change without prior notice.

 Related Topics




